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Introduction

keptical about your new anodized aluminum iMac, with that supercharged

Intel processor? Perhaps you’re thinking it’s too doggone thin, or you’re

wondering where all the buttons are. Shouldn’t there be places to plug in
cables?

Ladies and gentlemen, I have great news for you: Not only did you make The Right
Decision about which computer to buy, but you also shot a hole in one! Today’s
iMac and iMac Pro have everything a computer power user could want: speed, the
latest in hardware and standards, a top-of-the-line LED screen, and all the
connectors you need to add just about any device meant for today’s computers.

I wrote this book especially for the proud iMac owner who wants to make the most
of this stunning new aluminum computer, so this book is a guide to the iMac and
iMac Pro, Mojave (the latest version of Apple’s superb macOS operating system),
and the digital lifestyle and productivity applications that Apple provides. I start
by describing the basics that every iMac owner should know. Then I move on to
chapters devoted to the software that comes with your iMac. Along the way, you
come across a generous sprinkling of power-user tips and tricks that save you
time, effort, and money.

Foolish Assumptions

So who is the target audience for this book? As in past editions, I make no assump-
tions about your previous knowledge of computers and software. I figure you’ve
either just bought a brand-new iMac or iMac Pro (or you’re considering buying
one). Perhaps you’ve found a great bargain on a gently used older iMac model, and
you’d like guidance as you learn the ropes. Those are the only assumptions
I make . .. and unlike other books that require all sorts of technical experience and
know-how, the only requirement between these covers is your desire to become
an iMac power user (someone who produces the best work in the least amount of
time and has the most fun doing it)!
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By the way, if your friends and family told you that you’re going to spend half your
life savings on software — or that no “decent” software is available for Mac
computers — just smile quietly to yourself! Both iMac models come complete with
about a ton more software than any Windows box, and those applications are
better than anything available on a PC!

This book was written using the latest iMac computer, so owners of older iMac
computers might not be able to follow along with everything I cover. However, if
you’ve upgraded an older Intel iMac with macOS Mojave (and the latest Apple
applications) then you should be able to use most of the book with no problem.

About This Book

2

In writing about the iMac, I’ve kept one precept firmly in mind: macOS Mojave,
the operating system you’ll run, is just as important as the actual iMac computer
itself. Therefore, you’ll find that iMac For Dummies is just as much about familiar-
izing you with all the software you get as it is with introducing you to hardware
features like your keyboard and mouse. After all, it’s relatively easy to connect an
entire forest of cables and turn on any new computer. What comes next is the
challenging part!

As in my other For Dummies titles, I respect and use the same English language you
do, avoiding jargon, ridiculous computer acronyms, and confusing techno-babble
whenever possible.

If you’re upgrading from a PC running the Windows operating system, I’ve got
tips, tricks, and entire sections devoted to those hardy pioneers called Switchers!
You’ll discover both the similarities and differences between the iMac running
Mojave and the PC running Windows. I also show you how to make the switch as
easy and quick as possible.

A word about the conventions I use: Even with an absolute minimum of techno-
speak, this book needs to cover the special keys that you have to press or menu
commands that you have to choose to make things work. Therefore, please keep
this short list of conventions in mind as you read:

¥ Stuff you type: If | ask you to type (or enter) something, such as in a text box
or field, that text appears in bold, like this:

Type me.

iMac For Dummies



If I ask you to type a command within an application, that text appears like this
(and note that you usually have to press the Return key before anything
happens):

Type me.

3 Menu commands: | list menu paths and commands using another format.
For example, this instruction indicates that you should click the Edit menu and
then choose the Copy menu item:

Edit=> Copy

3 Web addresses: No up-to-date book on a computer would be complete
without a bag full of web addresses for you to check out. When you see these
in the text, they look like this: www.mlcbooks . com.

Icons Used in This Book

©

TIP

T
TECHNICAL
STUFF

®

WARNING

@

REMEMBER

)

MARK'S
MAXIM

Like other technology authors, I firmly believe that important nuggets of wisdom
should stand out on the page! With that in mind, this For Dummies book includes
margin icons for certain situations:

This is the most popular icon in the book, and you find it parked next to sugges-
tions that I make to save you time and effort (and sometimes even cash!).

You don’t have to know this stuff, but the technologically curious love high-tech
details. (Of course, we’re great fun at parties, too.)

Always read the information before you take action! I'm discussing something
that could actually harm your hardware or throw a plumber’s helper into your
software.

Consider these nuggets to be highlighter stuff — not quite as universally accepted
(or as important to the author) as a Mark’s Maxim (described next), but good
reminders nonetheless. I use these icons to reinforce what you should remember.

Mark’s Maxims: These are MFRs (short for My Favorite Recommendations). In
fact, I'’ll bet just about any iMac power user would tell you the same. Follow my
Maxims to avoid the quicksand and pitfalls that I’ve encountered with all sorts of
Macs for three decades!

Introduction 3
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Beyond the Book

Thanks to my good friends at Wiley, there’s a ton of extra content to accompany
this book that you won’t find between the covers! Fire up your Safari browser and
go online to find the following:

¥ Cheat Sheet: I've created several Cheat Sheet pages that cover things like
common keystrokes and maintenance procedures that every iMac owner
should follow on a regular basis. To get this Cheat Sheet, simply go to www.
dummies.com and enter iMac For Dummies Cheat Sheet in the Search box.

3 Bonus Chapters: If you're dying to find out how to share data among wireless
devices via Bluetooth technology, check out the handy Bluetooth bonus
chapter at the Wiley website (www . dummies . com) as well as at my website
(www . m1lcbooks . com). You'll also find a spiffy bonus chapter dedicated to
running Windows on your iMac using Boot Camp!

Where to Go from Here

Each chapter in this book is written as a reference on a specific hardware or
software topic. You can begin reading anywhere you like because each chapter is
self-contained. However, I recommend that you read the book from front to back
because the order of this book makes a great deal of sense.

/4. iMac For Dummies
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IN THIS PART ...

Tour the features of your iMac.
Unpack and set up your iMac.

Familiarize yourself with the basics of macOS Mojave.



IN THIS CHAPTER

» ldentifying the important parts of
your iMac

» Locating the right home for your
computer

» Plugging stuff in and getting
hooked up

» Playing with your bundled software

» Buying additional stuff that you
might need

Chapter 1

Okay, This Machine
Looks Really, Really
Weird

ou bought a brand-new iMac or iMac Pro, and there it sits, in the box.
Waiting. Waiting for you.

If you’re a little nervous about unpacking that shiny aluminum and glass rectan-
gle, I completely understand. Face it: The latest iMacs follow in the footsteps of
many revolutionary iMac designs that have come before. In other words, it doesn’t
look like a computer at all, and that can be a bit disconcerting. And if you’re
switching from a Windows PC to the Apple universe, you might find yourself
floating weightlessly in your office or your living room without a familiar bulky
black PC case to anchor yourself — hence, the reluctance you might be feeling.

However, dear reader, let me assure you that you’ve indeed made the right choice.

I commend you! Today’s line of Intel iMacs are the fastest, leanest, and easiest-
to-use self-contained all-in-one computer ever built. Practically everything’s in

CHAPTER 1 Okay, This Machine Looks Really, Really Weird 7
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one shining panel (except for your keyboard and mouse). You have one of the best
backlit LED screens on the planet, a super-fast processor, plenty of RAM
(memory), and a regular laundry list of the latest technology. Best of all, you don’t
have to be a techno-nerd to use all that power!

In this chapter, I introduce you to your new dream machine — whether you choose
the standard iMac or its powerful big brother, the iMac Pro — and give you an
overview of the most important locations within iMac City. I show you how to
unpack your new computer, what wires go where, and where your iMac should set
up housekeeping. I preview the awesome software that’s waiting within that
powerful panel. Finally, I list the accessories that help keep both you and your new
iMac computing smoothly.

iMac Pro - That Is the Question

Until recently, the iMac was offered in only a single model, identified by the year
it was produced and the size of the screen. With the arrival of the iMac Pro, our
venerable computer is now available in two models:

¥ The iMac is the standard home and small-office version, offering enough
power for all of the Apple applications | cover in this book - as well as gaming,
entry-level photography, music production and video editing work. This is
“the iMac for Most Of Us,” as | call it, with the right mix of performance and
affordability. The iMac also offers two display sizes.

¥ TheiMac Pro is the equivalent of a supercar, built for high-end, expensive
applications that demand the best performance possible: professional-level video
editing, 3D modeling, image editing and other processor-intensive programs.
Apple jams plenty of memory and some of today’s fastest processors into the
iMac Pro. The downside? You're going to pay top dollar for an iMac Pro. Period.

Since both iMac models can run the applications I present later in the book,
I won’t be differentiating much between the iMac and iMac Pro (except when I’m
describing hardware features in this chapter). If you haven’t purchased your iMac
yet, remember that the standard iMac model offers plenty of performance for the
average Mac owner. (That’s why I own an iMac!)

Here’s a good yardstick for comparing the iMac to the iMac Pro, presented as a
Mark’s Maxim:

If you need the power of an iMac Pro, you’re likely to know that already.

PART 1 Getting Started with Your iMac



An Introduction to the Beast

The Intel iMac might look like a sculpture straight out of a museum of modern art,
but it still sports everything that it needs to function as a computer. In this section,
I identify the important stuff that you need to live your life — you know, write a
term paper in Pages, hear the music you downloaded in iTunes, or manage the
affairs of those lazy Sims.

Major parts of your major appliance

Every computer requires some of the same gizmos. Figure 1-1 helps you track
them down. Of course, as you’d expect, a computer has a “body” of sorts in which
all the innards and brains are stored (the screen, in this case), a display screen, a
keyboard, a mouse or trackpad, and ports for powering and exchanging data with
peripherals.

FIGURE 1-1:

The charismatic
form of your
aluminum iMac.

CHAPTER 1 Okay, This Machine Looks Really, Really Weird 9
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That magnificent screen

What a view you have! The standard iMac is graced with either a 21.5" Retina or
27" 5K Retina display, and the iMac Pro uses a 27" 5K Retina display. Both models
feature display backlighting for outstanding color and brightness.

LED screens use far less electricity than their antique CRT ancestors, and they
emit practically no radiation (less, in fact, than even the LCD screens Apple
once used).

All of these displays offer a widescreen aspect ratio (the screen is considerably
wider than it is tall), which augurs well for those who enjoy watching movies.
(A favorite editor of mine loves it when I use the antique word augur, meaning to
predict or foretell.) For example, both the 27" iMac and the iMac Pro displays boast
a whopping 5120 x 2880 resolution.

That reminds me: Throw away your printed dictionary! You won’t need it because
macOS Mojave includes both a handy Dictionary widget and a fantastic Dictionary
application! (Each one uses the Internet to retrieve definitions.) More on launch-
ing applications and widgets in Chapter 3 . . . and yes, both do contain the word
augur.

The keyboard and mouse

Hey, here’s something novel for our favorite all-in-one computer — something
external (outside the computer’s case). Gotta have a keyboard and mouse (or
trackpad), right? And you gotta love the options with iMac: You'll go
nomadic . . . um, that is, wireless and free.

The iMac comes standard with a truly 21st-century combo of an Apple wireless
Magic keyboard and a Magic Mouse 2. (The Magic Trackpad 2 is also available for
$50 more.) This dynamic duo lets you sit back and relax with your keyboard in
your lap and without being tied down by a cord. (Say it with me: “Death to cords,
death to cords.”) Just stay within about 30 feet of your iMac screen, and sweet
freedom is yours. You can also feel safe using these wireless peripherals because
they offer secure 128-bit, over-the-air encryption, which helps keep sensitive
information safe while you type and click away. One downside of the wireless
keyboard, though: Unlike older wired keyboards, the wireless model doesn’t
include any USB ports, and you will need a supply of batteries. (Go rechargeable!)

If you prefer using a wired keyboard and mouse, they’ll work fine with your iMac
(and you can forget batteries altogether). Don’t forget, however, that your key-
board needs to be Mac-compatible.

PART 1 Getting Started with Your iMac
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The keyboard layout is a particular favorite of mine because from here:

¥ You can either control the sound volume (using the volume control buttons
F11 and F12) or mute all that noise (using the Mute button F10).

¥ Mission Control, Launchpad, and Dashboard — three outstanding features of
Mojave that you find out about later in the book — are each available with a
single keystroke.

3 Ahandy-dandy Media Eject key lets you eject a CD or DVD (if you have an
external optical drive).

Today’s iMac models don’t have a built-in optical drive. If you have one of these
machines, don’t drive yourself batty looking for a disc slot!

Both the wireless Magic Mouse 2 and Magic Trackpad 2 need a flat surface to rest
upon, but that’s what TV trays are for, right?

Yes, your computer has a foot. .. just one

You and I — normal human beings — would say that the iMac is supported by a
sturdy aluminum stand, but Apple calls it a foot. The foot lets you tilt the iMac/
iMac Pro panel up and down for the best viewing angle. Most important, though,
the foot minimizes the computer’s desk space requirements (or its footprint).
(Engineers . . . sheesh.) And yes, that foot is perfectly balanced and quite stable, so
there’s no danger of your treasured aluminum supercomputer taking a dive.

If you decide to get really snazzy and mount your iMac Pro to the wall, you can
remove the foot and install the VESA mounting adapter (available separately for
about $80). You can use any VESA standard mounting bracket on your wall, too.
You can be positioned within 30 feet or so of your wall-mounted iMac Pro with a
wireless Apple keyboard and mouse (or trackpad).

Hey, Hewlett-Packard or Dell, can you mount one of those monolithic desktop PCs
to the wall? I think not.

Food for your ears

A machine this nice had better have great sound, and the iMac doesn’t disappoint.
You have a couple of options for iMac audio:

¥ The iMac sports built-in stereo speakers (and a microphone to boot). The iMac
Pro raises the bar with stereo speakers and four microphones.

CHAPTER 1 Okay, This Machine Looks Really, Really Weird 11
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FIGURE 1-2:
nly slightly less
sexy — it's the

back end of a
standard iMac.

¥ Built-in ports connect your iMac audio to either:
More powerful (and more expensive) external speaker systems
A set of headphones (including the Apple iPhone headset)

A home stereo system

You can also use wireless Bluetooth speakers with your iMac.

The power cable

Sorry, but you can’t get a wireless power system . . . yet. (Apple’s working hard on
that one.) With the wireless keyboard and mouse/trackpad setup, though, the
power cable is actually the only required cable that you need to run your
computer! Now, that’s sassy.

The power button

Yep, you have one of these, too. It’s on the back of the case. (If you’re looking at
the screen, it’s at the lower-left corner.)

Those holes are called ports

Our next stop on your tour of Planet iMac is Port Central — that row of holes on
the back of your computer (see Figure 1-2). Each port connects a different type of
cable or device, allowing you to easily add all sorts of extra functionality to your

computer.
@ LI I A ( 5 )
‘ 1 W - W T ?
Headphone USB 3 Power button
Thunderbolt 2

SDXC card slot Gigabit Ethernet

One of the holes is an exception to the Rule of Ports: The iMac’s SDXC card slot
accepts the same type of SD memory cards as most of today’s digital cameras and
video cameras. (In other words, that hole is not for connecting a cable; you insert
the card instead.) The SDXC slot appears as a tiny vertical slot.

PART 1 Getting Started with Your iMac



Each of these stellar holes is identified by an icon. Here’s a list of what you’ll find
as well as a quick rundown on what these ports do:

¢

TIP
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»

4 >

USB: Short for Universal Serial Bus, the familiar USB port is the jack-of-all-
trades in today's world of computer add-ons. Most external devices (such as
portable drives, scanners, and digital cameras) that you want to connect to
your iMac use a USB port. Both current iMac models sport four USB 3.0 ports
on the back. USB 3.0 connections are much faster than the old USB 2.0
standard, but you can still use your USB 2.0 devices with the faster ports

(at the slower speed, of course).

For the specs on connecting your keyboard and mouse, see the upcoming
section “Absolutely essential connections.”

For more on USB ports, get the lowdown in Chapter 21.

Ethernet: The standard iMac includes a standard 10/100/1000 (1Gb) Ethernet
port, so it's ready to join your existing wired Ethernet network. (Alternatively,
you can go wireless for your network connection; find more on that in the
next section and in Chapter 11.) On the iMac Pro side, hold onto your hat: the
Pro also supports 2.5Gb, 5Gb and even an amazing 10Gb Ethernet connec-
tion! (Apple knows that professionals are more likely to use a superfast
network between computers.)

Thunderbolt 3: Yes, | know, it's a dumb name, but it really is that fast.
Thunderbolt 3 (also called USB-C) ports offer the absolute speediest connec-
tion between external devices and your iMac, including the fastest (and most
expensive) external drives and storage systems. Thunderbolt 3's appeal doesn't
end there, though: In case that splendid screen isn't quite big enough, you can
add an adapter or cable to this port and send the video signal from your iMac
to an Apple Thunderbolt monitor, a standard LCD/LED monitor, or a flat-
screen TV. (Apple also offers different adapters that can connect your iMac to
standard VGA monitors and projectors.) The standard iMac model sports two
Thunderbolt 3 ports, while the iMac Pro includes four Thunderbolt 3 ports.

Connections for external audio

ﬂ Your iMac comes equipped with two pretty powerful stereo speakers on the

digital

bottom of the case, but you’re certainly not limited to them. Apple provides a

Headphone/Audio Line Out jack, allowing you to send the high-quality audio from
your rectangular beast to a set of standard headphones or to an optical digital
audio device, such as a high-end home theater system.

You can also connect USB or Bluetooth speakers to your iMac.

TIP

CHAPTER 1 Okay, This Machine Looks Really, Really Weird 13
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Important hidden stuff

When you bought your new digital pride and joy, you probably noticed a number
of subtle differences between the standard 21.5" iMac, the 27" iMac, and the iiber-
expensive top-end iMac Pro. I call these differences the Important Hidden Stuff (or
IHS, in case you prefer acronyms), and they’re just as important as the parts and
ports that you can see:

¥ Internal drive: The current iMac can be equipped with either a traditional
serial ATA (SATA) hard drive or flash storage (also called a solid-state drive, or
SSD). Apple also offers a Fusion Drive, which is essentially a combination of a
SATA drive and flash storage (offering the larger capacity of a SATA drive and
the improved performance of flash storage).

As | type these words, the iMac product line offers several different storage
= capacities, depending on the processor speed and screen size you choose:

LD,
\J anywhere from a standard 1TB SATA drive to an immense 4TB solid-state
TECHNICAL drive. (Yes, friends and neighbors, TB means terabyte, or 1,000GB.) The bigger,
STUFF the better. (Remember, though, that the iMac has room for only one internal
drive.)

¥ Wireless Ethernet: “Look, Ma, no wires!” As | mention earlier, your iMac can
join an existing wireless Ethernet network with its built-in wireless hardware.
With wireless connectivity, you can share documents with another computer
in another room, share a single high-speed Internet connection among
several computers, or enjoy wireless printing. Truly sassy!

Although Apple would want you to build your wireless wonderland with an

@ Apple AirPort Extreme Base Station or a Time Capsule unit — go figure — you
can actually use your iMac with any standard 802.11g, 802.11n, or 802.11ac
TIP wireless network. And yes, PCs and Macs can intermingle on the same

wireless network without a hitch. (Scandalous, ain't it?) Since Apple’s AirPort
devices have been discontinued, however, you'll have to do some searching
online to locate an Apple Base Station or Time Capsule.

3 Bluetooth: Let's get the old “digital pirate” joke out of the way: “Arrgh, matey;, |
needs me a wireless parrot.” (Engineers again . . . sheesh.) Although strangely
named, Bluetooth is actually another form of wireless connectivity. This time,
however, the standard was designed for accessories like your keyboard and
mouse, and devices like your tablet and smartphone. Bluetooth is built into
every Intel iMac.

3 SDXC card slot: As | mention earlier, this slot allows your iMac to read photos
and video directly from standard SD memory cards. Photographers and video
fans, rejoice!

¥ FaceTime HD camera: The iMac built-in video and still camera appears as a
tiny lens and activity light at the top of your computer.

PART 1 Getting Started with Your iMac



¥ Video card: You'll be pleased as punch to find that your iMac comes equipped
with either Intel Iris Plus or fast AMD Radeon Pro graphics hardware. The AMD
Radeon Pro cards are well suited for entry-level 3D applications, and . . . well,
honestly, blasting the enemy into small, smoking pieces with aplomb. Proud
owners of iMac Pro models can choose from the Radeon Vega 56 or Vega 64,
which are currently two of the most powerful video cards on the market for
desktop computers. These cards are worthy of Hollywood-quality video
editing and the most demanding 3D applications.

Choosing a Home for Your New Pet

WARNING

If you pick the wrong spot to park your new iMac or iMac Pro, I can guarantee that
you’ll regret it later. Some domiciles and office cubicles obviously don’t offer a
choice — you’ve got but one desk at work, for example, and nobody’s going to
hand over another one — but if you can select a home for your iMac, consider the
important placement points in this section.

Picking the right location

You know the mantra: Location, location, location.

3 There's always the wall. Your iMac Pro can disguise itself as a particularly
interesting digital picture frame. With the right mounting adapter, you can
hang your computer right on the wall and snub your desk altogether.

This wall-mounted solution has three big problems:

Your VESA mounting plate must be installed safely and correctly (for
example, using the studs within your walls).

The iMac Pro is slim and trim, but it's no lightweight, and it doesn’t bounce
well. You don't want it to take a high dive!

You may have to remove your iMac from the wall mount to connect or
disconnect cables from the ports on the back.

External peripherals aren't happy campers with a wall-mounted iMac

Pro — that includes Thunderbolt and USB devices, which must either sit on
the floor or on a nearby (and conspicuous) shelf. (Personally, | think the
cables for external devices tend to spoil the appearance of a wall-mounted
computer, so if you're using a wall mount, | recommend using a wireless
Apple Time Capsule device for your backups!)

CHAPTER 1 Okay, This Machine Looks Really, Really Weird 15
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Your iMac Pro must be mounted at the proper height on the wall. It's not good
ergonomic practice to sit more than two feet away from your screen, and the
screen should be placed at (or slightly below) eye level.

My solution? Don't plan on using any external devices. Instead, opt for a
wireless network with a remote printer and remote backup storage space, like
a Time Capsule unit on your network.

Keep things cool. Your new iMac is nearly silent, but that super-fast Intel
processor generates quite a bit of heat. Fans inside the case draw the heat
away. (Nothing like an overheated processor to spoil an evening of
Civilization VI.)

Follow these three rules to keep your cool. Make sure that:
The location you choose is far from heating vents.
The location you choose is shielded from direct sunlight.

You allow plenty of room below the machine (where the air enters the
case) and behind the machine (where heated air escapes from the slot at
the back of the case).

Hot air from a wall-mounted iMac Pro can discolor the wall.

Considering the convenience factor

Technology is nothing if you can’t make it convenient:

»

TIP

»

»

Outlets, outlets, outlets! Your computer needs a minimum of at least one
nearby AC outlet and perhaps a nearby Ethernet jack (if you use the iMac's
built-in Ethernet port for connecting to a wired Ethernet network). Oh, and
don't forget a surge protector or uninterruptible power supply (UPS), which |
discuss at the end of this chapter.

If you prefer to send your data over the airwaves, consider using wireless
networking for your iMac. | discuss everything you need to know about
wireless networking in Chapter 11.

Don’t forget the lighting. Let me act as your mom. (I know that's a stretch,
but bear with me.) She'd say, “You can't possibly expect to work without
decent lighting! You'll go blind!” She's right, you know. At a minimum, you
need a desk or floor lamp.

Plan to expand. If your iMac hangs out on a desk, allow an additional foot of
space on each side. That way, you have space for external peripherals and
more powerful speakers.

PART 1 Getting Started with Your iMac



Unpacking and Connecting
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You are going to love this section. It’s short and sweet because the installation of
an aluminum iMac on your desktop is a piece of cake. (Sorry about the cliché

overload, but this really is easy.)

Unpacking your iMac For Dummies

Follow these guidelines when unpacking your system:

¥ Check for damage. I've never had a box arrive from Apple with shipping
damage, but I've heard horror stories from others (who claim that King Kong
must have been working for the shipping company). Check all sides of your
box before you open it.

Take a photograph of any significant damage (just in case).

¥ Search for all the parts. When you're removing those chunks o’ foam, make
certain that you check all sides of each foam block for parts that are snuggled
therein or taped for shipment.

3 Keep all those packing materials. Do not head for the trash can with that
box and those packing materials. Keep your box intact, complete with all the
packing materials, for at least a year until your standard Apple warranty runs
out. If you have to ship it to an Apple Service Center, the box with the original
packing is the only way for your iMac to fly.

And now, a dramatic Mark’s Maxim about cardboard containers:
Smart computer owners keep their boxes for the life of their machine.

For example, if you sell your iMac or move across the country, you'll want that
box. Trust me on this one.

¥ Store the invoice for safekeeping. Your invoice is a valuable piece of paper
indeed.

Save your original invoice in a plastic bag, along with your computer’'s manuals
and original software, manuals, and other assorted hoo-hah. Keep the bag on
your shelf or stored safely within that iMac box, and enjoy a little peace of mind.

3 Read the iMac manual. “Hey, wait a minute, Mark — why do | have to read
the manual from Apple along with this tome?” Good question, and here's the
answer: There might be new and updated instructions in the documentation
from Apple that override what I tell you in this book. (For example, “Never cut
the red wire. Cut the blue wire instead.” Or something to that effect.)

Besides, Apple manuals are rarely thicker than a restaurant menu. You can
also download them from the Support section of the Apple website.

CHAPTER 1 Okay, This Machine Looks Really, Really Weird



Connecting cables like a true nerd

The iMac makes all its connections really simple, but your computer depends on
you to place the outside wires and thingamabobs where they go.

Absolutely essential connections

After your new iMac is resting comfortably in its assigned spot (I assume that’s a
desktop or a wall), you need to make a minimum of one connection: the power
cable. Plug the cable into the corresponding socket on the iMac first; then plug ’er
into that handy AC outlet.

Apple has thoughtfully already installed your batteries in your wireless keyboard
and mouse (or trackpad). If you ordered your iMac with a wired Apple keyboard,
of course, you have no batteries to worry about at all.

TIP

Adding the Internet to the mix

If you have Internet access or a local computer network, you need to make at least
one of the following connections.

Your local cable and telephone companies can provide you more information on
cable or DSL Internet service.

TIP
If you have high-speed Internet service, or if you’re in an office or school with a

local computer network, you’ll probably connect through the iMac’s built-in
Ethernet port. You make two connections:

1. Plug one end of the Ethernet cable into the Ethernet port on the iMac.

2. Plug the other end of the Ethernet cable into the Ethernet port from your
network.

It's probably one of the following:
An Ethernet wall jack
An Ethernet switch

A cable or DSL Internet router (or sharing device)

Will you be joining a wireless network? If so, look to Chapter 11 to find all the
details you need to configure Mojave for wireless networking.

TIP
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Discovering All the Cool Things You Can Do

This section answers the most common of all novice computer questions: “What
the heck will I do with this thing?” You find additional details and exciting
factoids about the software that you get for free, software you’ll want to buy, and

stuff you can do on the Internet.

What software do | get?

Currently, all iMac computers ship with these major software applications

installed and ready to use:

3 Apple’s digital lifestyle applications: You know you want these applications!

They turn your iMac into a digital hub for practically every kind of high-tech
device on the planet, including DV camcorders, digital cameras, portable

music players, tablets, and even smartphones.

Chapters 13 through 16 of this book focus on the four major applications that
accompany your iMac: iTunes, Photos, iMovie, and GarageBand.

3 Apple’s productivity applications: Apple’s powerful office productivity
applications can be downloaded for free from the App Store. You can create
documents, spreadsheets, and presentations within Pages, Numbers, and
Keynote. (It's much like that Other Office Suite from those guys in Redmond,
but you didn't hear that from me.) Chapters 17-19 show you the basics of
producing great documents with these three applications.

Figure 1-3 illustrates a flyer under construction in Pages.

Bike Flyer
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Custom Fixie Bike: $300
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FIGURE 1-3:
Pages is a great
tool for home
and office.
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The installed software on your iMac might change as new programs become
available.

REMEMBER

Looking forward to fun on the Internet

What is a modern computer without the Internet? Apple gives you great tools to
take full advantage of every road sign and off ramp on the Information Super-
highway, right out of the box:

»

»

»

»

©
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»

Web surfing: | use the Safari web browser every single day. It's faster and better
designed than other browsers (although | might be biased). Safari includes tabbed
browsing and offers shared bookmarks with your iOS devices through iCloud.

If tabbed browsing and shared bookmarks sound like ancient Aztec to you, don't
worry. Chapter 8 is devoted entirely to Safari.

Web searches: Your Dashboard widgets can search the entire Internet for
stocks, movie listings, business locations, and dictionaries.

FaceTime: You can videoconference with someone using another Mac, or
even with those using iOS devices like the iPhone and the iPad. You'll find
more on FaceTime in Chapter 12.

Messages: Messages lets you use your iMac to chat with others around the
world for free via the Internet — by keyboard, voice, or (with your iMac’s
built-in FaceTime HD web camera) full-color video. This is awesome stuff
straight out of Dick Tracy and Buck Rogers. If you've never seen a video chat,
you'll be surprised by just how good your friends and family look!

Always wear a shirt when videoconferencing.

Email: Soldier, Apple’s got you covered. The macOS Mail application is a
full-featured email system, complete with defenses against the torrent of junk
mail awaiting you. (Imagine a hungry digital saber-toothed tiger with an
appetite for spam.) Send pictures and attached files to everyone else on the
planet, and look doggone good doing it.

Applications that rock

Dozens of useful applications are included with macOS. I mention the most impor-
tant of them in later chapters, but here are three good examples to whet your
appetite:

»

Calendar: Keep track of your schedule and upcoming events, and even share
your calendar online with others in your company or your circle of friends.
Figure 1-4 illustrates Calendar in action.

PART 1 Getting Started with Your iMac



3 DVD Player: Got an external optical drive for your iMac? Put all that wide-
screen beauty to work and watch your favorite DVD movies with DVD Player!
You have all the features of today's most expensive standalone DVD players,
too, including a spiffy onscreen control that looks like a remote.

¥ Contacts: Throw away that well-thumbed collection of fading addresses. The
macOS Contacts application can store, search, and recall just about any piece
of information on your friends, family, and acquaintances.

You can use the data you store in your Contacts in other Apple applications
that are included with Mojave, such as Apple Mail and Messages.
TIP
@ @@ Calendars | + Day = Week Year T
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FIGURE 1-4:
Hey, isn't that e &
Calendar running
on your iMac?
You are
iTogether!

Would you like to play a game?

“All productivity and no play . . .” Hey, even a hard-working person like you enjoys
a good challenging game, so you can look forward to playing Chess on your iMac
right out of the box. Ah, but this isn’t the chessboard your dad used! Play the game
of kings against a tough (and configurable) opponent — your iMac — on a beauti-
ful 3D board. Heck, your iMac even narrates the game by speaking the moves!

Stuff You Oughta Buy Right Now

Your new aluminum supercomputer may need an additional purchase or
two — but fear not, we’re not talking any outrageous expense here. I always
recommend the same set of stuff for new PC and Mac owners. These extras
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help keep your new computer clean and healthy (and some make sure you’re
happy as well):

»

S

oiS
TECHNICAL »

STUFF

WARNING »

»

LD,
TECHNICAL
STUFF

»

Surge suppressor or uninterruptible power supply (UPS): Even an all-in-
one computer like your iMac can fall prey to a power surge. | recommend
one of these:

A basic surge suppressor with a fuse can help protect your iMac from an
overload.

A UPS costs a little more, but it does a better job of filtering your AC line
voltage to prevent brownouts or line interference from reaching your
computer.

A UPS also provides a few minutes of battery power during a blackout so
that you can save your documents and safely shut down your iMac.

Screen wipes: Invest in a box of premoistened screen wipes. Your iMac Pro's
awe-inspiring 5K Retina display can pick up dirt, fingerprints, and other
unmentionables faster than you think.

Make sure your wipes are especially meant for flat-panel monitors or laptop
computer screens.

Blank optical discs and USB flash drives: Many folks still consider an optical
drive important, so if you'll miss watching DVD movies and importing/
recording audio CDs, I'll bet you've already bought an external drive — and
you'll need blank discs for recording music, video, and data. USB flash drives
come in many different capacities, and your iMac treats a flash drive just like a
traditional external drive. If you want the best performance from a flash drive,
buy a USB 3.0 drive; they're significantly faster than the older 2.0 drives. (All
current iMac models sport USB 3.0 ports.)

Cables: Depending on the external devices and wired network connectivity
you'll be using, these are:

A standard Ethernet cable (for wired networks or high-speed Internet)
Thunderbolt or USB cables for devices you already have

Most hardware manufacturers are nice enough to include a cable with their
products, but there are exceptions, especially USB printers. Shame on those
cheapskates!

A wrist rest for both your keyboard and mouse: You might have many
reasons to buy a new iMac, but | know that a bad case of carpal tunnel
syndrome is not one of them. Take care of your wrists by adding a keyboard
and mouse rest (even for a wireless keyboard/mouse combo hanging out on
a TV tray).
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» Turning on your iMac
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operation

» Setting up macOS Mojave
» Registering your iMac
» Using Migration Assistant

» Copying information from a
Windows PC

Chapterz
Life! Give My iMac Life!

f you’ve already been through Chapter 1, you got as far as unpacking your iMac

and connecting at least one cable to it. And unless you bought this computer

solely as a work of modern art, it’s time to actually turn on your iMac and begin
living The Good iLife. (Plus you still get to admire that Apple design whilst using
iTunes.) After you get your new beauty powered on, I help you here with an initial
checkup on your iMac’s health.

I also familiarize you with the initial chores that you need to complete — such as
using macOS Setup as well as moving the data and settings from your existing
computer to your iMac — before you settle in with your favorite applications.

In this chapter, I assume that macOS Mojave (version 10.14) was preinstalled on

your iMac or that you just completed an upgrade to Mojave. (If you’re upgrading,
your iMac is already turned on — and you can skip the next section!)

Throwing the Big Leaf Switch

Your iMac’s power switch is located on the back of the computer, at the lower-left
corner of the case (as you look at the screen). Press it now to turn on your iMac,
and you hear the pleasant startup tone that’s been a hallmark of Apple computers
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for many years now. Don’t be alarmed if you don’t immediately see anything
onscreen because it takes a few seconds for the initial Apple logo to appear.

In my experience, a simple, quick press of the power button on some iMacs some-
times just doesn’t do it. Instead, you actually have to hold down the button for a
count of two or so before the computer turns on.

While the Apple logo appears, you see the familiar “moving bar” progress indica-
tor appear. That’s the sign that your iMac is loading Mojave. Sometimes the bar
can take a bit to disappear. As long as it’s moving, though, something good is
happening — after all, Mojave has to load file sharing, networking, and printing
components (and such).

At last, your patience of a whole 5 to 10 seconds is rewarded, and you see the
Mojave Setup Assistant appear.

Mark’s Favorite Signs of a Healthy iMac
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Before you jump into the fun stuff, don’t forget an important step: a quick prelim-
inary check to make sure that your iMac survived shipment intact and happy.
Although the shipping box that Apple uses for the iMac series is one of the best
I've ever encountered in 40 years of swapping computer hardware, your computer
could still have met with foul play from its shipping travels.

If you can answer yes to each of these questions, your iMac likely made the trip
without serious damage:

1. Doesthe computer’s chassis appear undamaged?

It's pretty easy to spot damage to your iMac Pro’s svelte metal and glass design.
Look for scratches, puncture damage, and misalignment of the screen.

2. Does the LED screen work, and is it undamaged?

I'm talking about obvious scratches or puncture damage to your screen.
Additionally, you should check whether any individual dots (or pixels) on your
LED monitor are obviously malfunctioning. Bad pixels either appear black or in
a different color from everything surrounding them.

Techs call these irritating anarchists dead pixels. Unfortunately, many new LED
screens include one or two. After all, even the low-end 21.5" iMac screen sports
more than 1 million pixels.
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3. can you feel a flow of air from the vent on the back?

Your iMac's Intel processor, internal drive, and power supply generate quite a
bit of heat, so the fan system never turns off completely. If you don't feel warm
air from the fan system after your iMac has been on for a minute or two, you
might have a problem.

4. pothe keyboard and mouse work?

Check your iMac's Bluetooth connection by moving the mouse (or running your
finger across the trackpad); the cursor should move on your screen. To check
the keyboard, press the Caps Lock key and observe whether the green Caps
Lock light turns on and off. (Don't forget to check for good batteries in all your
wireless input devices and make sure they're turned on.)

If your iMac reports that there’s no Bluetooth keyboard, mouse, or trackpad
present, remember that you can always connect a standard Mac USB keyboard
and pointing device to help you troubleshoot the problem. You'll find informa-
TIP tion on connecting (or pairing) Bluetooth accessories in the Bluetooth Bonus

Chapter, available at www . dummies . com and my website, www . m1cbooks . com.

If you do notice a problem with your iMac (and you can still use your Safari
browser and reach the web), you can make the connection to an Apple support
technician at www.apple.com. If your iMac is lying on its back with its foot in the
air and you can’t get to the Internet, you can check your phone book for a local
Apple service center, or call the AppleCare toll-free number at (800) 275-2273.
Chapter 20 also offers troubleshooting information.

Harriet, It's Already Asking Me Questions!

After your iMac is running and you’ve given it the once-over for obvious shipping
damage, your next chore is to set up your iMac. Unlike most other tasks in this
book, I don’t cover the setup process step by step. Apple “tweaks” the questions
that you see during setup on a regular basis, and the questions are really very easy
to answer. Everything is explained onscreen, complete with onscreen Help if you
need it.

However, I do want you to know what to expect as well as what information you
need to have at hand. I also want you to know about support opportunities, such
as the AppleCare Protection Plan and Apple’s iCloud Internet services — hence,
this section. Consider it a study guide for whatever your iMac’s setup procedure
has to throw at you.
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Setting up macOS Mojave

After you start your iMac for the first time — or if you just upgraded from an ear-
lier version of macOS — your iMac will likely automatically launch the Mojave
setup procedure. The setup process takes care of several tasks:

3 Setup provides Mojave your personal information.

As | mention in Chapter 1, your iMac ships with a bathtub full of applications,
and many of those use your personal data (like your address and telephone
number) to automatically fill out your documents.

stored information starts you worrying about identity theft, | congratulate you.

If you're using your common sense, it should. However, Apple doesn't disseminate
REMEMBER this information anywhere else, and the applications that use your personal data

won't send it anywhere, either. And the Safari web browser fills out forms on a web

page automatically only if you give your permission — and security-conscious iMac

owners like me prefer to enter things manually. | applaud Apple's decades-long

commitment to privacy and security, and | trust them with my personal data.

@ Apple has recently strengthened its efforts to guard your privacy online. If personal

3 Setup configures your language and keyboard choices.

macOS Mojave is a truly international operating system, so Setup offers you a
chance to configure your iMac to use a specific language and keyboard layout.

3 Setup configures your email accounts within Apple Mail.

If you already have an email account set up with your Internet service
provider (ISP), keep that email account information handy to answer these
questions. (The list should include the incoming POP3/IMAP and outgoing
SMTP mail servers you'll be using, your email address, and your login name
and password. Don’t worry about those crazy acronyms, though, because
your ISP will know exactly what you mean when you ask for this information.)
Mojave can even automatically configure many email accounts for you —
including web-based services such as Google Mail, Yahoo! Mail, and AOL

Mail — if you supply your account ID and password. Sweet.

3 Setup allows you to sign up for an iCloud ID and Apple’s iCloud service.

iCloud makes it easy to share data automatically between your iMac and
devices like an iPhone or iPad, along with Apple email accounts (through both
web mail and the Apple Mail application). | go into all these in more detail in
Chapter 9. For now, just create your iCloud ID (also often called an Apple ID),
sign up for iCloud, and take the opportunity to feel smug about owning an
Apple computer.
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3 Setup sends your registration information to Apple.

As a proud owner of an iMac, take advantage of the year of hardware
warranty support and the free 90 days of telephone support. You have to
register to use 'em, but rest assured that all this info is confidential.

3 Setup launches Migration Assistant.

This assistant guides you through the process of migrating (an engineer's term
for copying) your existing user data from your old Mac or PC to your new iMac.
Naturally, if your iMac is your first computer, you can skip this step with a song
in your heart! (Read more on Migration Assistant in the section “Importing
Documents and Data from Your Old Mac.”)

Registering your iMac

I’ll be honest here: I know that many of us (myself included) don’t register every
piece of computer hardware we buy. However, your iMac is a different kettle of
fish, and I strongly recommend that you register your purchase with Apple during
the setup process. You spent a fair amount of moolah on your computer, and it’s
an investment with a significant number of moving parts.

Even the hardiest of techno-wizards would agree with this important Mark’s Maxim:
If you don’t register your iMac, you can’t receive support from Apple.

MARK'S Rest assured that Apple is not one of those companies that constantly pesters you
with email advertisements and near-spam. I’ve registered every Apple computer
I’ve owned, and I've never felt pestered. (And I have an extremely low tolerance for

pester.) However, just in case your tolerance is even lower than mine, Apple’s reg-
istration process allows you to disable this email communication.

Importing Documents and
Data from Your Old Mac

If you’re upgrading from an older Mac computer running macOS to your new
iMac, I have great news for you: Apple includes the Migration Assistant utility
application that can help you copy (whoops, I mean, migrate) all sorts of data
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from your old Mac to your new machine. The list of stuff that gets copied over
includes:

3 User accounts: If you set up multiple user accounts (so that more than one
person can share the computer), the utility ports them all to your new iMac.

3 Network settings: Boy howdy, this is a real treat for those with manual
network settings provided by an ISP or network administrator! Migration
Assistant can re-create the entire network environment of your old Mac on
your new iMac.

¥ System Preferences settings: If you're a fan of tweaking and customizing
macOS to fit you like a glove, rejoice. Migration Assistant actually copies over
all the changes that you've made within System Preferences on your old Mac!
(Insert sound of angelic chorus of cherubim and seraphim: Hallelujah!)

3 Documents: The files in your Documents folder(s) are copied to your new iMac.

3 Applications: Migration Assistant tries its best to copy over the third-party
applications that you've installed in your Applications folder on the older Mac.
| say tries its best because you might have to reinstall some applications,
anyway. Some developers create applications that spread out all sorts of files
across your hard drive, and Migration Assistant just can't keep track of those
nomadic files. Also, some other applications make the trek just fine, but you
might have to re-enter their serial numbers.

Setup launches Migration Assistant automatically if you indicate that you need to
@ transfer stuff during the setup process, but you can also launch Migration Assis-
tant manually at any time. Click the Launchpad icon on the Dock (which bears a
TIP rocket-ship icon); then click the Search box at the top of the screen and type the
word Migration. Click the Migration Assistant icon to launch the application. Note
that Migration Assistant will close any running applications, so make sure to save

and close any open documents.

To use Migration Assistant to copy your system from your older Mac, you need
one of the following:

3 Wired or wireless network connection between the computers: If you've
already hooked up your new iMac to your wired or wireless Ethernet network
while using Setup Assistant, eschew cables completely and click Use Network
instead. (Note, however, that a Wi-Fi migration will be much slower than
migrating with either a direct cable connection or a wired network connection.)

¥ Thunderbolt cable (compatible with all recent iMac, Mac mini, Mac Pro and
MacBook models): A Thunderbolt connection will transfer your data between
the two computers at lightning speed! (Bad pun intended.) Apple sells a
Thunderbolt cable that's perfect for the job for $49 at the Apple Store.
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3 Time Machine external drive or an AirPort Time Capsule backup unit: If
you're using Time Machine on the older Mac with an external drive, you can
migrate directly from your most recent backup — just plug your external Time
Machine drive into your new iMac. The same option applies if you've invested
in Apple’s Time Capsule wireless backup device.

If you’ll be using a Thunderbolt cable, make sure that the two machines are con-
nected with the cable first. If you’re using a network connection, both computers
should be connected to the same network. Typically, you’ll also have to load
Migration Assistant on the source Mac (or a free Windows program downloaded
from www . apple.com, if the source computer is a PC.)

After the two computers are connected, simply follow the onscreen instructions
displayed within the Migration Assistant window. The application will lead you
through the process step by step. If you need to return to the previous step at any
time, click the Back button that appears at the bottom of the screen.

Manually Importing Documents
and Data from Windows

If you’re a classic Windows-to-Mac Switcher, you made a wise choice, especially if
you’re interested in the creative applications supplied by Apple. Although you can
choose to start your Apple computing life anew, you probably want to migrate
some of your existing documents and files from that tired PC to your bright, shiny
new iMac.

If you’re switching from a PC to a Mac, you can run the Windows version of the
Migration Assistant on your PC (available from Apple’s website) to automatically
handle most of your migration tasks for you, and you should witness the miracle
of your PC’s photos, video, music, and documents suddenly appearing on your
iMac. Unfortunately, you’ll have some exceptions. Some stuff won’t make the
move because the Windows Migration Assistant simply can’t recognize and trans-
fer files and folders from some nonstandard locations. For example, folders you
created yourself at the root of your PC’s hard drive likely won’t be recognized, and
naturally, your Windows programs won’t run under macOS (without creating a
Boot Camp partition, which I discuss in the nearby sidebar titled “Switching from
aPCto...an Apple PC?").

Here’s the good news, though: You can easily copy those files that weren’t trans-
ferred! Moving items manually from a USB flash drive or over a network is easy.
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@ The macOS Help system contains an entire subsection on specific tricks that you
can use when switching from Windows to Mac, including how to connect to a

TIP Windows network and how to directly connect the two computers.

In general, you can move documents, movies, photos, and music without a
problem. Table 2-1 illustrates what can be moved between Windows (versions 7,
8, 8.1, and 10) and macOS, as well as the application that you use in Mojave to open
those files and documents.

TABLE 2-1 Moving Media and Documents betwixt Computers
File Type Windows Location macOS Location Mac Application
Music files My Music folder Music folder iTunes
}/:deo and movie My Videos folder Movies folder QuickTime/DVD Player/iTunes
iles
Digital photos My Pictures folder Pictures folder Photos
Office documents My Documents folder Documents folder Mac Office/Open Office/Pages,

Numbers and Keynote
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SWITCHING FROM APCTO ... AN APPLE PC?

With the Mojave Boot Camp feature, you can actually create a full Windows 10 system on
your iMac. Yup, Windows and Mojave coexist peacefully on the same computer. However,
you have to reboot your computer to use your iMac as a Windows system, and you can't
install Windows at all without retaining at least a basic macOS system. (All this is covered in
detail in the Boot Camp Bonus Chapter, which you can download at www . dummies . com.)

This capability brings a whole new meaning to the term Switcher because some iMac
owners are moving their stuff from Windows (running on their old PC) to . . . well,
Windows (running on their new iMac) rather than Mojave. If you do decide to create a
Windows system on your iMac by using Boot Camp, the files and folders on your exist-
ing PC can be copied directly by using a good old-fashioned Windows wizard. You can
use the Windows Easy Transfer utility (in Windows 7 and 8). Windows 8.1 and 10 users
will need a third-party application to move files and folders, such as PCmover Express
from Laplink (www . laplink.com).

PART 1 Getting Started with Your iMac


http://www.dummies.com
http://www.laplink.com

IN THIS CHAPTER

» Introducing the macOS Mojave
Desktop

» Coping with those missing mouse
buttons

» Launching and quitting applications

» Mastering Finder windows and
shortcuts

» Identifying and selecting items

» Manipulating your Desktop with
Mission Control and Dashboard

» Storing everything in your Home
folder

» Customizing the Dock and Desktop

» Taking care of the Trash (and
rescuing precious stuff from it)

» Printing your documents

» Getting help while learning about
Mojave

Chapter 3

The Basics Behind
macOS Mojave

h, the Finder. Many admire its scenic beauty. But don’t ignore its unsur-
passed power or its many moods. And send a postcard while you’re
there.
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Okay, so the Mojave Finder might not be quite as majestic as the mighty desert
region it’s named after, but it’s the basic toolbox you use every day while piloting
your iMac. The Finder includes the most common elements of macOS: window
controls, common menu commands, icon fun (everything from launching appli-
cations to copying files), keyboard shortcuts, and even emptying the Trash. In
fact, you could say that if you master the Finder and learn how to use it efficiently,
you’re on your way to becoming a power user!

This chapter is your Finder tour guide, and we’re ready to roll. I satisfy your curi-
osity about your new playground and introduce you to the basic elements of the
Mojave Desktop, and I outline the resources available if you need help with macOS.

Oh, and I promise to use honest-to-goodness English in my explanations, with a
minimum of engineer-speak and indecipherable acronyms. (In return, promise
that you will boast about Mojave to your family and friends. Aunt Harriet might
not be as technologically savvy as we are.)

Your Own Personal Operating System

32

TIP

Mojave is a special type of software called an operating system (or 0S, as in mac0S).
This means that Mojave essentially runs your iMac or iMac Pro and allows you to
run all your other applications, such as iTunes and Photoshop. It’s the most
important computer application — or software — that you run.

Think of a pyramid, with Mojave as the foundation and other applications running
on top.

You're using the OS when you aren’t running a specific application, such as these
actions:

¥ Copying files from a USB flash drive (also called a thumb drive) to your
internal drive

¥ Navigating through files and folders on your drive

¥ Choosing a different screen saver

Sometimes, Mojave even peeks through an application while it’s running. For
example, macOS controls application actions such as these:

PART 1 Getting Started with Your iMac



FIGURE 3-1:
Everything
Mojave starts
here — the
macOS Desktop.

¥ The Open, Save, and Save As dialogs you see when working with files in
Photoshop

¥ The Print dialog that appears when you print a document in Pages (Apple’s
desktop publishing application)

In the following sections, I escort you around the most important hotspots in
Mojave, and you meet the most interesting onscreen thingamabobs you use to
control your laptop. (I told you I wouldn’t talk like an engineer!)

The Mojave Desktop

The Mojave Desktop isn’t made of wood, and you can’t stick your gum under-
neath. However, this particular desktop does work much like the surface of a tra-
ditional desk. You can store things there, organize things into folders, and take
care of important tasks such as writing and drawing (using tools called applica-
tions). Heck, you even have a clock and a trash can.

Gaze upon Figure 3-1 and follow along as you venture to your Desktop and beyond.
I discuss each of these Desktop elements in more detail later in this chapter.
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FIGURE 3-2:
The Dock can

contain all sorts
of exotic icons.
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TIP

Meet me at the Dock

The Dock is a versatile combination: one part organizer, one part application
launcher, and one part system monitor. From the Dock, you can launch
applications — for example, the postage stamp icon represents the Apple Mail
application, and clicking the spiffy compass icon launches your Safari web
browser. Icons in the Dock also allow you to see what’s running, and display or
hide the windows shown by your applications.

Each icon in the Dock represents one of the following (many of which are proudly
displayed in Figure 3-2):

3 An application you can run (or that is running)

¥ An application window that's minimized (shrunk)

3 Aweb page URL link

3 Adocument or folder on your system

3 A network server, shared document, or shared folder

¥ Applications you've recently launched

¥ Your Trash

QOB O N @) FH o T -

The Dock is highly configurable:

¥ It can appear at different edges of the screen.
¥ It can disappear until you move the pointer to the edge to call it forth.

¥ You canresizeit.

Dig those crazy icons

By default, Mojave always displays at least one icon on your Desktop: your iMac’s
internal drive. To open a drive and view or use the contents, you double-click the
icon. Each icon is a shortcut of sorts that represents something, including:

¥ CDs and DVDs (if you have an optical drive).

¥ External drives and USB flash drives.
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FIGURE 3-3:
Clicking a menu
displays a list
of menu
commands.

¥ Applications and documents.
¥ Files and folders.

¥ Network servers you access.

Note that an icon can represent applications you run and documents you create.
Sometimes you single-click an icon to watch it do its thing (as in the Dock), but
usually you double-click an icon to make something happen.

There's no food on this menu

The menu bar isn’t found in a restaurant. You find it at the top of the Desktop,
where you can use it to control your applications. Virtually every application you
run on your iMac has a menu bar.

To use a menu command, follow these steps:

1 . Click the menu title (such as File or Edit).

2. Choose the desired command from the list that appears, as shown in
Figure 3-3.
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When you click a menu, it extends down so that you can see the commands it
includes. While the menu is extended, you can choose any enabled menu item
(just click it) to perform that action. You can tell that an item is enabled if its
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name appears in black(or white, if you’re using the Dark Mode color scheme).
Conversely, a menu command is disabled if it appears grayed out. Clicking it
does nothing.

When you see a menu path printed in this book (such as File=> Save), it’s just a
visual shortcut that tells you to click the File menu and then choose Save from the
drop-down menu that appears.

Virtually every Mac application has some menus, such as File, Edit, and Window.
You’re likely to find similar commands within these menus. However, only two
menus are in every macOS application:

% The Apple menu, which is identified with that jaunty Apple Corporation icon (6).
This is a special menu because it appears in both the Finder menu bar and the
menu bar in every application you run. It doesn't matter whether you're in
iTunes or Photoshop or Word. If you can see a menu bar, the Apple menu is
there. The Apple menu contains common commands to use no matter where
you are in Mojave, such as Restart, Shut Down, and System Preferences.
Figure 3-3 proudly displays the Apple icon at the upper left.

3 The Application menu, which always bears the name of the active application.
For instance, the DVD Player menu group appears when you run the Mojave
DVD Player, and the Word menu group appears when you launch Microsoft
Word. Figure 3-3 illustrates the Application menu for the App Store.

You can also display a context or shortcut menu — which regular human beings
call a right-click menu — by right-clicking the Mojave Desktop, an application, a
folder, or a file icon with your mouse. (If your iMac is equipped with a trackpad,
you can right-click by tapping the trackpad with two fingertips. I'll explain more
on clicking and tapping later in the section, “Wait a Second: Where the Heck Are
the Mouse Buttons.”)

The Finder menu bar is your friend

Whenever the Finder itself is ready to be used (or, in Mac-speak, whenever the
Finder is the active application), the Finder menu bar appears at the top of the
screen. You know the Finder is active and ready when the word Finder appears at
the left of the menu bar.

There's always room for one more window

You’re probably already familiar with the ubiquitous window itself. Both Mojave
and the applications you run use windows to display things such as:
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a@n IT'S APPLE TO THE RESCUE!
v
TECHICAL UNIX is the established, super-reliable OS that powers most of the high-performance
STUFF servers that make up the Internet. UNIX has built-in support for virtually every hardware
device ever wrought by the Hand of Man (including all the cool stuff that comes with
your iMac). It's also well designed and highly efficient.

Unfortunately, standard UNIX looks as hideous as old-fashioned character-based DOS,
complete with a confusing command line. So ease of use for normal human beings like
you and me goes out the window. Enter the genius types at Apple, who understood
over 15 years ago that all UNIX needed was a state-of-the-art, novice-friendly interface.
To wit: macOS was developed with a UNIX foundation (or core), so it shares the same
reliability and performance as UNIX. However, the software engineers at Apple (who
know a thing or two about ease of use) made it good-looking and easy to use.

¥ The documents you create
» Aweb page
¥ Your photographs

¥ The contents of your drive

For example, the window shown in Figure 3-1 is a Finder window, where Mojave
gives you access to the applications, documents, and folders on your system. You
use Finder windows to launch applications, to perform disk chores such as
copying and moving files, and to navigate your drives.

Wait a Second: Where the Heck
Are the Mouse Buttons?

Mojave takes a visual approach to everything, and what you see in Figure 3-1 is
designed for point-and-click convenience. That’s because the mouse (or track-
pad) are your primary navigational tools while you’re using your iMac. Of course,
you move the body of the mouse and the pointer follows like an obedient pup.
Likewise, you move your finger over the surface of the trackpad to move the
pointer. (The faster you move your finger, the farther the pointer goes.) When
your pointer is over the desired item, you tap it (or click it, if you prefer the more
familiar term), it opens, you do your thing, and life is good.
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WARNING

But wait! If you’ve grazed on the other side of the fence — one of Those Who Were
Once Windows Users — you’re probably accustomed to using a mouse with at
least two buttons. This brings up the nagging question: “Hey, Mark! Where the
heck are my mouse buttons?” Or perhaps you’re thinking even farther out of the
box, and you ordered a Magic Trackpad 2 as your pointing device of choice. Again,
no buttons!

In a nutshell, the “buttons” on your iMac’s Magic Mouse 2 (or Magic Trackpad 2)
are the entire top surface! Although you won’t see any separate buttons for click-
ing, your Magic pointing device can tell when you tap with one finger (to single-
click). iMac owners should think “tap” whenever they read “click” in the Apple
world. If you’ve used an iPhone, iPad, or iPod touch, the idea of tapping something
onscreen makes perfect sense. (In this book I refer to the pointer whether you’re
using the trackpad or a mouse.)

To configure everything Magic Mouse 2 — including all your buttons and your
double-click/tracking/scrolling speeds — visit the Mouse pane within System
Preferences. You can also configure your wireless mouse from here as well. Simi-
larly, you can configure your wireless Magic Trackpad 2 using the Trackpad pane.

Speaking of right-clicking, you can easily configure your Apple pointing device to
recognize a right-click (also called a secondary click) within System Preferences.
Tapping the top-right corner (of a Magic Mouse 2) or tapping with two fingers (on
the Magic Trackpad 2) performs the same default function in Mojave that clicking
the right mouse button does in Windows. Namely, when you right-click most
items — icons, documents, even your Desktop — you get a shortcut menu of things.
That is, you get more commands specific to that item. (To keep familiar things
familiar, I call it the “right-click menu,” and I promise to refer to it as such for
the rest of the book.)

Figure 3-4 shows a typical convenient right-click menu in a Finder window. I
have “extra” cool items at my disposal on this menu because of the applications
I've installed that make use of a right-click menu.

If you’re using a Magic Trackpad 2 with your iMac, never use any object other
than your finger (or a trackpad stylus) on the trackpad surface! That means no
pencils (no, not even the eraser end), pens, or chopsticks; they can damage your
trackpad in no time at all. And no, that doesn’t bode well for long fingernails.

But that’s not all. Apple’s series of Multi-Touch gestures for your Magic Mouse 2
and Magic Trackpad 2 include all sorts of handy time-saving commands! Depend-
ing on the changes you make within the Mouse and Trackpad panes in System
Preferences, these gestures can include:
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FIGURE 3-4:
Welcome to your
shortcut menu!
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3 Select the Tap to Click check box: Now, when you tap once quickly any-

where on the mouse, your Mac counts that as a click. Tap twice quickly, and

your iMac recognizes that as a double-click.

3 Select the Secondary Click check box: A single tap with two fingers displays

the right-click menu (which | cover in more detail in a page or two).

3 Enable the Look Up check box: Tap the trackpad with three fingers to look
up a selected word in the Dictionary.

3 Enable the Three Finger Drag check box: (Sounds like a dance from the '60s,

doesn't it?) By using three fingers, you can drag around windows on your

Desktop to reposition them.

3 Adjust your tracking speed: Click and drag the Tracking speed slider to
speed up or slow down the rate at which the pointer moves.

In this book I refer to the pointer whether you’re using the trackpad or a mouse.
I also use the term button from time-to-time for clarity — even though I've
already pointed out there aren’t physical buttons on either of these devices, it’s an
easy concept that we all recognize.
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Launching and Quitting Applications
with Aplomb

FIGURE 3-5:
Click a Dock icon
to launch that
application.
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TIP

Now it’s time to pair your newly found mouse or trackpad acumen with the Mojave
Finder window. Follow along with this simple exercise. Move the pointer over the
iTunes icon in the Dock. (This icon looks like a circle with a musical note on it.)
Then tap the surface of your mouse or trackpad once (see the preceding section for
how to set this preference). Whoosh! Mojave launches (or starts, or runs) the iTunes
application, and you see a window much like the one shown in Figure 3-5.
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If an application icon is already selected (which I discuss later in the chapter), you
can simply press $8+0 to launch it. The same key shortcut works with docu-
ments, too.

Besides the Dock, you have a plethora of other ways to launch an application or
open a document in Mojave:

» From the Apple menu (®): You can launch a number of applications from
anywhere in Mojave using the Apple menu. Click System Preferences to change all
sorts of settings, such as your display background and how icons appear. Click
App Store to launch the macOS App Store and display software that you can
download for your iMac. (Most are commercial applications that you have to pay
for, but many great free applications are available as well.) You can also use the
App Store to see whether update patches are available for your Apple software.
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From the Launchpad: Arrange all your application icons in a full-screen
display. (The Launchpad icon in the Dock bears a spiffy rocket.) If you have
more than one screen (or page) worth of applications, press the arrow keys to
move between Launchpad pages. To launch an application, just click the icon.
(If you're the proud owner of an iPhone or iPad, the Launchpad is familiar,
because it corresponds directly to the iOS Home screen on those devices.) The
Magic keyboard sports a Launchpad button - press F4 to display or hide the
Launchpad.

From the Desktop: If you have a document you created or an application
icon on your Desktop, you can launch or open it from the Desktop by
double-clicking that icon (tapping the surface of the mouse or trackpad twice
with one finger in rapid succession when the pointer is on top of the icon).

Double-clicking a device or network connection on your Desktop opens the
contents in a Finder window. This method works for CDs and DVDs you've
loaded, as well as external drives and USB flash drives. Just double-click ‘'em to
open them and display their contents in a Finder window. Applications and
documents typically launch from a CD, a DVD, or an external drive just like
they launch from your internal drive (the one that's typically named Macintosh
HD). So you don't have to copy stuff from the external drive just to use it. Note,
however, that running an application directly from your optical or external
drive usually causes the application to run significantly slower. (Oh, and don't
forget that you can't change the contents of CDs and DVDs you buy in the
store; they're read-only, so you can't write to them.)

From Siri: Click the Siri icon at the right side of the Finder menu bar. When
you see the Siri box appear (with the words What Can | Help You With? and the
waveform), say “Launch” and the name of the application. For example, you
can open Pages by saying “Launch Pages"” - you'll see Siri display the words it
hears.

From the Recent Items selection: When you click the Apple menu and hover
the pointer over the Recent Items menu item, the Finder displays all the
applications and documents you used over the past few computing sessions.
Click an item in this list to launch or open it.

From the Recent Applications group in the Dock: If you enable the Recent
Applications check box within the Dock pane in System Preferences, you'll see
the icons for the last three applications you used at the right side of the Dock.
Click one of these icons to launch that application.

From the Login Items list: Login items are applications that Mojave launches
automatically each time you log in to your user account. | cover login items in
detail in Chapter 10.

From the Finder window: You can also double-click an icon within the
confines of a Finder window to open it (for documents), launch it (for applica-
tions), or display the contents (for a folder).

CHAPTER 3 The Basics Behind macOS Mojave
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DIG THAT CRAZY LAUNCHPAD!

You can customize your Launchpad display by dragging icons to arrange them in the
order you prefer. (For example, | have all the applications | use the most on the first
Launchpad page.) Drag an application icon to the right or left side of the screen to move
it to another page.

Launchpad, like a Finder window, allows you to create folders to help organize your
applications. To create a folder in Launchpad, drag one application icon on top of
another, and then add other icons by dragging them to the folder (or remove them by
dragging them out of the folder). To run an application within a folder, click the folder
icon to display the icons within it, and then click the desired application. To change a
folder name, click the folder to open it, click the folder name to display a text-editing
box, type the new moniker for the folder, and press Return.

If you want to remove an application from Launchpad — which also deletes the applica-
tion from your iMac entirely — click the icon and continue pressing until the icons start to
wiggle. (Yes, you read that correctly; | wrote wiggle. iPhone and iPad owners know what
I mean.) Click the tiny delete (X) button that appears next to the icon whose application
you want to delete, and the icon — and its application — disappear. Press Esc to stop all
that wiggling. (Note that applications supplied with Mojave can't be deleted this way.)

The macOS Quick Look feature can display the contents of just about any docu-
ment or file — but without actually opening the corresponding application! Sweet.
To use Quick Look from a Finder window, click a file to select it, and then press
the spacebar. (Quick Look is also incorporated into the new Mojave Gallery view,

which I discuss in a page or two.)

After you finish using an application, you can quit that application to close its
window and return to the Desktop. Here are a number of different ways to quit an

application:

3 Press 38+Q. This keyboard shortcut quits virtually every Mac application. Just
make sure that the application you want to quit is currently active first (the
application name should appear immediately to the right of the Apple menu).

3 Choose the Quit command from the application’s menu. To display the
Quit command, click the application’s named menu from the menu bar. As |
just mentioned, this menu is always to the immediate right of the Apple
menu. For example, Safari displays a Safari menu, and that same spot in the
menu bar is taken up by Calendar when Calendar is the active application.
Refer to Figure 3-3, and look for the App Store menu, right next to the Apple
menu (®) at the very top of the figure.
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¥ Choose Quit from the Dock. You can right-click an application’s icon in the
Dock and then choose Quit from the menu that appears.

A running application displays a small dot under its icon in the Dock.

3 Click the Close button in the application window. Some applications quit
entirely when you close their window, such as the System Preferences window
or the Apple DVD Player. Other applications might continue running without
any window, such as Safari or iTunes; to close these applications, you have to
use another method in this list. (More on window controls like Close in the
next section.)

3 Choose Force Quit from the Apple menu. This is a last-resort measure! Use
this method only if an application has frozen and you can't use another
method in this list to quit. Force-quitting an application doesn't save any
WARNING changes to any open documents in that application!

TIP

Performing Tricks with Finder Windows

In the following sections of your introduction to macOS, I describe basic windows
management in Mojave: how to view the contents of your iMac, move things
around, how to close windows, and how to make windows disappear and reappear
like magic.

Viewing your stuff

The default appearance of a Finder window in macOS uses the familiar large-
format icons that have been a hallmark of the Mac since Day One. You can display
the contents of a Finder window in Icon view by clicking the Icon View button
on the Finder window toolbar. The Finder window shown in Figure 3-1 is using
Icon view.

List view displays the folders in a hierarchical fashion, with each subfolder appear-
ing indented underneath its parent folder. You can expand and collapse each
folder by clicking the disclosure triangle next to the folder name. (Thanks, Apple,
for such a unique name.) You can change to this view by clicking the List icon in
the Finder toolbar.

Column view is my favorite — thanks, Apple! It’s efficient and fast as all get-out.
Click the Column icon in the Finder toolbar, and drives on your Mojave system are
displayed on the left. Each column on the right represents a lower level of sub-
folders. When you click to select a file or program (rather than a folder), the Finder

CHAPTER 3 The Basics Behind macOS Mojave 43



L4

TIP

TIP

displays a preview, a quick summary of the selected item and any Quick Actions in
the right-most column.

Each column has its own, individual scroll bar (for those really big folders), and
you can drag the column handle at the bottom of the separators to resize the col-
umn width to the left. When you hold down the Option key and drag a column
handle, all columns are adjusted at one time.

Gallery view is new in macOS Mojave — click the Gallery View icon in the Finder tool-
bar to display a row of thumbnails at the bottom of the screen, which you can scroll
through with the scroll bar at the bottom of the window. A click on any item displays
a preview of the item that fills most of the window, along with file information (or
metadata, if the item is an image) and any Quick Actions associated with the item.

Scrolling in and resizing windows

Can you imagine what life would be like if you couldn’t see more than a single
window’s worth of stuff? Shopping would be curtailed quite a bit — and so would
the contents of the folders on your iMac’s drives!

That’s why Mojave includes scroll bars that you can click and drag to move through
the window’s contents. (By default, scroll bars don’t appear in Mojave until you
move the pointer close to them.) You can:

¥ Click the scroll box and drag it. For the uninitiated, that means clicking the
darker portion of the bar and holding down your finger on the mouse or
trackpad surface while you move your finger in the desired direction.

¥ Click anywhere in the empty area above or below the scroll box to scroll pages
one at a time.

¥ Hold down the Option key and click anywhere in the empty area above or
below the bar to scroll to that spot in the document.

Figure 3-6 shows two vertical scroll bars in a typical Finder window, as well as the
Sidebar and three Finder Tabs.

Often, pressing the Page Up and Page Down keys moves you through a document
one page at a time. Also, pressing the arrow keys moves the insertion cursor one
line or one character in the four compass directions.

You can also resize most Finder and application windows by enlarging or reducing
the window frame itself. Move the pointer over any corner or edge of a window,
and then drag the edge in any direction until the window is the precise size you
need. (More information on dragging pops up later in this chapter.)
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FIGURE 3-6:
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Minimizing and restoring windows

Resizing a window is indeed helpful, but maybe you simply want to banish the
doggone thing until you need it again. That’s a situation for the Minimize button,
which also appears earlier, in Figure 3-6. A minimized window disappears from
the Desktop but isn’t closed; it simply reappears in the Dock as a miniature icon.
Minimizing a window is easy: Move the pointer over the Minimize button (the
second of the three buttons at the upper-left corner of the window) — a minus
sign appears in the button to tell you you’re on target — and then click.

You can set your Dock preferences so that double-clicking the window’s title bar
(the top frame of the window, which usually includes a document or application
name) minimizes the window. (I cover Dock preferences in Chapter 5.)

To restore the window to its full size (and its original position on the Desktop),
just click its window icon in the Dock.
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Moving and zooming windows

Perhaps you want to move a window to another location on the Desktop so that
you can see the contents of multiple windows at the same time. Click the win-
dow’s title bar and drag the window anywhere you like. Then release the button.
(Don’t click the icon in the center of the title bar, though. You’ll move just the icon
itself, not the window.)

Many applications can automatically arrange multiple windows for you (examples
include Microsoft Word and PowerPoint). Choose Window=> Arrange All (if this
option appears).

To see everything a window can show you, use the Zoom feature to expand any
Finder or application window to its maximum practical size. Note that a zoomed
window can fill the entire screen, or, if that extra space isn’t applicable for the
application, the window might expand to only a larger part of the Desktop.

To zoom a window, move your pointer over the third button at the top-left corner
of the window. Again, refer to Figure 3-6, which struts its stuff and illustrates the
position. (Man, that is one versatile figure.) A double-arrow icon appears on the
Zoom/Full-Screen button. Click to expand your horizons to full-screen, or hold
down the Option key while clicking to zoom the window to maximum size.

Speaking of full-screen mode, it comes in very handy on your iMac’s beautiful
widescreen display — that’s where a single application fills the entire screen,
without displaying a window frame or traditional Finder menu bar. The method
you use to switch to full-screen mode varies depending on the application, so
there’s no One Menu Command or One Keyboard Shortcut that will always do the
deed. Most of the applications included with macOS Mojave use View= Enter Full
Screen, and many applications have a button you can click in the window to switch
back and forth. A click on the Zoom/Full-Screen button switches most Apple
applications into full-screen. Finder windows can also be switched to full-screen
mode in Mojave! To exit full-screen mode, just press Esc.

So how do you switch between applications if they’re all in full-screen mode?

3 Move your pointer to the bottom of the screen to display the Dock, where you
can click another application to switch to it.

¥ Invoke Mission Control and choose another application from there. (More
about Mission Control later in this chapter.)
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REMEMBER

TOGGLING TOOLBARS THE MOJAVE WAY

It's time to define a window control that's actually inside the window for a change. A tool-
bar is a strip of icons that generally appears under the window's title bar (although tool-
bars can appear in other locations as well). These icons typically perform the most
common actions in an application; the effect is the same as if you used a menu com-
mand or pressed a keyboard shortcut. Toolbars are popular these days. You see ‘emin
everything from the Finder window to most application windows.

You can usually banish a window's toolbar to make extra room for icons, documents, or
whatever the window happens to be holding. Just choose View=>Hide Toolbar. To
restore the toolbar to its original position, choose View= Show Toolbar. Note: If you tog-
gle the Finder window toolbar off, you also lose the Finder window Sidebar.

¥ If you're using a trackpad, swipe three fingers to the left or right across the
trackpad surface.

¥ From the keyboard, use the 38+Tab shortcut to cycle through the applications
you have running.

Closing windows

When you’re finished with an application or you no longer need to have a window
open, move the pointer over the Close button at the upper-left corner of the win-
dow (it’s the first of the three circular buttons). When the X appears in the button,
click it. And yes, I can make one more reference to Figure 3-6, which I’m thinking
of nominating as Figure of the Year.

Perhaps you have more than one window open in the same application, and you
want to close 'em all in one fell swoop. Hold down the Option key while you click
the Close button in any of the windows.

If you haven’t saved a document, and you try to close that application’s window,
the application gets downright surly and prompts you for confirmation.
“Hey, human, you don’t really want to do this, do you?” If you answer in the
affirmative — “Why, yes, machine. Yes, indeed, I do want to throw this away and
not save it.” — the application discards the document you were working on. If you
decide to keep your document (thereby saving your posterior from harm), you can
cancel the action and then save the document within the application.
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ONLY ONE WINDOW CAN BE
ACTIVE AT ONCE

Here's a very special Mark's Maxim in the macOS universe:
MARK'S
MAXIM

Only one application window can be active in Mojave at any time.
You can always tell which window is active:

® The active window is on top of other windows. (You can still use a window's Close,
Minimize, and Zoom buttons when the window is inactive.)

® Any input you make by typing or by moving your finger on the trackpad appears in
the active window.

® macOS dims the title bars of inactive windows you haven't minimized.

Juggling Folders and Icons

Finder windows aren’t just for launching applications and opening the files and
documents you create. You can also use the icons in a Finder window to select one
or more specific items or to copy and move items from place to place within your
system.

A field observer’s guide to icons

Not all icons are created equal. Earlier in this chapter, I introduced you to your
iMac’s drive icon on the Desktop. Here’s a little background on the other types of
icons you might encounter during your travels:

¥ Hardware: These icons are your internal storage devices (such as your drive) as
well as external peripherals — like an external DVD drive or a USB flash drive.

3 Applications: These icons represent the applications (or programs) you can
launch. Most applications have a custom icon that incorporates the company's
logo or the specific application logo. Double-clicking an application usually doesn't
load a document automatically; you typically get a new blank document or an
Open dialog box from which you can choose the existing file you want to open.

3 Documents: Many of the files on your hard drive are documents that can be
opened in the corresponding application, as shown in Figure 3-7. Double-clicking
a document automatically launches the associated application (that is, as long as
macOS recognizes the file type).
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FIGURE 3-7:
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¥ Files: Most of the file icons on your system are mundane things such as

»

preferences and settings files, text files, log files, and miscellaneous data files.
Yet most are identified with at least some type of recognizable icon that lets
you guess what purpose the file serves. You'll also come across generic file
icons that look like a blank sheet of paper (used when Mojave has no earthly
idea what the file type is).

Aliases: An alias acts as a link to another item elsewhere on your system. For
example, to launch Adobe Acrobat, you can click an Adobe Acrobat alias icon
that you can create on your Desktop instead of clicking the actual Acrobat
application icon. The alias essentially acts the same way as the original icon,
but it doesn't take up the same amount of space — only a few bytes for the
icon itself, compared with the size of the actual application. Plus, you don't
have to go digging through folders galore to find the original application icon.
(Windows switchers know an alias as a shortcut. The idea is the same,
although Macs had it first. Harrumph.) You can always identify an alias by the
small curved arrow at the base of the icon, and the icon might also sport the
tagalias at the end of its name.

You have two ways to create an alias. Here's one:
1. Select the item. (More on selecting items in the next section.)
2. Choose Filec> Make Alias, or press 38+L.

Figure 3-8 shows aliases for four macOS applications, complete with that
fashionable alias arrow.

Here's another way to create an alias:
1. Hold down g8+Option.
2. Drag the original icon to the location where you want the alias.

Note that this funky method doesn't add the alias tag to the end of the alias
icon name unless you drag the icon to another spot in the same folder.
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FIGURE 3-8:
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So why bother to use an alias? Two good reasons:

3 You can launch an application or open a document from anywhere on
your drive. For example, if you occasionally need to use another application
while working on a Pages project, you can add an alias and launch the other
application directly from the folder where you store those Pages documents.
Speed, organization, and convenience. Life is good.

3 You can send an alias to the Trash without affecting the original item.
When that school project is finished, you can safely delete the entire folder
without worrying about whether Pages will run the next time you double-click
the application icon!

Selecting items

Often, the menu or keyboard commands you perform in the Finder need to be per-
formed on something. Perhaps you’re moving an item to the Trash, getting more
information on the item, or creating an alias for that item. To identify the target
of your action to the Finder, you need to select one or more items on your Desktop
or in a Finder window. In the following sections, I show you just how to do that.

Selecting one thing
Mojave gives you a couple of options when selecting just one item for an upcom-
ing action:
3 Move the pointer over the item and click. A dark border (or highlight)
appears around the icon, indicating that it's selected.

¥ If anicon is already highlighted on your Desktop or in a window, move
the selection highlight to another icon in the same location by using the
arrow keys. To shift the selection highlight alphabetically, press Tab (to move
in order) or press Shift+Tab (to move in reverse order).

Selecting items in the Finder doesn’t actually do anything to them by itself. You
have to perform an action on the selected items to make something happen.

REMEMBER
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Selecting a whole bunch of things

You can also select multiple items with aplomb by using one of these methods:

¥ Adjacent items:

® Drag a box around them. If that sounds like ancient Sumerian, here's the
explanation: Click a spot above and to the left of the first item. Keep
holding down your finger on the mouse or trackpad surface, and drag
down and to the right. (This is called dragging in Mac-speak.) A box outline
like the one shown in Figure 3-9 appears, indicating what you're selecting.
Any icons that touch or appear within the box outline are selected when
you release the button.

© (lick the first item to select it, and then hold down the Shift key while you click
the last item. Mojave selects both items and everything between them.

3 Nonadjacent items: Select these by holding down the §8 key while you click

each item.
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Check out the status bar (which can appear at the top or bottom of a Finder
@ window, depending on whether the toolbar is hidden). It tells you how much space
is available on the drive you’re working in, as well as how many items are displayed

TIP in the current Finder window. When you select items, it shows you how many you
highlighted. (If you don’t see a status bar, choose View= Show Status Bar.)
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Copying items

Want to copy items from one Finder window to another, or from one location (like
a flash drive) to another (like your Desktop)? Trés easy. Just use one of these
methods:

3 On the same drive

To copy one item to another location: Hold down the Option key (you don't
have to select the icon first), and then click and drag the item from its
current home to the new location.

To put a copy of an item in a folder, just drop the item on top of the
receiving folder. If you hold the item you're dragging over the destination
folder for a second or two, Mojave opens a new window so that you can
TP see the target’s contents. (This is called a spring-loaded folder. Really.)

To copy multiple items to another location: Select them all (see the preceding
section), hold down the Option key, and then drag-and-drop one of the
selected items where you want it. All the items you selected follow the item
you drag. (Rather like lemmings. Nice touch, don’t you think?)

To help indicate your target when you're copying files, Mojave highlights
the location to show you where the items will end up. (This works whether
the target location is a folder or a drive icon.) If the target location is a
window, Mojave adds a highlight to the window border.

¥ On adifferent drive

To copy one or multiple items: Click and drag the icon (or the selected items
if you have more than one) from the original window to a window you
open on the target drive. (No need to hold down the Option key while
copying to a different drive.) You can also drag one item (or a selected
group of items) and simply drop the items on top of the drive icon on
your Desktop.

@ The items are copied to the top level, or root, of the target drive.

If you try to move or copy something to a location that already has an
item with the same name, you see a dialog that prompts you to decide
whether to replace the file or to stop the copy/move procedure and leave
the existing file alone. (Heck, you can even keep both — macOS performs
the copy or move, but also appends the word copy to the item being
copied.) Good insurance, indeed.

REMEMBER

PART 1 Getting Started with Your iMac



MY, WHAT AN ATTRACTIVE SIDEBAR ... AND
SO USEFUL!

Have you noticed the Sidebar that typically occupies the left side of a Finder window? It's
a pane of links to common locations and devices that you can use to jump like a flash to
a specific spot on your hard drive. For example, you can click the Applications link under
the Favorites heading, and you're transported to your Applications folder in an instant.

Here's a great example of Sidebar magic: | like as few icons on my Desktop as possible,
so each book I'm working on gets its own folder. All the items for that project that might
otherwise end up on my Desktop are saved to that folder instead. In fact, | make a point
of adding my current book project folder to my Finder window Sidebar so that it's avail-
able immediately from any Finder window. To do this, just drag the folder into the col-
umn at the left side of the Finder window and drop it on top of the Favorites heading in
the Sidebar’s list.

You can configure the items that will appear in your Sidebar: Choose Finder=>Preferences,
and then click the Sidebar tab to display the list. From here, you can select and deselect
check boxes to configure your Sidebar to your liking.

Moving things from place to place

Moving things from one location to another location on the same drive is the easi-
est action you can take. Just drag the selected item or items to the new location.
The item disappears from the original spot and reappears in the new spot.

Duplicating in a jiffy

If you need more than one copy of the same item in a folder, use the Mojave Dupli-
cate command. I use Duplicate often when I want to edit a document but want to
ensure that the original document stays pristine, no matter what. I just create a
duplicate and edit that file instead.

To use Duplicate, you can:

¥ Click an item to select it and then choose Filew> Duplicate.
¥ Right-click the item and choose Duplicate from the menu.

3 Hold down the Option key and drag the original item to another spot in the same
window. When you release the button, the duplicate file appears like magic!
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REMEMBER

TIP

The duplicate item has the word copy appended to its name. A second copy is
named copy?2, a third is copy3, and so on.

Duplicating a folder also duplicates all the contents of that folder. Therefore, cre-
ating a duplicate folder can take some time if the original folder was stuffed full
(or contained files several hundred megabytes or larger in size). The duplicate
folder has copy appended to its name, but the contents of the duplicate folder keep
their original names.

Using Finder Tabs

Mojave includes a powerful feature you can use to display multiple locations in the
same window. Finder Tabs work just like the tabs in Safari (as well as other popular
browsers for both Macs and PCs), allowing you to switch between multiple loca-
tions on your Mac instantly by clicking a tab to switch to that location. You can
even drag files and folders from tab to tab!

To open a new tab in a Finder window, you have a wealth of choices:

¥ Click the desired location and press 38+T.
¥ Right-click the location and choose Open in New Tab.

¥ Select the location and click the New Tab button (which bears a plus sign) at
the right side of the window.

¥ Click the Action icon (which bears a gear icon) in any Finder window toolbar,
and choose Open in New Tab.

For example, suppose that you’re working on an iMovie project. You might create
tabs using the Applications item in the Finder window Sidebar and a folder (or
even a DVD or shared drive) named Work that contains your video clips. The loca-
tion appears as a new tab immediately under the toolbar. You can open as many
tabs as you like, and you can also drag the Finder Tabs themselves to reorder
them. To switch between tabs using the keyboard, press Ctrl+Tab. To close a tab,
hover the pointer over it and click the X button that appears. That hardworking
Figure 3-6 (shown earlier in the chapter) shows three Finder Tabs at work.

You can also set new folders to open in tabs instead of windows. Just click the
Finder menu at the top of the Desktop, choose Preferences, click the General tab
and then click the Open Folders in Tabs Instead of New Windows check box to
enable it.
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Keys and Keyboard Shortcuts
to Fame and Fortune

Your iMac’s keyboard might not be as glamorous as the mouse, but any Mac power
user will tell you that using keyboard shortcuts is usually the fastest method of
performing certain tasks in the Finder, such as saving or closing a file. I recom-
mend committing these shortcuts to memory and putting them to work as soon as
you begin using your iMac so that they become second nature to you as quickly as
possible.

Special keys on the keyboard

The Apple standard keyboard has a number of special keys that you might not
recognize — especially if you’ve made the smart move and decided to migrate
from the chaos that is Windows to macOS! Table 3-1 lists the Apple keyboard’s
function keys and describes what they do.

TABLE 3-1 Too-Cool Function Keys
Action/Key Name SVaglele] Purpose
Audio Mute Mutes (and restores) all sound produced by your iMac
Volume Up Increases the sound volume

Volume Down

Decreases the sound volume

Ctrl Ctrl Displays the right-click/Control+click menu with the trackpad
Command 38 Primary modifier for menus and keyboard shortcuts

Delete Delete Deletes selected text

Option Option Modifier for shortcuts
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Using the Finder and application
keyboard shortcuts

The Finder is chock-full of keyboard shortcuts that you can use to take care of
common tasks. Some of the handiest shortcuts are listed in Table 3-2, along with
the locations where the corresponding menu entries appear in Mojave.

TABLE 32 Mojave Keyboard Shortcuts of Distinction
Key Combination  Location Action
3B+A Edit menu Selects all items (works in the Finder, too)
38+C Edit menu Copies the selected items to the Clipboard
38+H Application Hides the current application window
menu
38+M Window menu Minimizes the active window to the Dock (also works in the Finder)
38+0 File menu Opens or launches an existing document, file, or folder (also works

in the Finder)

B+P File menu Prints the current document

¥+Q Application Exits (quits) the application, and prompts you to save any changes
menu

$8+T File menu Opens a new Finder tab with the currently selected location

B+ Edit menu Pastes the contents of the Clipboard at the current pointer position

38+X Edit menu Cuts the highlighted item to the Clipboard

®+7Z Edit menu Reverses (undoes) the effect of the last action you took

8+? Help menu Displays the Help system (works in the Finder, too)

36+Tab Finder Switches between open applications

38+Option+M Finder Minimizes all Finder windows to the Dock

38+Option+W Finder Closes all Finder windows

keyboard shortcuts. While you’re working with a new application, display the
application’s Help file and print a copy of the keyboard shortcuts as a handy cheat
TIP sheet.

‘ But wait; there’s more! Most of your applications also provide their own set of

If you’ve used a PC before, you’re certainly familiar with three-key shortcuts. The
most infamous is Ctrl+Alt+Delete, the beloved reboot/Task Manager shortcut
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nicknamed the Windows three-finger salute. Three-key shortcuts work the same
way in Mojave (but you’ll be thrilled to know you don’t need to reboot by using
that notorious Windows shortcut!). If you’re new to computing, to use a three-key
shortcut, hold down the first two keys and then press the third key.

You’re not limited to the keyboard shortcuts I’ve listed. In System Preferences,
visit the Keyboard pane and then click the Shortcuts tab to list them (as well as
change an existing shortcut or add a shortcut).

Home, Sweet Home Folder

©

REMEMBER

Each user account you create in Mojave is actually a self-contained universe. For
example, each user has a number of unique characteristics and folders devoted to
just that person, and Mojave keeps track of everything that user changes or cre-
ates. (In Chapter 10, I describe the innate loveliness of multiple users living in
peace and harmony on your laptop.)

This unique universe includes a different system of folders for each user account
on your system. The top-level folder uses the short username Mojave assigns
when that user account is created. Naturally, the actual folder name is different
for each person. Mac techno types typically call this folder your Home folder. (On
the Sidebar, look for the teeny house icon under the Favorites heading, marked
with your account name.)

When you’re on the hunt for your Home folder, don’t look for a folder that’s actu-
ally named Home. Instead, look for the short username that was assigned when
you created the user account.

Each account’s Home folder contains a set of subfolders, including:

¥ Movies
¥ Music
¥ Pictures

¥ Downloads (for files you download by using Safari or through Apple Mail
attachments)

¥ Public (for files you want to share with others on your network)
¥ Sites (for web pages created by the user)

¥ Documents (for files created by the user)
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TIP

Although you can store your stuff at the root (top level) of your drive — or even on
your Desktop — that gaggle of files, folders, and aliases can get crowded and con-
fusing quickly. Here’s a Mark’s Maxim to live by:

Your Home folder is where you hang out and where you store your stuff. Use it to
make your computing life much easier!

Create subfolders within your Documents folder to organize your files and folders
even further. For example, I create a subfolder in my Documents folder for every
book I write so that I can quickly and easily locate all the documents and files
associated with that book project.

I discuss security in your Home folder and what gets stored where in Chapter 10.
For now, remember you can reach your Home folder easily, because it appears in
the Finder window Sidebar. One click on the Sidebar entry for your Home folder,
and all your stuff is within easy reach. (If your Home folder doesn’t appear in the
Sidebar, that’s easy to fix: Choose Finder= Preferences, click the Sidebar tab, and
then select the check box to display your Home folder.)

In addition to using the Finder window Sidebar, you can reach your Home folder
in other convenient ways:

¥ From the Go menu: Choose Go=>Home to display your Home folder
immediately from the Finder window. Alternatively, you can press $8+Shift+H
to accomplish the same thing.

3 From the Open dialog: The Mojave standard File Open dialog also includes
the same Home folder (and subfolder) icons as the Finder window Sidebar.

3 In any new Finder window you open: If you like, you can set every Finder
window you open to automatically display your Home folder:

1. Choose Finder> Preferences and click the General tab.

2. Click the arrow button at the right side of the New Finder Windows Show pop-up
menu.

A menu pops up (hence the name).

3. Click the Home entry (with the house icon and your short username) in the
menu.

4. Click the Close button at the upper-left corner of the dialog.

You're set to go. From now on, every Finder window you open displays your
Home folder as the starting location!
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Here’s another reason to use your Home folder to store your stuff: default locations!
Mojave expects your stuff to be there when you migrate your files from an older
Mac to a new iMac, and all Apple applications can use your Home folder when
loading and saving projects.

Working with Mission Control,
Spaces, and Dashboard

TIP

For those power users that often work with a passel of applications, allow me to
turn your attention to one of the sassiest features in Mojave: Mission Control.
Figure 3-10 shows off the Mission Control screen:

3 Press F3 (or Control+{, depending on your keyboard) to show all open
windows using Mission Control, grouped by application; then click the one
you want. Figure 3-10 illustrates the tiled All Windows display on my iMac after
| press F3. Move the pointer on top of the window you want to activate — the
window sports a blue border and its name is displayed when it's selected —
and click once to switch to that window. You can specify which keys you want
to use in the Mission Control pane in System Preferences.

3 Press Ctrl+F3 (or Control+}, depending on your keyboard) to show all
open windows from the application that you're currently using; click the one
you want to activate. This Mission Control function is great for choosing from
all the images you've opened in Photoshop or all the Safari web pages
populating your Desktop!

Astute observers will notice that the application menu bar also changes to match
the now-active application.

Besides the F3 and Control+F3 hot keys that I just discussed, Mission Control pro-
vides one more nifty function: Press $8+F3, and all your open windows scurry to
the side of the screen. Now you can work with drives, files, and aliases on your
Desktop — and when you’re ready to confront those dozen application windows
again, just press the keyboard shortcut a second time.

Naturally, these key combinations can be viewed and customized - visit the com-

fortable confines of System Preferences and click on the Mission Control icon to
choose what key sequence does what.
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Although the Mission Control screen appears automatically when necessary, you
can launch it at any time from your iMac’s Launchpad display or by pressing the
Mission Control key on your keyboard. From the trackpad, display the Mission
Control screen by swiping up with three fingers.

Switching Desktops with Spaces

Ah, but what if you want to switch to a different set of applications? For example,
suppose that you’re slaving away at your pixel-pushing job — say, designing a
magazine cover with Pages. Your page design Desktop also includes Adobe’s Pho-
toshop and InDesign, which you switch between often using one of the techniques
I just described. Suddenly, however, you realize you need to schedule a meeting
with others in your office, using Calendar, and you want to check your email in
Apple Mail. What to do?

Well, you could certainly open Launchpad and launch those two applications on
top of your graphics applications and then minimize or close them. But with Mis-
sion Control’s Spaces feature, you can press the Control+« or Control+— sequences
to switch to a different “communications” Desktop, with Calendar and Apple Mail
windows already open and in your favorite positions. (I've also created a custom
“music” Desktop for GarageBand and iTunes.) Figure 3-10 illustrates multiple
Spaces Desktops at the top of the Mission Control screen.

After you set up your meeting and answer any important email, simply press
Control+« or Control+— again to switch back to your “graphics” Desktop, where
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REMEMBER

all your work is exactly as you left it. (And yes, Virginia, Spaces does indeed work
with full-screen applications.)

To create a new Desktop for use in Spaces, click the Launchpad icon on the Dock
and then click the Mission Control icon. Now you can set up new Spaces Desktops.
Move your pointer to the top right of the Mission Control screen, and click the Add
button (with the plus sign) that appears. (If you relocated your Dock to the right
side of the screen, the Add button shows up in the upper-left corner instead.)
Spaces creates a new empty Desktop thumbnail. Switch to the new Desktop by
clicking the label at the top of the Mission Control screen, and then open those
applications you want to include. (Alternatively, you can drag the applications
from Mission Control onto the desired Spaces label.) That’s all there is to it!

To switch an application window between Spaces Desktops, drag the window to the
edge of the Desktop and hold it there. Spaces automatically moves the window to
the next Desktop. (Applications can also be dragged between Desktops within the
Mission Control screen.) You can also delete a Desktop from the Mission Control
screen. Just hover your pointer over the offending Spaces label to display the
thumbnail, and click the Delete button (with the X) that appears.

You can jump directly to a specific Spaces Desktop by clicking its thumbnail in
your Mission Control screen or by holding down the Control key and pressing the
number corresponding to that desktop. Finally, you can always use the Control+«
or Control+— shortcuts to move between Desktops and full-screen applications.

Stick it on the Dashboard

Dashboard is a favorite feature of mine within Mojave — I use it to hold widgets
and display them with the press of a button. (Okay, I know that sounds a little
wacky, but bear with me.) Widgets are small applications — dubbed by some as
‘“applets” — that typically provide only one function. For example, Dashboard
comes complete with a calculator, dictionary, clock, weather display, and quick-
and-simple calendar.

By default, Dashboard is turned off in Mojave. To enable Dashboard, open the
Mission Control pane in System Preferences, click the Dashboard pop-up menu
and select As Space (which displays your widgets as a separate Space in Mission
Control). You can also choose overlay mode if you prefer your widgets to “float”
over your Desktop instead.

You can display and use these widgets at any time by pressing the Dashboard
shortcut; by default, that’s Function-F12 (hold down the FN key and press F12).
You can modify the Dashboard key on the Mission Control pane in System Prefer-
ences. Dashboard also appears as a Desktop in the Spaces strip on the Mission
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Control screen and as an icon in Launchpad, and you can add it to your Dock from
the Applications folder.

You can add widgets to your Dashboard by clicking the Add button (which bears a
plus sign, naturally) at the lower-left corner of the Dashboard screen. Then Dash-
board displays your entire collection of widgets, and you can click a widget to add
it directly onto your Dashboard.

While you’re adding widgets, rearranging the widgets that are already populating
Dashboard is easy: Drag them to the desired spot. When it’s time to go back to
work (or play), you can return to your Mojave Desktop by pressing the Dashboard
key again, or by clicking anywhere on the Dashboard background.

Most widgets have an option button that allows you to change things, such as
borders, zip codes, display columns, and the like; look for a tiny circle with a low-
ercase letter i. Click this information icon, and you can then tweak whatever
options are available for that widget.

To remove a widget from the Dashboard display, just click the Delete button
(which bears a minus sign) and you’ll notice that a tiny X button appears next to
each widget on your Dashboard. Click the X button next to the widget you want to
remove, and it vanishes from the display. Note, however, that deleting a widget
doesn’t remove it from your Mac entirely! You can add that deleted widget back
again at any time by clicking the Add button. To return to your Dashboard, click
the Delete button again.

Personalizing Your Desktop

62

Many folks put all their documents, pictures, and videos on their Mojave Desktop
because the file icons are easy to locate! Your computing stuff is right in front of
you...or isit?

Call me a finicky, stubborn techno-oldster — go ahead, it’s true — but I prefer a
clean macOS Desktop without all the iconic clutter. In fact, my Desktop usually
has just three or four icons even though I use my iMac several hours every day,
often on multiple book projects. It’s an organizational thing; I work with literally
hundreds of applications, documents, and assorted knickknacks daily. Sooner or
later, you’ll find that you’re using that many, too. When you keep your stuff
crammed on your Desktop, you end up having to scan your screen for a particular
file, alias, or type of icon. You end up taking more time to locate it on your Desktop
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than in your Documents folder! And don’t forget, open windows hang out on your
Desktop too. To find anything, you have to close or move those windows!

Plus, you’ll likely find yourself looking at old icons that no longer mean anything
to you or stuff that’s covered in cobwebs that you haven’t used in years. Stale
icons — yuck.

I recommend that you arrange your Desktop so that you see only a few icons for
the files or documents you use the most. Leave the rest of the Desktop for that cool
image of your favorite actor or actress.

Besides keeping things clean, I can recommend a number of other favorite tweaks
that you can make to your Desktop:

3 Keep Desktop icons arranged as you like.
1. From the Finder menu, choose Viewr>Show View Options.

2. From the Sort By pop-up menu, choose the criteria that Mojave uses to auto-
matically arrange your Desktop icons, including the item name, the last
modification date, or the size of the items.

| personally like things organized by name, but many iMac owners prefer to
see things organized by date (putting the most recently modified item at the
top, for example).

3 Choose a favorite background.

1. Right-click any open spot on your Desktop and choose Change Desktop
Background.

The Desktop & Screen Saver pane appears, as shown in Figure 3-11.

2. Browse through the various folders of background images that Apple provides,
open a folder of your own images, or use an image from your Photos library.

3 Display all the peripherals and network connections on your system.
1. Choose Finderr> Preferences.

2. Make sure that all four of the top check boxes are selected: Hard Disks; External
Disks; CDs, DVDs, and iPods; and Connected Servers.

If you're connected to an external network, or if you've loaded an external
drive or device, these external storage locations show up on your Desktop.
You can double-click that Desktop icon to view your external stuff.
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Customizing the Dock

In terms of importance, the Dock — the quick-access strip for applications and
documents that appears on your Desktop — ranks right up there with the cockpit
of a modern jetliner. As such, it had better be easy to customize, and naturally,
macOS doesn’t let you down.

Adding applications and extras to the Dock

Why be satisfied with just the icons that Apple places on the Dock? You can add
your own applications, files, and folders to the Dock as well:

3 Adding applications: You can add any application to your Dock by dragging
its icon into the area to the /eft side of the Dock (that's to the left side of the
vertical line on the Dock). You'll know when you're in the proper territory
because the existing Dock icons obligingly move aside to make a space for it.

Attempting to place an application directly on the right side of the Dock sends
it to the Trash (if the Trash icon is highlighted when you release the button), so

beware. Note, however, that you can drop an application icon inside a Stack
WARNING (more on that in a bit) or a folder that already exists at the right side of the

Dock. (If you've repositioned the Dock to the left or right side of the screen,
consider the top of the Dock as the “left side” and the bottom of the Dock as
the “right side.”)
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¥ Adding individual files and volumes: Individual files and volume icons can be
added to the Dock by dragging the icon into the area to the right side of the Dock.
(Attempting to place these to the left side of the Dock opens the application
associated with the contents, which typically isn't what you intended.) Again, the
existing Dock icons move aside to create a space when you're in the right area.

To open the Dock item you've added in a Finder window, right-click the icon to
display a Dock menu, where you can open documents, run applications, and
have other assorted fun, depending on the item you choose.

¥ Adding several files or a folder: Mojave uses a feature called Stacks, which |
discuss in the next section, “Keeping track with Stacks,” to handle multiple files
or add an entire folder to the Dock.

¥ Adding websites: You can drag any URL from Safari directly into the area at
the right of the Dock. Clicking that Dock icon automatically opens your
browser and displays that page.

To remove an icon from the Dock, just click and drag it off the Dock. Note, how-
ever, that the original application, folder, or volume is not deleted — just the Dock
icon itself is permanently excused. If you like, you can delete almost any of the
default icons that macOS installs on the Dock; only the Finder and Trash icons
must remain on the Dock.

Mojave introduces Recent Applications to your Dock —this feature displays the
last three applications you’ve used on the right side of the Dock (convenient as all
get-out if you’re launching the same applications on a regular basis). To enable
Recent Applications, visit the Dock pane in System Preferences and enable the
Show Recent Applications check box.

Keeping track with Stacks

Mojave offers Stacks, which are groups of items (documents, applications, and
folders) that you want to place on the Dock or your Desktop for convenience —
perhaps the files needed for a project you’re working on, or your favorite game
applications. For example, I have a Stack named Wiley on my Dock that holds all
the project files I need for the book I’m currently writing.

Using Desktop Stacks

To create Stacks on the Desktop, you first need to enable them. From the Finder
menu, click View=> Use Stacks. Mojave automatically moves all the items on your
Desktop into Stacks grouped by file type — you can change the grouping criteria
by clicking View= Group Stacks By (or by right-clicking on the Desktop Stack and
selecting the same option). Items that you copy or move to your Desktop are added
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to the appropriate Desktop Stack (if it exists), or a new Desktop Stack is created to
hold them.

To display the items in a Desktop Stack, click it to open the Stack. The contents
appear on your Desktop as individual icons again, while the Stack itself remains
selected (and gains a down arrow icon to indicate that it’s open). To close a Desktop
Stack, click the Stack icon again. Note that individual Stacks cannot be removed
from your Desktop; you must completely disable the feature by choosing View«>Use
Stacks from the Finder menu, which returns all the individual items to your Desktop.

To open a document or folder from a Desktop Stack, display the contents and
double-click the desired icon.

Using Dock Stacks

To create a Stack in the Dock, just select a folder containing the items and drag the
folder to the right side of the Dock. As always, the Dock opens a spot on the right
side of the Dock to indicate you’re in the zone.

To display the items in a Dock Stack, just click it:

¥ If the Stack holds relatively few items, they're displayed in a really cool-
looking arc that Apple calls a fan, and you can click the item you want to open
or launch. Figure 3-12 illustrates a typical Stack on the Dock unfurled as a fan.

¥ If the Stack is stuffed full of many items, the Stack opens in a grid display,
allowing you to scroll through the contents to find what you need.

You can open a document or folder from a Dock Stack by displaying the contents
and clicking the desired icon.

Mojave provides a number of options for an individual Dock Stack, as well. Right-
click the Stack icon, and you can choose to sort the contents by name, date created
or added, date modified, or file type. If you’d prefer a grid display for a Dock Stack
(no matter how many items the Stack contains), you can choose Grid view mode.
Choose List to display the Stack’s contents in much the same way as List view in
a Finder window. List view mode also allows you to view folders in a Dock Stack as
nested menu items. Choose Automatic to return to the default view mode. When
set to Display as Stacks, the Stack icon is displayed using icon images from the
contents of the folder; if security is an issue, however, choose Display as Folder
from the right-click menu to display the Dock Stack as a plain folder icon instead.

You can remove a Stack from the Dock by right-clicking the Stack icon and choos-
ing Options from the menu that appears. Choose Remove from Dock from the
submenu that appears. Alternatively, just drag that sucker right off the Dock.
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FIGURE 3-12:
Stacks make it
easy to access

your stuff from
the Dock or
Desktop.

TIP

You can also display the contents of a Dock Stack in a Finder window. Right-click
the Stack icon, and choose the Open item at the bottom of the pop-up menu.

If you add a folder full of items to the Dock, the Stack is named after the folder;
otherwise, Mojave does the best job it can in figuring out what to name the Stack.

Apple provides a Dock Stack already set up for you: The Downloads folder, situated
next to the Trash, is the default location for any new files that you download using
Safari or receive in your email. Mojave bounces the Download Stack icon to indi-
cate that you’ve received a new item.

Resizing the Dock

You can change the size of the Dock from the Dock settings in System Preferences —
but here’s a simpler way to resize the Dock, right from the Desktop.

Move your pointer over the vertical solid line that separates the left side of the
Dock from the right side; the pointer turns into a funky vertical line with arrows
pointing up and down. This is your cue to click and drag while moving up and
down, which expands and shrinks the Dock, respectively.

You can also right-click when the funky line pointer is visible to display a menu

of Dock preferences. This allows you to change your Dock preferences without the
hassle of opening System Preferences and displaying the Dock settings.
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What's with the Trash?
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Another sign of an iMac power user is a well-maintained Trash can. It’s a breeze
to empty the discarded items you no longer need, and you can even rescue some-
thing you suddenly discover you still need!

The translucent Mojave Trash icon resides in the Dock, and it works just like the
Trash has always worked in macOS: Simply drag selected items to the Trash to
delete them.

Note one very important exception: If you drag a Desktop icon for an external
device or a removable media drive to the Trash (such as an iPod, DVD, or external
drive), the Trash icon turns into a giant Eject icon, and the removable device or
medium is ejected or shut down — not erased. Repeat, not erased. (That’s why the
Trash icon changes to the Eject icon — to remind you that you’re not doing any-
thing destructive.)

Here are other ways to chuck items you select to go to the wastebasket:

¥ Choose File> Move to Trash.

¥ Click the Action button on the Finder toolbar, and choose Move to Trash from
the list that appears.

¥ Press §8+Delete.

¥ Right-click the item and choose Move to Trash from the menu that appears.

You can always tell when the Trash contains at least one item, because the basket
icon is full of crumpled paper. However, you don’t have to unfold a wad of paper
to see what the Trash holds. Just click the Trash icon in the Dock to display the
contents of the Trash. To rescue something from the Trash, drag the item(s) from
the Trash folder to the Desktop or any other folder in a Finder window. (If you’re
doing this for someone who’s unfamiliar with Mojave, remember to act like it was
a lot of work, and you’ll earn big-time DRP, or Data Rescue Points.)

When you’re sure that you want to permanently delete the contents of the Trash,
use one of these methods to empty the Trash:

¥ Choose Finder= Empty Trash.

¥ Press 38+Shift+Delete.

¥ Right-click the Trash icon in the Dock and choose Empty Trash from the menu
that appears.
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All You Really Need to
Know about Printing

TIP

FIGURE 3-13:

The Print sheet is
available from
any application
with any

real guts.

Since we’re near the end of this chapter, I turn now to a task that most folks need
to tackle soon after buying their iMac or installing Mojave: printing documents.
Because basic printing is so important (and in most cases, so simple), allow me to
demonstrate how to print a document.

Most of us have a Universal Serial Bus (USB) printer — the USB being the favored
hardware connection in macOS. As long as your printer is supported by macOS,
setting it up is as easy as plugging it into one of your iMac’s USB ports.

Before you print, preview! Would you jump from an airplane without a parachute?
Then why would you print a document without double-checking it first? Most
applications now have their own built-in Preview thumbnails in the Print sheet,
as shown in Figure 3-13 — this is definitely a good thing because you see what the
printed document will look like, possibly saving you both paper and some of that
hideously expensive ink or toner.
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To print from any application using the default page characteristics — standard
81/2 x 11-inch paper, portrait mode, no scaling — follow these steps:

1.

In your application, choose File=> Print or press the $8+P keyboard
shortcut.

In most applications, macOS displays the simple version of the Print sheet. (To
display all the fields you see in Figure 3-13, click the Show Details button at the
bottom of the sheet.) Some applications use their own custom Print dialogs,
but you should see the same general settings.

Click in the Copies field, and enter the number of copies you need.

You can also enable or disable collation, just as you can with those oh-so-fancy
copiers.

Decide what you want to print.

The whole shootin’ match: To print the entire document, use the default
Pages radio button setting of Al.

Anything less: To print a range of selected pages, select the From radio
button and enter the starting and ending pages (or, if the application
allows it, a selection of individual pages).

(Optional) Choose application-specific printing parameters.

Each macOS application provides different panes so you can configure settings
specific to that application. You don't have to display any of these extra settings
to print a default document, but the power is there to change the look
dramatically when necessary. To display these settings, open the Layout
pop-up menu in the center of the Print sheet and choose one of these panes.
For example, if you're printing from Contacts, you can choose the Contacts
entry from the pop-up menu and elect to print a phone list, an envelope,
mailing labels, or an email list.

When everything is go for launch, click the Print button.

Of course, there are more settings and more functionality to the printing
system in macOS. However, | can tell you from my experiences as a consultant
and hardware technician that this short introduction to printing will likely
suffice for 90 percent of the Mac owners on Earth. 'Nuff said.

And Just in Case You Need Help.. ..

You can call on the resources described in this section if you need additional help
while you’re discovering how to tame Mojave.
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TIP

Some of the help resources are located on the Internet, so your Safari web browser
will come in handy when you search for answers.

The Mojave built-in Help system

Sometimes the help you need is as close as the Help menu on the Finder menu bar.
You can get help for either of the following:

¥ A specific application: From the application, just click Help. Then click in the
Search box and type a short phrase that sums up your query (such as startup
keys). You see a list of help topics on the menu. Just click a topic to display
more information.

¥ General topics: Click a Finder window, and then click Help on the menu bar.
Again, you see the Search box, and you can enter a word or phrase to find in
the Help system. To display the Help Center window, click the Help Center
item under the Search box.

The Apple web-based support center

Apple has online product support areas for every hardware and software product
it manufactures. Visit www.apple.com and click the Support link at the top of the
web page.

The Search box works just like the macOS Help system, but the knowledge base
that Apple provides online has a lot more answers.

Magazines

Many magazines and publications (both in print and online) offer tips and tricks
on using and maintaining macOS Mojave.

My personal online favorites are Macworld (www . macwor1d.com) and the Wiley For
Dummies website (www . dummies.com).

Local Mac user groups

I'd be remiss if I didn’t mention your local Mac user group. Often, a user group
maintains its own website and discussion forum. If you can wait until the next
meeting, you can even ask your question and receive a reply from a real live human
being. This is quite a thrill in today’s web-centric world!
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To locate a local user group using your Internet connection, launch Safari, click in
the Address box, and type

Mac User Group location
Instead of location, type the desired spot on the map, like
Mac User Group Columbia Missouri

Don’t forget to press Return!
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IN THIS PART ...

Learn more about the new features within macOS
Mojave.

Use System Preferences to fine-tune how Mojave
works.

Use Spotlight to search your entire system in seconds.

Keep track of practically everything using Reminders,
Maps, Notes, and Notifications.



IN THIS CHAPTER

» Changing the look of macOS with
Dark Mode

» Scrolling through content using
Gallery view

» Adding new iOS applications to
Mojave

» Using Quick Actions with one click

» Browsing the new App Store

Chapter4
What's New in Mojave?

ave you upgraded to Mojave from the previous version of macOS, High

Sierra? Or have you just bought a new iMac or iMac Pro with Mojave pre-

installed? Either way, you’ve opened the door to a number of new features,
and this chapter was written especially for you. (And if you’re not rubbing your
hands together with gleeful anticipation, you should be — I know I am.) Here,
you’ll find descriptions of my favorite new features that ship with the latest ver-
sion of macOS.

Note that a number of other new Mojave features appear elsewhere in the book —
for example, the discussion of the new website icons appears within the Safari
chapter. The new features you find here, however, are what I consider the real

standouts, so they’re showcased separately.

Let the fun begin!
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Come to the Dark Mode

©

REMEMBER

FIGURE 4-1:

Welcome to the
Dark side — ideal

76

when working
in a low-light
environment.

With the arrival of Mojave, you can cheerfully invite darkness to your desktop!
Notice I didn’t say “evil darkness” — in this case, Apple has simply introduced a
system-wide Dark Mode that affects just about all the macOS graphical elements
you see. Dark Mode will remind you of a photograph negative, changing the famil-
iar white background for windows and menus to a dark charcoal with white or
light-colored text and lines (as shown in Figure 4-1). You can easily switch
between the Light and Dark Modes from the General pane in System Preferences
(making your iMac yin or yang at will).

“So Mark,” you may ask, “why all the hubbub? Why is Dark Mode one of the key
new features of Mojave?” (Actually, dark desktops have been available in the
Linux world for many years, and have already appeared on iPhones and iPads
within applications like Maps. Some individual macOS applications - like Adobe
Acrobat DC - also offer dark schemes already.) The primary attraction is for those
using their iMacs in a low-light environment, where the traditional white back-
grounds on windows and menus resulted in eyestrain and glare. Dark Mode greatly
reduces the brightness of the iMac desktop without a significant loss of contrast.
As a secondary attraction . . . well, the Dark Mode just looks doggone cool!

At the time of this writing, only applications from Apple will use the Dark Mode —
for example, the System Preferences window will appear with a charcoal back-
ground, but your Microsoft Word window will still appear white. You can expect
many macOS software developers to add support for the Dark Mode in the future.

& [Finder’ File Edit view Go window Help
About Finder
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Empty Trash @ #E
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Showing Off Gallery View

I’ve always considered Quick Look to be one of the neatest features inside macOS:
select a file within a Finder window or your desktop and press the space bar, and
ZAP! You’re looking at the content of that file instantly, without the hassle or time
required to open it with the associated application. Well, dear reader, hold on to
your hat — Apple has taken that convenience to a whole new level in Mojave with
Gallery view. When you switch a Finder window to Gallery view (as I describe in
Chapter 3), the content of each file is displayed in a similar fashion, but within a
preview pane that fills most of the window. Figure 4-2 illustrates a Pages file dis-
played within Gallery view. You can move through the files in the current location
by pressing the left and right arrow keys, or you can click on the scrolling thumb-
nail strip below the preview pane.

Applications

Downloads
Movies

Colossus.

MNetwork

Tags

FIGURE 4-2: 5
Stroll through the :‘;’l":’ _ _
contents of an Blue . . . . ' . ﬂ
entire folder with o Xeow T ey =
Gallery view. o1 i
While you’re admiring your photos in Gallery view, don’t forget to check the
image metadata in the Preview pane on the right side of the window.
TIP
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Welcome New iOS Apps

One stellar observation I’ve made about our favorite computer manufacturer:
when Apple comes up with a good idea in the iOS world of iPhones and iPads, it
doesn’t take long before Apple carries that idea over to the macOS world. Previous
versions of macOS included features pulled directly from iOS — for example, Maps
and the Notification Center. Likewise, Mojave introduces a set of new crossover
applications to your iMac. The new arrivals include:

3 News. The News application displays the latest news (both text and video)
from an impressive list of sources.

¥ Stocks. Tracks daily, monthly, and yearly prices and news items on the stocks
you choose.

3 Voice Memos. This new application allows you to record your voice — perfect
for making quick audio memos and notes, recording meetings or creating
audio for use in GarageBand.

3 Home. Your iMac can now control HomeKit-compatible devices, including
lights, thermostats, and security hardware.

Quick Actions Are the Cat's Meow

78

Convenience is a big plus in my book, and Mojave’s new Quick Actions feature
makes it easy to handle common tasks on many types of documents and files with
just a single click. When you select one or more items in the Finder window, Quick
Actions appear on the Preview pane. (If you’re not displaying the Preview pane,
you can open it by choosing View > Show Preview from the Finder menu bar, or by
pressing Command+Shift+P.) Figure 4-3 illustrates the Quick Actions available for
a JPEG image at the lower-right corner of the Finder window — in this case,
Rotate Left, Markup, and More. Click the button to perform the action.

Note that the default Quick Actions that appear change depending on the file type
or folder you’ve selected. However, you can click the More button that appears at
the right and choose Customize to specify additional functions!
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FIGURE 4-3:
macOS Mojave
offers one-click

convenience with
Quick Actions.

& iCloud Drive

Applications

Downloads
Movies

Music

Strolling Through the Improved App Store

TIP

©

REMEMBER

If you’ve used macOS before, you’re familiar with the App Store — you can browse
software available for your iMac and download it directly, as well as update exist-
ing software you’ve already installed. With Mojave, however, the App Store has
come of age! The new Store offers better reviews, videos you can watch that sum-
marize features, and even biographical information on the developers that pro-
duce the applications (and the artists and professionals who use their products).
Plus, the new App Store “learns” what types of software interest you, and over
time highlights applications that might fit your needs.

I especially like the new “how-to” headings in the Create section, which offer a
quick rundown of the software available for accomplishing a specific task (as well

as helpful tips and tricks).

macOS system updates are no longer handled within the App Store. Instead, you
can use the Software Update pane in System Preferences to update Mojave.
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IN THIS CHAPTER

» Navigating System Preferences

» Locating specific controls

» Customizing Mojave from System
Preferences

Chapter 5

A Nerd’'s Guide to System
Preferences

emember the old TV series Voyage to the Bottom of the Sea? You always knew

you were on the bridge of the submarine Seaview because it had an entire

wall made up of randomly blinking lights, crewmen darting about with
clipboards, and all sorts of strange and exotic-looking controls on every available
surface. You could fix just about anything by looking into the camera with grim
determination and barking an order. After all, you were On the Bridge. That’s why
virtually all the dialog and action inside the sub took place on that one (expensive)
set: It was the nerve center of the ship, and a truly happenin’ place to be. Just like
the bridge of your favorite starship from an entire host of TV shows and movies.

In the same vein, I devote this chapter to the System Preferences window and the
most commonly used settings within it. After all, if you want to change how
Mojave works or customize the features in our favorite operating system, you
should head toward System Preferences. This one window is the nerve center of
macOS and a truly happenin’ place to be. Sorry, no built-in wall of randomly
blinking lights — but you do find exotic controls just about everywhere.
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An Explanation — without Jargon, No Less

The System Preferences window, shown in Figure 5-1, is a self-contained beast.
You can reach it in the following ways:

¥ Click the Apple menu and choose System Preferences.

¥ Click the Time and Date display in the menu bar, and then choose Open Date
and Time Preferences. In fact, you can also click most of the other menu
status icons — including Bluetooth and Wi-Fi — and then choose Open
Preferences.

¥ Right-click any uninhabited area of your Desktop and choose Change Desktop
Background.

¥ Last, but not least, click the Launchpad icon in the Dock, and then click the
System Preferences icon (it looks like a collection of gears).
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r— — 5 ®
" o m a o
General Desktop & Dock Mission Language Security Spotlight  Notifications
Screen Saver Control & Region & Privacy
- -
- o o= N &
Displays Energy Keyboard Mouse Trackpad Printers & Sound Startup
Saver Scanners Disk
iy s I 1
s @ ® @ 0 L =
iCloud Internet Software Netwark Blustooth  Extensions Sharing
Accounts Update
FIGURE 5-1:
The powerhouse n @ e ! @ @
of settings and a2 N fig
: . Users & Parental Siri Date & Time Time Accessibility
switches: SyStem Groups Controls Machine
Preferences.

When the System Preferences window is open, you can click any of the icons to
switch to that pane. The entire window morphs to display the settings for the
selected pane. For example, Figure 5-2 shows the Sound pane, which allows you
to set a system alert sound, configure your iMac’s built-in microphone, and
choose from several different output options.
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FIGURE 5-2:

The Sound pane,
proudly showing
off the Sound
Effects section.

TIP
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Many panes also include a number of tabbed buttons at the top — in this case,
Sound Effects, Output, and Input. You can click these tabs to switch to another
section in the same pane. Many panes in System Preferences have multiple sec-
tions. This design allows our friends at Apple to group a large number of related
settings in the same pane (without things getting too confusing).

To return to the top-level System Preferences pane from any other pane, just click
the Show All button (located in the upper-left corner of the pane) or press 38+L.
You can also click the familiar Previous and Next buttons to move backward
through the panes you’ve already visited and then forward again, in sequence.
(Yep, these buttons work just like the browser controls in Safari. Sometimes life is
funny that way.)

Although the System Preferences panes are arranged by category when you first
install Mojave, you can also display the panes in alphabetical order. To arrange the
panes in this way, choose View> Organize Alphabetically. Note that you can also
select any pane directly from the View menu. Choose View= Customize, and you
can hide specific icons from the System Preferences window. Just deselect the
check box next to each icon you want hidden, and then click Done. You can still
reach hidden icons from the System Preferences View menu, so they’re not ban-
ished forever.

You can right-click the System Preferences icon in the Dock to jump to any pane
from the shortcut menu. Wowzers!

CHAPTER 5 A Nerd’s Guide to System Preferences 83



©

REMEMBER

HEY, | HAVE BONUS ICONS
IN MY WINDOW!

Some third-party applications and media plug-ins can actually install their own panes in
your once-pristine System Preferences window. You see them arranged at the bottom of
the window. Naturally, | can't document these invited guests in this chapter, but they work
the same way as any other pane in System Preferences. Click the icon, adjust any settings
as necessary, and then close the System Preferences window to save your changes.

You won’t find an OK button that you have to click to apply any System Prefer-
ences changes. Apple’s developers do things the right way. Your changes to the
settings in a pane are automatically saved when you click Show All or when you
click the Close button in the System Preferences window. You can also press $8+Q_
to exit the window and save all your changes automatically. This is one of my
favorite shortcuts.

If you see an Apply button in a pane, you can click it to immediately apply any
changes you made, without exiting the pane. This is perfect for settings you might
want to try before you accept them, like many of the controls in the Network pane.
However, if you’re sure about what you changed and how those changes will affect
your system, you don’t have to click Apply. Just exit the System Preferences
window or click Show All as you normally would.

Locating That Certain Special Setting
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Wouldn't it be great if you could search through all the different panes in System

Preferences — with those countless radio buttons, check boxes, and slider
controls — from one place, even when you’re not quite sure what you’re
looking for?

Figure 5-3 shows exactly that kind of activity taking place. Just click in the System
Preferences Spotlight Search box (located in the upper-right corner of the pane,
with the magnifying glass icon), and type just about anything. For example, if you
know part of the name of a particular setting you need to change, type that. Mojave
highlights the System Preferences panes that might contain matching settings.
And if you’re a switcher from the Windows world, you can even type what you
might have called the same setting in Windows.

The System Preferences window dims, and the icons that might contain what
you’re looking for stay highlighted. Slick.
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FIGURE 5-3:
Searching for
specific settings
is a breeze with
the Spotlight
Search box.
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You can also search for System Preferences controls by using the Spotlight Search
box from the Finder menu. Find more on this cool feature in Chapter 6.

If you need to reset the Spotlight Search box to try again, click the X icon that
appears at the right side of the box to clear it.

Popular Preferences Panes Explained

It’s time to get down to brass tacks: Let’s open the most often-used panes in Sys-
tem Preferences to see what magic you can perform. I won’t discuss every pane,
because I cover many of them in other chapters. In fact, you might never need to
open some System Preferences panes, such as the Language & Region pane. This
chapter covers just about all the settings you’re likely to use on a regular basis.

The Displays pane

If you’re a heavy-duty gamer, or you work with applications such as Keynote or
Photoshop, you probably switch your monitor’s characteristics regularly. To switch
easily, visit the Displays pane, shown in Figure 5-4. It includes three sections:

3 Display: To allow Mojave to choose the best resolution for your display, select the
Default for Display radio button. To manually select a resolution, select the Scaled
radio button, and then click the resolution you want to use from the Resolutions
list that appears. In most cases, you want to use the highest resolution.
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FIGURE 5-4:

The Display pane
makes it easy to

change your

screen resolution.
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TIP
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1024 x 640
Brightness:

|4 Automatically adjust brightness

»

»

Move the Brightness slider to adjust the brightness level of your iMac's
display. If you like, you can enable the Automatically Adjust Brightness check
box to allow your iMac to select a brightness level.

Ready to stream content to your TV directly from your iMac — without cables?
You can use Mojave's wireless AirPlay feature to send the display from your
desktop to your HD-TV. AirPlay requires an Apple TV unit that supports this
feature. You can also send the audio from your iMac directly to an AirPlay-
enabled receiver or speaker system. To make it easier to control AirPlay, select
the Show Mirroring Options in the Menu Bar When Available check box. (Note
that the icon will only appear in your menu bar when you have an Apple TV
unit within range.)

Color: Click a display ColorSync profile to control the colors on your screen. To
load a ColorSync profile, click the Open Profile button. To create a custom
ColorSync profile and calibrate the colors that you see, click the Calibrate
button to launch the Display Calibrator. This easy-to-use assistant walks you
step by step through creating a ColorSync profile matched to your iMac's
gamma and white-point values.

Night Shift: The Night Shift feature allows Mojave to automatically adjust
your display to provide warmer colors during nighttime operation. Click
Schedule to choose either Sunset to Sunrise operation or create your own
custom schedule. You can also turn on Night Shift manually using the Turn On
Until Tomorrow check box. Finally, adjust the Color Temperature slider to
increase or decrease the warmth of colors on your display.
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If you connect your iMac or iMac Pro to an external monitor, don't be surprised

@ to see the Arrangement section appear as well. You can drag the output to a
different monitor, or drag the menu bar to another screen, or you can choose
TIP to mirror the same output to all displays connected to your computer.

The Desktop & Screen Saver pane

No offense to the awesome Mojave “desert dunes” background, but who doesn’t
want to choose his or her own background? And what about that nifty screen saver
you just downloaded from the Apple website? You can change both the background
and screen saver by using these options in the Desktop & Screen Saver pane.

The settings on the Desktop section, shown in Figure 5-5, are:

3 Current Desktop picture: You can click a picture in the thumbnail list at the
right half of the screen to use it as your Desktop background. The Desktop is
immediately updated, and the thumbnail appears in the well (the upper-left
box in Figure 5-5). To display a different image collection or open a folder of
your own images, click the Add Folder button at the lower-left corner of the
window (a plus sign) and browse for your heart's desire; then click Choose to
select a folder and display the images it contains.

o0 < i Desktop & Screen Saver Q
Screen Saver
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Dynamic | < |
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Layout: You can tile your background image, center it, fill the screen with it
(cropping the edges if necessary), and stretch it to fill the screen (without
cropping). Note that filling the screen in either case may distort the image. The
layout pop-up menu appears only when you're using your own pictures, so
you don't see it if you're using a Desktop image supplied by Apple.

Change Picture: Change the Desktop background automatically after the
delay period that you set, including each time you log in and each time your
Mac wakes up from sleep mode.

Random Order: To display screens randomly, enable the Random Order
check box. Otherwise, the backgrounds are displayed in the sequence in
which they appear in the thumbnail list.

The new Dynamic Desktop selection automatically changes your desktop image
based on the time of day, offering you a subtle change in mood, as well!

The settings on the Screen Saver section are:

Screen Saver: In the Screen Saver list at the left, click any screen saver to
preview (on the right). To try out the screen saver in full-screen mode, hover
your pointer over the display on the right and click the Preview button that
appears. (You can end the test by moving the cursor.) If the screen saver
module you select has any configurable settings, click the Screen Saver
Options button to display them. (A screen saver is not configurable if the
Screen Saver Options button doesn't appear.) Enable the Use Random Screen
Saver check box to display a different screen saver module each time the
screen saver is activated.

Start After: Specify the period of inactivity that triggers the screen saver. To
disable the screen saver, choose the Never setting at the top of the list. (Your
Start After delay should be a shorter time than the Display Sleep delay you set
in the System Preferences Energy Saver pane. Otherwise, you won't see the
great screen saver at all. | describe the Energy Saver pane later in this chapter.)

Show with Clock: If you want your selected screen saver to display the time
as well, select this check box.

Hot Corners: Click the Hot Corners button, and then click any of the four
pop-up menus at the four corners of the screen. Doing so designates that
corner as an activation hot corner (immediately activates the screen saver) or
as a disabling hot corner (prevents the screen saver from activating). As long as
the cursor stays in the disabling hot corner, the screen saver doesn't kick in,
no matter how long a period of inactivity passes. Note that you can also set
the Sleep, Mission Control, Launchpad, Notification Center, and Dashboard
activation hot corners from here. For the scoop on these features, see the
next section.
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For additional security, check out the Security & Privacy pane in System

@ Preferences, where you find the Require Password After Sleep or Screen Saver
Begins check box. When you select this check box, Mojave requires your user
TIP account password before allowing anyone to turn off the screen saver (a great

idea in an office environment, as you can imagine).

Mission Control preferences

Figure 5-6 shows the Mission Control, Spaces, and Dashboard settings you can
configure in this group. You can use Mission Control to view all the application
windows you’re using at one time so that you can select a new active window. Or
you can move all windows aside so that you can see the Desktop. Dashboard pres-
ents a number of mini-applications (or widgets), which you can summon and hide
by pressing a single key.

[ N} < 22 Mission Control Q,

Mission Control gives you an overview of all your open windows, thumbnails of your full-
screen applications, and Dashboard, all arranged in a unified view.

7 Automatically rearrange Spaces based on most recent use

74 When switching to an application, switch to a Space with open windows for the application
Group windows by application

24 Displays have separate Spaces

Dashboard: | As Overlay |~

Keyboard and Mouse Shortcuts

‘With a single keystroke, view all open windows, windows of the current application, or hide windows to locate an
item on the desktop that might be covered up.

Mission Control: = ~4 | < |
Application windows: | 4 |~ ]
Show Desktop: | F11 |~ ]
Show Dashboard: = F12 | <]
FIGURE 5-6:
Set yOUr (for additional choices press Shift, Control, Option, or Command)
Mission Control Hot Corners... ?

preferences here.

The settings are:
3 Automatically Rearrange Spaces Based on Most Recent Use: If this check

box is selected, Mission Control presents your most recently used Spaces first
in the thumbnails at the top of the screen.
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3 When Switching to an Application: When selected, this check box allows
you to switch applications between Spaces desktops by using the §8+Tab
shortcut. Yosemite jumps to the Desktop that has an open window for the
application you choose, even if that Desktop is not currently active.

3 Group Windows by Application: When selected, this check box automatically
arranges windows in the Mission Control screen by the application that
created them.

¥ Displays Have Separate Spaces: If you have multiple monitors connected to
your Mac, you can select this check box to create a separate Spaces display for
each monitor.

To display your Dashboard as a Space (a virtual desktop) in the Mission
Control screen, click the Dashboard pop-up menu and choose the As Space
option. If you prefer your Dashboard widgets to appear as an overlay over
TIP your Desktop, select the As Overlay option from the pop-up menu.

3 Keyboard Shortcuts: From each pop-up menu, set the key sequences for
Mission Control, Application Windows, Show Desktop, and Show Dashboard.

You're not limited to keyboard and mouse shortcuts in the pop-up menus.
@ Press the Shift, Control, Option, and 38 keys while a pop-up menu is open, and

you see these modifiers appear as menu choices! (Heck, you can even
REMEMBER combine modifiers, such as $8+Shift+F9 instead of just F9.)

3 Hot Corners: Click the button at the lower-left corner of the pane to specify
your hot corner settings. These four pop-up menus operate just like hot
corners and active screen corners in the Desktop & Screen Savers pane,
allowing you to control the operation of the screen management features
within Mojave. Click one to designate that corner as one of the following:

A Mission Control corner displays the Mission Control screen.

An Application Windows corner displays only the windows from the active
application.

A Desktop corner moves all windows to the outside of the screen to uncover
your Desktop.

A Dashboard corner displays your Dashboard widgets.
A Launchpad corner activates the Launchpad screen.

A Notification Center corner displays the Notification Center strip at the right
side of your Desktop.

Note that you can also set the Screen Saver Start and Disable corners from
here, as well as put your display to sleep.
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The General pane

The talented General pane, shown in Figure 5-7, determines the look and opera-
tion of the controls that appear in application windows and Finder windows. It
looks complex, but I cover each option here.

[ N ] < R General Q

—==
ses
Appearance:

Light Dark
Accentcolor: B @ ® @ © @
Highlight color: Green |~ ]

Sidebar icon size: = Medium | < |

Automatically hide and show the menu bar

Show scroll bars: Automatically based on mouse or trackpad
When scrolling
o) Always
Click in the scroll bar to: (£ Jump to the next page

Jump to the spot that's clicked

Default web browser: | @ Safari | <]

Ask to keep changes when closing documents
"/ Close windows when quitting an app

When selected, open documents and windows will not be restored

FIGURE 5-7: ‘when you re-open an app.
Appearances Recent items: = 60 2| Documents, Apps, and Servers
mlght_ not be 7 Allow Handoff between this Mac and your iCloud devices
everything, but
they’re easy to 4 Use LCD font smoothing when available ?
find here.

The settings are:

3 Appearance: Click the Light or Dark option to switch between Light or Dark
mode for your Finder menu bar, window buttons and window background,
and your Dock. You can also choose to hide the Finder menu bar — to display
it while hidden, move your pointer to the top of the screen.

9 Accent Color: Click on an Accent color to use for buttons and menus.

3 Highlight Color: Choose a color to highlight selected text in fields and pop-up
menus.

¥ Sidebar Icon Size: Select the size of the icons in the Finder window Sidebar.
It's the strip to the left of the Finder window that displays your devices and
favorite locations on your system. If you have a large number of hard drives,
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or if you've added several folders to the Sidebar, reducing the size of the icons
allows you to display more of them without scrolling.

3 Show Scroll Bars: Specify when Mojave should display scroll bars in a
window. By default, they're placed automatically when necessary, but you can
choose to display scroll bars always or only when you're actually scrolling
through a document.

¥ Click in the Scroll Bar To: By default, macOS jumps to the next or previous
page when you click in an empty portion of the scroll bar. Select the Jump to
the Spot That's Clicked radio button to scroll the document to the approxi-
mate position in relation to where you click.

3 Default Web Browser: Click this pop-up menu to specify which application
Mojave should use to display web pages. By default, macOS uses the Safari
web browser.

3 Ask to Keep Changes When Closing Documents: If you select this check
box, Mojave prompts you for confirmation if you attempt to close a document
with unsaved changes. If the check box is deselected, Mojave allows the
unsaved document to be closed without saving a new version.

¥ Close Windows When Quitting an App: If this check box is deselected, the
macOS Resume feature automatically saves the state of an application when
you quit. When you relaunch the application again, Mojave restores all
application windows and opens the documents you were working on when
you quit. In effect, you can continue using the application just as if you had
never quit. If you select the check box, Mojave does not restore your work,
and you have to reload your document.

¥ Recent Items: The default number of recent applications, documents, and
servers (available from the Recent Items item in the Apple menu) is 10. To change
the default, open the pop-up menus here and choose up to 50. (I like 20 or 30.)

3 Allow Handoff Between this Mac and Your iCloud Devices: If this check box
appears within the General pane, you can enable it to turn on Handoff function-
ality within Mojave. (I discuss Handoff within the confines of Chapter 9.)

3 Use LCD Font Smoothing When Available: By default, this check box is
enabled, making the text on your iMac’s display appear more like the printed
page. You can turn off this feature to speed up text display slightly.

The Energy Saver pane

I’m an environmentalist — it’s surprising how many techno types are colored
green — so the controls on this pane are pretty doggone important. When you use
them correctly, you not only conserve power but also invoke the Power of Mojave
to automatically start up and shut down your iMac whenever you like!
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FIGURE 5-8:
Reduce your
iMac's power
consumption

from the Energy

Saver pane.

TIP

Move the Computer Sleep slider, shown in Figure 5-8, to specify when Mojave
should switch to sleep mode. The Never setting disables sleep mode. To choose a
separate delay period for blanking your screen, drag the Display Sleep slider to the
desired period. You can also power down the drive to conserve energy and prevent
wear and tear (an especially good feature for magnetic hard drives).

[eRe] < i Energy Saver Q

Computer sleep:

1min 15 min 1hr 3hrs Never

Display sleep:

1min 15 min 1hr 3hrs Never

Put hard disks to sleep when possible
Wake for network access

Start up automatically after a power failure

Restore Defaults

Schedule...

If you want to start up or shut down your iMac at a scheduled time, click the
Schedule button. Select the desired schedules (the Start Up or Wake check box and
the Shut Down/Sleep check box) to enable them. Then click the up and down
arrows next to the time display to set the trigger time. Click OK to return to the
Energy Saver pane.

The Dock pane

I’ll come clean: I think the Dock is the best thing since sliced bread. (I wonder
what people referred to before sliced bread was invented?) You can use the set-
tings shown in Figure 5-9 to configure the Dock’s behavior until it fits your per-
sonality like a glove:

¥ Size: Pretty self-explanatory. Just drag the slider to change the Dock’s scale.

¥ Magnification: When you select this check box, each icon in the Dock swells
like a puffer fish when you move the cursor over it. (The Magnification slider
determines just how much it magnifies.) | really like this feature because |
resize my Dock smaller, and | have a large number of Dock icons.

3 Position on Screen: Select a radio button here to position the Dock on the
left, bottom, or right edge of the Desktop.
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FIGURE 5-9:
Customize
your Dock with
these controls.

Prefer tabs when opening documents: | In Full Screen Only [

< 22 Dock Q

Size:
small Large

¥ Magnification:
Min M;’]Jﬂ

Position on screen: .
Left Bottom Right

Minimize windows using: | Genie effect |7

24 Double-click a window's title bar to | minimize |73
Minimize windows into application icon

4 Animate opening applications

4 Automatically hide and show the Dock

4 Show indicators for open applications
Show recent applications in Dock ?

C

<

<

»

»

»

»

»

»

Minimize Windows Using: Mojave includes two cool animations that you can
choose from when shrinking a window to the Dock (and expanding it back to
the Desktop). Click the Minimize Windows Using pop-up menu to specify the
genie-in-a-bottle effect or the scale-up-or-down-incrementally effect.

Prefer Tabs when Opening Documents: This setting allows you to specify
when your applications should open documents in a new tab display or within
a new document window. You can choose to use tabs always, only when using
full-screen mode, or only when you actually create a new tab in the applica-
tion itself. (Note that if an application doesn’t support tab display, new
documents will open in a window.)

Double-Click a Window's Title Bar to Minimize/Zoom: Select this check box
to minimize or zoom a Finder or application window by simply double-clicking
the window's title bar.

Minimize Windows into Application Icon: If this check box is not enabled,
minimized application windows appear as thumbnail icons on the Dock.

To minimize application windows into the application icon on the Dock —
which can save space on your Dock — select this check box. (To restore a
window that's been minimized into the application icon, right-click the icon
on the Dock and choose Restore from the menu that appears.)

Animate Opening Applications: Active souls who like animation probably
get a kick out of the bouncing application icons in the Dock, which indicate
that you've launched an application and that it's loading. If you find this
effervescence overly buoyant or distracting, deselect this check box.

Automatically Hide and Show the Dock: Select this check box, and the Dock
disappears until you need it. (Depending on the size of your Dock, the Desktop
real estate you gain can be significant.) To display a hidden Dock, move the
cursor over the corresponding edge of the Desktop.

94  PART 2 Shaking Hands with macOS



FIGURE 5-10:
Use controls
on the Sharing
pane to share
your toys.

3 Show Indicators for Open Applications: macOS indicates which applications
are running in the Dock with a small gray dot in front of the icon. To disable
these indicators, deselect this check box.

3 Show Recent Applications in Dock: Enable this check box to park the icons
for the three applications you used last at the right side of the Dock (a real
boon for those of us who use the same group of applications often). macOS
automatically updates the three icons as you use your iMac.

The Sharing pane

So you’re in a neighborly mood, and you want to share your toys with others on
your local wired or wireless network. Perhaps you’d like to start your own website
or protect yourself from the Bad Guys on the Internet. All these fun diversions are
available from the Sharing pane in System Preferences, as shown in Figure 5-10.

[ N ] < e Sharing Q

Computer Name: SilverGhost

Computers on your local network can access your computer at:

SilverGhost.local Edit...

@ File Sharing: On

On  Service

Screen Sharing Other users can access shared folders on this computer, and administrators
- all volumes, at smb://192.168.0.107
File Sharing
) Printer Sharing Options...
Remate Login
N Shared Folders: Users:
Remote Management -
Remote Apple Events |1 Johnny Ex...ublic Folder ]_ Johnny Example Read & Write
Internet Sharing [# Mark Cha...ublic Folder ;Etaﬁ Read Only
veryone ad Onl
Blustooth Sharing v Read Only
Content Caching
+|— +

Click the Edit button to change the default network name assigned to your iMac
during the installation process. Your current network name is listed in the Com-
puter Name text field.

Each entry in the services list controls a specific type of sharing, including DVD

and CD Sharing (if you have an optical drive, which I don’t, so this option is not
shown in the figure), Screen Sharing, File Sharing (with other Macs and PCs
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running Windows), Printer Sharing, Remote Login, Remote Management (using
Apple Remote Desktop), Remote Apple Events, Internet Sharing, Bluetooth Shar-
ing and Content Caching (which stores updates and other content for later instal-
lation). To turn on any of these services, select the On check box for that service.
To turn off a service, click the corresponding On check box to deselect it.

From a security standpoint, I highly recommend that you enable only the services
you actually use. Each service you enable automatically opens your Mojave fire-
wall for that service. Here’s a Mark’s Maxim to remember:

Poking too many holes in your firewall is not A Good Thing.™

MARK'S When you click one of the services in the list, the right side of the Sharing pane
changes to display the settings you can specify for that particular service.

The Time Machine pane

iMac owners are thrilled with the Time Machine automatic backup feature that’s
built in to Mojave. It’s saved all my stuff numerous times. You can easily configure
how Time Machine handles your backups from this pane, as shown in Figure 5-11.
Chapter 21 covers how to use Time Machine. Of course, you need an external drive
(or an AirPort Time Capsule wireless backup device) for the best backup security.
Note that Time Machine doesn’t work with a CD or DVD rewriteable drive; you
must use a USB or Thunderbolt external hard drive.

[ X ] < i Time Machine Q

T Time Machine Backups
O 387 GB of 500 GB available
Oldest backup: February 25, 2018
Latest backup: February 25, 2018
Select Disk... Next backup: When disk is connected
Time Machine
) Back Up Automatically
Time Machine keeps:

« Local snapshots as space permits

« Hourly backups for the past 24 hours

« Daily backups for the past month

« Weekly backups for all previous months

FIGURE 5-11:

Put Time Machine
to work, and your
datais always 7/ Show Time Machine in menu bar Options... ?
backed up.

The oldest backups are deleted when your disk becomes full.
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To enable Time Machine, click the Back Up Automatically check box to enable it,
and then select a disk to hold your Time Machine backup data on the sheet that
appears. (You can also switch backup disks at any time by clicking the Select Disk
button.) Click Use Disk to confirm your choice — if you have an external Time
Capsule wireless unit, click Set Up instead and follow the on-screen steps.

Your external backup drive should be at least twice the capacity of your internal
drive, thus ensuring that your backup files have the elbow room they need.

By default, Time Machine backs up all the drives on your system; however, you
may not need to back up some folders on your iMac. To save time and backup drive
space, Time Machine allows you to exclude specific folders from the backup pro-
cess. Click Options, and then click the Add button (with the plus sign) to select the
drives or folders you want to exclude. They appear in the Exclude These Items
From Backups list.

To remove an exclusion, select it in the list and click the Delete button (with the
minus sign). Note that the Estimated Size of Full Backup figure increases, and
Time Machine adds the item you deleted from the list to the next backup.

If you enable the Show Time Machine in Menu Bar check box, you can elect to back
up your Mac immediately by clicking the Time Machine icon in the Finder menu
bar and then choosing Back Up Now.

By default, Mojave warns you when deleting older backup files, but you can turn
this off from the Options sheet as well.

Would you like your data to be safe in case of fire or stolen hardware? You can
always create copies of your most important files and documents in your iCloud
Drive, or copy them to a USB flash drive and store it in another location!

iCloud preferences

From the Mojave System Preferences iCloud pane, shown in Figure 5-12, you can
specify which types of data are automatically pushed to your iMac Pro and iOS
devices. If you haven’t created an iCloud account yet — or if you signed out of an
existing account earlier — System Preferences prompts you to enter your Apple ID
and password. Click Sign In to display the contents of the iCloud pane.

Mojave allows you to set up Family Sharing, where up to six accounts can share
photos, iTunes media and apps, and a common calendar — group members can
even display the current location of other members who are carrying MacBooks or
i0S devices! Click the Set Up Family button, and then click Continue to launch the
Family Sharing setup assistant.
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4 ‘. iCloud Drive Options...
&5 Photos Options...
U + Q.‘ Mail
Mark Chambers
5 ‘ Contacts
Account Details
2 1471 Calendars
Set Up Family
s u Reminders
FIGURE 5-12:
~ @ Safari
Control and
configure your @ | | Notes
iCloud activity iCloud 4.39 GB of 5 GB used
with these Sign Out [ N Manage...
settings.

The check boxes for each category are:

¥ iCloud Drive: Enable and disable iCloud Drive access system-wide, or click the
Options button to set access for specific applications.

3 Photos: Push the latest photos and video clips you've added in Photos to
other devices, and update your Photos library with photos and video clips
pushed from your iOS devices.

¥ Mail: Synchronize your Mail account settings between devices.

3 Contacts: Push your Contact cards between devices.

3 Calendars: Push your calendar events to and from your iOS devices.
3 Reminders: Synchronize the reminders you've set between devices.
¥ Safari: Synchronize your Safari bookmarks.

3 Notes: Synchronize your Notes between devices.

¥ Siri: Synchronize your Siri configuration.

¥ Keychain: Share passwords for applications and websites between your
devices.

3 Find My Mac: If your iMac is stolen, you can locate it from a web browser or
your iOS device. You can also choose to remotely lock your computer — or
even wipe your iMac’s internal drive completely to prevent someone from
stealing your data.
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FIGURE 5-13:
Each application
that uses
notifications can
be individually
configured.

Wiping your iMac remotely is a drastic step that will prevent you from locating it
in the future.

3 News:Synchronize groups and favorites in News with your other Macs and
iOS devices.

¥ Stocks: Synchronize your favorite stocks and settings between devices.

3 Home: Synchronize your Home accessory operating schedules and settings
with other Macs and iOS devices.

To display the storage currently being used by your mail, backups, documents,
and application data, click the Manage button at the lower-right corner of the
pane. Apple provides each iCloud account 5GB of space for free, but you can also
elect to buy additional storage from this sheet.

Notifications preferences

The Notifications group is shown in Figure 5-13. Each application that can display
notifications appears in the list at the left of the pane.

[ X ] < i Notifications Q

Notification Center shows your alerts in the upper-right of your screen, without interrupting what you're
doing. Show and hide Notification Center by clicking its icon in the menu bar.

Da Not Disturb Turn on Do Not Disturb in
Notification Center

Books “ -

U Badges, Sounds, Banners Banners and alerts will be hidden and
! ! notification sounds will be silenced.

Calendar
; 1 Badges, Sounds, Alerts Turn on Do Not Disturb:
@ Dropbox From: 10:00 PM 2 to:  7:00 AM 2

Badges, Sounds, Alerts [l When the display is sleeping

FaceTime — S ;

\ |24 When mirroring to TVs and projectors

L" Badges, Sounds, Banners z 9 prol

Games When Do Not Disturb is turned on:
‘ Badges, Sounds, Banners Allow calls from everyone

Home Allow repeated calls

Badges, Sounds, Banners ‘When enabled, a second call from the same person within
iTunes three minutes will not be silenced.

/  Badges, Scunds, Banners

A O D

Mail

\
Radnoes. Sounds. Bannars

Notification Center sort order: Recents | < | ?
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Click the Do Not Disturb entry in the list at the left to set Do Not Disturb mode,
where Notification banners, alerts, and sounds are disabled. You can specify a
time period, turn on Do Not Disturb when your iMac is in sleep mode, or turn on
Do Not Disturb when you’re mirroring (or sending) the video from your iMac to a
TV or projector. You can also optionally allow FaceTime calls from anyone while
Do Not Disturb is active or just from those you’ve marked as Favorites in
FaceTime. If you select Allow Repeated Calls, a FaceTime caller can call a second
time within three minutes without being disabled.

Click an application in the list at the left to configure its notifications. Different
applications display different options in the settings pane, but the settings can
include the following:

¥ Alert Style: These three buttons specify which type of alert should appear
under the Notification Center icon in the menu bar. You do not need to
display the Notification Center to see alerts, which appear on your Desktop.
Choose None to disable alerts for this application. Choose Banners to display
alert messages that automatically disappear after a delay. Choose Alerts to
display alert messages that remain onscreen until you click the confirmation
button in the Alert dialog.

3 Show Notifications on Lock Screen: If it appears, you can select this check
box to allow notifications even if your iMac is displaying the Lock screen.

3 Show Notification Preview: If enabled, notifications for this application will
include a preview of the content. You can also specify whether the preview will
appear while your iMac display is locked.

3 Show in Notification Center: To display notification messages from this
application in the Notification Center, select this check box.

3 Badge App Icon: This check box toggles on and off the display of this
application’s icon in alert boxes and in the Notification Center. It also activates
the numeric display of pending items on the icon itself (for example, unread
mail and messages).

3 Play Sound for Notifications: To play a sound when alerts appear, enable
this check box.

You can change the order that notifications are sorted in the Notification Center
using the Notification Sort Order drop-down list box at the bottom of the pane.
The default sort is by the most recent, but you can choose Recents by App to sort
recent notifications grouped by applications. For the ultimate in custom notifica-
tions, choose Manually by App from the drop-down list box and drag the applica-
tions in the list at the left to your desired order.
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IN THIS CHAPTER

» Mastering basic Spotlight searching
skills

» Selecting text and keywords for best
results

» Displaying results in the Finder
search window

» Customizing Spotlight within System
Preferences

Chapter 6

Searching Amidst
iMac Chaos

hat would you say if I told you that you could search your entire system

for all the data connected with a person — and in only the short time it

takes to type that person’s name? And I’'m not just talking about files
and folders that might include that person’s name. I mean every email message
and every Calendar event that references that person — and even that person’s
Contacts card to boot. Heck, how about if that search could dig up every occur-
rence of the person’s name inside your PDF documents? What if it could even
search folders shared on other Macs across your network?

You’d probably say, “That makes for good future tech. I’ll bet I can do that in five
or ten years. It’ll take Apple at least that long to do it — and just in time for me to
buy a new iMac! (Harrumph.)”

Don’t be so hasty. You can do all this right now. (In fact, this functionality has
been part of macOS for a number of years.) The technology is the macOS feature
named Spotlight, built into Mojave. In this chapter, I show you how to use it like a
fearsome iMac power guru. I also show you how to take advantage of Internet
search widgets you can display within the Dashboard. (From what I hear, there’s
good stuff on the Internet, too.)
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Doing a Basic Search

FIGURE 6-1:

Lots of power
purrs behind this
single Spotlight

102

Search box.

TIP

Figure 6-1 shows the Spotlight Search box, which is always available from the
Finder menu bar. Click the magnifying glass icon once (or press §§+spacebar), and
the Spotlight Search box appears on your Desktop, front and center.

@ Finder File Edit View Go Window Help FOL O % 5un11:38 PM Mark Chambers QG i=

To run a search, simply begin typing. (The words you type that you want to match
are called keywords.) Matching items appear as soon as you type, and the search
results are continually refined while you type the rest of your search keywords.
You don’t need to press Return to begin the search.

After a second or two, the Spotlight Search box expands to display the results of
your search, and the list is updated automatically in real time while you continue
to type. The most-relevant items are grouped into categories — such as Messages,
Websites, Definitions, Documents, Folders, Images, PDFs, and Contacts — right
in the Spotlight Search box. Spotlight Search takes a guess at the item that’s most
likely the match you’re looking for (based on your Search Results list in System
Preferences, which I cover later in the chapter) and presents it first. To open the
top item like a true Mojave power user, just press Return. (My brothers and sisters,
it just doesn’t get any easier than that.)

Although one or two keywords are typically enough to do the job, you can also type
phrases, such as emails from Mark Chambers or songs with sunshine in the title.
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TIP

Single-click any item in the list, and shazam! — Spotlight uses the Quick Look
technology built in to Mojave to display the contents (such as a thumbnail image
of a document or an album cover) or information on the item! For example, if the
item is an iTunes playlist, you see the song list in the results pane on the right,
and you can click one of the songs to open iTunes and play it. If the item is a Mail
message, click it once in the list to view the contents of the message — without
leaving the Spotlight Search box.

When you click an item in the list, Spotlight indicates which application will be
used to open the item by displaying the icon for that application in the upper-
right corner of the Spotlight box. For example, you’ll see the iTunes icon for a
song and the Safari icon for a website.

Literally, any text string is acceptable as a Spotlight Search. However, here’s a
short list of the common search criteria I use every day:

> Names and addresses: Because Spotlight has access to the Contacts
application in Mojave, you can immediately display contact information using
any portion of a name or an address.

¥ Email message text: Need to open a specific email message, but you'd rather
not launch Mail and spend time digging through the message list? Enter the
person’s email address or any text string contained in the message you're
looking for.

¥ File and folder names: A simple item name is the classic search favorite.
Spotlight searches your entire system for that one file or folder in the blink
of an eye.

3 Events and Reminder items: Yep, Spotlight gives you access to your
Calendar events and those all-important Reminders you've created.

¥ Specific songs and playlists: Itching to hear “Rock Me Amadeus” by Falco?
With the power of Spotlight and your iTunes library, you can satisfy your
musical needs in seconds!

3 System Preferences: Now things start to get really interesting! Try typing the
word desktop in the Spotlight field. At least one of the results in the list will be
a System Preference pane! That's right: Every setting in System Preferences is
referenced in Spotlight. (For example, the Desktop background setting resides
on the Desktop & Screen Saver pane in System Preferences.)

3 Weather, stocks, and sports scores: Put Spotlight to work, and you can get
instant displays of current weather and forecasts (type weather followed by
a town name), stock figures (type the desired stock abbreviation), and even
sports scores (type your favorite team name).
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3 Web pages: Whoa. Stand back, Google. You can use Spotlight to search the
web — and, if necessary, the web pages you've recently displayed in Safari!
However, it's important to note that Spotlight can't search data stored online,
like the files you may have saved on a “cloud-based” backup site. Spotlight can
only search the text on the web pages themselves.

¥ Metadata: This category is pretty broad, but it fits. If you're not familiar with
the term metadoata, think of the information stored by your digital camera
each time you take a photo — exposure setting, time and date, and even
the location where the photo was taken, which are also transferred to iPhoto
when you import. Here's another example: | like to locate Word documents
on my system using the same metadata that's stored in the file, such as the
contents of the Comments field in a Word document. Other supported
applications include Adobe Photoshop images, Microsoft Excel spreadsheets,
Keynote presentations, iTunes media, and other third-party applications that
offer a Spotlight plug-in. Metadata is also prominently displayed when you're
viewing images and PDF files in Gallery view, providing you with a wealth of
convenient details.

To reset the Spotlight Search and try another text string, press 38+A to select the
entire contents and then press Delete.

After you find the item you’re looking for in the list at the bottom of the Spotlight
Search box, you can double-click the entry in the list to do any of these things:

¥ Launch it (if the item is an application).

¥ Open it in System Preferences (if it's a setting or description on a System
Preferences pane).

¥ Open it within the associated application (if the item is a document, website,
or data item).

¥ Display itin a Finder window (if the item is a folder).

Here’s another favorite time-saver: You can display all the files of a particular
type on your system by using the file type as the keyword. For example, to provide
a list of all images on your system, just use images as your keyword. The same

TIP goes for movies and audio, too.

= When you give Siri a command or ask Siri a question, macOS uses Spotlight’s
\ search features “behind the scenes” to locate everything from applications and

Tecunicar  documents to contacts and music tracks.
STUFF
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How Cool Is That? Discovering
What Spotlight Can Do

Don’t get fooled into simply using Spotlight as another file-'n’-folder-name
search tool. Sure, it can do that, but Spotlight can also search inside PDFs, Pages
and Word documents, and HTML files, finding matching text that doesn’t appear
in the name of the file! To wit: A search for Mojave on my system pulls up all sorts
of items, not only files with Mojave in their names, but also files with the text
Mojave within the documents themselves:

3 Apple Store SF.ppt is a PowerPoint presentation with several slides contain-
ing the text Mojave.

3 new ch03.doc is a Microsoft Word file chapter of this book that mentions
Mojave in several spots.

3 Conference Call with Colleen is a Calendar event pointing to a conference
call with my project editor about upcoming Mojave book projects.

Not one of these three examples has the words Mojave occurring anywhere in the
title or filename, yet Spotlight found them because they all contain the text Mojave
therein. That, dear reader, is the true power of Spotlight, and it can literally guar-
antee you that you’ll never lose another piece of information in the hundreds of
thousands of files and folders on your iMac’s drive.

Heck, suppose that all you remember about a file is that you received it in your
mail last week or last month. To find it, you can type time periods, such as yester-
day, last week, or last month, to see every item that you saved or received within that
period. (Boy howdy, I love writing about TGIs — that’s short for Truly Good Ideas.)

Be careful, however, when you’re considering a search string. Don’t forget that
(by default) Spotlight matches only those items that have all the words you enter
in the Spotlight box. To return the highest number of possible matches, use the
fewest number of words that will identify the item. For example, use horse rather
than horse image, and you’re certain to be rewarded with more hits. On the other
hand, if you’re looking specifically for a picture of a knight on horseback, using a
series of keywords — such as horse knight image — shortens your search consider-
ably. It all depends on what you’re looking for and how widely you want to cast
your Spotlight net.
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IS SPOTLIGHT SECURE?

So how about all those files, folders, contacts, and events that you don't want to appear in
Spotlight? What if you're sharing your Mac as a multiuser computer or accessing other Macs
remotely? Can others search for and access your personal information through Spotlight?

Definitely not! The results displayed by Spotlight are controlled by file and folder permis-
sions as well as your account login, just as the applications that create and display your
personal data are. For example, you can't access other users’ calendars using Calendar,
and they can't see your Mail messages. Only you have access to your data, and only after
you've logged in with your username and password. Spotlight works the same way. If a
user doesn’t normally have access to an item, the item simply doesn't appear when that
user performs a Spotlight search. (In other words, only you get to see your stuff.)

However, you can hide certain folders and disks from your own Spotlight searches
if necessary. Check out the final section of this chapter for details on setting private
locations on your system.

To allow greater flexibility in searches, Apple also includes those helpful Boolean
friends that you may already be familiar with: AND, OR, and NOT. For example,
you can perform Spotlight searches such as these:

3 Horse AND cow: Collects all references to both those barnyard animals
into one search
3 Batman OR Robin: Returns all references to either Batman or Robin

3 Apple NOT PC: Displays all references to Apple that don't include any
information about dastardly PCs

Expanding Your Search Horizons

106

I can just hear the announcer’s voice now: “But wait, there’s more! If you double-
click the Show All in Finder menu item at the bottom of your search results list,
we’ll expand your Spotlight Search box into the Finder Search window!”
(Fortunately, you don’t have to buy some ridiculous household doodad.)

Keyboard mavens will appreciate the Finder Search window shortcut key, and
I show you where to specify this shortcut in the final section of this chapter.

m Figure 6-2 illustrates the Finder Search window. To further filter the search, click

one of the buttons on the search criteria bar to create your own custom filter. Click
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FIGURE 6-2:
The spacious
borders of the
Finder Search
window.

TIP

the button with the + (plus) on the search criteria bar and then click the pop-up
menus to choose criteria, such as the type of file, the text content, or the location
on your system (for example, your hard drive, your Home folder, or a network
server). You can also filter your results listing by the date when the items were
created or last saved. To add or delete criteria, click the + (plus) and — (minus)
buttons at the right end of the search criteria bar. To save a custom filter that
you’ve created, click the Save button.
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Images appear as thumbnail icons, so you can use that most sophisticated search
tool — the human eye — to find the picture you’re looking for. (If you don’t see
thumbnail images, click the Icon view button on the toolbar.) Don’t forget that
you can increase or decrease the size of the icons by dragging the slider at the bot-
tom right of the window.

To display the contents of an item in the list (without leaving the comfortable
confines of the Finder Search window), click the item to select it, and press the
spacebar for a better view. Note that Mojave must recognize the format of the file,
and it must be supported by at least one application.

Again, when you’re ready to open an item, just double-click it in the Finder Search
window.

As I mention earlier, Spotlight can look for matching items on other Macs on your
network only if those remote Macs are configured correctly. To allow another Mac
to be visible to Spotlight on your system, enable File Sharing on the other Mac.
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REMEMBER

(Oh, and remember that you need an admin-level account on that Mac — or access
to a good friend who has an admin-level account on that Mac.)

Follow these steps to enable file sharing on the other Mac:
1 . On the Dock, click the System Preferences icon (the one with the gears).

Click the Sharing pane.

2.

3. Inthe service list on the left side of the Sharing pane, select the On check
box next to the File Sharing item to enable it.

4.

Click the Close button in the System Preferences window (or, if you're a
keyboard power user, simply press the 35+Q shortcut).

You can search only those items that you have rights and permissions to view on
the remote Mac (such as the contents of the Public folders on that computer). I dis-
cuss these limitations earlier in this chapter, in the sidebar “Is Spotlight secure?”

Customizing Spotlight to Your Taste

108

You might wonder whether such an awesome macOS feature has its own pane in
System Preferences — and you’d be right again. Figure 6-3 shows off the Spot-
light pane in System Preferences. Click the System Preferences icon on the Dock
and then click the Spotlight icon to display these settings.

Click the Search Results section to:

3 Determine which categories appear in the Spotlight search box. For
example, if you don't use any presentation software on your Mac, you can
clear the check box next to Presentations to disable this category (thereby
making more room for other categories that you will use).

¥ Specify the Spotlight search box and Finder search window keyboard
shortcuts. Click the Keyboard Shortcuts button to enable or disable either
keyboard shortcut and choose the key combination from the pop-up menu.
By default, the menu keyboard shortcut is §8+spacebar, and the Finder search
window keyboard shortcut is $8+Option+spacebar.

Click the Privacy section (shown in Figure 6-4) to specify disks and folders that
should never be listed as results in a Spotlight Search. I know, I know — I say
earlier that Spotlight respects your security, and it does. However, the disks and
folders that you add to this list won’t appear even if you are the one performing
the search — a great idea for folders and removable drives that you use to store
sensitive information, such as medical records.
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FIGURE 6-3:
Fine-tune your
Spotlight menu
and Results
window from
System
Preferences.

FIGURE 6-4:
When certain
folders and disks
must remain
private (even
from you!), add
them to this list.
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To add locations that you want to keep private, click the Add button (a plus sign)
and navigate to the desired location. Click the location to select it and then click
Choose. Alternatively, you can drag folders or disks directly from a Finder window

and drop them onto the pane.
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IN THIS CHAPTER

» Setting reminders

» Making notes
» Using the Notification Center
» Navigating with Maps

» Staying current with News

Chapter 7

Putting Common
Apps to Work

s I’ve said many times before in my books, “If it works in one place, it’s

likely to show up in another.” In this case, five popular time-saving (and

headache-preventing) apps have crossed over from the world of iOS
devices — the iPhone and iPad— and have securely landed on your Mojave
Desktop. These apps are Reminders, Notes, Notification Center, Maps, and News,
all taken from the iOS world.

That’s not the only good news, though: These five Mac applications work seam-
lessly with an iCloud account. So if you also use an iOS device (with the same
Apple ID), much of the data you store — such as the notes you take and the
reminders you make — is automatically synchronized between all your Apple
computers and devices.

Because all five of these applications have a similar goal — keeping you in touch
with the information, daily tasks, locations, and digital events that matter to
you — I decided to cover them in one shiny chapter. Consider this chapter a guide
that demonstrates how you can remind, note, notify, read,and map like a true
power user.
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Remind Me to Use Reminders

FIGURE 7-1:
The main
Reminders
window in
action.

TIP

You don’t need to look far to find the Reminders application on your Mac. Just
click the Reminders icon on the Dock to display the main window, as shown in

Figure 7-1.

Reminders Sidebar

Search box Reminder Add Reminder
o0e | |
a Reminders &
77 Scheduled Deposit tax return
iCloud
Reminders
Work
| B |
——&@ Add List
< July 2018 >
S M T WT F §
1 2 3 4 ] ] 7
8 9 10 M 12 13 14
15 16 17 18 19 20 21
22 23 24 25 268 27 28
29 30
Add List Calendar

These are highlights of the Reminders window:

¥ Search box: Click here and type a phrase or name to search for it among your

»

reminders.

Reminders Sidebar:You can add as many separate Reminder lists as you like
in the application (one for work, for example, and another for your Mac user
group). In the Sidebar, you can switch quickly between your lists.

You can hide or show the Reminders Sidebar at any time using the View
menu, or by pressing §8+Option+S. You save a significant amount of screen
real estate when the display is hidden.
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Calendar: This handy calendar indicates which days of the current month
already have reminders pending: They're displayed with a dot under the date.
You can jump to any date by clicking it. To move forward and backward
through the months, click the Previous and Next buttons next to the month
name. (Note that this calendar does not sync or exchange reminder dates
with the Calendar application.) To display the Calendar, click View = Show
Calendar — to hide the Calendar, click View=>Hide Calendar.

Add List button: Click this button to add a new Reminder list to the Sidebar;
from the keyboard, press 38+L. The list name is highlighted in a text box, so
you can simply type the new name and press Return.

Reminders: These entries are the reminders themselves. Each is prefaced by
a radio button so you can select the radio button when the reminder is
complete, thereby moving that reminder automatically to the Completed list.
And yes, if you click the Show link next to the number of completed reminders
to display them and deselect the radio button for a reminder, it returns (like a
bad penny) to the original list.

Add Reminder button: Click this button to add a new reminder to the currently
selected list; from the keyboard, press §8+N. In its simplest form, a reminder is
just a short phrase or sentence. Press Return afterward to save it to your list.

Adding a reminder is straightforward. First, click a date in the calendar display to
jump to that date, and then click the Add Reminder button. Type a few words and
press Return to create a basic reminder. However, if you hover your cursor over
the reminder you just created, an Info button (the lowercase i in a circle icon)
appears next to the text. The game is afoot! Click the Info button to display the
settings you see in Figure 7-2.

These fields are on the Edit sheet:

»
»

»

Reminder text: Click this text to edit the reminder text itself.

On a Day: Enable this check box if the reminder should appear in Notification
Center on a particular day. By default, the date is the one selected when you
created the reminder. You can click the Date and Time fields to change them.

At a Location: This is a powerful feature. Select the At a Location check box,
and a pop-up menu appears below the check box. Now you can type an
address in the Enter a Location field. Reminders monitor your current location
on your iPad or iPhone using Location Services. They notify you when you're
leaving or arriving at that location (and, optionally, on the date and time you
specify in the On a Day field). For example, you could create a reminder that
notifies you on your iPhone when you're arriving at the mall on September 15
to pick up the watch that's being repaired. Shazam!
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reminder.

¥ Repeat: If you select the On a Day check box, you can also set this reminder
to automatically repeat every day, week, month, or year at the same time.

¥ Priority: You can assign one of four priorities to the reminder: Low, Medium,
High, or None. Assigning a priority prefaces the reminder text with one (Low),
two (Medium), or three (High) blue exclamation points so the reminder stands
out from the crowd.

¥ Note: Click next to the Note field to enter a free-form text note along with the
reminder.

Click Done on the Edit sheet when you’ve finished making changes. You can edit a
reminder as often as you like. For example, I sometimes need to change the date
on a reminder multiple times as my schedule changes.

To delete a reminder from the list, right-click it and choose Delete from the menu
that appears.

TIP . - . . . .
iCloud connectivity allows Reminders to share information with other Macs and

i0S devices, as well as Microsoft Outlook on both PCs and macOS. To share remind-
ers, click the System Preferences icon on the Dock, click the Internet Accounts
icon and then click one of the accounts at the left of the pane. If an account allows
you to share data from the Reminders application — such as the iCloud account —
you’ll see a Reminders check box at the right side of the pane.
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Taking Notes the Mojave Way

FIGURE 7-3:

The notable
Notes application
window.

Imagine a notepad of unlimited pages that’s always available whenever you’re
around your Mac, iPhone, iPod touch, or iPad — that’s the idea behind Notes, and
it’s superbly simple. To open the Mac version of the application, click the Notes
icon on the Dock. The window shown in Figure 7-3 appears.
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o ¥ Newspaper advertisement
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New Foldgr
Folders list Notes list

The salient stuff in the Notes window includes these items:

¥ Search box: If you're hunting for a specific note, click in this box and type a
phrase or name to search for it.

¥ Folders list: You can create new folders to hold specific kinds of notes. In
Figure 7-3, for example, | added a Work folder. To add a new folder, choose
File> New Folder or press 38+Shift+N and type the new folder name. To
switch between folders, display the Folders list and click the desired folder.
You can display or hide the Folders list from the View menu.

3 Notes list: Each Note you create appears as a separate entry in the Notes List.
You can click a Note in the list to switch to it immediately.
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TIP

¥ New Note button: Click this button to add a new Note. Notes uses the first
line of text you type as the title of the Note, which appears in the list.

3 Note Page: This free-form pane is where you type the body of your note.
You can also drag images from a Finder window or the Photo Browser and
include them in the body of the note, or embed PDF and audio files by
dragging them from a Finder window as well.

3 Lock button: Click this button to lock the selected note with a password.
Notes allows you to specify a single password for all locked notes — if a
note is locked, you'll have to enter this password to view, edit, or delete it.

3 Share button: Open this pop-up menu to share the contents of the current note,
just like the Share button that appears on the Finder window toolbar. Sharing
options can include a new email message, a new message in the Messages
application, a new Reminder,and new postings to Twitter or Facebook.

To edit a note, click it to select it in the Notes List, and then simply make your
changes or additions in the Note Page. You can format the text from the Format
menu — everything from different fonts and colors to inserting bulleted and
numbered lists.

To delete a note you no longer need, right-click it in the Notes List and choose
Delete from the menu that appears. The application prompts you for confirmation
before the deed is done.

You can pin a note to the top of the Notes list to make it more visible - it stays
anchored to the top of the list whenever it’s visible. Right-click on the desired
note in the list and choose Pin Note (or Unpin Note to return the note to regular
status).

A note can now include tables to help organize your data, much like the Pages
application! Click the Table button in the Notes toolbar to create a default table
(two columns and three rows), then click in the first field and begin typing. Press
Tab to continue to the next field in the table. To create a custom table, click For-
mat in the Notes menu bar and choose Table — you can specify the number of rows
and columns there.

To add an image from your Photos library, click the Photo Browser button in the
toolbar and choose Photos from the pop-up menu. The familiar Browser window
appears, and you can drag images directly into the Note Page.

Like Reminders, the Notes application can share information with Macs and iOS
devices, as well as Outlook on both Macs and PCs. The process is the same: Open
System Preferences and click the Internet Accounts icon, and then click the desired
account at the left of the pane. Accounts that support sharing data from Notes will
display a Notes check box at the right side of the pane.
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Staying Current with Notification Center

FIGURE 7-4:
Notification
Center muscles
your Desktop to
the side.

TIP

Unlike Reminders and Notes, Notification Center isn’t an application you launch.
Instead, the Notification Center icon appears at the far right side of the Finder
menu bar, and it’s always running.

Click the icon (or, if you’re using a trackpad, swipe with two fingers from the right
edge to the left) to display your notifications. These notifications can be generated
by a whole host of Mojave applications and functions, including Calendar, Mail,
FaceTime, Reminders, Game Center, Photo Stream, Messages, Safari, Facebook, and
even the Mac App Store. Third-party applications can also generate notifications.

You can also click the Today button at the top of the Notification Center to display
all sorts of information that specifically applies to today’s date (as shown in
Figure 7-4), including things like Calendar events, Reminders, the current weather,
the macOS calculator and the latest stock figures. To switch back to the Notifica-
tions view, click the Notifications button at the top of the Notification Center.

38 9O = o) Sat12:08PM Mark Chambers Q & =

Today

Saturday,
July 14
Partly Cleudy currently. The high will be 83*
Cloudy tonight with a low of 73
L) REMINDERS
Deposit tax return 1:00 PM
[ WEATHER
Columbia 91
6:08 PM °
London 81
Now York 84

Baton Reuge 91°

@ CALENDAR

You can add applets called widgets to the Today view as well, allowing you to
customize the information you see there. Notification widgets are very similar to
Dashboard widgets — you can download them from the App Store.

CHAPTER 7 Putting Common Apps to Work 117



TIP

I love how Notification Center doesn’t interfere with open applications. It simply
moves the entire Desktop to the left so you can see the Center. You can close Noti-
fication Center at any time by clicking anywhere on the Desktop to the left, click-
ing the Notifications icon on the Finder menu bar again, or swiping in the opposite
direction.

Notification entries that appear in the Notification view are grouped under the
application that created them. Many entries can be deleted from Notification Cen-
ter by clicking the Delete button that appears next to the application heading (the
button bears an X symbol). Other entries, such as Calendar alerts, remain in Noti-
fication Center until a certain time has elapsed.

But wait, there’s more to Notification Center than just a strip of happenings—
depending on the settings you choose, notifications can also appear without Noti-
fication Center being open at all. These notifications are displayed as pop-up
banners (which disappear in a few seconds) and alerts (which must be dismissed
by clicking a button).

Mojave can also allow actions in notifications. Depending on the application or
function that generates the notification, you may see buttons on a banner or an
alert that allow you to take care of business (without requiring the application to
be running). For example, if a new email message is received in Apple Mail, you
can choose to reply to or delete the message. Websites can display updates as noti-
fications, and you can answer a FaceTime oran iPhone call directly from the
notification.

You can configure the notifications for all your applications from the Notifications
pane in System Preferences, which you can reach easily if Notification Center is
open. Just click the gears icon at the lower-right corner of the Notification Center.

Introducing the Maps Application

18

If you own an iPad or iPhone, prepare yourself for a joyful state: Your beloved
Maps application also resides on your Dock! As long as you have a connection to
the Internet, Maps is ready to display locations, provide directions, and even allow
for informal views of important sites worldwide! (Recognize the grand dame in
Figure 7-5?)

Displaying an overhead view of an address is one of the simplest chores in all of
macOS — from the Maps window, just click in the Search box at the top of the
window, type the address, and press Return. Maps displays the address with a red
pushpin to help you locate it.
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FIGURE 7-5:

The Statue of
Liberty shines in
the Maps
application.

looks like a lowercase i within a circle) next to the name. To view more informa-
tion, click the Info icon.

@ Depending on the location you’ve chosen, you may also see a tiny Info icon (which

TIP

If you are in range of a Wi-Fi signal, and have turned Location Services on, you
@ can quickly map your current location — just click View= Go to Current Location,
or press 38 +L.
TIP
Ah, but why stop with just a simple address? You can also enter the following
types of information:

¥ The name of a landmark, monument, or building (for example, Statue
of Liberty).

3 The name of a business or restaurant (or even a genre of food, such as
Chinese) followed by the city name. Maps displays matching sites with
pushpins (complete with reviews), and you can click any of the pushpins to
find out more information on a location. Figure 7-6 illustrates a search for
pizza in my hometown of Columbia, Missouri — you can see the Info pop-up
that appears when | click the Info icon next to the restaurant name, complete
with a link to their website and reviews a-plenty.

¥ Attractions and services, followed by the city name. You can search for a gas
station, movie theater, or local park.
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FIGURE 7-6:
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If you need to zoom in or zoom out on a Maps display, use the scroll function on
your pointing device, click the plus and minus buttons at the bottom-right corner
of the Maps window, or use the 38+plus and 3§ +minus shortcuts. To move around
the Maps window, click and drag the map in the desired direction.

Teachers and parents, take note: A virtual “flyby” of a famous site in Maps is a
valuable (and cool) resource.

Switching Views in Maps

120

A traditional printed map offers you only one view, which may be perfectly fine for
determining a route but provides no visual interest. (The word banal comes to
mind.) Maps, on the other hand, offers three types of views, each of which offers
certain advantages:

¥ Standard (or Map) mode is a familiar line map, with streets and highways
marked. Standard mode is best for planning a road trip, just like your
father’s old-fashioned paper map.

¥ Satellite mode is a photographic overhead view without streets or highways
marked, which is great for panoramic views of your neighborhood or a
location and its surroundings.
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FIGURE 7-7
Map view
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of an auto
GPS unit.
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¥ Transit mode displays public transportation routes and bus, subway and train
schedules. Note, however, that Transit information is not available in every
location.

To select your view, click one of the buttons at the top of the Maps window: press
98+1 for standard Map, 38+2 for Transit, or 38+3 for Satellite. Figure 7-6 shown
earlier illustrates Satellite view mode, while Figure 7-7 shows off Map view.
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Have you noticed the Show pop-up menu at the lower-left corner of the Maps
window? If you’re using Satellite view, you can click the Show menu and choose
Show Labels to toggle street names on and off. The Show pop-up menu also allows
you to display traffic conditions and toggle the 3D map.

“Wait, there’s a 3D map option?” Yes indeed, and no special glasses are required! For
additional visual thrills, you can angle the Maps display with a slight 3D effect —
nothing quite as grand as a 3D TV, but it does help add depth to Satellite view. To
toggle 3D on and off, press 38+0, click the Show pop-up menu, or press the 3D button
at the lower-right corner of the window.

By default, Maps is oriented with north at the top of the screen, but if you need to
change the orientation, click the red compass arrow at the bottom-right corner of
the screen and drag in the desired direction. To immediately return to north at the
top of the screen, press 3§+ or click View=> Snap to North.
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Getting Directions Over Yonder

My primary use for a map is getting directions from one point to another, and
Maps doesn’t disappoint when it comes to navigation. Click the Directions button
to display the panel you see in Figure 7-8, and you’re ready to plot your course.

Columbia, MO, United States (D @

6
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dun
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FIGURE 7-8:

The Directions

panel is ready to

provide directions

to your next
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Follow these steps to get directions between two addresses:

1. Inthestart box, type the starting address.

As you type, Maps provides a pop-up list of suggestions taken from your recent
locations, as well as addresses from your Contacts database and matching
streets from around the globe. To choose one of these suggestions, just click it.
To clear the contents of the field, click the X button that appears at the right
side of the box.

2. Press Tab to move to the End box.
3. IntheEnd box, type the destination address.

Note that your destination doesn't have to be a specific address — for
example, Memphis, TN, works just fine.
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4. Click the Drive button for road directions, click the Walk button for
walking directions or display mass transit information by clicking the
Transit button.

5. PressReturnto generate your directions.

Maps usually offers more than one route for your trip — the first route provided is
typically the fastest or shortest, and it appears as a bright blue. To view one of the
other routes, just click a light blue line and it turns bright blue to indicate that it’s
now the selected route. (You can see the approximate mileage and time for the
currently selected route at the top of the turn list.) The turn-by-turn list provides
approximate mileage for each leg of the journey.

Maps allows you to share your maps and directions using Mail, Messages, Twitter,
or Facebook. Click the Share button at the top of the window, and then select the
desired sharing method.

You can easily print the route map and directions by choosing File= Print (or by
pressing $8+P), and then clicking the Show Details button at the bottom of the
Print sheet to display all the options.

If you’d rather create a PDF document with your map and directions, choose
File=> Export as PDF.

TIP

Catching Up on News

Are you a current events junkie like I am? Before the arrival of the Internet, I used to
remain glued to my TV, absorbing the latest information from the news channels —
heck, I even subscribed to an old-fashioned newspaper! (To be honest, I still do, but
it’s the online edition of my hometown paper.) If news is your passion, then let me
introduce you to Mojave’s News app, shown in Figure 7-9!

The News window includes a number of items to help in your perusal:

¥ Toolbar:This familiar strip of buttons allows you to share stories and mark
favorites with a single click.

¥ Sidebar:The News sidebar makes it easy to navigate between topics, news
sources and stories you've saved. You can display or hide the sidebar from the
View menu, or you can click the Show/Hide Sidebar button in the toolbar.
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FIGURE 7-9:
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Although the items in the sidebar change over time (as News “learns” your
preferences and you add channels), you can click the Edit link at the top of the
sidebar to remove items whenever you like.

3 Content pane:Here's where News displays its content — similar to a webpage
in Safari, you can click on an item title or accompanying image to load the
entire story. When a single story occupies the Content pane, a left arrow
appears at the top left corner of the pane; when you're ready to return to
the item list, just click the arrow.

3 Share button:If you'd like to share a link to the displayed story within a Mail
message, social media post or a Message, click the Share button to display the
pop-up menu. You can also create a new Reminder or Note from the story.

Are you rushed for time? To save a story you're reading in the sidebar for later,
press 38 +S. News adds the story under the Saved Stories heading in the sidebar.

Using Favorites and Channels

As I mentioned above, News actually “learns” what type of stories you like as you
use it and will present stories that it thinks will interest you in the Sidebar (under
the “Suggested by Siri” heading). However, there are two News features that help
you focus even more on certain topics and news sources: favorites and channels.
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TIP

News allows you to mark a specific topic as a favorite, indicating that you’d like to
see more stories covering similar subjects. To mark a story you’re reading as a
favorite, press 38+L (for Loved Story) or click the Favorites button on the toolbar.
If, on the other hand, you’d like to avoid seeing similar stories in the future, press
38+D (for Dislike Story).

Within News, you can specify a news source as a channel, such as The Washington
Post or Wired Magazine — they will appear in the News Sidebar under the “Follow-
ing” heading. To choose channels, click File on the News menu bar and click
Browse Channels. When you see a news source you’d like to monitor, click it (the
Favorites heart icon turns red). Once you click Done, you’ll see that your channel
selections are added to the Sidebar under the “Following” heading. To stop fol-
lowing a channel, click File=> Unfollow Channel.

If you’d like to block all the stories from a specific channel, display it in the Con-

tent pane and click File=> Block Channel. You can edit your Block list from the File
menu as well.
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IN THIS PART ...

Surf the web with ease using Apple's Safari browser.
Sync documents and data automatically using iCloud.
Share your iMac with other users safely.

Join or create a wireless network with your iMac.

Hooking up printers, scanners, PhotoBooth, and
FaceTime.



IN THIS CHAPTER

» Introducing the Safari window and
controls

» Visiting websites with Safari

» Moving between sites

» Creating and using bookmarks

» Receiving files with Safari

» Surfing with your tabs showing

» Saving web pages to disk

» Protecting your privacy on the web

» Blocking those irritating pop-ups

Chapter 8
Let’'s Go on Safari!

proudly surf the web via a lean, mean — and fast — browser application. That’s
Safari, of course, and it keeps getting better with each new version of
macOS. Safari delivers the web the right way, without the wait. You’ll find that
features have been added to Safari that no other browser offers, such as the
Reading List, which allows you to easily select articles and pages for later perusal.

If you need a guide to Safari, this is your chapter. Sure, you can start using Safari
immediately, but wouldn’t you rather read a few pages so that you can surf like a
power user?

Within these pages, I show you how to use those other controls and toolbar
buttons in Safari — you know, the ones in addition to the Forward and Back
buttons. You’ll discover how to keep track of where you’ve been and where you’d
like to go.
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Pretending You've Never Used This Thing

Figure 8-1 illustrates the Safari window. You can launch Safari directly from the
Dock, or you can click the Safari icon in Launchpad.
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FIGURE 8-1:

Safari at a glance. Status bar

Sidebar

Content pane

These are the major sections of the Safari window:

¥ The toolbar: Here are the most-often-used commands for tasks such as
navigation, sharing content, and searching Google (or Yahoo!, or DuckDuckGo,
or Bing). Plus, here you can type or paste the address for websites that you'd
like to visit.

3 The Favorites bar: Consider this bar to be a toolbar that allows you to jump
directly to your favorite websites with but a single click or two. | show you
later (in the section “Adding and Using Bookmarks”) how to add sites to and
remove sites from your Favorites bar. For now, remember that you can toggle
the display of the Favorites bar by choosing View=> Hide/Show Favorites Bar or
by pressing $8+Shift+B.

3 The Tab bar: This toolbar allows you to quickly switch among multiple web
pages that you've loaded, using what appear to be old-fashioned file-folder
tabs. (Something familiar; familiar is good.) To hide or display the Tab bar,
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choose Viewr=> Hide/Show Tab Bar. You can also pin sites to the Tab bar
permanently (more on this later in the chapter).

The Sidebar: The Sidebar pane allows you to organize and read your book-
marks, Reading List, and shared links. To hide or display the Sidebar, press
98+Shift+L or choose View=> Hide/Show Sidebar.

The Content pane: Congratulations! At last, you've waded through the
pregame show and reached the area where web pages are displayed. The
Content pane can be scrolled, and when you minimize the Safari window to
the Dock, you get a thumbnail (minimized) image of the Content pane.

The Content pane often contains underlined text and graphics that transport
you to other pages when you click them. These underlined words and icons
are links, and they zip you right from one area of a site to another area (or to
a different site altogether). You can tell when your pointer is resting on a link
because it changes to that reassuring pointing-finger hand. Handy! (Sorry
about that.)

The Status bar: The Status bar displays information about what the pointer
is resting on, such as the address for a link or the name of an image; it also
updates you about what's happening while a page is loading. To hide or
display the Status bar, press 38+/ (forward slash) or choose View=> Hide/Show
Status Bar.

Visiting Websites

Here’s the stuff that virtually everyone over the age of 5 knows how to do . . . but
I get paid by the word, and some folks might just not be aware of the many ways
to visit a site. You can load a web page by using any of these methods:

»

»

Click in the Address box. If you're not viewing your Top Sites display, click the
Address box to display a scrolling thumbnail list of your Favorites and most
frequently visited sites. Click a thumbnail to jump immediately to that page.
That's about as simple as life gets!

Type (or paste) a website address in the Address box on the toolbar, and
press Return. If you're typing an address, and Safari recognizes the site as
one that you've visited in the past, it “helps” by autocompleting the address for
you. Press Return if you want to accept the suggested site. If this site is a new
one for you, just keep typing.

The Safari Address box also acts as a smart address field, displaying a new
pop-up menu of sites that match the text you enter. Safari does this by
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using sites taken from your History file and your bookmarks, as well as sites
returned from Google, Yahoo!, DuckDuckGo, or Bing. If the site you want to
visit appears in the list, click it to jump there immediately.

Click a Bookmarks or Favorites entry. Bookmarks appear in the Sidebar
and the Bookmarks menu, while Favorites appear in the Favorites bar.

Click a tab for a pinned site. Pinned tabs appear as icons at the left end of
the Tab bar.

If the Home button appears on your toolbar, click the button to go to the
home page that you specify. Read more in the upcoming section “Setting Up
Your Home Page.”

If the Top Sites button appears on the toolbar, click it to open the Top
Sites display. Safari displays a wall of preview thumbnail pages from your
most frequently visited sites, and you can jump to a site just by clicking the
preview. You can anchor a thumbnail to keep it onscreen permanently by
hovering your pointer over the thumbnail and clicking the pin icon that
appears, or you can delete a thumbnail by clicking the X button that appears.

Because each thumbnail is updated with the most current content, the Top
Sites wall makes a great time-saver. Quickly make a visual check of all your
favorite haunts from one screen!

Click an item you saved earlier in the Sidebar’'s Reading List tab.
To display items in your list, click the button bearing the eyeglasses icon
at the top of the Sidebar.

Click a page link in Apple Mail or another Internet-savvy application.
These links are typically highlighted or underlined to make them easier to see.

Never click a link in an email unless you know and trust the sender!

Click a page link in another web page. By default, Safari opens the new
page in a separate tab.

Select a web address in a document, click the Services menu, and choose
Open Page in Safari. Safari automatically loads and displays the page.

Type a search term in the Address box. By default, Safari uses Google as
a search engine, but you can use Yahoo!, Bing, or DuckDuckGo if you prefer.
To set the default search engine, choose Safari= Preferences; then, on the
Search tab, click the Search Engine drop-down menu. (You can immediately
switch to another engine by clicking the magnifying-glass icon that appears
before you start typing in the Address box.)

Click the Address box, type the contents that you want to find, and press
Return. Safari presents the search results page on Google for the text you
entered. (In case you've been living under the Internet equivalent of a rock for
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the past several years, Google (https://www.google.com) is the preeminent
search site on the web. People use Google to find everything from used auto
parts to ex-spouses.)

Click a Safari page icon on the Dock or in a Finder window. Drag a site
from your Favorites bar (or drag the icon from the left side of the Address
box), and drop it on the right side of the Dock. Clicking the icon that you add
launches Safari and automatically loads that site.

This trick works only on the side of the Dock to the right of the vertical line.
You'll find more detail on that all-important divider and how you can add
icons to the Dock in the section titled “Customizing the Dock” in Chapter 3.

If you minimize Safari to the Dock, you'll see a thumbnail of the page with the
Safari logo superimposed on it. Click this thumbnail on the Dock to restore
the page to its full glory.

Speaking of full glory, Safari supports the same full-screen mode as many
other Mojave applications. Click the Zoom/Full Screen button in the top-left
corner of the Safari window to switch to full-screen mode, or press the
Control+38+F shortcut (a good shortcut to memorize because it works with
virtually all Mojave-compatible applications). To make things convenient
for you, the toolbar and Favorites bar remain. To exit full-screen mode,
press Esc or the Control+38+F shortcut again.

Navigating the Web

A typical web-surfing session is a linear experience. You bop from one page to the
next, absorbing the information you want and discarding the rest. After you visit
a few sites, however, you might find that you need to return to where you’ve been
or head to the familiar ground of your home page. Safari offers these navigational
controls on the toolbar:

»

»

Back: Click the Back button (the left-facing arrow) on the toolbar to return
to the last page you visited. Additional clicks take you to previous pages,
in reverse order. The Back button is disabled if you haven't visited at least
two sites.

Forward: If you've clicked the Back button at least once, clicking the Forward
button (the right-facing arrow) takes you to the next page (or through the
pages) where you originally were, in forward order. The Forward button

is disabled if you haven't used the Back button and haven't navigated to
another page.
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Safari supports several trackpad gestures. You can swipe in either direction
with two fingers to move backward and forward, for example, just as you
would move with the Forward and Back buttons. To zoom in and out on the
Content pane, you can double-tap the trackpad or pinch with two fingers —
yes, just like on an iPhone. (Ever get the notion that someday, we'll have a
single box called “The Device” that does it all?)

Home: Click this button (look for the little house) to return to your home page.

Not all these buttons and controls may appear on your toolbar; you may not
see many of these toolbar controls unless you add them yourself. To display
or hide toolbar controls, choose View=>Customize Toolbar. The sheet that
appears works just like the Customize Toolbar sheet in a Finder window: Drag
the control you want from the sheet to your Safari toolbar, or drag a control
that you don't want from the toolbar to the sheet. As with most buttons and
controls in Mac applications, if you hover your pointer over an unfamiliar
button on the toolbar, Safari displays a tooltip to identify the button for you.

Show/Exit Tab Overview: A click of this toolbar button displays all the tabbed
sites you've opened, as well as the iCloud Tabs from Safari on your other
Macs, PCs, and iOS devices.

AutoFill: If you fill out lots of forms online — when you're shopping at
websites, for example — you can click the AutoFill button (which looks like
a little text box and a pen) to complete these forms for you. You can set
what information is used for AutoFill by choosing Safari> Preferences and
clicking the AutoFill toolbar button.

To be honest, I'm not a big fan of automatically releasing any of my personal
information to any website, so | don't use AutofFill. If you do decide to use this
feature, make sure that the connection is secure (look for the padlock icon in
the Address box), and read the site's Privacy Agreement page first to see how
your identity data is treated. Never enter credit card numbers or personal
information on a website without a secure connection!

Top Sites: Click this button to display the Top Sites screen, which | discuss
earlier. If you're having trouble finding it, the button bears a tiny, fashionable
grid of squares.

Zoom: Shrink or expand the text on the page, offering smaller, space-saving
characters (for the shrinking crowd) or larger, easier-to-read text (for the
expanding crowd) by clicking one of the Zoom buttons, which are labeled
with a small and large letter A, respectively. You can also press $8+= (equal
sign) to expand and 38+- (hyphen) to shrink.

Favorites bar: Click this button (which carries the Bookmarks symbol
sandwiched between two horizontal lines) to display or hide the
Favorites bar.
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Stop/Reload: Click Reload (which has a circular arrow in the Address box)

to refresh (reload) the contents of the current page. Although most pages
remain static, some pages change their content at regular intervals or after
you fill out a form or click a button. By clicking Reload (look for the curved
arrow in the Address box), you can see what's changed on these pages. (I use
Reload every hour or so with CNN.com, for example.) While a page is loading,
the Reload button turns into the Stop button — with a little X mark — and
you can click it to stop the loading of the content from the current page. This
feature is a real boon when a download takes forrevverr, which can happen
when you're trying to visit a popular or slow website. Using Stop is also handy
if a page has several large graphics that are likely to take a long time to load.

Sidebar: Click this toolbar button at the left end of the Address box to hide
or display the Safari Sidebar. You'll find the complete description of the
sidebar in the upcoming sections “Adding and Using Bookmarks” and
“Working with the Reading List".

History: Click this button, which bears a clock symbol, to display or hide the
History list, which | discuss later in this chapter.

Downloads: This toolbar button appears only if you're currently downloading
a file or if you've downloaded files that haven't been cleared yet. Click it to
display the files you've downloaded recently, and click the Clear button to
clear the contents of the Download list. Note that clearing the list doesn't
delete the files you've downloaded; it simply cleans things up. You can also
double-click a completed download in the list to open it immediately. (More
on downloading in the section “Downloading Files.”)

When you're downloading a file, a tiny progress bar appears in the Downloads
button on the toolbar to show you how much you've received. Now that, good
reader, is progress! (Let's see whether my editor allows such a horrible pun to
remain.) Anyway, you can click the Downloads button during the file transfer
to pause or stop the download completely.

Open in Dashboard: Click this button to create a Dashboard widget, using
the contents of the currently displayed web page. Safari prompts you to
choose which clickable section of the page to include in the widget's borders,
such as the local radar map on your favorite weather website. Click Add, and
Dashboard loads automatically with your new widget. For more on widgets,
see Chapter 3.

Mail: Click this button (bearing an envelope icon) to send an email message
with a link to the current page, just as though you clicked the Share button
and chose Email This Page. Safari automatically opens Apple Mail (or your
default email application) and creates a new message with the link already
in the body. Shazam!

CHAPTER 8 Let's Go on Safari! 135



¥ Print: Click this convenient button to print the contents of the Safari window.
(Dig that crazy printer icon!)

3 Website Preferences: Click this button to display (or change) the preference
settings you've selected for this specific website. You can elect to use the
Reader whenever possible, enable the content blocker to prevent most
advertisements from appearing (more on both these features later in the
chapter), set the Zoom level, and enable or disable the Auto-Play feature
for videos that contain an audio track.

¥ Share: If you have an iPhone or iPad, you're probably familiar with this button,
which carries a rectangle and arrow symbol. Click the Share button to send
the current page (or a link to it) to any of several destinations, including
your Reading List; an email message; your Notes, Messages or Reminders
applications; AirDrop; or Facebook, LinkedIn, or Twitter. You can also add a
bookmark to the current page by clicking the Share button. Figure 8-2
illustrates the Share button in action.

eee < o} = dummies. com ol =
5 Newsv Apple |
, PR R —— ¢ oo s ny - St
1 €
d i BROWSE B2B SHOP FOR AT
umﬂ)jﬂ?’; TOPICS SOLUTIONS BOOKS 5 ::::ders
(@ AirDrop
*) More...
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How ta Use the Automater on Your iMac H OW TO U SE TH E IMac For Dummies,
AUTOMATOR ON = o, " Eition
Haw to Perform a Basic Search on Your e
e YOUR IMAC f
How ta Fix Permissions and Catalog Errars on By Mark L. Chambers L J
Your iMac
El Capitan’s Automator application is a big hit among iMac power users. You use G+
_‘::Wm Manually Clean the Hard Drive on Your Automator to create customized tools that automate repetitive tasks. Of course,
iMac -
writing an application might sound daunting — akin to singlehandedly building =
[ your own nuclear submarine over a long weekend — but Automator is actually ®
Physical defenses can’t easy to use. Heck, you might find it downright fun!
stop cyber attacks. =]
FIGURE 8-2:
The Share button
makes it easy to
spread goodness
and light!

Setting Up Your Home Page

Choosing a home page is one of the easiest methods of speeding your web surfing.
But a large percentage of the iMac owners I've talked with have never set their
own home page; instead, they simply use the default home page provided by their
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FIGURE 8-3:
Adding your own
home page is an
easy change you
can make.

TIP

browser. Declare your independence! With Safari running, take a moment to

follow these steps to declare your freedom to choose your own home page:

1. In Safari, display the web page that you want to become your new

home page.

I recommend selecting a page with few graphics or a fast-loading popular site.

2. Choose Safari=> Preferences, or press 38+, (comma).

3. Click the General tab.

You see the settings shown in Figure 8-3.

4. Click the Set to Current Page button.

5. Cclick the Close button to exit the Preferences dialog.
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General Tabs AutoFill Passwords Search Security Privacy

Safari opens with:
New windows open with:
New tabs open with:

Homepage:

Remove history items:
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File download location:

Remove download list items:
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© & O
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A new window |~ ]
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12 sites | ~ ]
| Downloads | < ]
After one day | <
) Open “safe” files after downloading
“Safe" files include movies, pictures,
sounds, PDF and text documents, and a
archives. :

Alternatively, click the New Windows Open With pop-up menu and choose Empty
Page if you want Safari to open a new window with a blank page. This choice is the

fastest one for a home page.

Visit your home page at any time by clicking the Home button on the toolbar. If it
doesn’t appear on your toolbar, you can add it by choosing View= Customize

Toolbar.
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Adding and Using Bookmarks
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TIP

TIP

No doubt about it: Bookmarks make the web a friendly place. As you collect book-
marks in Safari, you’re able to jump immediately from one site to another with a
single click of the Bookmarks menu or the buttons on the Favorites bar.

To add a bookmark, first navigate to the desired page and then do any of the
following:

»

»

»

Choose Bookmarks Add Bookmark.

Safari displays a sheet where you can enter a name and description for the
bookmark, as well as choose where it appears (on the Favorites bar, Top Sites
display, Bookmarks folder, or Bookmarks menu).

Press the 38+D keyboard shortcut.
Again, you see the sheet requesting a name and location.

Drag the icon next to the web address from the Address field to the
Favorites bar.

This trick also works in applications other than Safari, including Mail and
Messages. Drag the icon from the Safari Address field to the other application
window, and the web page’s link is added to your document.

You can also drag a link on the current page to the Favorites bar, but note that
doing this adds a bookmark only for the page corresponding to the link — not the
current page.

To jump to a bookmark, do one of the following:

»

»

»

Choose it from the Bookmarks menu. If the bookmark is contained in a
folder, as | discuss later in this section, hover your pointer over the folder
name to show its contents, and click the bookmark.

Click the bookmark on the Favorites bar.

If you've added a great number of items to the Favorites bar, click the More
icon on the edge of the Favorites bar to display the rest of the buttons.

Click the Show Sidebar button on the Safari toolbar, click the Bookmarks
button in the Sidebar, and then click the desired bookmark. The Sidebar
(shown in Figure 8-4) displays all your bookmarks, allowing you to review
each collection at your leisure.
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3 Click Bookmarks=> Edit Bookmarks (or press Option+38+B) to open the
Bookmark list. For those who prefer more information (and more onscreen
elbow room) while selecting or organizing their bookmarks, the Bookmark
list is the cat's meow. It displays both the name and web address for each
bookmark in your collection.

The more bookmarks you add, the more unwieldy the Bookmarks menu and
the Sidebar can become. To keep things organized, choose Bookmarks=
Add Bookmark Folder, and type a name for the new folder. With folders, you
can organize your bookmarks into collections, which appear in the column

on the left side of the Sidebar, as folders in the Bookmark list, and as menus
on the Bookmarks bar. (Collections also appear as separate submenus in the
Bookmarks menu on the Safari menu bar.) You can drag bookmarks into the
new folder to help reduce clutter.

To delete a bookmark or a folder from any of these locations, right-click the icon
next to the entry and choose Delete from the contextual menu.

Working with the Reading List

Now that you know all about bookmarks, I'll introduce you to another method of
loading, saving, and retrieving specific pages in Safari — and it’s hiding in the
now-familiar confines of the Safari Sidebar!
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The Sidebar’s Reading List tab allows you to save entire pages for later perusal.
From the keyboard, press 3§ +Shift+L to display the Sidebar, and click the Reading
List button. Then choose Bookmarks+>Add to Reading List or press §8+Shift+D to
add the current page to the list, or hover your pointer over the left side of the
Address box and click the circular icon with the plus sign that appears. Oh, don’t
forget that you can click the Sharing icon on the toolbar and choose Add to Read-
ing List to achieve the same victory.

When you click one of those entries in the Reading List and then click the Show
Reader View icon (it looks like a paragraph) that appears at the left end of the
Address box, the real magic begins! If you click it, the Reader section appears to
display text articles free of advertisements and silly pop-ups. And if an article is
continued over multiple web pages, the Reader section automatically stitches
them together to form a continuous block of text. (Think of an e-book displayed
in iBooks on your iMac, and you get the idea.)

To delete an item from the Reading List, right-click the item and choose Remove
Item from the contextual menu, or click the X icon that appears next to the title.

If the Show Reader View icon appears in Safari’s Address box — and you’re not
using the Reading List — don’t panic! Because the page you’re reading contains
text articles, Safari is offering to display it in the Reader section. (If a page has
nothing to display in the Reader section, the icon disappears.) To display the page
in the Reader section, click the Show Reader View button in the Address box. To
return to your mundane browsing experience, click the Reader icon again.

If you’re as big a fan of Reader View as I am, you’ll be thrilled to learn that you can
turn on this feature for every page on a website! When Reader View is set on as a
default, every page on a website that’s compatible with the Reader section auto-
matically displays in Reader View. (I always set all my news websites — such as
CNN and Macworld — to default to Reader View.) When you’ve navigated to the
desired website, click the Website Preferences button on the toolbar (if you’ve
added it), or choose Safari Settings for This Website. Click the Use Reader When
Available check box to enable it, and you’re good to go!

Downloading Files

140

A huge chunk of the fun you’ll have on the web is downloading images and files.
If you’ve visited a site that offers files for downloading, you typically click the
Download button or the download-file link, and Safari takes care of the rest. While
the file is downloading, feel free to continue browsing or even to download addi-
tional files; the Downloads status list helps you keep track of what’s going on and
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when everything will be finished transferring. To display the Downloads status
list from the keyboard, press 38 +Option+L. You can also click the Download button
in the top-right corner of the window to display the Download list.

By default, Safari saves any downloaded files to the Downloads folder on your
Dock, which I like and use. To specify the location where downloaded files are
stored (if you’d like to scan them automatically with an antivirus program, for
example), follow these steps:

. Choose Safari=> Preferences, or press 38+, (comma).

Click the General tab (refer to Figure 8-3), and open the File Download
Location pop-up menu.

Choose Other.

Navigate to the location where you want the files to be stored.

Click the Select button.

oOUMhAW N=

. Click the Close button to exit Preferences.

To download a specific image that appears on a web page, move your pointer over
the image, right-click, and choose Save Image As from the contextual menu that
appears. Safari prompts you for the location where you want to store the file.

You can choose to automatically open files that Safari considers to be safe —
things like movies, text files, and PDF files that are very unlikely to store a virus or
a damaging macro. By default, the Open “Safe” Files after Downloading check box
is selected on the General pane of the Safari Preferences dialog. If you’re interested
in preventing anything you download from running until you’ve manually checked
it with your antivirus application, you can deselect the check box and breathe easy.

timedia file types that it encounters. If you’ve downloaded a multimedia file,
however, and Safari doesn’t seem to be able to play or display it, try loading the
TIP file in QuickTime Player. QuickTime Player is the Swiss Army knife of multimedia
players; it can recognize a huge number of audio, video, and image formats. To
launch the Player, click the Spotlight search icon and type QuickTime Player.

‘ Luckily, Safari has matured to the point that it can seamlessly handle most mul-

Using History

To keep track of where you’ve been, you can display the History list by clicking the
History menu in Safari. To return to a page in the list, just choose it from the
History menu. Note that Safari also arranges older history items by the date when
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you visited a site so you can easily jump back a couple of days to that page you
forgot to bookmark!

Safari also searches the History list automatically, when it fills in an address
you’re typing. That’s the feature I mention in the earlier section “Visiting
Websites.”

To view your Top Sites display, choose History = Show Top Sites. You can also click
the Top Sites button at the far-left end of the Favorites bar or on the Safari toolbar
(if you’ve added it).

You can add a site to your Top Sites manually by dragging a bookmark from the
Sidebar to the Top Sites icon on the Favorites bar or by dragging a link or URL
address from another application to the Top Sites icon in the Favorites bar. (A plus
sign appears next to your pointer to indicate the addition.) To rearrange screens
in the Top Sites display, just drag a screen thumbnail to the desired location. If
you prefer that a specific thumbnail remain in the same place, hover your pointer
over the thumbnail, and click the gray push-pin icon, which turns blue to indicate
that the thumbnail is pinned in place.

If you’re worried about security and would rather not keep track of where you’ve
been online, find out how to clear the contents of the History file in the upcoming
section “Handling ancient history.”

Tabs Are Your Browsing Friends

142

Safari also offers tabbed browsing, which many folks use to display (and organize)
multiple web pages at one time. If you’re doing a bit of comparison shopping for
a new piece of hardware in different online stores, for example, tabs are ideal.
Heck, tabbed browsing is so popular that Apple added tabs to Finder windows with
the release of OS X Mavericks!

When you hold down the 38 key and click a link or bookmark, a tab representing
the new page appears at the top of the Safari window. Just click the tab to switch
to that page. By holding down Shift+3g, the tab is both created and displayed. (If
you don’t hold down g8, things revert to business as usual, and Safari replaces the
contents of the current tab with the new page.)

You can also open a new tab by clicking the plus sign that appears in the top-right
corner of the Safari window or by pressing 3$8+T. To move among multiple tabs,
simply click the desired tab header. If you’re finished with a page, you can remove
a tabbed page by hovering your pointer over the tab and clicking the X button that
appears.
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FIGURE 8-5:
Hang on, Martha;
we've struck tabs!

TIP

Trackpad fans will appreciate Safari’s two gestures that control tabs. With mul-
tiple tabs active, you can do these things:

3 Pinch to display them all in the All Tabs view display (as shown in Figure 8-5).

3 With All Tabs view open, swipe with two fingers to move among tabs.
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To display your tabs in All Tabs view without a trackpad, click the Show All Tabs
button that appears at the right end of the Safari toolbar. From All Tabs view, you
can click any tab thumbnail to switch immediately to that tab. (Note that the
iCloud Tabs shared from your other Macs and iOS devices appear at the bottom of
the All Tabs view display.) To close a tab in All Tabs view, move your pointer over
the thumbnail, and click the X button that appears. To close the All Tabs view
display, click the Hide All Tabs button at the right end of the Safari toolbar.

The All Tabs view also displays the iCloud Tabs you’ve set on your other Macs
(running OSX Lion or later) and iOS devices (running iOS 7 or later).

To fine-tune your tabbed browsing experience, choose Safari=> Preferences to dis-
play the Preferences dialog, and click Tabs. From there, you can specify whether a
new tab or window automatically becomes the active window in Safari and whether
you want to switch among tabs by pressing g8 +1 through §8+9.
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POWER USERS PIN SITES

Safari also offers pinned tabs, which allow you to jump immediately to a specific page.
Pinned sites hang out at the left end of the Tab bar, usually sporting a recognizable
symbol (taken from the site itself). Unlike the standard tabs that | discuss in this section,
however, pinned tabs are updated automatically in the background from the moment
you launch Safari, which is perfect for sites (like your Facebook page or Twitter feed)
that are constantly changing.

To set a pinned tab, navigate to the page you want to pin, and choose Window=> Pin
Tab. The pinned tab is added to the far-left end of the Tab bar, and you can click it at
any time to return to that page.

To remove a pinned tab, click the tab to switch to that page and then choose
Window= Unpin Tab.

If you open a page that plays audio — as background music or as part of a video
shown on the page — you can click the speaker icon that appears on the tab
header to mute that audio. (Think really, really irritating video advertisements.)
To unmute the audio, click the speaker icon again. You can also display the Website
Preferences sheet to disable autoplay of videos with sound across all the pages on
a website. Choose Safari= Settings for This Website, click the Auto-Play drop-
down menu, and choose Stop Media with Sound to banish those irritating videos
from the current website.

With the arrival of macOS Mojave, tabs can display website icons — commonly
called favicons by the rest of the online world — next to the tab name in the
header. These little critters have to be enabled on the Tab pane of the Safari Pref-
erences window. (No, they’re not a requirement for proper browsing, but many
Mac owners like them as eye candy!)

Printing Web Pages

144

If you’ve encountered a page that you'd like to print, follow these steps:

1. Display the desired page.
2. Choose File=> Print, or press 38+P.

3. Sselect the number of copies, and specify whether you'd like to print the
entire page, only the current page, or a range of pages.

4. Click Print.
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and text colors may conspire to render your printed copy worthless. In a case like
that, use your printer’s grayscale setting (if it has one), or click the Show Details

TIP button at the bottom of the Print sheet and deselect the Print Backgrounds check
box (which can save you quite a bit of ink or toner). Alternatively, you can simply
click and drag to select the text on the page; press 38 +C to copy it; and paste the
text into TextEdit, Microsoft Word, or Pages, where you can print the page on a
less-offensive background (while keeping the text formatting largely untouched).
You can also save the contents of a page as an PDF file by choosing File= Export
As PDF or by clicking the PDF pop-up menu at the bottom of the Print sheet.
Finally, if the page is available in Reader View, you can print it from there and
avoid most color conflicts!

‘ A quick word about printing a page in Safari: Some combinations of background

and choose Email This Page. If you’ve added the Mail button to your toolbar, one
click does the job. Mail loads automatically, complete with a prepared email mes-
TIP sage. Just address the message to the recipients, and click Send.

‘ If you’d rather mail the contents of a web page to a friend, click the Share button,

Protecting Your Privacy

No chapter on Safari would be complete without a discussion of security: protec-
tion against both outside intrusion from the Internet and prying eyes around your
iMac. Hence, this last section covers protecting your privacy.

Although diminutive, the padlock icon that appears to the left of the website’s
name in the Address box when you’re connected to a secure website means a great
deal! A secure site encrypts the information you send and receive, making it much
harder for those of unscrupulous ideals to obtain private data, such as credit card
numbers and personal information. You can click the padlock icon (next to the site
name) to display the security certificate in use on that particular site. A secure
site’s web address begins with the prefix https: instead of http:. (The extra s
stands for secure. A Good Thing.)

Yes, there are such things as bad cookies

First, a definition of this ridiculous term: A cookie, a small file that a website auto-
matically saves on your Mac’s drive, contains information that the site uses on
your future visits. A site may save a cookie to preserve your site preferences for the
next time or — as Amazon.com does — to identify you automatically and help
customize the offerings that you see.
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TIP

In and of themselves, cookies aren’t bad things. Unlike a virus, a cookie file isn’t
going to replicate itself or wreak havoc on your system, and only the original site
can read the cookie that it creates. But many folks don’t appreciate acting as gra-
cious hosts for a slew of little snippets of personal information. (Not to mention
that some cookies have highly suggestive names, which can lead to all sorts of
conclusions. End of story.)

You can opt to disable cookies. You can also set Safari to accept cookies only from
the sites you choose to visit. To change your Cookie Acceptance Plan (CAP, for
those who absolutely crave acronyms), follow these steps:

1 . Choose Safari-> Preferences.
2. Click the Privacy tab.
3. Click Block All Cookies.

If a site’s cookies are blocked, you may have to take care of things manually,
such as by providing a password on the site that used to be read automatically
from the cookie.

Feeling nervous about the data stored by the websites you visit? You can always
delete all that stored information with a single click. On the Privacy pane of the
Safari Preferences dialog, click the Manage Website Data button; then click the
Remove All button. You’ll be asked to confirm your draconian decision.

The Privacy pane also includes the Ask Websites Not to Track <e check box, which
works . . . sometimes. Unfortunately, it’s up to a particular website whether to
honor Safari’s request for privacy. Also, some sites — such as Amazon.com — use
tracking legitimately, to keep track of your likes and purchases each time you
return. Apple includes Intelligent Tracking Prevention within Safari; this feature
is automatic and works behind the scenes, helping prevent unwanted intrusion
into your browsing history. But if you’re especially worried about leaving a trail of
breadcrumbs behind you on the web, I recommend selecting this check box. You
can also choose to block any attempts at cross-site tracking, in which multiple web
sites share tracking information.

Finally, you can limit the access that websites have to your iMac’s Location
Services feature, which can pinpoint your current location, on the Websites tab of
the Safari Preferences dialog. Facebook’s website, for example, uses Location
Services if you allow it to do so. You can set access through prompting or deny
access to Location Services for all websites.
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Banishing pesky iCloud Keychain passwords

I’'m the world’s biggest critic of keychains, which Mojave uses to automatically
provide all sorts of login information throughout the system. In Safari, for
example, the password information is entered for you automatically whenever a
website you’ve approved requires you to log in.

To be more specific, I'm sure that many readers will adopt iCloud Keychain, which
stores password and credit card information for Safari and wirelessly distributes
that information automatically to other Macs and iOS devices that use the same
Apple ID. Apple even says that the passwords generated by iCloud Keychain are
more complex and harder to crack, which sounds more secure, right?

I'd rather keep a pet piranha in a cereal bowl than use this feature! Why? Whenever
you’re logged in, anyone using your shiny iMac Pro gets control of your online
persona (in the form of your passwords to secure websites). Safari, like an obedient
puppy, automatically provides access to sites with stored keychain passwords.

If you'd like to take the far-less-convenient-but-much-safer, old-fashioned
route of remembering your passwords yourself, follow my lead: Visit the iCloud
pane in System Preferences, and deselect the Keychain check box to turn the
iCloud Keychain feature off.

Now that I’ve warned you thoroughly, I feel better about mentioning the Pass-
words tab in Safari Preferences for those who do decide to use iCloud Keychain.
From the Passwords tab, you can view the iCloud Keychain information that Safari
uses and then remove a specific password or all passwords from your iCloud
Keychain.

Handling ancient history

As you might imagine, your History file leaves a clear set of footprints indicating
where you’ve been on the web. To delete the contents of the History menu, choose
History= Clear History (at the bottom of the History menu).

Safari also allows you to specify an amount of time to retain entries in your History
file. Open the Safari Preferences dialog, click the General tab (refer to Figure 8-3),
and click the Remove History Items pop-up menu to specify the desired amount
of time. Items can be rolled off daily, weekly, biweekly, monthly, or yearly. You
can also turn off automatic removal.
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Setting notifications

In Mojave, Safari can allow websites that you’ve approved to send you messages
via Notification Center. You can control which sites have this functionality on the
Websites tab of Safari’s Preferences dialog. To prevent a website from sending
notifications, click the Notifications entry in the list on the left; then choose Deny
from the drop-down menu next to the offending site. You can also remove a web-
site from the list by clicking it and then clicking the Remove button.
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IN THIS CHAPTER

» Introducing iCloud

» Using your iCloud Drive

» Sharing documents with iOS devices
by using Handoff

» Setting iCloud preferences

» Managing iCloud storage

Chapter 9

Expanding Your Horizons
with iCloud

eaders often ask me to name my favorite reasons why they should switch

platforms. In other words, why should a Windows user who thinks all is

well move to the Apple universe? I always mention the superior hardware
and the fact that Mojave is (in my honest opinion) a much better operating system
than Windows 10. My favorite selling point is innovation. Apple comes up with the
best ideas first, and everyone else plays catch-up.

Here’s the perfect example: The folks at Apple got tired of constantly synchroniz-
ing their iOS devices with their computers over a USB cable. Remember those
archaic days? When you took a photo with your iPhone or created a new document
with your iPad, your new additions just sat there in their original locations until
you had a chance to sync your device with your iMac. But with Apple’s iCloud
functionality, your stuff gets automatically synchronized and backed up across the
Internet!

In this chapter, I save you the trouble of researching all the benefits of iCloud.
Heck, that’s one of the reasons you bought this book, right?
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So How Does iCloud Work, Anyway?

FIGURE 9-1:

iCloud works by

pushing data

among all your

150

iOS devices.

Today’s i0S devices can all display or play the same media: photos, music, books,
TV shows, and such. Heck, iOS devices like your iPhone and iPad can even share
applications. Therefore, it makes sense to effortlessly share all your digital media
across these devices, and that’s what iCloud is all about. Apple calls this synchro-
nization pushing.

Here’s how the pushing process works. Imagine that you just completed a Pages
document on your iMac (an invitation for your son’s birthday party), but you’re at
the office, and you need to get the document to your family so they can edit and
print it with your son’s iPad.

Before iCloud, you had to attach the document to an email message or upload it to
some type of online storage, such as Dropbox or Microsoft’s OneDrive; then a
family member had to download and save the document to the iPad before work-
ing with it. With iCloud, you simply save the document on your iMac to the Pages
folder on your iCloud Drive, and macOS automatically pushes the document to the
iPad (using the same Apple ID). Your document appears on the iPad, ready to
be opened, edited, and printed — and it appears on any other devices that use
the same Apple ID as well. Figure 9-1 gives you an idea of what’s happening in the
background when one of your devices pushes data using iCloud.

L] — .

A new Pages Uploaded Stored in iCloud Pushed to other The Pages

document you've i0S devices such document

created and saved as your iPhone automatically
on your iMac and iPad appears on
your iPad

iCloud isn’t limited to digital media, though. Mojave can also automatically
synchronize your email accounts, Calendar events, and Contacts entries with
other i0S devices across the Internet, so staying in touch is much easier (no matter
where you are or which device you happen to be using at the moment).
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Apple also throws in 5GB of free online storage that you can use for all sorts of
things — not only digital media files, but also documents you’d like to save online
for safekeeping. Items you buy through the iTunes Store, iBooks Store, or App
Store — music, video, podcasts, books, and applications — don’t count against
your 5GB limit. (More on how you can expand that 5GB limit later in the chapter.)

To join the iCloud revolution, you need an Apple ID. If you didn’t create one during
initial Mojave setup, you can create an Apple ID from the App Store.

REMEMBER
You can also access your documents through the web at https://www.icloud.com.

Log in with your Apple ID and password to send mail; access your photos, contacts,

@ and calendar; edit your notes and reminders; locate your devices; and use online

versions of Pages, Numbers, and Keynote. (And there’s no need to tote your iMac

with you wherever you go!) Always maintain the security of your iCloud account,

however, especially on public-access computers, and don’t allow any web browser
to save your iCloud password.

TIP

Moving, Saving, and Opening
iCloud Documents

iCloud online storage for your documents is definitely neat. Your iCloud Drive
functions much like other popular online storage services, such as Dropbox and
Microsoft OneDrive, allowing you to save documents, load documents, and move
files to and from your iMac’s drive with ease by using a Finder window. In fact,
iCloud Drive keeps things tidy for you: If you move a file from your iCloud Drive to
your local drive, it’s also deleted automatically from iCloud Drive on your other
Macs and iOS devices that use the same Apple ID. (Mojave prompts you for per-
mission first, of course.)

Figure 9-2 illustrates my iCloud Drive in action. You can access your iCloud Drive
from the Finder window sidebar. Note that iCloud folders are automatically cre-
ated for supported applications, allowing you to click the corresponding iCloud
folder in the application’s Open dialog. (In other words, both your iCloud Drive and
the application-specific iCloud folder are available within the application’s Open
dialog. That’s about as convenient as you can get!)
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Handoff to Work

If you’re like me, your favorite moment in a team track event is the all-important
handoff of the baton from one runner to the next, making Handoff the perfect
name for this Mojave feature, because it actually transfers what you’re doing on
your i0S devices to matching applications on your Mac!

Suppose that you’re using Maps on your iPhone, and you realize that you’d rather
view the location on your iMac’s larger screen (as well as print it on the USB
printer connected to your iMac). If you’re within Bluetooth-signal range of your
iMac, Handoff is ready to go: An icon for the macOS version of Maps automatically
appears on the left side of the Dock in Mojave. One click of that icon, and your
iMac opens Maps and displays the same location.

You’re not restricted to one application, either. Each time you open an application
that Handoff supports (such as Safari and Mail), Mojave offers you the chance to
open the matching application on your iMac and displays the current data from
the iOS app. All this is completely trouble-free: There’s nothing to configure or set.

Caveats? Only three at this writing:

3 Bluetooth is required. For Handoff to work, Bluetooth networking must be
turned on for both the iOS device and the iMac, and the iOS device must be
within a 30-foot radius of the iMac. (That's the maximum distance over which
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Bluetooth hardware can broadcast; walls and other obstructions reduce
that range.)

3 You need the right hardware. To use Handoff, you need an iPhone 5 (or
later), a fourth-generation iPad (or later), any iPad mini, or a fifth-generation
iPod touch (or later). On the computer side, you must have a 2012-model
iMac (or later) that includes Bluetooth LE hardware.

¥ i0S 8 is a must. Handoff is compatible only with iOS devices running iOS 8
or later.

Handoff works in the other direction as well, allowing you to pick up where you
left off on your iMac application by transferring the active session to your iPhone,
iPad, or iPod touch. Swipe the icon that appears on your iOS device to start the ball
rolling.

betwixt your iMac and your iOS devices (or another Mac). This feature is called
Universal Clipboard, and it allows you to copy items on the source device and paste

TIP them on the destination device! The process is automatic: Just copy the item as you
normally would, let iCloud do all the technical stuff behind the scenes, switch to
the other device, and paste the item. (Sorry, Microsoft: Only Macs and iOS devices
need apply.)

‘ Your old friends Copy and Paste can even be used to share text, video or images

Configuring iCloud

You control all the settings for iCloud from Mojave’s iCloud pane in System Prefer-
ences (shown in Figure 9-3). Click the System Preferences icon on the Dock and then
click the iCloud icon. At the sign-in prompt, enter your Apple ID and your password.
Then System Preferences guides you through basic iCloud configuration.

Most of the check boxes on the iCloud Preferences pane control whether a particu-
lar type of data — such as a Contacts entry, password, Mail message, or calendar
in Calendar — is pushed to all your iOS devices.

Note, however, that you can enable three other unique features from this pane:

3 iCloud Drive: If you enable your iCloud Drive (and you definitely should, in my
opinion), you can click the Options button next to the iCloud Drive entry to
specify which applications are allowed to store documents and data there.
You can also click the Look Me Up by Email tab to specify which applications
allow the owners of other Macs or iOS devices to access your Apple ID. If you
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enable the Optimize Mac Storage check box, Mojave keeps a local copy of
your entire iCloud Drive on your internal drive whenever possible. If your
iCloud Drive grows too large to store locally, macOS saves older documents

in your iCloud Drive only within iCloud itself (and you'll need an active Internet
connection to use your iCloud Drive). If you disable the check box, macOS
notifies you if your iCloud Drive becomes too large to store locally.

3 Photos: Click the Options button to turn on iCloud Photos, allowing
macOS to automatically store all your photos and videos online; you can
view them on any Mac or iOS device that uses your Apple ID. Enable the
My Photo Stream check box to allow your iMac to automatically receive
photos from your iOS devices. Take a photo with your iPhone, for example,
and that image is immediately pushed to your iMac and iPad. On Mac
computers, however, Photo Stream goes one step further: The photos
appear automatically in Photos in a special album titled Photo Stream.

You can also enable Shared Albums, which allows you to share photos
with others from Photos.

To turn on these features in Photos, choose Photosc> Preferences, click the
iCloud button, and select the desired check boxes.

REMEMBER 3 Find My Mac: Talk about Buck Rogers! Imagine locating a lost or stolen iMac
from your iPhone or iPad. Now think about this: With Find My Mac, you can
lock or completely wipe your Mac's internal drive remotely, preventing
unauthorized use and erasing your private data! After you access your
iMac from another iOS device, you can play a sound, send a message to be
displayed onscreen, remotely lock the machine, or remotely wipe the drive.

& After you wipe the drive, you can't locate your iMac again.

WARNING
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You can also enable Family Sharing from the iCloud pane, which allows you to
share purchased media and apps with as many as six users’ accounts. Participants
can share a special Photo Stream, apps, and media (purchased from the iTunes
Store, iBooks Store, or App Store), common reminders and a common calendar —
and no, they don’t need to be members of the same family. To launch the Family
Sharing Setup assistant, click the Set Up Family button, and follow the onscreen
instructions.

Managing Your iCloud Storage

FIGURE 9-4:
Checking on your
iCloud storage

TIP

Apple knows that you’re curious about how much space you’ve taken up in your
personal iCloud. To monitor your iCloud storage, click the Manage button in the
bottom-right corner of the iCloud System Preferences pane. On the sheet that
appears — shown in Figure 9-4 — you can see how much space you’re using for
document and data storage.

LJ Q

Manage Storage

Buy More Storage...
627.48 MB of 5 GB available

l: %

il iBooks
- ‘Your photos and videos are using 4.3 GB.

If you want ta stop using iCloud Photo Library and recover
your iCloud storage, you can disable it on all your devices.
You then have 30 days to download your photos and
videos.

2558 photos and 4 videos stored in iCloud

3 Other Documents

Pages

Disable and Delete
o GarageBand

| _one |
iCloud 4.39 GB of 5 GB used
Sign Out Photos and Videos Manage.

Click the data type in the left column, and iCloud displays the amount of storage
space that’s being used for that data. In Figure 9-4, I'm checking the amount
taken by my iCloud Photo Library. Other items that might appear on this sheet
include Mail and selected iPad and iPhone apps that support iCloud.

If you find yourself running out of iCloud storage space, delete any stored item by
selecting it in the list at the right side of the sheet and clicking Delete.
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And if you need more elbow room than 5GB, Apple is happy to provide 50GB,
200GB, or even a whopping 2TB of additional storage for a monthly subscription
fee of 99 cents, $2.99, or $9.99, respectively. (Naturally, these prices are subject
to change.) Click the Manage button on the iCloud pane in System Preferences and
then click the Buy More Storage button to subscribe.
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IN THIS CHAPTER

» Enjoying the advantages of a
multiuser iMac

» Understanding access levels

» Adding, editing, and deleting user
accounts

» Restricting access for managed
accounts

» Configuring your login window
» Sharing files with other users

» Securing your stuff with FileVault

Chapter 10
Creating a Multiuser iMac

verybody wants a piece. (Of your iMac, that is.)

Perhaps you live in a busy household with kids, significant others, grandparents,
and a wide selection of friends, all of them clamoring for a chance to spend time
on the Internet, take care of homework, or enjoy a good game.

On the other hand, your iMac might occupy a classroom or a break room at your
office — someplace public, yet everyone wants his own Private Idaho on the iMac,
complete with a reserved spot on the hard drive and his own hand-picked attrac-
tive Desktop background.

Before you throw your hands up in the air in defeat, read this chapter, and take
heart! Here, you find all the step-by-step procedures, explanations, and tips to

help you build a safe multiuser iMac that’s accessible to all.

(Oh, and you still get to use it, too. That’s not being selfish.)
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Once Upon a Time (An Access Fairy Tale)
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Okay, so you don’t have Cinderella, Snow White, or that porridge-loving kid with
the trespassing problem. Instead, you have your brother, Bob.

Every time Bob visits your place, it seems he needs to do “something” on the
Internet, or he needs a moment with your iMac to bang out a quick message, using
his web-based email application. Unfortunately, Bob’s forays onto your iMac
always result in stuff getting changed, like your Desktop settings, Contacts data-
base, and Safari bookmarks.

What you need, good reader, is a visit from the Account Fairy. Your problem is that
you have but a single user account on your system, and macOS Mojave thinks that
Bob is you. If you turn your iMac into a multiuser system and give Bob his own
account, though, Mojave can tell the difference between the two of you — keeping
your druthers separate!

With a unique user account, Mojave can track all sorts of things for Bob, leaving
your computing environment blissfully pristine. A user account keeps track of
stuff such as:

¥ Contacts entries
¥ Safari bookmarks and settings (sigh)

¥ Desktop settings, including background images, screen resolutions, and
Finder tweaks

¥ iTunes libraries, just in case Bob brings his own music (resigned sigh)

Also, Bob gets his own reserved Home folder on your iMac’s hard drive, so he’ll
quit complaining about how he can’t find his files. Oh, and did I mention that user
accounts keep others from accessing your stuff? And that you can lock Bob out of
where-he-should-not-be, such as certain applications, Messages, Mail, and
websites (including that offshore Internet-casino site that he’s hooked on)?

Naturally, this is only the tip of the iceberg. User accounts affect just about every-
thing you can do in Mojave and on your iMac. The moral of my little tale? A Mark’s
Maxim to the rescue:

Assign others their own user accounts, and let Mojave keep track of everything.
Then you can share your iMac with others and still live happily ever after!
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Big-Shot Administrator Stuff

TIP

MARK'S
MAXIM

Get one thing straight right off the bat: You are the administrator of your iMac.
In network-speak, an administrator (or admin for short) is the one with the power
to Do Unto Others, creating new accounts, deciding who gets access to what, and
generally running the multiuser show. In other words, think of yourself as the
Monarch of macOS (the ruler, not the butterfly).

I always recommend that you have only one (or perhaps two) accounts with
administrator-level access on any computer. This way, you can be assured that no
one can monkey with your iMac while you’re away from the keyboard. So why
might you want a second admin account? Well, if you’re often away on business,
you might need to assign a second administrator account to a trusted individual
who knows as much about your iMac as you do. (Tell him or her to buy a copy of
this book.) Then, if something breaks or an account needs to be tweaked in some
way, the other person can take care of it while you’re absent (but without getting
access to your personal data). Even if it’s just you using your iMac, a second admin
account makes it easier to troubleshoot problems with Mojave (including those
that affect your own user account). If necessary, don’t forget that you can always
log in to your second admin account and change the password to guarantee security!

In the following sections, I explain the typical duties of a first-class iMac
administrator.

Deciding who needs what access

The three most common user account levels are:

3 Admin (administrator): See the preceding section.

¥ Standard level: Perfect for most users, these accounts allow access to just
about everything but don't let the user make drastic changes to Mojave or
create new accounts.

3 Managed with parental controls level: These accounts are standard
accounts with specific limits assigned by you or another admin account.

Another Mark’s Maxim is in order:
Assign other folks standard-level accounts and then decide whether each new

account needs to be modified to restrict access as a managed account. Never assign
an account admin-level access unless you deem it truly necessary.
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TIP

Standard accounts are quick and easy to set up, and I think they provide the per-
fect compromise between access and security. You’ll find that standard access
allows your users to do just about anything they need to do, with minimum hassle.

Managed accounts (with parental controls) are highly configurable, so you can
make sure that your kids don’t end up trashing the hard drive, sending junk mail,
or engaging in unmonitored chatting. (Note: Attention, all parents, teachers, and
anyone designing a single public access account for a library or organization: This
means you.)

Adding users

All right, Mark. Enough pregame jabbering. Show this good reader how to set up
new accounts! Your iMac already has one admin-level account set up for you (cre-
ated during the initial Mojave setup process). You need to be logged in to that
account to add a user. To add a new account, follow these steps:

1. Intheusers& Groups pane (in System Preferences), click the New User
button (plus sign) at the bottom of the accounts list to display the empty
user record sheet shown in Figure 10-1.

If the New User button is disabled and you can't click it, click the padlock in the
bottom-left corner of the System Preferences pane, and provide your pass-
word to unlock the Users & Groups pane.

. Choose the access level for this user from the New Account pop-up menu.

By default, the user receives a standard-level account. You can also choose an
administrator account, a managed standard account with parental controls
already enabled, a group account, or a sharing-only account.

The sharing-only account allows the user to copy or open shared files from
your iMac remotely (from another computer), but that user can't directly log in
to your iMac. The group account allows you to assign access levels based on
the group name that you specify for files and folders.

3. Inthe Full Name text box, type the name you want to display for this
account (both in the Current User list and on the Login screen); then
press Tab to move to the next field.

macOS automatically generates an account name in the Account Name field
for use as your screen and buddy name in Messages and various network
applications. The account name is also the name of the folder that macOS
creates on the computer’s hard drive for this user. You can keep the default
account name or type a new one, but the new name can't contain any spaces.
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FIGURE 10-1:

Fill out those
fields, and you
have a new user.
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Type the password for the new account.

Click the button with the key icon next to the Password field, and Mojave is
happy to display Password Assistant, complete with a suggestion. Click the
Suggestion pop-up menu to see additional suggestions. You can choose the
password's length and choose among several types: letters and numbers,
numbers only, memorable, completely random, or even FIPS-181-compatible
(government-quality). Password Assistant automatically copies the password
you're considering into the Password and Verify text boxes.

As always, when you enter a password or its verification, macOS displays bullet
characters for security.

Press Tab, type the password in the Verify text box, and press Tab again.

(Optional) If you decide to use the password hint feature, you can enter a
short sentence or question in the Password Hint text box.

The hint is displayed after you make three unsuccessful attempts to enter the
account password.

From a security standpoint, password hints are taboo. (Personally, | never use
‘'em. If someone is having a problem logging in to a computer that | administer,
you'd better believe | want to know why.) Therefore, despite the recommenda-
tion that Mojave shows here, | strongly recommend that you skip this field. If you
decide to offer a hint, keep it vague! Avoid hints like “Your password is the name
of the Wookiee in Star Wars.” And don't embed the password in the hint!

Click the Create User button to finish and create the account.

The new account shows up in the Current User list and on the Login screen.

m Login upuuns

+

f_a Click the lock to prevent further changes. ?

New Account: | Standard |~ |
Mark
et Full Name: ord...
Account Name:

John
This will be used as the name for your home folder.

Gueg Password: ?

Werify:

Password hint:
(Recommended)

? Cancel

Enable parental cantrols = Open Parental Controls...
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Each user’s Home folder has the same default subfolders, including Movies,
Music, Pictures, and Sites. A user can create new subfolders within his or her
Home folder at any time.

Here’s one more neat fact about a user’s Home folder: No matter what the account
level is, most of the contents of a Home folder can’t be viewed by other users. (Yes,
that includes admin-level users. This way, everyone using your iMac gets his or
her own little area of privacy.) In the Home folder, only the Sites and Public fold-
ers can be accessed by other users — and only in a limited fashion. (Read all about
Home folders in Chapter 3.)

Modifying user accounts

Next, consider the basic modifications you can make in a user account, such as
changing existing information or selecting a new picture to represent that user’s
unique personality.

To edit an existing account, log in with your admin account, display the System
Preferences window, and click Users & Groups to display the account list. Then
follow these steps:

1 . Inthelist on the left side of the window, click the account you want to
change.

If the accounts in the list are disabled, and you can’t select one, you must
unlock the Users & Groups pane. Click the lock in the bottom-left corner of the
System Preferences pane (and type your password, if prompted).

2. Editthe settings you need to change.

Examples include temporarily enabling administrator rights for an account (by
selecting the Allow User to Administer This Computer check box) and changing
the account password (by clicking the Reset Password button).

3. Click the round picture well (the circle that displays the image) to specify
the thumbnail image that appears in the Login list next to the account
name.

Apple provides several good images in the preview collection. Click a thumbnail
to select it.

4. To replace your account image, drag a new image from a Finder window
or the iPhoto window, and drop it into the picture well.

Note that some of these choices are available only when you're using an
Admin-level account.
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FIGURE 10-2:
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TIP

To choose an image from the default set of Mojave icons: Click the picture well,
click the Defaults tab (see Figure 10-2), click the desired image, and then
click Save.

To take an icon image using your iMac’s FaceTime camera: Click the Camera
tab, click the Take Photo button, and then click Save. (“Say cheese!”)

To choose an image from your Photos collection: Click the Photos tab, click
the desired image, and then click Done.

5. After you make your changes, press 3$5+Q to save them and close the
System Preferences window.
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Standard-level users have some control of their accounts; they’re not helpless, after
all. Standard users can log in, open System Preferences, and click Users & Groups to
change the account password or picture, as well as the Contacts Card assigned to
them in the Mojave Contacts application. All standard users can also set up login
items, which I cover later in this chapter. Note, however, that managed users may
not have access to System Preferences, so they can’t make changes. (Read about
this topic in the upcoming section “Managing an account’s access settings.”)

| banish thee, mischievous user!

Not all user accounts last forever. Students graduate, co-workers quit, kids move
out of the house (at last!), and Bob might even find a significant other who has a
faster cable modem. You can only hope.
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Anyway, no matter what the reason, you can delete a user account at any time. Log
in with your admin account, display the Users & Groups pane in System Prefer-
ences, and then follow these steps to eradicate an account:

1. Inthe user list on the left side of the window, click the account you want
to delete.
2. Click the Delete User button (which bears the Minus Sign of Doom).

macOS displays the confirmation sheet shown in Figure 10-3.

Note that the contents of the user's Home folder can be saved in a disk

@ image in the Deleted Users folder (in case you need to retrieve something).
Alternatively, you can choose to leave the deleted user's Home folder as is,
TIP without removing it (but naturally, you won't regain any space, even though

the user account is deleted).

If you're absolutely sure that you won't be dating that person again, select
the Delete the Home Folder radio button (which doesn't save anything in the
Deleted Users folder). You regain all the drive space that was being occupied
by the contents of the deleted user's Home folder. As an extra measure of
protection, you can choose to securely erase the contents of the deleted
user's Home folder.

3. Dooneofthe following:
To delete the account, click Delete User.

If you're not sure, click the Cancel button to abort and return to the
Accounts list.

— Are you sure you want to delete the user account
| "mac"?
Mearl To delete this user account, select what you want to do with the home rd...
felder for this account, and then click “Delete User™

Save the home folder in a disk image

The disk image is saved in the Deleted Users folder (in the
Users folder).

Don't change the home folder
The home folder remains in the Users folder.

O Delete the home folder

Cancel

FIGURE 10-3: {7 Allow user to administer this computer
This is your last m Login Options Enable parental controls  Open Parental Controls...
chance to save +| =
the stuff from a .
deleted user [ﬂ Click the lock to prevent further changes. ?
account.
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WORKING WITH THE GUEST ACCOUNT

The Guest account is a convenient method of granting someone temporary access to
your iMac. In fact, your guest doesn't even need a password to log in. Your Guest account
has all the attributes of a standard account, so the visitor has little chance of accidentally
(or deliberately) damaging your system. Nevertheless, after the guest user logs out, the
Guest account is flushed, and all the data and files that the person created with that
account are deleted automatically. (This deletion allows the next guest to start with a
clean slate.)

By default, the Guest account is disabled. To turn on this feature, open System
Preferences, click Users & Groups, and then click the Guest User entry in the list. (You
may have to click the lock icon in the bottom-left corner of the Users & Groups pane
and provide your admin password before you can continue.) Click the Allow Guests to
Log In to This Computer check box to enable it.

Oh, don't forget that you can enable specific parental controls for the Guest account,
just as you can for any other standard-level account. This feature should come in handy
if your child has a slumber party coming up this weekend.

Time once again for a Mark’s Maxim:

Always delete unnecessary user accounts. Otherwise, you’re leaving holes in your
Mac’s security.

Setting up login items and
parental controls

Every account on your iMac can be customized. Understandably, some settings are
accessible only to admin-level accounts, and others can be adjusted by standard-
level accounts. In the following sections, I introduce you to the things that can be
enabled (or disabled) in a user account.

Automating with login items

Login items are applications or documents that can be set to launch or load auto-
matically as soon as a specific user logs in, such as Apple Mail or Contacts. In fact,
a user must be logged in to add or remove login items. Even an admin-level
account can’t change the login items for another user.
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A user must have access to the Users & Groups pane of the System Preferences
window to use login items. As you can read in the following section, a user can be
locked out of System Preferences, which makes it more difficult for login items to

rememser  be deleted for that account. (Go figure.) Therefore, if the account is managed, and
access to System Preferences has been turned off, an administrator must enable
the account’s access to System Preferences, allowing the managed user to delete
login items.

To set login items for your account, follow these steps:

1. click the System Preferences icon on the Dock and then click the Users &
Groups icon.

2. Click the Login Items tab to display the settings shown in Figure 10-4.

It bears repeating: You can change Login Items only for the account that's
currently logged in, so be sure that the desired account appears below the
Current User heading in the list on the left side of the tab.

3. Click the Add button (with the plus sign) to display a file-selection sheet.

4, Navigate to the application you want to launch each time you log in, click
it to select it, and then click Add.

If you're in the mood to drag and drop, drag the applications you want to add
from a Finder window, and drop them directly into the list.

5. Press $8+Q to quit System Preferences and automatically save your

changes.
[ N ] < i Users & Groups Q
Password
) Marl( Chambers These items will open autematically when you log in:
Admin
Item Kind Hide
. Johnny Example () TunesHelper Application
€ Dropbox Application
Guest User
To hide an application when you leg in, select the checkbox in the Hide
column next to the application.
m Login Options x
+
FIGURE 10-4:
i
Add apps to your El Click the lock to prevent further changes. ?
Login Items list.
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If the application is running at the moment, you can take an easy shortcut and
avoid these steps. Simply right-click the application icon on the Dock and choose
Options=> Open at Login from the contextual menu that appears.

Login items are launched in the order in which they appear in the list, so feel free
to drag the items into any order you like.

Managing an account’s access settings

A standard-level account with restrictions is a managed account. (You can read
about managed accounts earlier in this chapter in the section titled “Deciding who
needs what access”.) With these accounts, you can restrict access to many places
in Mojave and your iMac’s applications by using parental controls. (Naturally,
admin-level accounts don’t have parental controls because an admin account has
no restrictions.)

In short, parental controls come in handy for preventing users — family members,
students, co-workers, friends, or the public at large — from damaging your files,
your software, or Mojave itself. If an account has been restricted with parental
controls, the account description changes from Standard to Managed in the
Accounts list.

To display the parental controls for a standard account, start here:

1. Log in with an admin-level account.
2. Open System Preferences, and click Users & Groups.

3. Click the desired Standard account in the list, and select the Enable
Parental Controls check box.

If necessary, click the lock icon in the bottom-left corner to confirm your access.

Now click the Open Parental Controls button to display the six categories (tabs)
shown in Figure 10-5:

3 Apps: These settings (which | discuss in more detail in a second) affect what
the user can do in Mojave, as well as what the Finder itself looks like to
that user.

3 Web: Mojave offers three levels of control for websites:

Allow Unrestricted Access to Websites: Select this radio button to allow
unfettered access for this user.

Try to Limit Access to Adult Websites: You can allow Safari to automatically
block websites that it deems to be adult. To specify particular sites that the
automatic “adult filter” should allow or deny, click the Customize button.
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Allow Access to Only These Websites: Choose this radio button to specify
which websites the user can view. To add a website, click the Add (plus
sign) button, and respond to the Mojave prompt for a title and the website
address.

Stores: You can specify whether the user can use the iTunes Store and the
iBooks Store, as well as restrict access within both stores to music, movies,
TV shows, apps, and books by age or rating.

Time: Parents, click the Time button, and you'll shout with joy! Check out
the options on this pane, shown in Figure 10-6. You can limit an account to
a certain number of hours of use per weekday (Weekday Time Limits) and
per weekend day (Weekend Time Limits). You also can set a bedtime com-
puter curfew time for both weekdays (called Bedtime in Figure 10-6) and
weekend days.

Privacy: From this tab, you can individually configure the user’s ability to
launch apps or access social media. Use the convenient check boxes to
allow or prevent changes to the settings used by Location Services, Contacts,
Calendars, Reminders, Twitter, Facebook, and Diagnostic Apps. For even
more control, click the Manage Privacy button to jump immediately to the
Privacy tab of the Security & Privacy pane (allowing you to fine-tune which
apps can access specific data).

Other: These settings control the Dictionary and hardware devices such as
your printer and DVD burner. They include

Turn Off Siri &Dictation: Enable this check box to turn off the Siri voice
assistant and Dictation features in Mojave.

Disable Editing of Printers and Scanners: When this check box is selected,

the user can’t modify the printers and printer queues in the Print & Scan
pane in System Preferences. If this option is enabled, the user can still print
to the default printer and switch to other assigned printers but can't add
or delete printers or manage the macOS print queue. (If the print job
encounters a problem, that user has to bug you to fix things.)

Block CD and DVD Burning in the Finder: Select this check box to prevent the
user from recording CDs or DVDs via the built-in disc-recording features in
macOS. (Note, however, that if you load a third-party recording program,
such as Roxio Toast, the user can still record discs with it — unless you also
disable access to that program in the Apps section.)

Restrict Explicit Language in Dictionary: When this check box is selected,
profane terms in the Dictionary are hidden for this user.
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Prevent the Dock from Being Modified: Select this check box, and the user
can't remove applications, documents, and folders from the Dock in the
full Finder. (This option is a great choice if you dont want the contents of
the Dock changing according to the whims of other users.).

Use Simple Finder: | discuss the Simple Finder later in this section; it's a great
idea for families and classrooms with young children.

[ N ] < eER Parental Controls Q

= Weh Stores Time  Privacy  Other
Johnny Example

‘ 4 Allow use of camera
Applies to built-in cameras in devices and connected displays.

: 2 Allow jeining Game Center multiplayer games
Q. Limit Mail to allowed contacts
=)

@ % Limit Applications on this Mac
: Allow the user to open only the specified applications on this
Mac. An administrator password is reguired to open other
applications.

Allowed Apps: Q
» B Other Apps
= [ Utilities
%
.
fij Click the lock to prevent further changes. Logs... 7

You may want to create a single standard-level account for an entire group of
people to use. Maybe you want to leave the iMac in kiosk mode in one corner of the
office, or perhaps everyone in a classroom will use the same account on the iMac.
Keep your one admin-level account close to your bosom, and create a standard-
level account for the Unwashed Horde.

Mojave keeps different types of text log files, which track where the user goes on
the Internet, the applications launched by the account, and the contents of any
Messages conversations in which the user participated. Click the Logs button on
any Parental Controls screen to monitor all the logs for a particular account.

You can always tell whether an account has been assigned parental controls,
because the account description changes from Standard to Managed in the User list.
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don't have to).

Of particular importance are the Finder and the applications controls. Click the
Apps tab (refer to Figure 10-5) to modify these settings:

3 Allow Use of Camera: Specify whether the account has access to your iMac's
built-in camera. (Note that an external USB Web camera is unaffected by
this setting.)

3 Allow Joining Game Center Multiplayer Games: This check box controls the
user’s access to the multiplayer games in Game Center.

3 Limit Mail to Allowed Contacts: Select this check box to specify the email
addresses that this user can communicate with. (Note that this feature affects
only Apple Mail; other mail clients, web-based mail, instant-messaging
applications, and audio/video chat applications aren’t controlled.) To add
an address to which the user can email, click the Manage button; then click
the familiar Add button bearing the plus sign. To delete an address, click the
Manage button, select the offending address, and click the Delete button
(bearing the minus sign).

If you want a notification if the user is attempting to send an email to some-
one who's not on the list, select the Send Requests To check box and then

type your email address in the text box.
TIP

3 Limit Applications on this Mac: When this option is selected, you can
choose which specific applications the user sees. These restrictions are in
effect whether the user has access to the full Finder or just the Simple Finder.
Click the triangle icon next to the desired group heading in the Allowed Apps
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list to expand the group. To locate a specific application, click the Search box,
and type the application name.

You can fine-tune application limits in several ways by using these controls,
from turning limits off to modifying the access to single applications:

To allow access to all applications: Disable the Limit Applications on This Mac
check box.

To allow or restrict access to all the applications of a specific type: Enable or
disable the check box next to the desired group heading. Clicking the Other
Apps check box to disable it, for example, prevents the user from launch-
ing any of the applications in that group.

To allow or restrict access to an individual application: Select the check box
next to any application to select or deselect it.

To add a new application to the Allowed Apps list, drag its icon from the
Finder, and drop it in the list in the Other Apps group. After you add an
application, it appears in the Other Apps group, and you can toggle access
to it just as you can the applications in the named groups.

These settings can work hand in hand with the Mojave Gatekeeper feature,
which prevents anyone from launching applications that weren't downloaded
from the App Store (or aren’t Apple-approved).

You can restrict your standard-level users even further by assigning them the
Simple Finder set of limitations. The Simple Finder is a highly simplified version
of the regular macOS Finder. It has a basic Dock that contains only the Finder icon;
the Trash icon; and the folders for the user’s approved applications, documents,
and shared files.

The Simple Finder is the network administrator’s idea of a foolproof interface for
macOS: A user can access only the system files and resources needed to do a job,
with no room for tinkering or goofing off.

A Simple Finder user can still make the jump to the full version of the Finder by
choosing Finder=>Run Full Finder and entering an admin-level username and
password.

Would you like to set up a public-access iMac? You can also change the Automatic
Login account from the Users & Groups pane. Click the Login Options button below
the User list and then click the Automatic Login pop-up menu to choose the
account that automatically logs in when macOS starts. On the confirmation sheet
that appears, enter the account password, and click OK. I know — I’ve made it
clear elsewhere that using Automatic Login typically is not smart for security-
conscious iMac owners, but it can be a good feature if you’re preparing an iMac for
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public use. If you set the Automatic Login to your public standard-access account,
macOS automatically uses the correct account if the iMac is rebooted or restarted.

You can always choose Log Out from the & menu to log in under your own account,
or use the Fast User Switching feature I describe in the next section.

Mundane Chores for the Multiuser Laptop
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When you’re hip to user accounts and the changes you can make to them, you can
turn to topics that affect all users of your iMac. These topics include how they log
in, how they can share information with everyone else on the computer, and how
each user account can be protected from unscrupulous outsiders with state-of-
the-art encryption. (Suddenly, you’re James Bond! I told you that Mojave would
open new doors for you.)

Logging in and out in Mojave For Dummies

Hey, how about the login screen itself? How do your users identify themselves?
It’s time for another of my “Shortest books in the For Dummies series” special
editions. (The title is practically longer than the entire book.)

Exploring your login options

Mojave offers four methods of logging folks in to your multiuser iMac, all of which
are available from the Login Options button in any admin account:

3 The username and password login: This screen is the most secure type of
login screen you'll see in Mojave because you have to type your account
username and password. (A typical hacker won't know all the usernames on
your iMac.) Press Return to complete the process.

When you enter your password, you see bullets rather than your password,
because Mojave displays bullet characters to ensure security. Otherwise,
someone could simply look over your shoulder and see your password.

Keep your iMac secure: Use a username and password login, and always
choose a password that's tough to guess.

¥ The list login: This login screen offers a good middle of the road between
security and convenience. Click your account image in the list, and type your
password when the login screen displays the password prompt. Press Return
to continue.
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FIGURE 10-7:
The Fast User
Switching menu,
unfurled for

all to see

¥ Fast User Switching: This feature allows another user to sit down and log in
while the previous user’s applications are still running in the background. This
feature is perfect for a fast email check or a scan of your eBay bids without
forcing someone else off the iMac. When you turn on Fast User Switching,

Mojave displays the active user's name at the right end of the Finder menu bar.

To switch to another account:
1. Click the current user’s name in the Finder menu (see Figure 10-7).
2. Click the name of the user who wants to log in.

Mojave displays the login window, just as though your computer had
rebooted.

The previous user’s stuff is still running, so you definitely shouldn’t reboot
or shut down the computer!

To switch back to the previous user:
1. Click the username on the Finder menu bar again.
2. Click the previous user's name.

For security, Mojave prompts you for that account's login password.

3O LD | F Sunga0PM a 0=
€ =
©

f

Login Window...

Users & Groups Preferences...
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3 Automatic login: This option is the most convenient method of logging in but
offers no security whatsoever. Mojave automatically logs in the specified
account when you start or reboot your iMac.

| strongly recommend that you use automatic login only if:

WARNING Your iMac is in a secure location, such as your home or a locked office.

You can guarantee that you're the only one using your iMac. Period.

You're setting up a public-access computer kiosk, in which case you want
your iMac to log in immediately with the public account.

Are you working in a public environment? Never set an admin-level account as
the auto login account, which is the very definition of an SDI (Supremely
Dumb Idea).

Changing your login settings

To set up a username/password or list login, open System Preferences, click the
Users & Groups icon, and then display the Login Options settings, shown in
Figure 10-8. (If necessary, click the lock icon at the bottom-left corner to confirm
your access.) Here’s a rundown of key login settings:

3 Automatic Login: To set Automatic Login, click the Automatic Login pop-up
menu, and choose the account that Mojave should use.

¥ Display Login Window As: Select the List of Users radio button for a list login
screen, or select the Name and Password radio button to require your users
to type their full usernames and passwords.

3 Show Fast User Switching Menu As: Select this check box to enable Fast
User Switching. Click the pop-up menu to specify how accounts should appear
on the Finder menu bar (as full names, short names, or account icons).

Logging out

Logging out of Mojave all the way (without Fast User Switching) is a cinch. Just
click the # menu and then choose Log Out. (From the keyboard, press $8+Shift+Q.)
A confirmation dialog appears that automatically logs you off in 1 minute. And
that minute is important, because if someone walks up and clicks Cancel, he’ll be
using your iMac with your account! Therefore, it’s a good idea to bypass the con-
firmation dialog by pressing Option while choosing Log Out (or by combining it
with the keyboard shortcut). Your iMac returns to the login screen, ready for its
next victim. Heed this Mark’s Maxim:
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Always click the Log Out button in the logout confirmation dialog before you leave
your iMac (or use the Option key to bypass the confirmation dialog), and double-
check to make sure that the logout completes successfully.

Interesting stuff about sharing stuff

You may wonder where shared documents and files reside on your iMac. That’s a
good question. Like just about everything in Mojave, the answer is simple. The
Users folder on your iMac has a Shared folder within it. To share a file or folder,
place it in the Shared folder.

You don’t have to turn on file sharing in the Sharing pane of System Preferences
to use Shared folders on your iMac. File sharing affects only network access to
your machine by users of other computers.

Each user account on your iMac also has a Public folder in that user’s Home folder.
The Public folder is a read-only folder that other users on your iMac (and across
the network) can access. They can only open and copy the files it contains. (Sorry;
other users can’t create new documents or change existing documents.) Every
user’s Public folder contains a Drop Box folder, where other users can copy or save
files but can’t view the contents. Think of the Drop Box as a mailbox where you
drop off stuff for the other user.
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Encrypting your Home folder can be fun

Allowing others to use your iMac always incurs a risk — especially if you store
sensitive information and documents on your computer. Although your login
password should ensure that your Home folder is off limits to everyone else, con-
sider an extra level of security to prevent even a dedicated hacker from accessing
your stuff. All it takes is a forgetful moment in an office or classroom, and your
personal and business data is suddenly within someone else’s reach. Top-notch
security is a Supremely Good Thing!

To this end, Mojave includes FileVault, which automatically encrypts the contents
of your iMac’s drive. Without the proper key (in this case, your login password or
the FileVault recovery key), the data stored on your drive is impossible for just
about anyone to read. (I guess that the FBI or CIA would be able to decrypt it, but
they’re not likely a worry at your place!)

The nice thing about FileVault is that it’s completely transparent to you and your
users. In other words, when you log in, Mojave automatically takes care of decrypt-
ing your files and folders. You won’t know that FileVault is on the job (which is
how computers are supposed to work).

To turn on FileVault protection for a specific account, follow these steps:

1. click the System Preferences icon on the Dock and then click the Security &
Privacy icon.

2. Click the FileVault tab and then click the Turn On FileVault button.

3. Specify whether your iCloud (Apple ID) account can be used to reset your
P y PP y
password and unlock your disk, and click Continue.

For most iMac owners, the Allow My iCloud Account to Unlock My Disk option
is probably just fine, but if you're security-conscious (or you've shared your
iCloud account information with others), click the Create a Recovery Key and
Do Not Use My iCloud Account radio button.

4. you decide to create a separate recovery key, write down the FileVault
recovery key displayed by Mojave, and store it in a safe place.

To avoid mistakes, you can capture an image of your screen by pressing
$8+Shift+3. The screen shot appears as an image file on your Desktop. You can
open that file and print a copy, or even copy the file to a USB flash drive or
another computer on your network for safekeeping.

Personally, | love the FileVault feature. | use it on all my Macs running Mojave.
Yet a risk is involved (insert ominous chord here). To wit: Do not forget your login
and iCloud account passwords (or make DOGGONE sure that you or your Admin
user have access to a copy of that all-important FileVault recovery key)! macOS
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displays a dire warning for anyone who's considering using FileVault: If you
forget these safeguards, you can't retrieve any data from your iMac’s drive.
Even the smartest Apple support technician will tell you that nothing can be
done. As Jerry Reed used to say, “It's a gone pecan” (with pecan pronounced
Southern style, as “puh-kahn”).

If necessary, click Enable User, provide the login password for each user
on your account, and then click Continue.

Each user on your iMac has to be enabled to use your iMac after FileVault has
been turned on. If you don't know the login passwords for the other user
accounts on your system, you have to ask each person to provide his or her
password to continue. (If an account isn't enabled, that person can no longer
access anything on the hard drive after it has been encrypted.)

Click the Restart button on the confirmation screen.

Your iMac automatically reboots and begins the encryption process. You can
continue to use your computer normally during encryption.

You're done!
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IN THIS CHAPTER

» Considering the benefits of a network

» Choosing between wired and wireless
networks

» Sharing an Internet connection

» Gathering the stuff you need to
network

» Making the network connection
» Using your network

» Protecting your iMac with a firewall

Chapter 11

Working Well with
Networks

n my opinion, network access ranks right up there with air conditioning and the

microwave oven. Like other “I can’t imagine life without them” kinds of tech-

nologies, it’s hard to conceive sharing data from your aluminum supercomputer
with others around you without a network. I guess you could still make use of a
sneakernet (the old-fashioned term for running back and forth between computers
with a floppy disk), but these days, Apple computers don’t even have floppy drives.
(Even with a high-capacity USB 3.0 flash drive, a sneakernet is still a hassle.)

Nope, networking is here to stay. Whether you use a network to share an Internet
connection, challenge your friends to a relaxing game of World War II battlefield
action, or stream your MP3 collection to other computers that use iTunes, you’ll
wonder how you ever got along without one. In this chapter, I fill you in on all the
details you need to know to get your iMac hooked up to a new (or existing) network.
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What Exactly Is the Network Advantage?

If you have other family members with computers, or if your iMac is in an office
with other computers (including those rascally PCs), here’s just a sample of what
you can do with a network connection:

3 Share an Internet connection. This is the major reason why many families and
most small businesses install a network. Everyone can simultaneously use the
same digital subscriber line (DSL) or cable Internet connection on every com-
puter on the network. On a wireless network, even devices like your iPhone
and iPad can take advantage of that same shared Internet magnificence!

3 Share a printer. You say your fellow employee — or, even worse, your big
sister — has a great printer connected to her computer? Luckily, that printer
can be shared with anyone across your network.

3 Copy and move files of all sizes. Need to get a Keynote presentation from
one Mac to another? With a network connection, you can accomplish this
task in seconds. Otherwise, you'd have to copy that file to a USB flash drive,
burn it to a DVD-R, or use an external hard drive. A network connection
makes copying as simple as dragging the project folder from one Finder
window to another.

3 Share documents across your network. Talk about a wonderful collab-
oration tool! You can drop a Word document or Keynote presentation file in
your Public folder (or save it in your iCloud Drive), for example, and ask for
comments and edits from others in your office (or around the planet).

3 Stream music and video. With iTunes, you can share your audio and video
media collection on your iMac with other Macs and PCs (and even devices
such as an Apple TV or an AirPlay speaker system) on your network. Your
eyes and ears can't tell the difference! Using a network connection, you can
also watch streaming TV and movies from services like Netflix and Hulu.

3 Play multiplayer games. Invite your friends over, and tell ‘'em you're host-
ing a LAN party (the technonerd term for a large gathering of game players,
connected through the same network, all playing the same multiplayer game).
You'll see firsthand just how devious a human opponent can be. Each
participant needs to buy a copy of the same game, naturally, but the fun
you'll have is worth every cent you spend. Don't forget the chips!

If your iMac isn’t within shouting distance of an existing network, or you don’t
plan on buying any additional computers or devices, you may not need to create a
network. A lone iMac hanging out in your home with no other companions around
should need a network only for Internet access.
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If you have just your iMac and an Internet connection through a high-speed DSL/
cable modem, and you have no plans to add another computer, wireless equip-
ment, a network printer, or a mobile device, a network probably isn’t necessary.

Should You Go Wired or Wireless?

TABLE 11-1

After you decide that you indeed need a network for your home or office, you have
another decision to make: Should you install a wired network (running cables
between your computers) or a wireless network? Heck, should you throw caution
to the wind and build a combination network with both wireless and wired
hardware?

Your first instinct probably is to choose a wireless network for convenience. After
all, this option allows you to eliminate running cables behind furniture, in the
walls, or in your office ceiling. Ah, but I must show you the advantages of a wired
network as well. Table 11-1 gives you the lowdown to help you make up your mind.

Wireless versus Wired Networks

Factor Wireless Networks Wired Networks
Speed Moderate Much faster

Security Moderate Much better
Convenience Much better Worse

Compatibility Confusing standards Easier to understand
Cables Few (or none) Required

As I see it, here are the advantages of choosing a wired versus a wireless network
setup:
¥ Wired: A wired network offers two significant perks over a wireless network:

Faster speeds: In general, wired networks that are compatible with your
iMac are many, many times faster than the fastest 802.11ac or 802.11n
wireless connections.
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The performance of a wireless connection can be compromised by
interference (from impeding structures, such as concrete walls, and from
household appliances, such as some smartphones and microwave ovens)
and by distance. Wired networks have no such problems as long as you
keep your cables to lengths of 25 feet or less.

Better security: A wired network doesn't broadcast a signal that can be
picked up outside your home or office, so it's far more secure and much
more difficult to breach.

Hackers can attack through your Internet connection, though, even if
you're using a wired network — hence, the final section of this chapter,
“Use Your Firewall!”

¥ Wireless: A wireless connection really has only one advantage, but it's a big
one: convenience (which, in this case, is another word for mobility for all your
networked devices). Laptop owners crave this independence — a freedom
that desktop computer owners can only dream about. What's more, only
wireless networks allow your iOS devices to join the party, as the iPhone and
iPad aren't equipped with Ethernet ports.

Accessing your network anywhere within your home or office — without
cables — is so easy. Connecting a wireless printer is a breeze. And when
you're using an AirPort Express maobile Base Station, even your home stereo
can get connected to your MP3 collection on your iMac. Read more about
base stations later.

GRAFTING WIRELESS ACCESS
TO A WIRED NETWORK

Maybe you're caught in the middle when trying to choose between wired and wireless
networking. Or perhaps you're already using a wired network but are thrilled by the
idea of sitting on your deck in the sunshine, checking your email on your laptop, unteth-
ered. By combining both technologies, you can get the faster transfers of a wired net-
work among all the computers in your office and the freedom you crave.

In my home office, | use a wireless base station that includes a built-in wired switch, a
common feature in today's wireless routers and base stations. My family gets all the
convenience that a wireless network offers, and everyone can connect to the Internet
from anywhere in our house. On the other hand, my three office computers have the
faster performance and tighter security of a wired network. Sassy indeed!
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It’s time to see what’s necessary to share an Internet connection. In the following
sections, I cover two methods of connecting your network to the Internet. (And
before you open your wallet, keep in mind that you may be able to use your iMac
or iMac Pro to share your broadband connection across your network!)

Using your iMac as a sharing device

You can use your iMac to provide a shared Internet connection across a simple
wireless network, using a broadband DSL or cable connection. Because your iMac
has built-in AirPort Extreme wireless hardware, it’s easy to share your cable/DSL
broadband connection wirelessly with other computers in your home or office.

When your iMac is functioning as an Internet-sharing device, your computer uses
Mojave’s built-in Internet-connection-sharing feature to get the job done, but
your iMac must remain turned on to allow Internet sharing. I show you how to do this
in the later section “Network Internet connections.”

Using a dedicated Internet-sharing device

You can also choose to use a dedicated Internet-sharing device (often called an
Internet router) to connect to your cable or DSL modem. You do have to buy this
additional hardware, but here’s the advantage: Your iMac doesn’t have to remain
turned on just so everyone can get on the Internet.

As I mentioned, Internet routers usually include either wired or wireless network
connections, and many include both.

Setting up an Internet router is usually a simple matter, but the configuration
depends on the device manufacturer and usually involves several settings in Sys-
tem Preferences that vary according to the router model. Grab a diet cola, sit down
with the router’s manual, and follow the installation instructions you find there.
(In some cases, you must set up your cable or DSL modem as a bridge between
your ISP and your router, which should be covered in your modem and router
manuals as well.)

Most Internet routers offer a DHCP server, which automatically assigns Internet
protocol (IP) addresses, and I strongly recommend that you turn on this feature!
(You can read more about DHCP later in this chapter, in the sidebar “The little
abbreviation that definitely could.”)
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REMEMBER

Most normal folks — whom I define as those who have never met a network sys-
tem administrator and couldn’t care less — think that connecting to a network
probably involves all sorts of arcane chants and a mystical symbol or two. In the
following sections, I provide you the shopping list you need to set up a network or
connect to a network that’s already running.

Wireless connections

Today’s iMacs come complete with built-in AirPort Extreme wireless hardware,
so if you already have an AirPort Extreme or Express Base Station, you’re all set.
Otherwise, hold on tight while I lead you through the hardware requirements for
wireless networking.

The maximum signal range — and effectiveness — of any wireless network can
be impeded by intervening walls or electrical devices, such as microwave ovens
and some smartphones, all of which can generate interference.

Connecting a iMac to an existing wireless network

Connecting any Mac computer to an existing wireless network requires no extra
hardware, because your hardware is already built in. (Whew. That was easy!)

USING A BASE STATION TO GO WIRELESS

If you decide that you want to build your own wireless network, you eschew cables,
or you want to add wireless support to your existing wired network, you need a
base station. (If you do have an existing wired network, the base station can act as
a bridge between computers using wireless hardware and your wired network,
allowing both types of computers to talk to one another.) Such a wireless base sta-
tion has either:

¥ A port that can connect to your existing wired network’s switch

¥ Afull built-in switch for wired connectivity (which means that you can sell your
old wired Ethernet switch to your sister in Tucson)

And, of course, a base station can simply act as a central switch for your wireless
network (with no support for a wired network).

You can use either a cool Apple Base Station or a boring 802.11ac or 802.11n generic
wireless base station, but the Apple hardware requires less configuration and
tweaking. (Sounds like a Mark’s Maxim!)

PART 3 Connecting and Communicating



If you don’t want the hassle of tweaking PC hardware to accommodate your iMac,
buy Apple hardware and software.

MARK'S
MAXIM

Apple has discontinued all of the Base Station models I discuss in the following

networking hardware.

@ section, so it may take a few visits to eBay to locate the best price on used Apple

REMEMBER

APPLE BASE STATION MODELS

As listed in the upcoming Table 11-2, your iMac can work with four Apple Base
Station models for wireless networking:

»

»

»

»

©

REMEMBER

AirPort Extreme: | recommend using AirPort Extreme if your network needs
an enhanced antenna, which provides greater range. You can read about
connectivity ranges in Table 11-2.

AirPort Time Capsule: Apple’s Time Capsule unit (an external wireless
backup unit) isn't just a wireless remote hard drive. It can also act as a full
AirPort Extreme Base Station. In fact, the wireless specifications for a Time
Capsule unit and an AirPort Extreme Base Station are almost identical.

AirPort Express: | recommend using AirPort Express if you want to:

Carry your wireless base station with you. Express is much smaller than the
other Apple Base Station models. (Think “party on the patio” or a LAN
gaming get-together at a friend's house.)

Extend the range of your existing wireless network. If your network signal
fades by the pool or potting shed, consider adding an AirPort Express at
the edge of your current range to extend the reach of your wireless
network.

Connect your home stereo or speakers for wireless music streaming using
AirPlay. You can connect a pair of speakers to your AirPort Express and
use AirPlay to play music from your iMac's iTunes library. (Heck, you're not
limited to playing the music on your iMac. You can also stream music from
your iPhone, iPad, or iPod touch!)

AirPort: You might find an 802.11g AirPort Base Station on eBay or at a
garage sale. Go ahead and pick it up if you want to save cash unless you're
considering doing multiplayer gaming or performing high-speed file transfers
over your wireless network.

The latest 802.11ac standard used by the AirPort Extreme Base Station and
AirPort Time Capsule delivers a connection that's several times faster than the
old AirPort Base Station’'s 802.11b/802.11g/802.11n standards. 802.11ac is
also compatible with all the older standards — 802.11b/a/g/n — so | highly
recommend that you stick with 802.11ac in the future. It plays well with
others, and at warp speed to boot!
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TABLE 112 Apple Wireless Network Base Stations

AirPort Extreme/ AirPort
Feature AirPort Time Capsule Express
Price (discontinued) (discontinued)
Users (maximum) 50 50
802.11ac support Yes No
802.11n support Yes Yes
802.11g support Yes Yes
802.11b support Yes Yes
LAN Ethernet jack (high-speed Internet  Yes Yes
connection)
WAN Ethernet jack (wired computer Yes Yes
network)
Stereo mini-jack No Yes
USB printer port Yes Yes

& The names of the Apple Base Stations are irritatingly similar; Apple usually does a
better job of differentiating its product names. Jot down the name of your model
on a sticky note on your macOS desktop so you don’t get confused.
WARNING

Installing an Apple Base Station is simple. Follow these steps:

1 . Ifyou have a DSL or cable modem, connect it to the WAN (wide-area
network) port on the Base Station with an Ethernet cable.

2. I you have an existing wired Ethernet computer network with a switch
or router, connect it to the Ethernet LAN (local-area network) port on the
Base Station with an Ethernet cable.

@ Only the AirPort Extreme and AirPort Time Capsule stations have a WAN port.

REMEMBER 3 If you have a USB printer, connect it to the USB port on the Base Station.

‘ | cover the steps for sharing a printer in the later section “Sharing a network
@ printer.”

4. Connect the power cable.
TIP
5. switchon your Base Station.

6. Run the installation software provided by Apple on your iMac.
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NON-APPLE BASE STATIONS

If any company other than Apple manufactured your wireless base station, the
installation procedure is almost certainly the same. (Naturally, you should take a
gander at the manufacturer’s installation guide to make sure, but I’ve added many
brands of these devices, and I used the same steps for each one.)

I should note, however, that Apple wireless hardware uses a slightly different
security encryption standard from most PC wireless hardware. This fact creates an
extra hurdle when you connect to a non-Apple base station or access point with
your iMac. (More on this in the next section. For now, remember that I recom-
mend using Apple wireless hardware with your iMac whenever possible because
the installation process is somewhat easier.)

Joining a wireless network

As far as I'm concerned, the only two types of base stations are Apple and non-
Apple (which includes all 802.11ac, 802.11n, and 802.11g base stations and access
points). In the following two sections, I relate what you need to know to get on
board with either type of hardware.

USING APPLE AirPort BASE STATIONS

To join a wireless network that’s served by any flavor of Apple Base Station, follow
these steps on each Mac with wireless support:

. Click the System Preferences icon on the Dock.

Click the Network icon.

In the Connection list on the left, click Wi-Fi.

Select the Show Wi-Fi Status in Menu Bar check box.

Click the Apply button.

Press 38+Q to quit System Preferences and save your settings.

NoOUAWNS=

Click the Wi-Fi status icon (which looks like a fan) on the Finder menu bar,
and choose an existing network connection you'd like to join.

The network name is the same as the network name you chose when you set
up your AirPort Base Station.

8. i you set up a secure network, enter the password you assigned to the
network during setup.
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AUTHOR
SAYS

By the way, security is always A Good Thing. I strongly recommend that you
enable the password encryption features of your Apple Base Station while install-
ing it. (Luckily, the Apple Base Station setup application leads you through this
very process.) In the words of an important Mark’s Maxim:

Keep uninvited guests out of your network! Use your base station’s security
features, and encrypt your data by using WPA2 encryption!

Some wireless networks may not appear in your Wi-Fi menu list. These networks
are closed networks, which you can specify when you set up your AirPort Base
Station. You can’t join a closed network unless you know the exact network name
(which is far more secure than simply broadcasting the network name). To join a
closed network, follow these steps:

1 . Click the Wi-Fi status icon (which looks like a fan) on the Finder menu bar,
and choose Join Other Network.

2. Type the network’s name.

3. Ifthe network is secured with WPA, WPA2, WEP, or LEAP encryption
(the security standards for protecting your data through encryption),
click the Security pop-up menu, and choose which type of encryption
is being used.

My technical editor and | heartily agree: Simply forget that WEP encryption ever
existed, and never use it! Your best bet is WPA2 encryption, which is the current
standard for home wireless networks.

4. Enter the network password, if required.

To disconnect from a Wi-Fi network, click the Wi-Fi menu and choose Turn Wi-Fi
Off or connect to another wireless network. In other words, if you choose another
available wireless network from the Wi-Fi menu, your iMac automatically drops
the previous connection. (You can be connected to only one wireless network at a
time, which makes Good Sense.)

USING NON-APPLE BASE STATIONS

If you’re using your iMac to connect to a non-Apple base station at your office,
you may need to follow a specific procedure that takes care of the slightly different
password functionality of standard 802.11b/g/n/ac hardware.

Mojave can take care of many potential wireless “language barriers” caused by
security encryption. The two most common forms are WPA2 and WEP. So whether
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you need to massage your password to connect to your non-Apple base station
depends on the specific hardware and encryption system it uses.

To read or print the latest version of this procedure, fire up Safari, visit http://
support.apple.com/kb/index?page=search&locale=en_US&q=, and type HT1126
in the search field. The article provides details on how to convert a standard wire-
less encrypted password to a format that your AirPort Extreme hardware can
understand.

TRANSFERRING FILES THE
EASY AIRDROP WAY

AirDrop is the local Mac-to-Mac file transfer feature built into macOS Mojave, and it
couldn't be easier to use. No setup and no passwords are involved! But it comes with
three caveats:

® AirDrop works only with Macs running Lion and later, and only with specific iMac
models: computers produced in early 2009 or later that support AirDrop.

® AirDrop uses the Wi-Fi and Bluetooth hardware built into today’s Mac laptops and
desktops, so don't forget to turn on Wi-Fi and Bluetooth first. (If you're displaying
the status icons on your Finder menu bar, click the icon, and choose Turn Wi-Fi/
Bluetooth On.)

® You have to be within Bluetooth signal range of another Mac to use AirDrop. Note,
however, that the two computers don't have to be using the same Wi-Fi network.
(My iMac uses a wired connection to my network, but because the iMac has internal
Wi-Fi and Bluetooth hardware, | can use AirDrop to send files to my MacBook Air.)
Because AirDrop uses both your Wi-Fi and Bluetooth connections, file transfers are
significantly slower (and less secure) than they'd be over a wired Ethernet network.

To use AirDrop to transfer files to another Mac, both users should click the AirDrop icon
in any Finder window's sidebar to join the AirDrop group. After a short delay, you see
the account pictures for all Macs within signal range and with AirDrop open. Just drag
the files you want to transfer to the person’s picture. Both you and the recipient are
prompted for confirmation before the transfer begins. When the transfer is complete,
the files you sent are saved in the recipient's Downloads folder.

When you're done using AirDrop, close the Finder window displaying the account pictures
(or click another location in the Finder window's sidebar) to exit the AirDrop group. (Don't
forget that you have to reopen AirDrop if someone wants to send you files. | leave my
AirDrop Finder window open and minimized to the Dock.)
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TIP

Wired connections

If you’re installing a wired network, your iMac already comes with most of what
you need for joining your new cabled world. You just connect the hardware and
configure the connection. Don’t forget that you also need cables and an inexpen-
sive Ethernet switch. (If you’re using an Internet router or other hardware sharing
device, it almost certainly has a built-in four- or eight-port switch.)

Connecting an iMac to a wired network

Your Ethernet 10/100/1000 port (which looks like a slightly oversize telephone/
modem jack) is located on the back of your iMac. It’s ready to accept a standard
Ethernet Cat5/Cat5E/Cat6 cable with RJ-45 connectors.

If you’re connecting to an existing wired network, you need a standard Cats/
Cat5E/Cat6 Ethernet cable of the necessary length. I recommend a length of no
more than 25 feet, because longer cables are often subject to line interference
(which can slow or even cripple your connection). You also need a live Ethernet
port from the network near your Mac. Plug the cable into your iMac and then plug
the other end into the network port on the switch or router.

WIRED NETWORK HARDWARE

If you don’t know your switch from your NIC, don’t worry. Here, I describe the
hardware you need for your wired network.

WIRED NETWORK COMPONENTS

If you’re building your own wired network, you need:

¥ A switch: This gizmo's job is to provide more network ports for the other
computers in your network. Switches built for home use typically come in
four- and eight-port configurations.

As mentioned earlier in this chapter, most Internet routers (sometimes called
Internet-sharing devices) include a built-in switch. So if you've already invested
in an Internet router, make doggone sure that it doesn’'t come equipped with
the ports you need before you go shopping for a switch!

3 Ethernet cables: Exactly how many cables you need is determined by how
many computers and other devices (such as a network printer) you're con-
necting. If you're working with a Gigabit Ethernet system, you need Cat5E or
Catb6 cables. Cat6 cables provide better performance but are more expensive.
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TIP

Naturally, if you’re using a broadband Internet connection, you also have a DSL or
cable modem. These boxes always include a port for connecting to your wired
Ethernet network. (If you have one of the new breed of wireless modems, which
acts as a wireless base station, don’t panic. It should also have a wired port for
connecting to your existing switch.)

WIRED NETWORK CONNECTIONS

After you assemble your cables and your router or switch, connect the Ethernet
cables from each of your computers to the router or switch and then turn on the
device. (Most devices need AC power to work.) Check the manual that comes with
your device to make sure that the lights you’re seeing on the front indicate normal
operation. (Colors vary by manufacturer, but green usually is A Good Color.)

Next, connect your cable or DSL modem’s Ethernet port to the WAN port on your
switch with an Ethernet cable. If your modem isn’t already on, turn it on now, and
check for normal operation.

When your router or switch is powered on and operating normally, you’re ready to
configure macOS for network operation. Just hop to the upcoming section “Con-
necting to the Network.” (How about that? Now you can add network technician
to your rapidly growing computer résumé!)

Joining a wired Ethernet network

After all the cables are connected and your central connection gizmo is plugged in
and turned on, you’ve essentially created the hardware portion of your network.
Congratulations! (Now you need a beard and suspenders.)

With the hardware in place, it’s time to configure Mojave. In this section, I assume
that you’re connecting to a network with an Internet router or switch that includes
a DHCP server. (Jump to the later sidebar “The little abbreviation that definitely
could” for more on DHCP.)

Follow these steps on each Mac running macOS that you want to connect to the
network:

1. click the System Preferences icon on the Dock.

2. Click the Network icon.

3. Inthe Connection list on the left, select Ethernet.

The entry may also be named Ethernet 1, depending on the Mac model you're
configuring. (Make sure that you select the Ethernet entry that doesnt carry the
Wi-Fi fan symbol.)
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4. Click the Configure IPv4 pop-up menu, and choose Using DHCP, as shown
in Figure 11-1.

® 4 i Network Q
Location:  Automatic a

Ethernet 1 75

O ected Y Status: Connected

Ethernet 1 is currently active and has the IP

@ Bluetooth PAN address 192.166.0.106.
Not Connected
iPhone USB Configure IPv4: | Using DHCP a
Not Connected B

o FireWire IP Address: 192.168.0.106

Not Connected
Subnet Mask: 255.2565.255.0
° Thunde...lt Bridge
Not Connected A Router: 192.168.0.1

° r\{Vi—Fi —_— DNS Server:
Off <

Search Domains:

FIGURE 11-1:
All hail DHCP, ey e Advanced... ?
the magic
networking
fairy!
5. clickthe Apply button.
The Apply button is inactive in the figure because my status (in this dialog) is
Connected.
Enjoy the automatic goodness as macOS connects to the DHCP server to
e, obtain an IP address, a subnet mask, a gateway router IP address, and a
6 Domain Name System (DNS) address. (Without a DHCP server, you'd have to
TECHNICAL add all this stuff manually. Ugh.)
STUFF

A few seconds after clicking the Apply button, you should see the information.
You might also notice that the DNS Server and Search Domains fields are
empty. Fear not. macOS is really using DNS server and domain information
provided by the DHCP server.

6. Press $8+Q to quit System Preferences and save your settings.

You're on!
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Connecting to the Network

All right! The hardware is powered up, the cables (if any) are installed and con-
nected, and you’ve configured Mojave. You’re ready to start (or join) the party. In
the following sections, I show you how to verify that you’re connected, as well as
how to share data and devices with others on your network.

Verifying that the contraption works

After you have at least two computers on a wired or wireless network, test whether
they’re talking to each other over the network by pinging them. (No, I didn’t make
up the term. Honest.) Essentially, pinging another computer is like yelling “Are
you there?” across a crevasse.

THE LITTLE ABBREVIATION THAT
DEFINITELY COULD

You know, some technologies are just peachy. (So much for my tber-tech image.)
Anyway, these well-designed technologies work instantly. You don’t have to fling set-
tings around like wrapping paper on Christmas Day. And every computer can use
them — Magc; Windows; Linux; and even the laptops used by funny-looking creatures
from Roswell, New Mexico.

Dynamic Host Configuration Protocol (DHCP for short) is about as peachy as it gets.
This protocol enables a computer to automatically get all the technical information
necessary to join a network. Let me hear you say “Oh, yeah!” Virtually all network
devices can use DHCP these days, including Internet routers, switches, and (go figure)
macOS. Today's networking hardware and operating systems provide a DHCP server,
which flings the proper settings at every computer on the network all by itself. Your
iMac just accepts the settings and relaxes in a placid networking nirvana.

In this book, you can bet the farm that | assume you want to use DHCP and that your
network hardware supports it (which is a virtual certainty with today’s hardware). That
way, | won't spend 30 pages leading you through the twisting alleyways of manual net-
work settings.

If you're connecting to an existing network, tell the network administrator you're
taking the easy route and using DHCP. A warning, however: Adding more than one
DHCP server on a single network will cause a civil war, and your system will lock up
tight. Therefore, before adding hardware with a DHCP server to an existing network,
ask your network administrator to ensure that you aren’t making a mistake.
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To ping another computer on the same network from any Mac running Mojave,
follow these steps:

1.  Click the Siri icon on the Finder menu bar.

2. Say “Launch Network Utility” to launch the application.

3. Click the Ping tab, as shown in Figure 11-2.

200 Metwork Utility

Info  Metstat Lookup  Traceroute  Whois  Finger  Port Scan

Enter the network address to ping.

182.168.0.102 {ex. 10.0.2.1 or www.example.com)

Send an unlimited number of pings
2 Sendonly |5 pings

Ping has started.

PING 192.168.0.122 (192.168.8.102): 56 data bytes

64 bytes from 192.168.0.102: icmp_seqg=0 tt1=128 time=6.419 ms
B4 bytes from 192.168.@.182: tt1=128 ti .B@5 ms
64 bytes from 192.168.8.182: i tt1=128 ti L7909 ms
64 bytes from 192.168.8.102: i tt1=128 ti .827 ms
B4 bytes from 192.168.@.182: tt1=128 time=54.168 ms

-— 102.168.0.102 ping statistics —-
5 packets transmitted, 5 packets received, @.0% packet loss
round-trip minfavg/max/stddev = 3.7908/14.422/54.168/19.68%8 ms

FIGURE 11-2:
Look, Ma, I'm
pinging!
4. Inthe Enter the Network Address to Ping text field, enter the IP address
of the computer you want to ping.
If you're pinging another Mac running macQS, you can get that machine’s IP
address simply by displaying its Network pane in System Preferences,
which always displays the IP address.
REMEMBER

If you're trying to ping a PC running Windows, and you don’t know that
machine’s IP address, follow these steps:

(@) In Windows 7, click Start, right-click Network, and then choose Properties
from the contextual menu. In Windows 8, 8.1 or 10, display the Control
Panel, and click Network and Sharing Center.

(b) Click Change Adapter Settings, right-click your Local Area Network connec-
tion icon, and choose Status from the contextual menu.

(c) Click the Details button.

The IP address of that computer is proudly displayed.
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OLAOD,
TECHNICAL
STUFF

TIP

5. Sselect the Send Only x Pings radio button, and enter 5 in the text field.
6. Cclick the Ping button.

Yay: If everything is working, you should see results similar to those shown
in Figure 11-2, in which I'm pinging my Windows server at IP address
192.168.0.102 across my wired Ethernet network.

The address 192.168.0.xxx is a common series of local network IP
addresses provided by Internet routers, hubs, and switches with DHCP
servers, so don't freak if you have the same local IP address. Similarly,
Apple tends to use the form 10.0.1.xxx for local networks.

Nay: If you don't get a successful ping, check your cable connections, power
cords, and macOS settings. If you're using a wireless connection, you may
have to move closer to the network base station to connect successfully,
especially through walls.

If all is well, you should also be able to see the other local computers connected to
your network from any Finder window. Just click the Network heading on the
sidebar.

Sharing stuff nicely with others

It works! By golly, it works! Okay, now what do you do with your all-new shining
chrome network connection? Ah, my friend, let me be the first to congratulate you
and the first to show you around! In the following sections, I cover the most popu-
lar network perks. (The good news is that these perks work with both wired and
wireless connections.)

Network Internet connections

If your DSL or cable modem plugs directly into your iMac (rather than into a ded-
icated Internet-sharing device or Internet router), you might ponder just how the
other computers on your network can share that spiffy high-speed broadband
connection. If you’re running a wireless network, it comes to the rescue!

Follow these steps to share your connection wirelessly:

1. click the System Preferences icon on the Dock.
2. Clickthe Sharing icon.
. Click the Internet Sharing entry in the Services list to the left of the pane.

From the Share Your Connection From pop-up menu, choose Ethernet.

T I T

. Select the Wi-Fi check box (in the To Computers Using list).
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6. select the On check box next to the Internet Sharing entry in the
Services list.

Mojave displays a warning dialog stating that connection sharing could affect
other computers on your network. If you intend to share the Internet connec-
tion provided on an existing network at your home or office that you didn't set
up, contact your network administrator first! (It's best to avoid sowing chaos
and disorder.)

7. click Startin the warning dialog to continue.

8. Click the Close button to exit System Preferences.

Sharing an Internet connection (without an Internet router or dedicated hardware

device) through macOS requires your computer to remain on continuously. Remind

others in your office or home that your svelte iMac must remain on; otherwise,
rememeer  they’ll lose their Internet connection!

Don’t forget — you don’t need to configure Internet sharing if your DSL or cable
modem connects to a dedicated sharing device or router. That snazzy equipment
automatically connects your entire network to the Internet.

Network file sharing

You can swap all sorts of interesting files with other computers on your network.
When you turn on file sharing, Mojave allows all computers on the network to
connect to your iMac and share the files in your Public folder. (Note that sharing
across a network is different from sharing a single computer among several peo-
ple. I cover that environment in Chapter 10.)

Follow these steps to start sharing files and folders with others across your
network:

1. click the System Preferences icon on the Dock.

2. Click the Sharing icon.

3. Select the On check box next to the File Sharing service entry to enable
the connections for Mac and Windows sharing.

Other Mac users can connect to your computer by clicking Go on the Finder
menu and choosing the Network menu item. The Network window appears,
and your iMac is among the choices. If the other Macs are running Mojave,
your iMac’s shared files and folders appear in a Finder window, and they're
listed below the Shared heading in the sidebar.
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TIP

Vista/Windows 7 users can use the Network window to connect to your Mac.
Windows 8, 8.1 and 10 users should head to the Network panel. Those lucky
Windows folks also get to print to any shared printers you've set up. (The
following section covers shared printers.)

4. Click the Close button to exit System Preferences.

Mojave conveniently reminds you of the network name for your beloved iMac at
the top of the Sharing pane.

Sharing a network printer

I love describing easy procedures, and sharing a printer on a Mac network ranks
high on the list! You can share a printer that’s connected to your iMac (or your
AirPort Extreme, AirPort Time Capsule, or AirPort Express Base Station) by fol-
lowing these simple steps:

1. click the System Preferences icon on the Dock.

2. Click the Sharing icon.

3. Select the On check box next to the Printer Sharing service entry.

4. Inthelist at the right of the System Preferences window, select the check
box next to the printer you want to share.

5. Cclick the Close button to exit System Preferences.

A printer you share automatically appears in the Print dialog on other computers
connected to your network.

Use Your Firewall!

MARK'S
MAXIM

Yep. That exclamation point tells you how important this section is.
The following Mark’s Maxim, good reader, isn’t a request, a strong recommenda-
tion, or even a regular Maxim. Consider it to be an absolute command (right up

there with “Pay your taxes”).

Turn on your firewall now.

CHAPTER 11 Working Well with Networks 197



198

When you connect a network to the Internet, you open a door to the outside world.
As a consultant to several businesses and organizations in my hometown, I can
tell you that the outside world is chock-full of malicious individuals who dearly
love to inflict damage on data and would like to take control of your pristine iMac
for their own purposes. Call ’em hackers, call ’em delinquents, or call ’em some-
thing I can’t repeat, but don’t let them in!

Mojave comes to the rescue again with the built-in firewall in macOS. When you
use the firewall, you essentially build a virtual brick wall between yourself and the
hackers out there (both on the Internet and within your local network). Follow
these steps:

1. click the System Preferences icon on the Dock.

2. Click the Security & Privacy icon.

3. Click the Firewall tab.

4. Click the Turn On Firewall button to activate your firewall.
5. Click the Firewall Options button.

6. select the check box titled Automatically Allow Built-In Software to
Receive Incoming Connections.

7. select the check box titled Automatically Allow Downloaded Signed
Software to Receive Incoming Connections.

8. Select the Enable Stealth Mode check box.

This important feature prevents hackers from trolling for your iMac on the
Internet — or, in normal-speak, searching for an unprotected computer — so
it's much harder for them to attack you. (Stealth mode also prevents other
computers from pinging you, so don't be surprised if your iMac suddenly clams
up if you try to ping it.)

9. click ok.

10. click the Close button to exit System Preferences.

Mojave even keeps track of the Internet traffic that you do want to reach your
iMac, such as web page requests and file sharing. When you activate one of the
network features described in the section “Sharing stuff nicely with others,”
Mojave automatically opens a tiny hole (called a port by net types) in your firewall
to allow just that type of communication with your Mac.

If you decide to turn on printer sharing, for example (as described in the preceding
section), Mojave automatically allows incoming print jobs over the network from
other computers.

PART 3 Connecting and Communicating



You can also add ports for applications that aren’t on the firewall’s Allow list, such
as third-party instant messaging clients and multiplayer game servers. Depend-
ing on the type of connection, Mojave often displays a dialog prompting you for
confirmation before allowing certain traffic, so you probably won’t need to do
anything manually.

You can manually add a program to your list of allowed (or blocked) firewall ports.
Follow these steps:
1. click the System Preferences icon on the Dock.
2. Click the Security & Privacy icon.
3. Click the Firewall tab and then click the Firewall Options button.
4. Click the Add button (which carries a plus sign).
Mojave displays a standard file-browsing sheet.

5. Browseto the application that requires access to the outside world — or
the application that you want to block from outside communication —
and click it to select it.

6. Click the Add button on the File sheet.

The application appears in the Firewall list. By default, it's set to Allow Incoming
Connections.

7. If you want to block any communications coming into the application,
click the Allow Incoming Connections pop-up menu, and choose Block
Incoming Connections instead.

8. Click the Close button to exit System Preferences.
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IN THIS CHAPTER

» Adding a printer or a scanner to your
system

» Using Photo Booth

» Connecting with friends and family
using FaceTime

Chapter 12
Hooking Up with
Handy Helpers

his chapter is all about getting interesting things into — and out of — your

iMac. Some of the devices I mention are mundane and pretty easy to take

care of, such as scanners and printers. Then I might surprise you with
something new to you, such as your iMac’s built-in FaceTime HD video camera,
which gives you the ability to place and receive video and audio calls to friends and
family on their Macs, iPhones, and iPads.

Heck, I also show you how to turn your iMac into an old-fashioned photo booth,
just like the expensive models at your local mall or amusement park. Think “iMac
selfies” at your next party — complete with outrageous effects!

Connecting Printers

All hail the USB port! It’s the primary connection point for all sorts of goodies. In
this section, I concentrate on adding a local USB printer and the basics of adding
a network printer to your system. (Find more on connecting a wireless Bluetooth
printer in the Bluetooth Bonus Chapter at www.dummies . com.)
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USB printers

Connecting a USB printer to your iMac is duck soup. Don’t you wish all things in
life were this easy? You may very well be able to skip most of the steps in this sec-
tion, depending on whether your printer came with an installation disc. (Virtually
all printers do, of course, but you might have bought yours used, say, from eBay.)

“aés Your printer needs to be fully supported within macOS:

TECHMICAL % If the software is designed for earlier versions of OS X (say, 10.9 or 10.10),
it probably works with Mojave.

¥ | always recommend visiting the manufacturer's website to download the
latest printer driver and support software before you install your printer.
That way, you know that you're up to date. (Don't forget to check the Read Me
file that accompanies your new software to make sure that no new system
requirements have come about!)

& Save and close open files and applications before installing your printer. You may
have to restart your iMac to complete the installation.

WARNING . . . .
The physical connections for your printer are pretty simple:

¥ Make sure that your printer's USB cable is plugged into both your iMac and
the printer itself. (Naturally, you'll use one of the iMac’'s USB ports on the back
of the computer unless you've already added a USB hub to expand your
external horizons.)

¥ After the USB connection is made, plug the printer into an AC wall socket, and
turn it on.

Don’t forget to add the paper, check the ink or toner cartridge(s), and remove all
the packing material from your printer!

REMEMBER
Additional printer installation steps depend on whether you have the manufac-

turer’s installation software for your printer.

Sure, I've got the install software

If your printer comes with its manufacturer’s installation disc (and you have an
external optical drive), follow these steps when everything is connected and
powered on:
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TIP
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TIP

©

REMEMBER

1. Insert the installation disc into the iMac’s optical drive.

Don't have an optical drive? Download the printer’s installation software from
the manufacturer’s website as a disk image file (ending with the extension
.dmg), and simply double-click that file. macOS displays it on your Desktop just
as though it were an external drive. Now you can follow along with the rest of
the steps in this procedure.

The disc contents usually appear in a Finder window. If they don't, double-click
the installation disc icon on the Desktop to open the window.

N

Double-click the installation application to start the ball rolling.
3. Follow the onscreen instructions.
Files get copied to your drive.

You may have to restart your iMac.
You’re ready to print!

Don’t forget to visit your printer manufacturer’s website to check for any driver
updates for your particular model.

Whoops, I've got diddly-squat (software-wise)

Didn’t get an installation CD? Try installing the printer without software, or
download the software from the manufacturer’s website.

INSTALLING WITHOUT SOFTWARE

If you didn’t get an installation CD with your printer (or you can’t locate the
installation software to download), you maybe lucky enough that your printer’s
driver was included in your installation of macOS. First, press $8+P within an
application to display the Print dialog, where you can check whether the printer
you connected is already recognized.

If it’s not displayed, here’s how to check for that pesky driver after you connect
the printer and switch it on:

1. Open the System Preferences window.

2. Click the Printers & Scanners icon.
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3. Check the Printer list on the left side of the window to see whether your
printer has been added automatically within macOS.

If your printer appears here, dance a celebratory jig. You can close System
Preferences and choose that printer from the Print dialog in your applications.
(You can even set it as the default from the System Preferences Printers &
Scanners pane. Just click the Default Printer pop-up menu to choose your new
printer.)

DOWNLOADING SOFTWARE

If you don’t have installation software, and your iMac doesn’t automatically
match your USB printer with a driver, it’s time to check the Internet to locate a
Mojave???—compatible driver for your printer.

Check the manufacturer’s website for your printer’s software and any additional
information for operating your printer under macOS Mojave. Look for:

3 Special software drivers that the printer may need: Install any drivers you
find before you run an installation application. The installation app may not be
able to recognize or configure the printer if the driver hasn't been installed.

3 Technical documents or FAQs covering your printer under Mojave: | make
it a practice to check for FAQ files for every external device | add to my iMac!
Although these documents may not qualify as “riveting” reading, they often
provide feature descriptions and troubleshooting solutions that you'll find
nowhere else.

3 An installation application: If the manufacturer offers an installation
application for your printer, download and run the application.

Network printers

Your wired or wireless Ethernet network provides a quick and easy way to share
any printer that’s already connected to your iMac. Follow these steps to share your
printers across the network with others:

1. click the System Preferences icon on the Dock.

2. Click the Sharing icon.

3. Select the On check box next to the Printer Sharing service entry.

. Click Close to exit System Preferences.
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In most cases, a printer that you share appears automatically in the Print dialog
on other computers connected to your network. Therefore, if you want to access a
printer being shared by another Mac across your network, open the Print dialog
within your application, and click the Printer pop-up menu to choose it.

If the remote printer isn’t listed automatically, you can dig a little further. To add
a printer that another Mac on your network is sharing to your list of printers, fol-
low these steps:
1. click System Preferences on the Dock.
2. Click the Printers & Scanners icon.
3. Click the Add button (which carries a plus sign).
4. Cclick the Default button on the toolbar.
macOS displays all the available local shared printers.
5. Cclick the desired printer and then click Add.

Depending on the built-in support within macQS for the printer you're
accessing or sharing, you may have to install the driver on your iMac or the
other Macs on your network as well.

Connecting Scanners

TIP

USB scanners practically install themselves. As long as the model is listed as
macOS-compatible and supports the TWAIN device standard (as just about all
scanners do), things really are plug-and-play. (Not sure whether a scanner is
macOS-compatible? Check the system requirements on the scanner’s box or on
the manufacturer’s website.)

If you have the scanner manufacturer’s installation disc, go ahead and use it. Most
scanners don’t require specialized drivers, however, so even that orphan model
that you picked up from Uncle Milton last year should work (if it’s recognized by
mac0S). It doesn’t hurt to check the manufacturer’s website to see whether any of
the software has been updated since the disc was produced.

If macOS doesn’t support your older scanner, a third-party application maybe
able to help. Get thee hence to Hamrick Software at https://www.hamrick.com,
and download a copy of the latest version of VueScan. This great scanning appli-
cation supports thousands of scanner models, including several that don’t work
with Mojave otherwise. At $40, it’s a world-class bargain to boot.

CHAPTER 12 Hooking Up with Handy Helpers 205


https://www.hamrick.com/

AUTHOR
SAYS

Ready to go? Make sure that your scanner is powered on and connected to your
iMac (and that you load a page or photograph to scan). If your scanner’s installa-
tion disc provided a proprietary scanning application, I recommend that you use
that application to test your scanner. In fact, it’s Mark’s Maxim time!

If your printer or scanner includes bundled applications, try them!

Sure, macOS has the Printers & Scanners pane within System Preferences for
printers and the Image Capture application for scanners and digital cameras, but
these tools are bare-bones compared with the print manager and image acquisition
software that comes bundled with your hardware. I turn to the built-in hardware-
handling stuff that comes with macOS only when I don’t have anything better.

Hey, I’m not saying that anything’s wrong with Image Capture (which is in your
Applications folder, in case you need to use it). But don’t expect Image Capture to
support any specialized features offered by your scanner, such as one-button
email or web publishing. You have to use the application especially designed for
your manufacturer and model to take advantage of any extras that it offers. For
alternatives, many image-editing applications (such as Adobe Photoshop and
Photoshop Elements) may offer more scanning features than Image Capture.

Using Photo Booth

206

TIP

Many Apple Switchers and first-time owners quickly notice the tiny square lens
and LED light at the top of the iMac’s svelte frame. What gives?

Mystery solved, good reader: That’s the lens of your iMac’s built-in FaceTime HD
camera, which allows you to capture video or snap a quick, fun series of photos via
the Photo Booth application that comes with macOS.

What’s that, you say? You've never used a computer video camera? Well then,
good reader, you’ve come to the right place!

The FaceTime HD camera’s indicator light glows green whenever you’re taking a
snapshot or recording video . . . which, when you think about it, is A Good Thing
(especially if you prefer chatting at home in Leisure Mode).

If you need a quick picture of yourself for use on your web page, or perhaps your
user account icon needs an update to show off your new haircut, use Photo Booth
to capture images at 1080 x 720 resolution (on the iMac) or true 1080p resolution
(on the iMac Pro). Although today’s digital cameras can produce a much-higher-
quality photo, you can’t beat the built-in convenience of Photo Booth for that
quick snapshot!
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To snap an image in Photo Booth, follow these steps:

1. Launch Photo Booth from the Spotlight box or from Launchpad.
To try things out in full-screen mode, choose Viewr>Enter Full Screen.
2. Choose to take one image, four quick photos as a group, or digital video.

The three buttons in the bottom-left corner of the Photo Booth window allow
you to switch among taking one photo, four photos in a row (arranged as a
square group, like an arcade photo booth), or a movie clip.

3. (Optional) Click the Effects button to choose an effect you'd like to apply
to your image.

Photo Booth displays a screen of thumbnail preview images so that you can
see how each effect changes the photo (see Figure 12-1). To move through the
thumbnail screens, click the Previous and Next arrow buttons that appear at
the bottom of the window.

You can produce some of the simple effects you maybe familiar with from
Photoshop, such as a black-and-white image or a fancy colored-pencil filter,
but you can also play with some mind-blowing distortion effects and even very
convincing faux thermal and X-ray cameras!

You can always launch your favorite image editor afterward to use a filter or effect
on a photo (such as the effects available in the Photos application), but Photo
Booth can apply these effects automatically as soon as you take the picture.

eCe Photo Booth

FIGURE 12-1: \J !’v&

Photo Booth
does one thing

particularly well: 4 e e o o p  Effects
special effects.

[}

L —I' ]
Glow y, Thermal Camera
~
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4, (Optional) Click a thumbnail to apply the desired effect.

When you choose an effect, Photo Booth automatically closes the Effects
display.

To return the display to normal, click the Normal thumbnail, which appears in
the center. (Um, that would be Paul Lynde’s spot, for those of you old enough
to remember Hollywood Squares.)

TIP

5. Click the red Camera button.

The image (or video clip) appears in the filmstrip at the bottom of the window.

Photo Booth keeps a copy of all the images and clips you take in the filmstrip so
that you can use them later. After you click a photo or film clip in the filmstrip, the
familiar Share button appears in the bottom-right corner of the window, inviting
you to take any of a series of actions, including:

¥ Sending the photo in an email or as a Messages attachment
¥ Saving the photo directly to Photos
¥ Sharing the photo or video on Twitter, Facebook, or Flickr

¥ Using the image as your macOS user account icon

WHO NEEDS A FANCY GREEN SCREEN?

Ever admired the animated background behind your favorite TV weather prognostica-
tor? Believe it or not, you don't need an expensive green-screen backdrop (and time
spent in a video-editing application) to create the same effect. Instead, use Photo Booth
to create those outrageous images and video clips! Photo Booth provides a surprising
array of visual effects you can use.

Within Photo Booth, click the Effects button to start the ball rolling and then click the
right arrow next to the Effects button until you reach the series of thumbnails with
names like Hologram, Pop Art, Fish, and Rollercoaster. These are the animated back-
grounds. Click a background, and Photo Booth asks you to step outside the frame for a
second so that your iMac can detect the patterns behind you. When the background
animation begins, step back into the frame, and capture your image or video clip. (Just
as you do with a real green-screen backdrop, you get the best results if you shoot your
images and video in front of a blank white wall.)

You're not limited to the Apple animated backgrounds: Use your own image or video
clip by choosing one of the eight predefined User Backdrop thumbnails.
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TIP

To delete an image from the Photo Booth filmstrip, click the offending photo and
then click the X button that appears in the top-left corner of the thumbnail.

Conversing with FaceTime

©

REMEMBER

With Apple’s FaceTime technology, you can video-chat with owners of i0S devices
and Macs, and if they can run FaceTime, they’re guaranteed to have the right
video hardware!

At this writing, the minimum requirements for FaceTime-compatible devices
include:

¥ Macs running OS X 10.9.2 (or later)
¥ AniPhone 4/4s or 5/5s/5c running iOS 4.1 (or later)
¥ Asecond-generation iPad (or later)

¥ Afourth-generation (or later) iPod touch running iOS 4.1 (or later)

If you’re running a mobile device under iOS 6 or later, you can use either a Wi-Fi
or cellular connection to use FaceTime, and your iMac requires either a wired or
Wi-Fi connection to the Internet.

To launch FaceTime, click the Launchpad icon on the Dock, and click the jaunty-
looking video camera icon. (Naturally, you can also use Spotlight to launch the
application.) The first time you use the application, you have to enter your
Apple ID and your email address. The folks you chat with on the other end use that
same email address to call you via FaceTime. (You can call iPhone owners by
using their telephone numbers.)

After you sign in, you can initiate a call with any contact by clicking the Search box
near the top of the FaceTime window and typing the desired name, email address,
or phone number. Click the email or telephone number that FaceTime should use,
and the connection process begins.

Apple isn’t satisfied with providing access to your Contacts list, however. You can
use the Recent Calls list (which appears along the left side of the window) to
choose a contact whom you’ve called or attempted to call, or who has called you
within the recent past. Click the Video or Audio buttons at the top of the window
to further filter the Recents list, displaying only the recent video calls or audio-
only calls.
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When the call is accepted, you see a large video window with a smaller picture-in-
picture display. The video of the other person fills the large window, and the video
that you’re sending to that person appears in the small display. Click the End icon
to end the FaceTime call.

To switch FaceTime to Landscape mode and take advantage of your iMac’s
widescreen display, choose Video=>Use Landscape or press 38 +R. (Why let iPhone,
iPod touch, and iPad owners have all the landscape fun?)

TIP
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Living the
Digital Life



IN THIS PART ...

Build the digital media library of your dreams with
iTunes.

Create slideshows and share memories with Photos.
Put your moviemaking talents to work with iMovie.

Use GarageBand to compose and record your own
music.



IN THIS CHAPTER

» Playing music with your iMac

» Arranging and organizing your music
collection

» Tuning into the world with Internet
radio

» Sharing your songs across a network
» Creating eye candy with Visualizer

» Buying the good stuff from the iTunes
Store

Chapter 13

The Multimedia
Joy of iTunes

ometimes, words just aren’t enough. iTunes is that kind of perfection.

To envision how iTunes changes your iMac, you have to paint the picture with
music — music that’s easy to play, search for, and transfer from device to device.
Whether you like classical, alternative, jazz, rock, hip-hop, or folk, I guarantee
you won’t find a better application than iTunes to fill your life with music. And
podcasts. And video. And TV shows. And online education. And ringtones. And
Internet radio. (See how hard it is to pin down this wonderful application? Along
with your iMac, iTunes really does form the hub of your digital lifestyle.)

In this chapter, I lead you through all the features of my absolute-favorite Apple

application. (It’ll be pretty doggone obvious how much I appreciate this piece of
software.)
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What Can | Play on iTunes?
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Simply put, iTunes is a media player that plays audio and video files. These files
can be in any of many formats. iTunes supports these common audio formats:

»

»

»

»

»

»

»

»

»

MP3: The small sizes of MP3 files make them popular for file trading on the
Internet. You can reduce MP3 files to a ridiculously small size (albeit at the
expense of audio fidelity), but a typical CD-quality, three-minute pop song in
MP3 format is 3MB to 5SMB.

AAC: Advanced Audio Coding is an audio format that's similar to MP3 but offers
offer better recording quality at the same file sizes. This format, however, is
somewhat less compatible with non-Apple music players and software. (Luckily,
you can still burn AAC tracks to an audio CD, just as you can MP3 tracks.) The
tracks that you download from the iTunes Store are in AAC format, and AAC
music files are becoming more popular for downloading on the Internet.

Apple Lossless: Another format direct from Apple, Apple Lossless format (also
known as ALAC) provides the best compromise between file size and sound
quality. These tracks are encoded without loss of quality, although Apple
Lossless tracks are somewhat larger than AAC. This format is generally the
favorite of discerning audiophiles.

AIFF: This standard Macintosh audio format produces sound of the absolutely
highest quality. This high quality, however, also means that the files are pretty
doggone huge. AIFF recordings typically require about 10MB per minute of audio.

WAV: Not to be outdone, Microsoft created its own audio file format (WAV),
which works much like AIFF. It can reproduce sound at a higher quality than
MP3, but the file sizes are very large, similar in size to AIFF files.

CD audio: iTunes can play audio CDs. Because you usually don't store CD
audio anywhere but on an audio CD, file size is no big whoop — but again,
10MB of space per minute of music is a good approximation.

MP2: A close cousin of the far more popular MP3 format, MP2 is the preferred
format in radio broadcasting and is a standard audio format for HDV cam-
corders. It produces file sizes similar to MP3 format.

Movies and video: You can buy and download (or rent and stream) full-
length movies, TV shows, music videos, and movie trailers from the iTunes
Store ... and with an Apple TV unit connected to your home theater system,
you can watch those movies and videos from the comfort of your sofa on the
other side of your living room (or even from your bedroom on the other side
of your house).

Podcasts: These audio downloads (typically, in MP3 format) are like radio
programs for your iOS devices, but iTunes can play and organize them too.
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Some podcasts include video and photos to boot. You can download podcasts
from the iTunes Store, and most are free.

¥ iTunes U: iTunes offers educational materials (think slideshows, presenta-
tions, and class recordings) from a wide variety of colleges and technical
institutions — and virtually all free for the download.

3 Audiobooks: You no longer need cassettes or audio CDs to enjoy your
spoken books. iTunes can play them for you, or you can send them to your
iOS device for listening on the go.

¥ Streaming Internet radio: You can listen to a continuous broadcast of songs
from one of tens of thousands of Internet radio stations, with quality levels
ranging from what you'd expect from FM radio to the full quality of an audio
CD. You can't save the music in iTunes, but streaming radio is still great fun.
(I run my own station; there's more on MLC Radio later in this chapter.) Unlike
services like Spotify, Pandora, and Apple Music, these streaming radio stations
are free and don't require a subscription!

Playing an Audio CD

If you have an optical drive (either internal or external), playing an audio CD in
iTunes is simple. Just insert the CD into the drive, start iTunes by clicking its icon
on the Dock, and click the Play button. (Note that your iMac Pro may be set to
launch iTunes automatically when you insert an audio CD.) The iTunes interface
resembles that of a traditional CD player. The main playback controls of iTunes
are Play, Previous, Next, and the Volume slider, as shown in Figure 13-1.

Click the Play button to begin listening to a song. While a song is playing, the Play
button toggles to a Pause button. As you might imagine, clicking that button again
pauses the music. If you don’t feel like messing around with a mouse or trackpad,
you can always use the keyboard. The spacebar acts as the Play and Pause buttons.
Press the spacebar to begin playback; press it again to stop.

Click the Next button to advance to the next song on the CD. The Previous button
works like the Next button but with a slight twist: If a song is currently playing,
and you click the Previous button, iTunes first returns to the beginning of the cur-
rent song (just like an audio CD player). To advance to the previous song, double-
click the Previous button. To change the volume of your music, click and drag the
volume slider.

As with other Mac applications, you can control much of iTunes with the key-
board. Table 13-1 lists some of common iTunes keyboard shortcuts.
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FIGURE 13-1:
The main
playback controls:
Play, Previous,
and Next.
TABLE 13-1 Common iTunes Keyboard Shortcuts

Press This Key or

Key Combination To Do This

Spacebar Play the currently selected song if iTunes is idle.

Spacebar Pause a playing song.

- Advance to the next song.

«— Go back to the beginning of a song. Press a second time to return

to the previous song.

38+T Increase the volume of the music.
98+ Decrease the volume of the music.
9g+Option+) Mute the audio if any is playing. Press again to play the audio.

Playing Digital Audio Files

In addition to playing audio CDs, iTunes can play the digital audio files that you
download from the Internet or obtain from other sources in the WAV, AAC, Apple
Lossless, AIFF, MP2, and MP3 file formats.
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REMEMBER

Enjoying a digital audio file is slightly more complicated than playing a CD. After
downloading or saving your audio files to your iMac, open Finder, and navigate to
wherever you stored the files. Launch iTunes, and choose the Music entry from
the Media Type drop-down list in the top-left corner (or press 38+1); then click the
Songs entry in the Sidebar. (If the Sidebar doesn’t appear in your iTunes window,
choose View+> Show Sidebar.) Now you can simply drag the music files (or an
entire folder of music) from the Finder window to the list of your songs on the
right side of the window. The added files appear in the Music section of your
iTunes Library. You can also drag a song file from a Finder window and drop it on
the iTunes icon on the Dock, which adds it to your Music Library as well.

The iTunes Sidebar is a convenient beast indeed. You can drop the music file(s) on
top of a playlist name in the list, and iTunes adds it to that particular playlist as
well as the main Library. (More about playlists in a bit.) If you drop a folder of
songs on top of the Playlists header in the sidebar, iTunes creates a new playlist
with the name of the folder and adds all the songs in the folder to the new
playlist. Bam!

You can customize the iTunes Sidebar to display only those media types and music
classes that you prefer. (I like my Internet Radio media type and the Composers
class to be visible, for example.) To edit the entries in the Sidebar, hover your
pointer over the Library label at the top of the Sidebar and click the Edit link that
appears; then enable or disable the check boxes next to each heading as desired.

Think of the Music Library as being a master list of your audio and video media.
To view that library, choose Music from the Media Type drop-down list below the
Play, Previous, and Next controls, and click the Songs entry in the Sidebar, as
shown in Figure 13-2. (Go figure.) In a similar manner, you can view your movies
and TV shows by choosing those types from the Media Type drop-down list.
(In classic Apple style, you can also switch your media type by choosing a new one
from the View menu or by pressing 38+1 through 38+5 on the keyboard). Because
the current focus is on music, I discuss playing video in more depth later in this
section.

To play a song, just double-click it in the Music list. Alternatively, you can use the
playback controls (Play, Previous, and Next) that I discuss earlier in this chapter
(refer to Figure 13-1).

The iTunes window can play media from a surprising number of sources:

¥ Library: The Media Type drop-down list in the top-left corner of the screen
can display Music, Movies, TV Shows, Podcasts, and Audiobooks.

¥ Store: | discuss this music source in the final section, “Buying Digital Media the
Apple Way.”
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FIGURE 13-2:

The Music Library
keeps track of all
your audio files.

3 Shared: If another Mac or PC on your local network is running iTunes and is
set to share part or all of its library, you can connect to the other computer for
your music.

¥ Devices: If an iPod is connected, it appears in the Sidebar and on the toolbar
next to the Media Type drop-down list. (And yes, Virginia, other models of MP3
players from other companies also appear in the list if they're supported in
iTunes.) If you connect an iPhone or iPad to your Mag, it shows up here as well.

¥ Genius: Choose Filew> New=> Genius Play list to allow iTunes to automatically
create playlists from songs in your iTunes Music Library. You can also allow
Genius to recommend music, movies, and TV shows based on the titles you
already have in your iTunes Library. (More on this feature later in the chapter.)

3 Audio CD: A standard audio CD (anything from The Byrds to Justin Timberlake)
shows up in as an icon if you load the CD into your optical drive.

3 Home Sharing: You can turn on Home Sharing to share your Mac's media
library across your wireless network with up to five other Mac computers, as
well as iPhones, iPads, and the iPod touch. (More on Home Sharing later in
this chapter.)

¥ Playlists: Think of playlists as folders you use to organize your music. (More
on playlists later in this chapter.)

If you’ve invested in an Apple TV, it appears in the list as well, allowing iTunes to
share media with your Apple TV, which in turn sends it to your HD-TV.

TIP
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You can browse your Music Library in several ways. First, click the Media Type
drop-down list, and choose Music to display your music. By default, the applica-
tion sorts by Songs (active in Figure 13-2), but you can choose View Sort By to
sort by different criteria (including Album, Artist, Genre, and Time).

If you’re using the Songs view mode, the Music Library may display information
for each song that you add to it, including these items:

3 Name: The title of the song
¥ Time: The length of the song
¥ Artist: The artist who performs the song

3 Album: The album on which the song appears

If any song you’re adding doesn’t display anything for the title, album, or artist
information, don’t panic; most MP3 files have embedded data that iTunes can
read. If a song doesn’t include any data, you can always add the information to
these fields manually. I show you how later, in the section “Setting or changing
the song information manually.”

If you’d rather eschew the iTunes menu, it’s easy to change your sort order by
clicking any column heading in the Music Library list; iTunes reorders the Library
list according to that category. Clicking the Artist column heading, for example,
alphabetizes your Library by artist name. I often click the Time heading to sort my
Library according to the length of the songs. Oh, and you can drag column titles to
reorder them any way you like (except for the check-box column at the far left,
which remains fixed).

While listening to your music, you can always display the tracks that iTunes will
play next and even change their order. (Believe me, this feature is great fun for us
amateur party DJs.) Choose View Show Up Next to display the list, and drag
selected songs into the perfect order! (You can also click the button with the list
icon that appears on the toolbar.)

Browsing the Library

After you add a few dozen songs to iTunes, viewing the Library can become a task.
Although a master list is nice for some purposes, it becomes as cumbersome as an
elephant in a subway tunnel if the list is very long. To help out, iTunes can display
your Library in another format: namely, browsing mode. To view the Library in
browsing mode, choose View= Column Browser= Show Column Browser.
(Keyboard mavens can simply press the 38+B keyboard shortcut to switch to
browsing mode.)
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WILL | TRASH MY COUNT BASIE?

Novice iTunes users, take note: iTunes watches your back when you trash tracks.

To illustrate: Suppose that you delete a song from the Library that's located only in the
iTunes music folder (which you didn’t copy into iTunes from another location on your
hard drive). That means you're about to delete the song entirely, and there'll be no copy
remaining on your trusty iMac! Rest assured, though, that iTunes prompts you to make
sure you really want to move the file to the Trash. (I get fearful email messages all the
time from readers who are loath to delete anything from iTunes because they're afraid
they!l trash their digital music files completely.)

Remember: If you delete a song from the Library that also exists elsewhere on your
hard drive (outside the reach of the iTunes music folder), it isn't deleted from your drive.
If you mistakenly remove a song that you meant to keep, just drag it back into iTunes
from Finder, or even from the Trash. ‘Nuff said.

The Browse mode of iTunes displays your library in a compact fashion, organizing
your tunes into up to five sections:

¥ Genres
¥ Artists
¥ Albums
3 Composers

3 Groupings

Selecting an artist from the Artist list in Browse mode causes iTunes to display that
artist’s albums in the Album list. Select an album from the Album list, and iTunes
displays that album’s songs in the bottom section of the Browse window. (Those
Apple software designers . . . always thinking of you and me.) You can also specify
which sections you want to include in Browse mode by choosing View= Column
Browser; click a section name to toggle the display of that section on or off.

Finding songs in your Music Library

After your collection of audio files grows large, you may have trouble locating that
Swedish remix version of “I’m Your Boogie Man.” To help you out, iTunes has a
built-in Search function. To find a song, type some text into the Search box in the
top-right corner of the iTunes window. While you type, iTunes tries to find a
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selection that matches your search text. The search is thorough, showing any
matching text from the artist, album, song title, and genre fields in the results. If
you type Electronic in the field, for example, iTunes might return results for the
band named Electronic or other tunes that you classified as electronic in the Genre
field. (The section “Know Your Songs,” later in this chapter, tells you how to clas-
sify your songs by genre, among other options.) Click the magnifying-glass icon
at the left end of the Search field to restrict the search even more: by Artists,
Albums, Composers, and Songs.

Removing old music from the Library

After you spend some time playing songs with iTunes, you may decide that you
didn’t really want to add 40 versions of “Louie Louie” to your Library. (I prefer
either the original or the cast from the movie Animal House.) To remove a song
from the Library, click the song to select it and press the Delete key on your key-
board, or right-click the song entry and choose Delete from the contextual menu.

You can also remove a song from the Library by dragging it to the Trash on
the Dock.

TIP

Watching Video

Watching video in iTunes is similar to listening to your music. To view your video
collection, click the Media Type drop-down list in the top-left corner of the iTunes
window, and choose Movies or TV Shows. Music videos appear as a Smart Playlist
within the iTunes Sidebar, as I discuss later in the chapter.

From your collection, you can do the following:

3 Double-click a video thumbnail or an entry in the list.

¥ Drag a QuickTime-compatible video clip from the Finder window to the iTunes
window. (These clips typically include video files ending in .mov,.mv4, or .mp4.)

iTunes plays video in the box below the Source list, within the iTunes window, or
in full-screen mode, depending on the settings you choose by choosing
View=> Video Playback. In full-screen mode, move your pointer to display a control
strip at the bottom of the screen. This control strip sports the standard slider bar
that you can drag to move through the video, as well as a volume control and a
Fast Forward/Reverse button. You can also pause the video by clicking the Pause
button.
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Keeping Slim Whitman and Slim Shady
Apart: Organizing with Playlists

222

As I mention earlier, the iTunes Music Library can quickly become a fearsomely
huge beastie. Each Library can contain thousands upon thousands of songs: If
your Library grows anywhere near that large, finding all the songs in your lifelong
collection of Paul Simon albums is not a fun task. Furthermore, with the Library,
you’re stuck playing songs in the order in which iTunes lists them.

To help you organize your music in groups, use the iTunes playlist feature. Typi-
cally, a playlist is a collection of some of your favorite songs from the Library, but
playlists can also include media such as movies and audiobooks. You can create as
many playlists as you want, and each playlist can contain any number of items.
Whereas the Music Library lists all available songs, a playlist displays only the
items that you add to it. Further, any changes you make in a playlist affect only
that playlist, leaving the Library untouched.

To create a playlist, do any of the following:

¥ Choose Filec> Newr> Playlist.
¥ Press g8+N.

¥ Choose Filer> Newr> Playlist from Selection. This command creates a new
playlist and automatically adds any tracks that are currently selected.

¥ Choose Filer> Newr> Genius Playlist. iTunes builds a playlist of songs that are
similar in some way (typically, by matching the genre of the selection or the
beats per minute, but also based on recommendations from other iTunes
members). Note that your iMac needs an Internet connection to create a
Genius playlist, and the larger your music library is, the longer it takes iTunes
to build your playlist. You also need to turn on the Genius feature by choosing
File=> Library=>Turn on Genius and entering your Apple ID. (Note that Genius
playlists sometimes mix tracks containing explicit content with less objectiona-
ble material — especially in the comedy and rap genres.)

¥ Drag a folder containing audio files from a Finder window to the Playlists
heading in the Sidebar

To help organize your playlists, it’s a good idea to . . . well, name them. (Aren’t you
glad now that you have this book?) Suppose that you want to plan a party for your
polka-loving friends. Instead of running to your computer after each song to
change the music, you could create a polka-only playlist. Select and start the play-
list at the beginning of the party, and you won’t have to worry about changing the
music the whole night. (You can concentrate on playing the accordion.) To load a
playlist, select it in the Sidebar list; iTunes displays the songs for that playlist.
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REMEMBER

SOME PLAYLISTS ARE SMARTER
THAN OTHERS

You can create a Smart Playlist in the iTunes Sidebar by choosing File=> New Smart
Playlist, or by pressing Option+38+N.

The contents of a Smart Playlist are automatically created from a specific condition or
set of conditions that you set via the Smart Playlist dialog. You can limit the track selec-
tion by mundane things, such as album, genre, or artist; you can get funky and specify
songs that were played last, or by the date you added tracks, or even by the sampling
rate or total length of the song. iTunes can create a playlist packed with songs that are
shorter than three minutes, for example, so you can fill your iPod touch with more stuff!
If you want to add another criterion, click the plus sign on the right side of the dialog,
and you get another condition field to refine your selection even further. Smart Playlists
can even contain TV shows, movies, podcasts, and audiobooks.

You can choose the maximum songs to add to the Smart Playlist, or limit the size of the
playlist by the minutes or hours of play or the number of megabytes or gigabytes that
the playlist will occupy. (Again, this feature is great for automatically gathering as much
from your KISS collection as will fit into a specific amount of space on a CD or your iPod.)
Mark the Live Updating check box for the ultimate in convenience. iTunes automatically
maintains the contents of the Smart Playlist to keep it current with your conditions at all
times in the future. (If you remove tracks from a Smart Playlist manually, iTunes adds
other tracks that match your conditions.)

Now think about what all these settings mean when combined. Whoa. Here's an example
yanked directly from my own iTunes library. | created a Smart Playlist that selects only
those songs in the Rock genre. It's limited to 25 songs, selected by least often played, and
live updating is turned on. The playlist is named Tracks I've Gotta Hear because it finds
the 25 rock songs (from my collection of more than 10,000 songs) that I've heard least
often! After | listen to a song from this Smart Playlist, iTunes automatically “freshens” it
with another song, allowing me to catch up on the tracks I've been ignoring.

The same items can appear in any number of playlists because the items in a
playlist are simply pointers to the media in your Music Library — not the actual
songs, movies, or TV shows themselves. Add them to any playlist and remove
them at will, secure in the knowledge that the items remain safe in your Library.
Removing a playlist is simple: Select the playlist in the Sidebar, and press Delete.

Removing a playlist doesn’t delete any songs from your Library.
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Know Your Songs

Besides organizing your music into Elvis and non-Elvis playlists, iTunes gives you
the option to track your music at the song level. Each song you add to the Music
Library has a complete set of information associated with it. iTunes displays this
information (see upcoming Figure 13-3) on the Details tab:

3 Song Name: The name of the song
¥ Artist: The name of the artist who performed the song

3 Album Artist: The name of the artist responsible for a compilation
or tribute album

3 Album: The album where the song appears

3 Grouping: A group type that you assign

3 Composer: The name of the astute individual who wrote the song
3 Comments: A text field that can contain any comments on the song
¥ Year: The year the artist recorded the song

¥ Track: The position of the song on the original album

¥ Genre: The classification of the song (such as rock, jazz, or pop)

3 Disc Number: The original disc number in a multi-CD set

3 BPM: The beats per minute (indicates the song's tempo)
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©

REMEMBER

You can display this information by clicking a song name and pressing $8+I. The
fields appear on the Details tab.

Setting the song information automatically

Each song you add to the iTunes Music Library may have song information
included with it. If you add music from a commercial audio CD, iTunes connects
to a server on the Internet and attempts to find the information for each song on
the CD. If you download a song from the Internet, it often comes with some infor-
mation embedded in the file; the amount of included information depends on
what the creator supplied. (And that information is often misspelled; think
Leenard Skeenard.) If you don’t have an Internet connection, iTunes can’t access
the information and displays generic titles instead.

Setting or changing the song
information manually

If iTunes can’t find your CD in the online database, or someone gives you an MP3
with incomplete or inaccurate information, you can change the information your-
self. Believe me, you want to have at least the artist and song name! To view and
change the information for a song, follow these steps:

1. selectthe song in the Song list or a playlist.
2. Press 38+l, or choose File= Get Info.

3. Click a field to edit the song’s information on the Details tab, as shown in
Figure 13-3.

You can move to the next or previous tracks in the Music Library list or playlist by
clicking the Next or Previous buttons in the bottom-left corner of the dialog.

The more work you put into setting the information of the songs in your Music
Library, the easier it is to browse and use iTunes. Incomplete song information
can make it more difficult to find your songs in a hurry. If you prefer, you don’t
have to change all information about a song (but you make life easier later if you
do). Normally, you can get away with setting only a song’s title, artist, and genre.
The more information you put in, however, the faster you can locate songs and the
easier they are to arrange. iTunes tries to help by automatically retrieving known
song information, but sometimes, you have to roll up your sleeves and do a little
work. (Sorry, but some things can’t be automated.)

“What about cover art, Mark?” Well, I'm overjoyed that you asked! iTunes can try
to locate artwork automatically for the tracks you select. (Note that embedding
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large images can significantly increase the size of the song file.) Follow these
steps:

1. select the desired songs from the track list.

2. Choose File=> Library=> Get Album Artwork.

You can set iTunes to automatically attempt to add album artwork every time you
rip tracks from an audio CD (as described in the next section) or when you add
songs without artwork to your Music Library. Choose iTunes«> Preferences«> Store,
and select the Automatically Download Album Artwork check box in the resulting
dialog. (By the way, if you buy tracks or an album from the iTunes Store, Apple
includes album covers automatically!)

Want to add album covers to your song info manually? Select one or more songs
in the track list, display the Info dialog, and click the Artwork tab. Now launch
Safari, visit Amazon.com, and search for the same album (or search an online art-
work library such as AllICDCovers.com). Drag the cover image from the web page
right into the Info dialog, and drop it on top of the “sunken square” Artwork
image well. When you click OK, the image appears in the Artwork tab of the Info
dialog.

Ripping Audio Files

226

You don’t have to rely on Internet downloads to get audio files: You can create
your own MP3, AAC, Apple Lossless, AIFF, and WAV files from your audio CDs with
iTunes. The process of converting audio files to different formats is called ripping.
(Audiophiles with technical teeth also call this process digital extraction, but they’re
usually ignored at parties by the popular crowd.) Depending on what hardware or
software you use, each has its own unique format preferences.

The most common type of ripping involves converting CD audio to MP3 (or AAC)
format. To rip MP3s from an audio CD, follow these simple steps:

1. Launch iTunes by clicking its icon on the Dock.

Alternatively, you can locate iTunes in your Applications folder or in Launchpad.

N

Choose iTunes-> Preferences.

w

In the Preferences dialog that appears, click the General tab.

4. Click the Import Settings button that appears at the bottom of the
Preferences dialog.

PART 4 Living the Digital Life



n

Choose MP3 Encoder from the Import Using pop-up menu.

6. choose High Quality (160 Kbps) from the Setting pop-up menu, and click
OK to return to the Preferences dialog; click OK again to return to iTunes.

This bit-rate setting provides the best compromise between quality (better-than-
CD quiality, which is 128 Kbps) and file size (significantly smaller tracks than
audiophile bit rates such as 192 Kbps or higher).

@ The songs you buy and download from the iTunes Music Store are all 256 Kbps.

7. Load an audio CD into your Mac's optical drive.

REMEMBER
The CD title shows up in the iTunes Source list (below the Devices heading),
which is on the left side of the iTunes window. The CD track listing appears on
the right side of the window.

If iTunes asks whether you want to import the contents of the CD into your
Music Library, you can click Yes and skip the rest of the steps; if you've disabled
this prompt, continue with the remaining two steps.

TIP
8. Clear the check box of any song you don’t want to import from the CD.

All songs on the CD have a check box next to their title by default. Unmarked
songs aren't imported.

9. click the Import CD button.

Tweaking the Audio for Your Ears

Besides the standard volume controls that I mention earlier in this chapter, iTunes
offers a full equalizer. An equalizer permits you to alter the volume of various
frequencies in your music, allowing you to boost low sounds, lower high sounds,
or anything in between.

To open the Equalizer, choose Window=>Equalizer or press $8+Option+E. Use the
leftmost slider (Preamp) to set the overall level of the Equalizer. The remaining
sliders represent various frequencies that the human ear can perceive. Setting a
slider to a position in the middle of its travel causes that frequency to play back with
no change. Move the slider above the midpoint to boost that frequency; conversely,
move the slider below the midpoint to reduce the volume of that frequency.

Continue adjusting the equalizer sliders until your music sounds the way you like
it. In case you prefer to leave frequencies to the experts, the iTunes Equalizer has
several predefined settings to match most musical styles. Open the pop-up menu
at the top of the Equalizer window to choose a genre. When you close the Equalizer
window, iTunes remembers your settings until you change them again.
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A New Kind of Radio Station

228

Besides playing back your favorite audio files, iTunes can tune in Internet radio
stations from around the globe. You can listen to any of a large number of preset
stations, seek out lesser-known stations that aren’t recognized by iTunes, and
even add your favorite stations to your playlists. You can also subscribe to the
iTunes Radio feature to create a custom station dedicated to the genres and artists
you prefer. This section shows you how to do it all.

Internet Radio

Although it’s not a radio tuner in the strictest sense, iTunes can locate virtual
radio stations all over the world that send audio over the Internet — a process
usually dubbed streaming. iTunes can track down hundreds of Internet radio sta-
tions in a variety of styles with only a few mouse clicks.

To begin listening to Internet radio with iTunes, click the Internet Radio item in
the Sidebar list. (If Internet Radio doesn’t appear under the Library heading in the
Sidebar, it’s hidden. Hover your pointer over the Library label at the top of the
Sidebar, click the Edit link that appears, and then click the Internet Radio check
box to enable it.) The result is a list of more than 20 types of radio stations,
organized by genre.

When you expand an Internet category by clicking its disclosure triangle, iTunes
queries a tuning server and locates the name and address of dozens of radio
stations for that category. Whether you like Elvis or not-Elvis (those passing fads,
such as New Wave, classical, or alternative), something’s here for everyone. The
Internet also offers news, sports, and talk radio.

WHAT'S WITH THE NUMBERS NEXT
TO THE STATION NAMES?

When choosing an Internet radio station, keep your Internet connection speed in mind.
If you're using a broadband DSL or cable connection — or if you're listening at work
over your company’s high-speed network — you can listen to stations broadcasting

at 128 Kbps (or even higher). The higher the bit rate, the better the music sounds.

At 128 Kbps in AAC format, for example, you're listening to sound that's as good as

an audio CD.
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HAVE AN ITCH TO HEAR “KUNG FU
FIGHTING"?

As you can probably tell from this chapter, music is very important to me. This particular
technology author has a preference for a certain hot jam spot: MLC Radlo, the Internet
radio station I've been running for several years now. | call my station a '70s Time Machine
because it includes hundreds of classic hits from 1970 through 1979. You hear everything
from “Rock and Roll Hoochie Koo” by Rick Derringer to “Moonlight Feels Right” by Starbuck.
(Hey, 'm summing up a decade here, so be prepared for both Rush and the Captain &
Tennille.) The station broadcasts at 128 Kbps (audio CD quality), so you need a broadband
connection to listen. For the station’s Internet address or to ask for help connecting to MLC
Radio, visit my website at www . mlcbooks . com.

After iTunes fetches the names and descriptions of radio stations, double-click
one that you want to hear. iTunes immediately jumps into action, loads the
station, and begins to play it.

Tuning in your own stations

Although iTunes offers you a large list of popular radio stations on the web, it’s by
no means comprehensive. Eventually, you may run across a radio station that
you’d like to hear but don’t find listed in iTunes. Luckily, iTunes permits you to
listen to other stations, too. To listen to a radio station that iTunes doesn’t list,
you need the station’s web address.

In iTunes, choose File>Open Stream (or press 38+U). In the Open Stream dialog
that appears, enter the URL of your desired radio station, and click OK. In seconds,
iTunes tunes in your station.

Radio stations in your playlists

If you find yourself visiting an online radio station more than once, you’ll be glad
to know that iTunes supports radio stations in its playlists. To add a radio station
to a playlist from the Internet Radio list, follow these steps:

1. Open the category that contains the station you want to add to your
playlist.

CHAPTER 13 The Multimedia Joy of iTunes 229


http://www.mlcbooks.com

TIP

©

REMEMBER

2. Locate the station you want to add to your playlist, and drag it from the
Radio list to the desired playlist on the left.

If you haven't created any playlists yet, see the section “Keeping Slim Whitman
and Slim Shady Apart: Organizing with Playlists” earlier in this chapter to find
out how.

You can also follow the same steps to add a radio station that doesn’t appear in the
Radio list. iTunes allows you to load a radio station URL manually by choosing
File> Open Stream; any station that you play by using the Open Stream command
is automatically added to your Songs list. Therefore, you can drag the station from
the Songs list to any playlist.

Creating a custom iTunes Radio station

The recent addition of iTunes Radio makes it possible for you to listen to the art-
ists, songs, and genres that you prefer in iTunes without selecting a specific
Internet radio station. To use iTunes Radio, click the Radio button at the top of the
iTunes window, and type the artist name, song name, or genre in the Search field.
(Note that iTunes Radio is an Apple Music subscription service, unlike the Internet
Radio stations I describe in the preceding section.)

As you download new music from the iTunes Store (and add new artists and
genres in iTunes Radio), the service learns more about your musical tastes and can
automatically play and recommend new music, much like the Genius feature
I discussed earlier in this chapter.

Like Internet radio, the iTunes Store, and Apple’s iTunes Match subscription ser-
vice (described in the next section), iTunes Radio requires an Internet connection
and an Apple ID.

Your iTunes Radio station is automatically shared among all your Macs running
0OS X Lion or later (as well as any devices you own that run iOS 7 or later).

iTunes and iCloud Together

230

iTunes is connected closely with the Apple iCloud service, allowing you to share
music betwixt all your Macs and iOS devices. To download a local copy of any
iCloud item, simply click the iCloud icon next to the item. After the local copy has
been saved to your Mac’s drive, the iCloud icon disappears, and you’re ready to
listen or watch your purchase.
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Apple’s iTunes Match subscription service builds on this same functionality,
allowing you to store all your music in iCloud (including the songs you’ve ripped
from audio CDs and downloaded from other sources) and listen to it on any of your
Macs, PCs, or iOS devices! When you join iTunes Match, all the songs that aren’t
available from the iTunes Store are automatically uploaded to iCloud.

At this writing, the service is $25 a year and is limited to a maximum of 10 devices
and 100,000 songs. (Note that purchases you make from the iTunes Store don’t
count toward that 100,000-song limit.)

To subscribe to iTunes Match or manage your Match storage, click the Store but-
ton to display the iTunes Store, and click the iTunes Match link on the right side
of the screen.

iSending iStuff to iPod, iPhone, and iPad

©

REMEMBER

If you’re cool enough to own an iPod, you’ll be happy to know that iTunes has
features for your personal audio and video jukebox as well. The iPod touch, Apple’s
multimedia player, will set you back $200 to $300 (depending on storage capac-
ity). The iPod touch can hold thousands of songs, as well as podcasts, photos, and
video. This great gadget and those like it have become known worldwide as the
preferred portable digital media players.

If you own an iPhone or iPad, you probably already know that these devices can
act as music players as well. You can listen to music you’ve purchased through the
iTunes Store on any of your iOS devices. You can buy all sorts of applications for
these devices at the iTunes Store. iTunes even keeps track of these applications as
part of your iTunes Library.

To sync correctly, your computer and the device must share an Apple ID.

You connect your iPod to any Macintosh or Windows PC that has USB 2.0 ports,
using the included cable. After the iPod is connected, you can synchronize it with
iTunes. By default, this process is automatic: The iPod and the iTunes software
communicate with each other and figure out what items are in your iTunes Library
(compared with the iPod Library). If they discover songs, podcasts, and video in
your iTunes Library that are missing from your iPod, the items automatically
transfer to the iPod. Conversely, if the iPod contains stuff that’s no longer in
iTunes, the iPod automatically removes those files from its drive.
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WARNING

Go back and reread that last sentence about how the iPod automatically removes
files from its drive. (I’ll wait.) Apple added this feature in an effort to be respon-
sive to copyright concerns. The reasoning is that if you connect your iPod to your
friend’s computer, you can’t transfer songs from the iPod to that computer.
Always pay close attention and read all warning dialogs when connecting to a
computer other than your own; otherwise, you might wipe out your iPod’s library.

You can change your settings on the device’s Summary pane so that iTunes auto-
syncs only selected playlists. (Click the device icon in the top-left corner of the
window to display the Summary pane). If you’re really nervous, you can choose to
manually manage the contents of your iPod with iTunes from the Summary pane.

Sharing Your Media across Your Network

232

TIP

Ready to share your music, podcasts, and video — legally, mind you — with other
folks on your local network? You can offer your digital media to other iTunes users
across your home or office. Follow these steps:

1. choose iTunes= Preferences to open the Preferences dialog.
. Click Sharing.

2
3. Select the Share My Library on My Local Network check box.
4

. Specify whether you want to share your entire library or only selected
playlists and files.

Sharing selected playlists is a good idea for those Marilyn Manson and Sex
Pistols fans who work at a cubicle farm in a big corporation.

5. you want to restrict access to a few people, select the Require
Password check box, and then type a password in the text box.

6. Cclick OK.

Note that the music you share with others can’t be imported or copied, so
everything stays legal.

Want to change that frumpy default name for your shared media library to some-
thing more exotic, like “Dan’s Techno Beat Palace”? No problem. Display the
Preferences dialog again, click the General tab, and click the Library Name text
box. Edit your network-entertainment persona to your heart’s content.
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SENDING MUSIC ELSEWHERE WITH AIRPLAY

If you're using an AirPort Express portable wireless Base Station, you can ship your
songs right to your Base Station from iTunes and from there to your home stereo or
boombox! Pick up an AirPlay-enabled sound system, and you can eliminate the stereo
or boombox and the AirPort Express device entirely. (I get into some serious discussion
of AirPort Express in Chapter 11.)

After your AirPort Express Base Station is plugged in and you've connected your home
stereo (or a boombox or a pair of powered stereo speakers) to the stereo minijack on
the Base Station, click the Speakers button on the iTunes toolbar, and you can choose
to broadcast the music you're playing in iTunes across your wireless network. Ain't tech-
nology truly grand?

You can also share your media library by using Home Sharing, which allows others
join in the fun, including up to five Mac computers and iOS devices (your iPad,
iPhone, and iPod touch). Home Sharing requires a network connection for all your
devices, and you have to enter the same Apple ID information on each device. To
turn on Home Sharing in iTunes, chooseFile> Home Sharing, and select Turn On
Home Sharing. (Don’t forget to repeat this setup on each computer and iOS device.)
After Home Sharing is enabled, a Shared Libraries heading appears in the Sidebar.

Burning Music to Shiny Plastic Circles

Besides being a great audio player, iTunes is adept at creating CDs. (Your iMac must
have an internal SuperDrive or an external optical drive to record CDs, of course.)
iTunes makes the process of recording songs to a CD as simple as making a few
clicks on the mouse or taps on the trackpad. Making the modern version of a com-
pilation (or mix) tape is easier than getting a kid to eat ice cream! If you have an
internal or external optical drive, iTunes lets you burn CDs in any of three formats:

3 Audio CD: This format is the typical kind of commercial music CD you buy at a
store. Most typical music audio CDs store up to 800MB of data, which translates
into about 80 minutes of music.

3 Data CD or DVD: A standard computer CD-ROM or DVD-ROM is recorded
with the audio files. This disc can't be played in any standard audio CD player
(even if it supports MP3 CDs, which | discuss next). Therefore, you can listen to
these songs only by using your Mac and an audio player, such as iTunes or a
PC running Windows.
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WHAT THE HECK IS A PODCAST?

Today's podcasts are much like the recurring radio commentary programs of old, cover-
ing a huge range of subjects. Most are produced by fans of a particular topic (as you can
create your own website, you can create your own podcast),but others are offered by
major news outlets and talk radio shows, sometimes as companions to their
broadcasts.

Podcasts are designed to entertain and inform, usually while you're doing something
else, but they can contain video as well. A typical podcast is released on a regular sched-
ule, and iTunes helps you maintain the schedule by allowing you to subscribe to a pod-
cast from within the iTunes Store. After you subscribe, iTunes automatically downloads
new episodes of the podcast.

To get started with podcasts, click Store on the iTunes toolbar, and choose Podcasts
from the Media Type drop-down list. Remember, virtually all podcasts are free!

3 MP3 CD: As does the ordinary computer CD-ROM that | describe, an MP3 CD
holds MP3 files in data format. The files, however, are arranged in such a way
that they can be recognized by audio CD players that support the MP3 CD
format (especially boomboxes, DVD players, personal CD players, and car
stereos). Because MP3 files are so much smaller than the digital audio tracks
on traditional audio CDs, you can fit as many as 160 typical four-minute songs
on one disc. These discs can also be played on your Mac via iTunes.

Keep in mind that MP3 CDs aren’t the same as the standard audio CDs you buy at
the store, and you can’t play them in older audio CD players that don’t support the
MP3 CD format. Rather, this disc is the kind of archival disc that you burn at home
for your own collection or for use in a CD/DVD player or car audio system that
supports MP3 discs.

To begin the process, build a playlist (or select an existing playlist that you want
to record). If necessary, create a new playlist and add to it whatever songs you’d
like to have on the CD. (See the earlier section “Keeping Slim Whitman and Slim
Shady Apart: Organizing with Playlists” if you need a refresher.) With the songs
in the correct order, right-click the playlist and choose Burn Playlist to Disc from
the contextual menu to commence the disc-burning process. Click the desired
recording format (again, usually Audio CD) in the Burn Settings dialog that
appears.
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TIP

To save yourself from sonic shock, I always recommend that you enable the Use
Sound Check check box before you burn.When you do, iTunes adjusts the volume
on all the songs on your audio CD so that they play at the same volume level.

Ready to go? Click Burn, and load the blank disc. iTunes lets you know when the
recording is complete.

Feasting on iTunes Visuals

TIP

By now, you know that iTunes is a feast for the ears, but did you know that it can
provide eye candy as well? With just a click or two, you can view mind-bending
graphics that stretch, move, and pulse with your music.

To begin viewing iTunes visuals, choose View> Show Visualizer (or press 38+T).
Immediately, most of your iTunes interface disappears and begins displaying
groovy lava lamp-style animations (like, sassy, man). To stop the visuals, choose
View= Hide Visualizer (or press $8+T again). The usual sunny aluminum face of
iTunes returns.

You can also change the viewing size of the iTunes visuals in the View menu.
Choose View= Enter Full Screen (or press 38+Control+F). To escape Full Screen
Visuals mode, press Esc, or press g8+Control+F again.

You can still control iTunes with the keyboard while the visuals are zooming
around your screen. See Table 13-1 earlier in this chapter for a rundown on
common keyboard shortcuts.

Exercising Parental Authority

Do young children use your Mac? I'll be honest here: A large amount of content in
the iTunes Store (including audio, movies, and even apps) is stuff that I don’t
consider suitable for kids. And what about the media that others in the family may
decide to share? Such is the world we live in today, and the good folks at Apple
recognize that you may not want to inadvertently allow your kids to have access
to explicit content.

Luckily, you can use the Restrictions settings in iTunes to build a secure fence
around content that’s for grownups only. Heck, you can even banish items from
the Sidebar. Figure 13-4 illustrates the Restrictions pane in the iTunes Preferences
dialog.
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FIGURE 13-4:
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Restrictions Preferences

> By m® B G

General Playback Sharing Downloads Store Restrictions Devices Advanced

Disable: Podcasts
Internet Radio
iTunes Store
Apple Music
Music Profiles & Posts
Shared Libraries

Ratings for: | United States | ~ |
7 Show content ratings in library
Restrict: Music with explicit content
Movies to | PG-13 | < |
TV shows to | Tv-14 | 7]

Books with explicit sexual content

Restrictions apply to playback, sharing, iTunes purchases,
and the iTunes Store.

Ei] Click the lock to prevent further changes.

Cancel

You must log in with an Administrator account to change these settings, just as
with the Parental Controls in the System Preferences dialog. If the settings are
locked (the padlock icon at the bottom of the dialog is closed),click the padlock
and supply your administrator password to unlock them. (Read more about

Parental Controls in Chapter 10.)

To restrict access, follow these steps:

1.
2.
3.

Choose iTunes~> Preferences.
Click the Restrictions tab.
Select any of the Disable check boxes to prevent access to those features.

Disabling features in iTunes applies to all user accounts — no matter who is
logged in! Notice that any features you disable disappear from the Sidebar
after you click OK at the end of these steps.

Choose your country from the Ratings For pop-up menu.

Because Apple maintains separate iTunes Stores for different nations, you can
choose which country’s iTunes Store to monitor. If you like, you can disable the
display of content ratings in your iTunes Library by deselecting the Show Content
Ratings in Library check box.

To restrict specific content in the iTunes Store, select the check box next
to the source, and make choices from the corresponding pop-up menu to
choose the restriction level.
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Note that these restrictions apply only to content in the iTunes Store, content
that can be downloaded through iCloud, and media shared with your Mac.

6. Cclick the padlock icon at the bottom of the dialog to close it and prevent
any further changes.

7. Cclick OK.

Buying Digital Media the Apple Way

The hottest spot on the Internet for buying music and video is the iTunes Store,
which you can reach from the cozy confines of iTunes. (That is, as long as you
have an Internet connection. If you don’t, it’s time to turn the page to a different
chapter.)

Click the iTunes Store button near the top of the window, and after a few moments,
you see the latest offerings. Click a link in the store list to browse according to
media type. The Back and Forward buttons at the top of the iTunes Store window
operate much the same as those in Safari, moving you backward or forward in
sequence through pages you’ve already seen.

To display the details on a specific album, track, video, podcast, or audiobook
(whew), just click it. If you’re interested in buying certain tracks (for that perfect
road-trip mix), you get to listen to 90 seconds of any track — for free, no less, and
at full sound quality. When you’re ready to buy, click the Buy Now button. (At this
writing, tracks are usually 99 cents a pop, and an entire album is typically $9.99.
What a bargain!)

The iTunes Store uses your Apple ID to identify you, and it keeps secure track of
your payment information for future purchases. After you use the iTunes Store
once, you rarely have to log in again or retype your credit card information.

The tracks and files that you download are saved to a separate playlist called
Purchased. When the download is finished, you can play them, copy them to other
playlists, burn them to CD or DVD, share 'em over your network, or ship them to
your iOS devices via iCloud, just as you can any other item in your iTunes Library.

device (including another Mac and your iPhone, iPad, or iPod touch). To set up
automatic downloading, choose iTunest> Preferences to open the Preferences

TIP dialog, and click the Downloads tab. After you’re signed in at the iTunes Store, you
can choose to download music or app purchases, and you have the option to check
for new downloads automatically. Click OK to save your changes.

‘ iTunes can automatically download the media you purchase on another iCloud
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IN THIS CHAPTER

» Importing pictures from your internal
drive or digital camera

» Organizing images with Photos

» Tweaking the appearance of
photographs

» Sharing photos with your friends

Chapter 14
Focusing on Photos

or decades now, the Mac has been the choice of professional photographers

for working with digital images — not surprising, considering the Mac’s

graphical nature. Apple continues this tradition with Photos, its photography
tool for the home user that can help you organize, edit, and even publish your
photographs. (It sports more features than a handful of Swiss army knives.) After
you shoot your photos with a smartphone or a digital camera, you can import
them into Photo, edit them, and publish them. You’re not limited to photos that
you take yourself, either; you can edit, share, and organize all kinds of digital
image files, as well as video clips. You can even create a photo album and use the
third-party applications to order a handsome soft-bound or hard-bound copy
shipped to you, or create a slideshow that you can upload to YouTube.

In this chapter, I walk you through an overview of what Photos can do. After that,
I give you a brief tour of the controls in Photos so that you can see what features
are available to you, including those for managing, printing, and publishing your
photos.

Delving into Photos

Figure 14-1 shows most of the major controls Photos offers. (Other controls appear
automatically when you enter different modes; I cover them in upcoming
sections.)
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FIGURE 14-1:
Photos greets
you with an
attractive
window. Sidebar Thumbnails

These controls and sections of the window are covered in more detail in the fol-
lowing sections. For now, here’s a quick rundown of what you see when you launch
Photos and click the Photos mode button at the top center of the initial screen:

¥ Sidebar: Like iTunes, Photos sports a sidebar that displays different
locations and groupings within the application —photos you've recently
imported, for example, or specific photo albums and book projects you've
created. Switching among your photo library, your albums, and your proj-
ects involves a single click.

¥ Toolbar: This group of controls determines how many images the Photos
Viewer displays and allows you to perform several actions with selected
photos:

® You can display photos by moment (photos taken around the same time
and at the same location), collection (a group of related moments, like
each day of a family reunion), or year (the year when the photos were
taken). If the Back button is visible, you can click it to see more images.
To zoom in on a specific photo, click the desired thumbnail. To switch
among groupings, click one of the four view buttons on the toolbar (or
press 38+1 through 38+4 on the keyboard). The Photos view button
returns you to an overview of your entire library.
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You can create new albumes, slideshows, and print projects (such as books,
calendars and cards) by using your photos. These new thumbnails appear
when you click the My Albums or My Projects entries in the sidebar, which
makes it much easier to organize your photos.

You can share selected photos in a slew of ways, including Apple Mail,
Messages, and AirDrop networking, as well as popular online sites such as
Facebook, Twitter, and Flickr. If you've enabled iCloud Photo Sharing, you
can also share photos to your other Macs and iOS devices.

You can search for specific images. Just click the search box and start
typing to search by description and title, or even by Faces and keywords,
which | cover later in the chapter.

Viewer: This pane displays the images from your Photos Library.

You can click and drag or g8+click to select photos in the Viewer for further
tricks, such as assigning keywords and image editing.

Thumbnails: If you're displaying a single image from your Library, you can
press Option+S to open and close the Thumbnails pane. The Thumbnails
pane allows you to quickly switch to another image by clicking the desired
thumbnail — a helpful feature when you're editing several images taken
around the same time.

Full Screen: Click the Full Screen/Maximize button in the top-left corner of the
window to switch to a full-screen display of your photos. In full-screen mode,
you can double-click a thumbnail to view the image in your supercomputer’'s
entire screen real estate. (The toolbar is available at any time: just move your
pointer to the top of the screen to display it.) Press Esc to return to windowed
mode.

Click View = Always Show Toolbar and Sidebar in Full Screen to prevent the
toolbar and sidebar from disappearing in full-screen mode.

Zoom: Drag this slider to the left to reduce the size of the thumbnails in the
Viewer, which allows you to see more thumbnails at one time, which is
convenient for quick visual searches. Drag the slider to the right to expand the
size of the thumbnails, making it easier to differentiate details in similar
photos in the Viewer. You can also use the Zoom slider when a single image is
displayed in the Viewer.

Add To Favorites: This toolbar button (which bears a heart icon) appears on
the toolbar only while you're viewing or editing a single image. Click the Add to
Favorites button to add the item that's currently displayed in the Viewer as a
Favorite. (When viewing your Library as moments or collections, you can also
hover your pointer over an item and click the heart symbol that appears in the
bottom-left corner of the photo.) You can search for Favorite photos by using
keywords, which are covered later in this chapter.
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¥ Info: Click this button to display information on the item that's currently
displayed in the Viewer.

3 Share: Click this button to share the selected photos on Flickr, Twitter, or
Facebook. Choose iCloud Photo Sharing to send the selected photos to your
iPhone, iPad, or iPod touch (they'll appear in the Photo Stream albums on
those devices) or to another Mac. If you still use Apple's legacy Aperture
application to edit or organize photos, you can add the selected photos to
your Aperture library. You can also add them to a note, attach the photos to
a text message, or email them.

¥ Edit: Here's another button that's displayed on the toolbar only when you
view a single image. Click this button to switch to the editing controls within
Photos and make changes in the current image. | cover editing in depth later
in the chapter.

3 Auto Enhance: Click this button to allow Photos to automatically clean up
the single photo currently displayed in the Viewer by making adjustments in
the contrast. After a few seconds, the corrected image appears in the Viewer.
If you don't agree that the photo is “new and improved,” you can press 38+Z
to undo the changes.

9 Rotate Counterclockwise: This button is pretty self-explanatory: A click rotates
the selected image(s) in a counterclockwise direction. | find myself doing this
often, which is why Apple designers decided to park this button here.

¥ Search: Click within the familiar confines of the Search box to filter the photos
displayed in the Viewer by keyword, description, filename, or date.

Working with Images in Photos

Even a superbly designed image display and editing application such as Photos
would look overwhelming if everything were jammed into one window. Thus,
Apple’s developers provide different operational modes, such as editing and book
creation, that you can use in the one Photos window. Each mode allows you to
perform different tasks.

In this section, I discuss three of these modes — import, organize, and edit — and
what you can do when you’re in them.
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Import images 101

In import mode, you’re ready to download images and video clips directly from
your digital camera — and you’re not limited to cameras, of course. You can also
import items from a folder on your hard drive; a memory-card reader, such as the
SDXC card slot sported by current iMac models; or even a Kodak PhotoCD.

Follow these steps to import images directly from your camera:

1. connect your digital camera to your iMac.

Plug one end of a USB cable into your camera and the other end into your
computer’s USB port, and prepare your camera to download images.

2. Prepare your camera to download files.

The procedure for downloading images and video varies by camera, but the
process usually involves turning on the camera and choosing a Download or
PC mode. Check your camera’s user guide for more details.

3. Launch Photos.

Your Mac probably launches Photos automatically when your camera is
detected, but you can always launch Photos manually by clicking the Photos
icon on the Dock (or clicking the Photos icon within Launchpad).

4. Choose File>Import, and click the device in the sidebar.

Photos displays all of the images and video clips currently stored on your
camera in the Viewer.

5. click the Import All New Photos button to import all new files from the
camera.

To select specific images to import, hold down the $8 key and click each desired
photo; then click Import Selected instead of Import All New Photos.

The images and clips initially appear within the Last Import album in your
Photos Library, where you can organize them as you want.

6. Fromthe Import To drop-down menu, choose a destination for the
imported files.

You can choose an existing album, create a new album, or add the files to
your library.

Note that Photos automatically groups imported images and video into moments
and collections, which use the date, time, and location where the files were cre-
ated, if your camera stores this information with each file. If you want to see
photos from your son’s graduation, for example, they’ll appear as a separate
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moment. Think about that. It’s pretty tough to arrange old-fashioned film prints
by the moment in time they document, but Photos makes it easy for you to see
which photos are part of the same group.

Don’t be surprised if Photos automatically appears when you connect your iPhone
or iPad to your iMac, giving you a convenient opportunity to import photos with a
single click.

Organize mode: Organizing and
sorting your images

In the days of film prints, you could always stuff another shoebox with your latest
photos or buy another sticky album to expand your library. Your digital camera,
though, stores images as files instead, and many folks don’t print their digital
photographs. Instead, you can keep your entire collection of digital photographs
and scanned images well-ordered and easily retrieved within Photos. Then you
can display them in a slideshow, email them, print them, use them as Desktop
backgrounds, or burn them to an archive disc.

IMPORTING IMAGES FROM YOUR
HARD DRIVE TO PHOTOS

Adding items stored on your hard drive, a CD, a DVD, an external drive, or a USB flash
drive is easy. If the images and clips are in a folder, just drag that folder from a Finder
window into the Viewer. You can even drag items directly to the Photos icon in the Dock.
Photos automatically creates a new album using the folder name, and you can sit back
while the images are imported into that new album.

If you have individual images, you can drag them as well. Select the images in a Finder
window, and drag them into the desired album in the Albums display. To add them to
the album currently displayed in the Viewer, drag the selected photos to the Viewer
instead.

If you'd rather import images by using a standard Mac Open dialog, choose File &> Import.
Simplicity strikes again!

You can allow Photos to import images directly from your iOS devices using My Photo
Stream, which | cover later in this chapter.
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FIGURE 14-2:
Adding a new
album in Photos.

A new kind of photo album

The most familiar method of organizing images in Photos is the album. Each
album can represent any designation you like, be it your pets, a vacation, your
daughter, or your daughter’s ex-boyfriends. Follow these steps:

1 . Create a new album.

You can choose File => New Album or press 38+N. If you've selected any item
thumbnails in the Viewer, they're added to the new album automatically.

2. Type the name of your new photo album in the Untitled Album text box
in the sidebar (see Figure 14-2).

3. Press Return.
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Photos also offers a special type of album called a Smart Album, which you can
create from the File menu. (For even faster action, press Option+3g+N.) If you’re
familiar with the Smart Folders that you can use within the Finder and the Smart
Playlists within iTunes (see Chapter 13), you’ve figured out this one already.

A Smart Album contains only photos that match certain criteria you choose, includ-
ing the keywords you assign your images. Other criteria include text in the photo
filenames, the dates when the images were added to Photos, a specific person
you’ve identified, and any description you added (as well as camera-specific data
such as ISO and shutter speed).
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Here’s the really nifty angle: Photos automatically builds and maintains Smart
Albums for you. It adds new photos that match the criteria and deletes those you
remove from your Photo Library (and also removes the photos that no longer
match the Smart Album’s criteria). Smart Album icons carry a gear symbol in the
Photos sidebar.

You can display (or edit) information about any photo or video clip. Right-click
the thumbnail, and choose Get Info from the contextual menu that appears. Click
the Add a Title heading in the dialog to display a text edit box, and simply type a
new value. You can also type a short note or description in the Add a Description
box that appears in the Info dialog.

You can copy selected items from the Viewer into any album you choose. Right-
click the desired items, hover your pointer over the Add To contextual menu item,
and choose the destination album. You can also copy selected items to an album
by dragging them from the Viewer to the desired album entry in the sidebar.

To remove a photo or video clip that has fallen out of favor, follow these steps:

1 . Click the desired album in the sidebar.
2. Inthe Viewer, click the item you want to remove to select it.
(To select multiple items to delete, hold down the $8 key while you click them.)

3. Press Delete.

When you remove a photo or clip from an album, you don’t remove the actual file
from your collection (represented by Photos button in the toolbar or the Photos
entry at the top of the sidebar). An album is actually a group of links to the images
in your collection, just as a playlist in iTunes is a group of links to songs in your
Music Library. If you want to remove an offending photo from Photos, click the
Photos button on the toolbar (or the Photos entry at the top of the sidebar) to dis-
play your entire collection of photos and clips, and delete the item there. The item
disappears from all albums with which it’s associated.

To remove an entire album, right-click the offending album entry in the sidebar,
and choose Delete Album from the contextual menu.

To rename an album from the sidebar, click the entry below the Albums heading
in the list to select it, and click again to display a text box. Type the new album
name, and press Return.
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HEY, WHAT HAPPENED TO MY EVENTS?

In iPhoto — the predecessor to Photos — an Event was a group of images you shot or
downloaded at the same time (much like a collection in Photos). Now that iPhoto has
bit the dust, you may be mourning the loss of your Events. Don't worry; they're still
available! You'll find that Photos includes a special album named iPhoto Events (which
is available as an entry in the sidebar list). Click this iPhoto Events entry in the sidebar,
and your existing Events appear like magic!

Note that you can no longer create Events within Photos, as collections now handle the
same chore.

Change your mind? Photos comes complete with a handy-dandy Undo feature.
Just press $8+Z, and it’s as though your last action never happened. (This trick is
great for those moments when you realize that you just deleted your only image
of your first car from your Library.) For an extra level of backup protection for
your priceless images, you can invest in an external hard drive and use the awe-
some macOS Time Machine backup feature.

Working with People
Photos includes a powerful organizational tool called People, which appears as a

separate item within the sidebar.

People is a sophisticated recognition system that automatically recognizes human
faces within the photos you add to your Photos Library. (I don’t know whether it
works well with pets, but you can try.) Naturally, you have to identify — or tag —
faces before Photos can recognize them.

To tag a face, follow these steps:

1. Inthe Viewer, double-click the photo with a person you want to tag.

Note that Photos indicates each person'’s face in the photo with a circle. If a
face has already been tagged, the label (which appears when you hover your
pointer over the icon) matches the person’s face.

2. To set Photos to always show labels in the Viewer — so that you don’t
have to click the Add Faces link — choose View > Show Face Names.

3. Click the unnamed label below the person'’s face to open a text box, as
shown in Figure 14-3.
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4, Type the person’s name, and press Return.

5. Ifthe name appears on a Contacts contact card (or is recognized
as an existing People name or as one of your Facebook friends),click
the matching entry that appears to confirm the identity.

Wowzers!

6. To delete an incorrect face recognition, right-click inside the circle
that appears around the face, and choose This is Not (Name) from
the contextual menu that appears.

Photos may not recognize the face if the person is turned at an angle to the camera
or is in a darker area of the photo. If so, display the Info pane, and click the Add
Faces link to display a “floating” circular outline; then click the outline, and drag
the circle over the person’s face. If necessary, you can resize the box by using the
handle that appears on the right side of the circle. Now you can click the Click to
Name label and type the person’s name.

After you tag an image, it appears in your People collection, which you can view
by clicking the People entry in the sidebar. You can double-click a portrait in your
People collection to see all the images that contain that person.

Organizing with keywords

“Okay, Mark, albums and People are great ideas, but there has to be a way to
search my Library by category!” Never fear, good Mac owner. You can also assign
descriptive keywords to items to help organize your Library and locate certain
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TIP

FIGURE 14-4:
Add keywords to
these selected
images.

pictures and video clips fast. Photos comes with standard keywords, and you can
create your own as well.

Suppose that you’d like to identify your images according to special events in your
family. Birthday photos should have their own keyword, and anniversaries deserve
another. By assigning keywords, you can search for Elsie’s birthdays or your silver
wedding anniversary (no matter what collection or album they’re in), and all
related photos with those keywords appear like magic!

Photos includes keywords that are already available:

¥ Favorite

¥ Family

» Kids

¥ Vacation

¥ Birthday

3 Photo Booth
¥ Photo Stream
3 Check Mark

What’s the check mark all about, you ask? It’s a special case. The Check Mark
keyword comes in handy for temporarily identifying specific items, because you
can search for only your check-marked photos and clips.

To assign keywords to images (or to remove keywords that have already been
assigned), select one or more photos in the Viewer. Choose Window > Keyword
Manager or press 38+K to display the Keywords window, as shown in Figure 14-4.

Quick Group

Favorite Keywords
Drag your favorite keywords below. They will also appear in the Show

Only menu.
v Keywords
v Alexandra... Birthday Dwayne Jo...
Farnily Favorite Flagged IIfenes
Jon Bass Kids Photo Stre.. Tim Curry
Vacation Zac Efron

Edit Keywords

CHAPTER 14 Focusing on Photos 249



250

TIP
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REMEMBER

TIP

YOU NEED YOUR OWN KEYWORDS

| bet that you take photos and video clips of things other than just kids and vacations.
That's why Photos allows you to create your own keywords. Display the Photos
Keywords window by pressing $8+K, click the Edit Keywords button, and then click
Add (the button with the plus sign). Photos adds a new unnamed keyword to the

list as an edit box, ready for you to type its name.

You can rename an existing keyword from this same window, too. Click a keyword to
select it and then click Rename. Remember, however, that renaming a keyword affects
all the images that were tagged with that keyword. That may be confusing when, for exam-
ple, photos originally tagged as Family suddenly appear with the keyword Foodstuffs.

(I recommend applying a new keyword and deleting the old one if this problem crops up.)

To change the keyboard shortcut assigned to a keyword, click the Shortcut button.
To remove an existing keyword from the list, click the keyword to select it and then
click the Delete button, which bears a minus sign. When your keywords are picture-
perfect (pun grudgingly intended), click OK to save them.

Drag the keyword buttons that you use the most to the Quick Group section of the
Keywords window, and Photos automatically creates a keyboard shortcut for each
keyword in the Quick Group. Now you don’t even need to display the Keywords
window to get business done!

Click the buttons for the keywords you want to attach to the selected images to
mark them. Or click the highlighted buttons for the keywords you want to remove
from the selected items.

Digging through your library with keywords

Behold the power of keywords! To sift through your entire collection of images by
using keywords, click the Search button on the toolbar in the top-right corner of
the Photos window, and type one or more keywords. To see all the items you’ve
flagged as Favorites that include kids, for example, you’d type Favorite Kids.

The images that remain in the Viewer after a search must have all the keywords
you specified. If an image is identified by only three of four keywords you chose,
it isn’t a match and doesn’t appear in the Viewer. (You can create a Smart Album
with specific keywords to get around this limitation.)

To search for a photo by words in its description, click the Search box, and start
typing. You can search your images by date and rating as well.
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REMEMBER

TIP

Searching by locations where photos were taken

Photos can also track the location where photos were taken automatically, but this
feature requires a digital camera that includes GPS tracking information in the
image metadata for Photos to do so without your help. (Older camera models are
unlikely to support GPS tracking. Naturally, newer iPhones and iPads support this
feature.) You don’t have to turn anything on to view photos by location.

When you’re viewing photos by moments and collections, you’ll notice that Photos
includes the location name to identify where the photos were taken. To search for
all images taken in a specific location, type the location name in the Search field.

If you right-click a specific photo (that includes location information) to select it
and then choose Get Info from the contextual menu, you see a close-up map of the
location where the photo was taken.

Edit mode: Removing and fixing
stuff the right way

Not every digital image is perfect. Just look at my collection if you need proof. For
shots that need a pixel massage, Photos includes editing tools that you can use to
correct common problems.

The first step in any editing job is selecting the image you want to fix. (Double-
click a thumbnail in the Viewer so that it fills the screen.) Then click the Edit but-
ton on the Photos toolbar (or simply press Return) to display the Edit mode
controls on the right side of the window, as shown in Figure 14-5. Now you’re
ready to fix problems, using the tools I discuss in the rest of this section.

If you display a video clip in the Viewer, you can play it by hovering your pointer
over the clip and clicking the Play button that appears. You can edit only photo-
graphs, however, so the Edit button is disabled when you’re viewing a video clip.

While you’re editing, you can press the left- and right-arrow keys to move to the
next image (or back to the previous image). This trick works whether you’re
browsing the Library or displaying the contents of an album. You can also display
the Thumbnail pane in Edit mode.

If you prefer to edit images while using more of your screen real estate, click the
Full Screen/Maximize button in the top-left corner of the Photos window. To
switch back to the standard window arrangement, press the Esc key.

When you’re finished with Edit mode, click the (wait for it) Done button to return

to the Viewer.
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FIGURE 14-5:
Photos is now

in edit mode.
Watch out,
image problems!

o s con

Rotating tipped-over shots

If an image is in the wrong orientation and needs to be turned to display correctly,
click the Rotate button to turn it once in a counterclockwise direction. Hold down
the Option key while you click the Rotate button to rotate in a clockwise direction.

Crop 'til you drop (and a whole lot more)

Does that photo have an intruder hovering around the edges of the subject? You
can remove some of the border by cropping an image, just as folks once did with
film prints and a pair of scissors. (We’ve come a long way.) With Photos, you can
remove unwanted portions from the edges of an image, which is a great way to get
Uncle Milton’s stray head (complete with toupee) out of an otherwise-perfect
holiday snapshot.

While you’re in Editing mode, follow these steps to crop, flip, and straighten an
image:

1. click the Crop button at the top of the window.

2. Sselectthe portion of the image you want to keep.

In the Viewer, click and drag the right-angle handles in the corners of the
rectangle to outline the part of the image you want. Whatever is outside this
rectangle disappears when the crop is complete.
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When you drag a corner or edge of the outline, a semi opaque grid (familiar to
amateur and professional photographers as the nine rectangles from the Rule
of Thirds) appears to help you visualize what you're claiming. (Check it out in
TIP Figure 14-6.)

You can expand the outline to the image's full dimensions at any time by
clicking the Reset button.

Notice the attractive Auto button that appears in the bottom-right corner of
the Photos window when you click the Crop button? A single click of the Auto
button, and Photos takes its best shot at producing the ideal cropping and
straightening job for you! If you don't like the results, use the Undo feature
(88+2) to return the photo to its previous appearance.

Photos features multiple Undo levels, so you can press $8+Z several times to
travel back through several changes. Alternatively, you can return the image to

its original form (before you did any editing at all) by clicking the Reset button.
REMEMBER

| Revertto Original B Adust @ Filters

FIGURE 14-6:
Select the stuff
you want to keep
in your photo.

3. (Optional) Choose a preset aspect ratio.

You may want to force your cropped selection to a specific aspect ratio, such as
4x3 or 16x9 for a widescreen desktop background, or 4x6 or 5x7 to match the
dimensions of photo paper. If so, click the Aspect item on the right side of the
window, and choose that ratio from the pop-up menu that appears. (Choose
the Square menu item for the perfect Facebook profile image and Freeform to
allow any aspect ratio when your cropping is done.)
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4, (Optional) Flip your photo horizontally.
A click of the Flip item gives you the mirror image of your original photo.
5. (Optional) Straighten what's crooked.

Was your camera slightly tilted when you took the perfect shot? Never fear!
Click the circular angle control at the right edge of the image, and drag in the
desired direction. (Besides straightening the subject, you can do some truly
wild camera angles this way, just like in the '60s Batman TV series!)

6. Click the Done button.

Enhancing images to add pizzazz

If a photo looks washed out, click the Auto Enhance button to increase (or decrease)
the color saturation and improve the brightness and contrast. Auto Enhance is
automatic, so you don’t have to set anything — but be prepared to use Undo if
you’re dissatisfied with the changes.

Removing rampant red-eye

Unfortunately, today’s digital cameras can still produce the same “zombies with
red eyeballs” as traditional film cameras. Red-eye is caused by a camera’s flash
reflecting off the eyes’ interior surfaces, and it can occur with both humans and
animals. (I’'m told that pets get green-eye or blue-eye, but Photos can handle
them too.)

Photos can remove red-eye and green-eye and turn frightening zombies back into
your family and friends. In Editing mode, click the Adjust button at the top of the
window; then hover your pointer over the Red-Eye item on the right side of the
screen, and click the Auto button that appears. Photos automatically attempts to
remove any red-eye effect it detects in the photo, and a blue check mark appears
next to the Red-Eye item to indicate that a change was made.

Retouching like the pros

The Photos Retouch feature is perfect for removing minor flecks or lines in an
image (especially those that you’ve scanned from prints). Click the disclosure
triangle (which looks like a right arrow) by the Retouch item, and click the Edit
button that appears (it carries a paintbrush icon). Now hover your pointer over the
photo to display the circular retouch tool. You can drag the Size slider to change
the size of the retouch tool. Drag the pointer across the imperfection, and click
Done when you’re finished touching up. Don’t forget to take a moment to marvel
at your editing skill!
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| REALLY NEED A SLIDESHOW

You can use Photos to create slideshows by following these steps:

1. Right-click the desired album in the sidebar, and choose Create = Slideshow
from the contextual menu.

2. Type the name of the slideshow in the text box, and press Return.

Photos adds a adds a new entry below Projects in the sidebar. Also, a scrolling thumb-
nail strip appears at the bottom of the Viewer, displaying the images in the alboum.

3. Click and drag the thumbnails to the desired order.

After creating your slideshow, you can customize it with the controls that appear on the
right side of the Photos window:

® Themes: Click the Theme Picker button to choose the theme for your slideshow.
The theme you choose controls the animation, transition type, and screen layout
that Photos uses — everything from the classic Ken Burns “moving photo” anima-
tion to a nifty Sliding Panels layout.

® Music: Click the Music button to display Apple’s theme music, as well as the tracks
from your iTunes Library. To choose a standard theme, choose Theme Songs from
the Source pop-up menu; then click the perfect song to select it. To choose songs
from your iTunes Library, choose iTunes from the Source pop-up menu; then click
the songs you want in the order in which you want them.

® Duration: Click the Duration Settings button, and choose to fit the display of
images to the length of the music you've chosen, or set individual timings for the
slide thumbnails you've selected. If you want your slideshow to loop when it fin-
ishes, click the Loop icon that appears in the bottom-right corner of the Viewer to
toggle it on. (The icon turns blue when the feature is on.)

To display a preview of your slideshow without leaving the Photos window, click the
Preview button in the bottom-left corner of the Viewer. This preview is a handy way
to determine whether the theme and music you've selected are really what you
want. When you're ready to play your slideshow, click the Play button that appears
below the Viewer, and Photos switches to full-screen mode. To create a movie file
from your completed slideshow, click Export on the Photos toolbar.

Using filters and adjustments to add a mood

Wonder whether a particular photo in your Library would look better as a black-
and-white (grayscale) print? Click the Filters button at the top of the screen to
display a list of effects that you can apply to the photo, including black-and-white
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effects, enhanced color levels, and subtle shading. Click any thumbnail on the
strip to apply the filter.

If you’d like more precise manual control of your image attributes — including
sharpness, color levels, shadows, definition, and white balance — click the Adjust
button at the top of the screen, and explore the lengthy array of options. Note that
most of the adjustments offer an Auto button if you hover your pointer over the
entry, and you can click the disclosure triangle to the left of each entry to display
additional controls that you can use to create a different look.

Exploring iCloud Photo Library

256

Yes, Apple has decided that everything except the kitchen sink should be stored
online in iCloud — first your iTunes Music Library; then your Pages, Numbers,
and Keynote documents; and it’s your photographs and video clips. To turn the
iCloud Photo Library feature on, choose Photos Preferences, click the iCloud tab
of the Preferences dialog, and click the iCloud Photos check box to enable it.

With iCloud Photo Library, your entire Photos Library is stored online, and every-
thing in your Library is also accessible from other Macs and iOS devices, such as
your iPad and iPhone. (Think “central storage house for everything visual that you
can reach from anywhere with an Internet connection.”) If you take a photo with
your iPhone, for example, you’ll see it appear automatically within Photos. And if
you’ve recently cropped and edited a photo to perfection with Photos, you’ll be
able to retrieve that edited photo on any of your iOS devices or another Mac.

From the same iCloud pane in the Preferences dialog, you can choose to:

¥ Download copies of the full-size images and full-resolution videos on your
iMac Pro's internal drive (allowing you to edit or view the originals even when
you're not connected to the Internet)

¥ Store smaller images and smaller-resolution videos on your internal drive,
with the ability to retrieve the originals from the iCloud at any time (if you're
connected to the Internet)

Naturally, if you’re a photographer who needs constant, instant access to your
original images, the first option is preferable. (Choose the Download Originals to
This Mac option in the iCloud pane.)If your iMac’s drive is nearly full, however,
and you’d like to conserve space, the second option is attractive. (Choose the
Optimize Mac Storage option in the iCloud pane.)

All this goodness is handled automatically, but there’s a catch: Your entire Photos
Library needs to fit within your free 5GB of iCloud storage. Otherwise you’ll have
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to pay a monthly subscription to get additional elbow room! (Storage subscrip-
tions range from 99 cents a month for 50GB of space to $10 a month for a whop-
ping 2TB of space.) If you have only 3GB of photos, you may be able to use iCloud
Photo Library without spending anything extra, but because my Photos Library is
nearing 10GB,I’d probably need to subscribe to take full advantage of the feature.
The choice is yours, dear reader: If you decide not to use the iCloud Photo Library,
rest assured that Photo Stream will still work as it did in iPhoto.

Putting My Photo Stream and iCloud
Photo Sharing to Work

Like iPhoto before it, Photos includes the My Photo Stream feature that automati-
cally shares the photos you take among your Macs, your PCs, and iOS devices.
Unlike with iCloud Photo Library, however, your images and videos are stored on
your iMac’s internal drive, not in your iCloud storage. (The images and videos are
also always full-size and full-resolution.)

To turn on My Photo Stream, choose Photos > Preferences, click the iCloud toolbar
button on the Preferences dialog, and select the My Photo Stream check box. When
the feature is turned on, Photos should automatically import My Photo Stream
photos taken with iOS devices and other Mac computers to your Photos Library.

When the My Photo Stream feature is turned on, it’s a cinch to share images and
videos across your Apple computers and devices. Simply copy the items to the My
Photo Stream location in the sidebar. Photos automatically sends the selected
images to all compatible devices over your Internet connection. (Note that all
devices that use My Photo Stream must be configured with the same Apple ID.)

You can also choose to share specific photos by using Shared Albums, which can
be turned on from the Photos Preferences dialog. Choose Photos< Preferences,
click the iCloud tab on the toolbar in the Preferences dialog, and select the Shared
Albums check box.

To subscribe to a shared-album invitation from another person, right-click the
desired shared album in the sidebar, and click Accept.

To create your own shared album, select the images you want to share, click the
Share button on the toolbar, and click the Shared Albums item. Click the New
Shared Album button, and Photos prompts you for the album name and the email
addresses of the folks you want to invite to your shared album. After you enter
each email address, click the Create button at the bottom of the sheet to start the
ball rolling. You can also add or delete items from your shared album in the same
way that you would with a regular Photos album.
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» Adding animated maps

» Creating a movie trailer

» Sharing your movie with others

Chapter 15

Making Film History
with iMovie

emember those home movies you used to make in high school? They were

entertaining and fun to create, and your friends were impressed. In fact,

some kids were so downright inspired, you’re not surprised when you dis-
cover at your high-school reunion that they turned out to be graphic artists or got
involved in video or TV production.

iMovie, part of Apple’s digital lifestyle suite, makes moviemaking as easy as those
homemade movies. Apple simplifies all the technical stuff, such as importing
video and adding audio, leaving you free to concentrate on your creative ideas.
In fact, you won’t find techy terms such as codecs and keyframes in this chapter.
I guarantee that you’ll understand what’s going on at all times. (How often do you
get a promise like that with video-editing software?)

With iMovie, digital video from your smartphone or your camcorder, and the other
applications that Apple provides, you can soon produce and share professional-
looking movies, with some of the same creative transitions and titles used by
Those Hollywood Types every single day — all on your iMac or iMac Pro, all by
yourself.
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If you turn out to be a world-famous Hollywood-Type Director in a decade or so,
don’t forget the little people — like computer-book authors — along the way!

Shaking Hands with the iMovie Window

If you've ever tried using a professional-level video-editing application, you
probably felt as though you were suddenly dropped into the cockpit of a jumbo jet.
In iMovie, though, all the controls you need are easy to use and logically placed.

To launch iMovie, click the iMovie icon on the Dock or within Launchpad. (It looks
like a star on the Hollywood Walk of Fame.) You can also click the Applications
folder in any Finder-window Sidebar and then double-click the iMovie icon.

To follow the examples I show you here, take these strenuous steps to create a
new movie project:
1 . Choose File=> New Movie (or press 35+N).

Alternatively, you can click the Create New thumbnail and choose the Movie
entry from the pop-up menu.

You can also create movie trailers (short previews or teasers) within iMovie,
as | demonstrate later in this chapter. Generally, however, you should create
your trailer project after your movie is completed (unless, of course, you're
TIP specifically creating just a trailer). Why? For the same reason that studios

create trailers after the filming is finished: After you complete your movie,
all the clips will be imported already, and you'll have a better idea of what
you want to include while “teasing” your audience!

2. Press $5+6 to display the Theme Chooser.
iMovie displays the window shown in Figure 15-1.

3. Click a Theme thumbnail to select a theme to apply to your finished

movie.
To preview the appearance of a theme, hover your cursor over the thumbnail,
and click the Play button that appears.

TIP iMovie automatically adds the transitions and titles that correspond to that
theme.

Normally, this step is what you want to do, but you can add transitions and
titles manually, as | show you later in this chapter. So if you decide not to use
a theme out of the gate, you don't have to open the Theme Chooser at all.
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Photo Album Playful

FIGURE 15-1:
Selecting a new
movie project
theme within

iMovie.
4. Click the Change button in the bottom-right corner of the window.
iMovie adds the new project to the list in the sidebar, and you're on your way!
Check out Figure 15-2: the whole enchilada in one window.
Content Library
Libraries List Event/Project Library pane Toolbar Viewer
< Projects | Ep H Mark's Home Movie
"
o
FIGURE 15-2:
iMovie is a lean,
mean, video-
producing )
machine. Playhead Project pane
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TIP
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REMEMBER

You’ll use these controls and displays most often:

»

»

»

»

»

»

Viewer: Think of the Viewer as being like your TV or computer monitor. Your
video clips, still images, and finished movie play here. You also crop and rotate
your video within the Viewer.

Content Library: This row of buttons allows you to add photos, video clips,
audio, and effects (such as transitions, titles, music, and sounds).

Libraries List: This sidebar list allows you to display your photos from your
Photos library. (You can also display images from your Aperture library, if you
used this legacy application.) Additionally, the Libraries list displays all the video
clips you can add to your project from events you've imported. The items in the
list change, depending on the type of content you've chosen from the Content
Library. You can also select an existing iMovie project from the iMovie Library.
To hide the Libraries list and make more room for the media pane, click the
Hide button that appears in the top-right corner of the Libraries list. (To display
the Libraries list again, click the same button, which now reads Show.)

You can hide and show both the Content Library and the Libraries list with
one click of the Show or Hide the Media Library button, which appears in the
top-left corner of the iMovie window. By hiding both, you maximize the space
available for your Viewer.

Event/Project Library pane: If you select an event from the All Events entry
in the Libraries list, iMovie displays a thumbnail of that event's content in the
Event pane. (Move your cursor over the Event thumbnail to see previews of
the clips.) If you decide that you want to include a clip, double-click the Event
to display the clips, and add the desired clip to your project. This pane also
acts as the Project Library pane, where you can display your existing iMovie
projects; click the Projects entry in the Libraries list to display your projects as
thumbnails. To load a project, double-click the thumbnail; it appears in the
Project pane.

The Event/Project Library pane displays different content, depending on the
entry you select in the Libraries list.

Project pane: This pane is where most of your work gets done within iMovie,
displaying the elements you added to that specific project (such as video clips,
still photos, and audio clips). Your movie appears as a linear strip of thumb-
nails, making it easy to select, insert, and delete elements.

Playhead: The white vertical line you see in the Project pane (or the red
vertical line you see in the Event/Project Library pane) is the playhead, which
indicates the current editing point while you're browsing your clips or creating
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your movie. When you're playing your movie, the playhead moves to follow
your progress through the movie.

¥ Toolbar: This strip of buttons allows you to enhance and adjust photos and

video clips.

Those elements are the major highlights of the iMovie window. A director’s chair
and megaphone are optional, of course, but they do add to the mood.

A Bird's-Eye View of Moviemaking

I don’t want to box in your creative skills. After all, you can attack the moviemak-
ing process from several angles (pun unfortunately intended).I’ve found, how-
ever, that my movies turn out best when I follow a linear process. So before I dive
into specifics, allow me to give you an overview of moviemaking with iMovie.

Here’s my take on the process, reduced to seven basic steps:

1.
2.
3.

Import your video clips from your camcorder, your iMac’'s FaceTime HD
camera, your Photos Library, or your internal/external drive.

Drag your clips from the Event pane to the Project pane, and arrange
them in the desired order.

Import or record audio clips (from iTunes, GarageBand, or external
sources, such as audio CDs or audio files you've recorded yourself), and
add them to your movie.

Import your photos (directly from Photos or your hard drive), and place
them where needed in your movie.

Add professional niceties, such as voiceovers, transitions, effects, and
text to the project.

Preview your film, and edit it further if necessary.

Share your finished film with others through the web, email, your Apple
TV, an iOS device (an iPhone or iPad), or within iMovie Theater.

If you have a iMac with an internal optical drive or an external USB optical
drive, you can also use a DVD recording application to create a DVD movie disc
of your exported movie. | use (and recommend) Toast 16Titanium by
Roxio(www . roxio.com).

CHAPTER 15 Making Film History with iMovie 263


http://www.roxio.com

TIP

Wonder how you save your project in iMovie, especially when the File menu has
no Save item? iMovie automatically saves your project as you work, leaving you
free to concentrate on your moviemaking art.

Importing the Building Blocks

264

TIP

Sure, you need video clips to create a movie of your own, but don’t panic if you
have a small supply. You can certainly turn to Apple’s other digital media applica-
tions for additional raw material. (See, I told you that whole “integration” thing
would come in handy.)

Along with video clips you import from your DV camcorder, your iMac’s trusty
built-in FaceTime HD camera (or an external webcam), and your hard drive, you
can call on Photos (as well as the legacy applications iPhoto and Aperture) for the
still images you’ll need for your credits. On the audio side, you can call on iTunes
and GarageBand for background audio and effects. In this section, I show you how.

Pulling in video clips

Your aluminum supercomputer comes equipped with extras that come in handy for
video editing: a large internal drive and ports to connect stuff. Depending on the
iMac model you’re using and your external devices, you may use a USB or Thun-
derbolt connection. Today’s mass-storage camcorders, tablets, and smartphones
typically use a USB connection to transfer clips. I cover both older tape-based cam-
corders and USB/Thunderbolt mass-storage devices in this section.

Oh, and don’t forget that your iMac has a FaceTime HD camera on board, ready to
record clips. Heck, you’re a self-contained movie studio!

Here’s the drill if your clips are on your camcorder or mass-storage USB/
Thunderbolt video device:

1. Plug the proper cable into your iMac.
2. Set the camcorder to VTR (or VCR) mode.

Some video devices call this mode Play mode.
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Click the Import button at the left side of the iMovie menu bar. The
Import button bears a downward-facing arrow (refer to Figure 15-2).

iMovie opens the Import window.

Open the Import To pop-up menu at the top of the Import window, and
choose the destination for your new video clips.

To create a new event for the imported clips, choose New Event. Alternatively,
you can import into an existing Event or iMovie project. If your family reunion
spanned more than one day, you can create a new Event for each day. (How
does Apple think up these things?)

Click the desired video source in the Source list on the left side of the
Import window.

If you're using a tape-based camcorder, playback controls appear below the
Camera Import window, mirroring the controls on your camcorder. This
feature allows you to control the unit from iMovie. Keen! If you're using a
mass-storage camcorder connected by USB, you instead get an Import All
button below the thumbnails of available clips. (Note that this button changes
to Import Selected if you select one or more of the clips.)

If you choose your FaceTime HD camera in the list, you see a real-time preview
and a big red Record button. Click the Record button to start and stop record-
ing. (You can skip the rest of the steps in this section, which deal only with
camcorders.)

To import selected clips from your camcorder, advance the video to a
couple of seconds before the point where you want to start your capture;
then click Import.

Click OK, and admire your handiwork.

iMovie begins transferring the footage to your drive and automatically adds
the imported clips to the specified destination.

If your clips are already on your drive, rest assured that iMovie can import them,
including those in high-definition video (HDV) format and 4K format. iMovie also
recognizes other video formats, as shown in Table 15-1.

To import a movie file, follow this bouncing ball:

1.
2.

Click the Import button on the toolbar.

Click the drive that stores your clips in the window's sidebar, and
navigate to their location.
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TABLE 15-1

3. Select the desired clips in the list.

4. Fromthe Import To pop-up menu at the top of the Import window,
choose the destination within iMovie.

5. click Import.

Video Formats Supported by iMovie

File Type Description

DV Standard 4:3 digital video

DV Widescreen 16:9 digital video

widescreen

MOV QuickTime movies

HDV and High-definition (popularly called widescreen) digital video, in 720p
AVCHD and 1080i

MPEG-2 Digital video format used for DVD movies

MPEG-4 A popular format for streaming Internet and wireless digital video, as

well as handheld iOS devices such as the iPad, iPhone, and iPod touch

Alternatively, you can drag a video clip from a Finder window and drop it in the
Project pane.

Making use of still images

Still images come in handy as impressive-looking titles or as ending credits for
your movie. (To be truly professional, make sure that you list a gaffer and a best
boy. I have no idea what they do, but they’re always listed.) You also can use still
images to introduce scenes, close scenes, and separate clips. I use stills when
delineating the days of a vacation within a movie or different Christmas celebra-
tions over time.

Here are two methods of adding stills to your movie:

¥ Adding images and video clips from Photos (or Apple's legacy iPhoto
and Aperture applications): Click the Photos, iPhoto, or Aperture Library
entry in the Libraries list to access your images right from iMovie (as shown
in Figure 15-3). When you find the image you want to add, drag it to the right
spot in the Project pane.
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FIGURE 15-3:
Pulling still
images from
Photos is
child's play.

¥ Importing images from your drive: If you're a member of the International
Drag-and-Drop Society, you can drag TIFF, JPEG, GIF, PICT, PNG, and PSD
images directly from a Finder window to the Project pane.

Croiecrs |y

My Media

Importing and adding audio
from all sorts of places

You can pull in everything from Wagner to Weezer as both background music and
sound effects for your movie. In this section, I focus on how to get those notes
into iMovie and then how to add them to your movie by dragging them to the
Project pane.

You can add audio from several sources:

3 Adding songs from iTunes and GarageBand: Click the Audio media button
in the Content Library, and click the iTunes entry in the sidebar to display the
contents of your iTunes Library. Click the desired song in the scrolling list
(which displays all your music). To display a playlist or Smart Playlist, click the
Music drop-down list box above the waveform display. Figure 15-4 illustrates
a playlist of Frank Sinatra | selected for this project. You can add a track to
your movie by dragging any song entry from the list to the desired spot in the
Project pane. (If you'll be sharing your video with the public, you should have
permission to include all of the music tracks in your work.)
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You're not limited to iTunes for ear candy, however. If you exported any
original music you've composed in GarageBand to your iTunes Library, you
can use those songs in your movie. Click the GarageBand button in the
sidebar to view your GarageBand music, and then drag and drop to your
heart's content.

L] < Projects | | Mark's Home Movie:

My Media

A Munes

FIGURE 15-4:
Calling on my
iTunes Library to
add Ol' Blue Eyes
to my iMovie.

3 Adding sound effects: If you need the sound of a horse galloping for your
Rocky Mountains vacation clips, click the Audio button in the Content Library;
then click Sound Effects in the sidebar. iMovie includes several top-shelf audio
effects that you can use in the sound-effects audio track in the Project pane.
This way, you can add sound effects even when you've already added a
background song. Again, to add a sound effect, drag it to the perfect spot in
the Project pane.

If you have several gigabytes of music in your iTunes Library, it maybe more

@ of a challenge to locate Janis Joplin's rendition of “Me and Bobby McGee,”
especially if she's included in a compilation. Let your supercomputer do the
TIP digging for you! Click the Search box above the track list (which carries the

familiar magnifying-glass icon), and begin typing a song name. iMovie narrows
down the song titles displayed to those that match the characters you type.
To reset the search box and display all your songs in the Library or selected
playlist, click the X icon that appears to the right of the box.

3 Recording directly from a microphone: Yep, if you're thinking voiceover
narration, you've hit the nail on the head. Check out the nearby sidebar
“Narration the easy way” for the scoop.
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NARRATION THE EASY WAY

Ready to create that award-winning nature documentary? You can add voiceover narra-
tion to your iMovie project that would make Jacques Cousteau proud. In fact, you can
record your voice while you watch your movie playing, allowing perfect synchronization
with the action! To add narration, follow these steps:

1. PressV to display the Voiceover controls below the Viewer.

2. Click the Voiceover Options button, and select the input device.

Today's iMac models sport stereo internal microphones, but you can always add a
professional-grade USB microphone to your system for higher-quality recording.

3. Drag the input volume slider to a comfortable level.

4. To mute the audio from your movie (which may make it easier to concentrate
on your narration), select the Mute Project check box.

5. Click the desired spot within your movie in the Project pane where the narra-
tion should begin.

6. Click the Start Recording button.

iMovie prompts you with three tones before the playhead reaches the selected spot
in your movie, so make sure that you begin speaking after the third tone.

7. Watch the video while you narrate so that you can coordinate your narration
track with the action.

8. Click the red Stop Recording button to stop recording.
iMovie adds an icon to the Project pane below the video with the voiceover.

9. Click the Close button in the Voiceover controls.

Building the Cinematic Basics

It’s time to dive in and add the building blocks to create your movie. Along with
the video clips, audio tracks, and still images you’ve imported, you can add
Hollywood-quality transitions, optical effects, and animated text titles. In this
section, I demonstrate how to elevate your collection of video clips into a real-life,
honest-to-goodness movie.
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Adding clips to your movie

You can add clips to your movie via the Project pane and Event/Project Library
pane (refer to Figure 15-2). The Dynamic Duo works like this:

3 Project pane: This pane displays the media you've added to your project so
far, allowing you to rearrange the clips, titles, transitions, and still images in
your movie.

3 Event/Project Library pane: This pane acts as the source repository for all
your clips, displaying them arranged by Event (the date when they were shot
or imported) or by Project (media you've added to existing iMovie projects).

Typically, you add a clip to your movie from an Event. Follow these steps:

1. click the My Media button in the Content Library.

. Click the All Events entry in the Libraries list.

3. Move the cursor across clips in the Event pane to watch a preview of the
video.
4

. When you've decided what to add to your project, add the entire clip
or a selection:

To select an entire clip: Right-click the clip’s thumbnail, and choose Select
Entire Clip from the contextual menu that appears.

To select a portion of a clip: Click and hold down the mouse button, and
drag the cursor across the thumbnail. A yellow frame appears around your
selection. To change the length of the selected video, hover the cursor
over either end of the clip, and drag the handle that appears on either
side. If you make a mistake while selecting video, click any empty space
within the Event pane to remove the selection frame and try again.

5. Drag the selection from the Event pane to the spot where it belongs
in the Project pane.

Alternatively, you can press the E key.
Preview your work — and do it often.

iMovie includes a Play Full Screen button, which appears at the lower-right corner
of the Viewer. (Alternatively, press 38+Shift+F or choose View= Play Full Screen to
watch the selection.) Press the spacebar to pause, and press Esc to return to iMovie.
You can also move the cursor across the filmstrip in the Project pane to browse
your project quickly.
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TIP

To play a selection from the beginning, press \ (the backslash). If you’ve ever
watched a director at work on a movie set, you may have noticed that he or she
constantly watches a monitor to see what things will look like for the audience.
You have the same option in iMovie!

Marking clips

While you’re watching video in the Event/Project Library pane, you may decide
that a certain clip has a favorite scene or that another clip has material you don’t
want, such as Uncle Ed’s shadow puppets. (Shudder.) iMovie features Favorite and
Rejected frames, allowing you to view and use your best camera work (and ignore
the worst stuff).

To mark a great video clip as a Favorite, select and right-click a range of frames
or the entire clip in the Event/Project Library pane; then choose the Favorite item
from the contextual menu (or press F). To mark clips that are subpar, select the
offending clip in the Event/Project Library pane, and press Delete (or right-click
it and choose Reject from the contextual menu). Clips marked as Favorites have a
green line, and clips marked as Rejected have a red line.

You can use the Search Filter option to specify which types of marked clips are
shown. Click the pop-up menu next to the Search field at the top of the Event/
Project Library pane. Your options include displaying all clips, displaying only
Favorite clips, hiding Rejected clips, or displaying only Rejected clips.

If you decide that a Rejected clip isn’t so bad after all or that a Favorite really isn’t
your best work, no problem. Unmark any selected Favorite or Rejected scene in the
Event/Project Library pane by choosing Mark+ Unrate (or pressing U).

Removing clips from your movie

Don’t like a clip? Bah. To banish a clip from your movie, follow these steps:

1. click the offending clip in the Project pane to select it.

Alternatively, you can select a portion of a clip by holding down the mouse
button (or maintaining pressure on the trackpad) and dragging the selection
box that appears.

2. Press Delete.

This step deletes the clip from the Project pane, but the clip is still available if
you choose All Events or the iMovie Library from the Libraries list.
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If you remove the wrong clip, don’t panic. Instead, use iMovie’s Undo feature
(press 38+Z) to restore it.

Reordering clips in your movie

If Day One of your vacation appears after Day Two, you can easily reorder your
clips and stills by dragging them to the proper space in the Project pane. When you
take your finger off the mouse (or trackpad), iMovie automatically moves aside
the rest of your movie with a minimum of fuss and bother.

Editing clips in iMovie

If a clip has extra seconds of footage at the beginning or end (as it should, to
ensure that you get all the action), you don’t want that superfluous stuff in your
masterpiece. Our favorite video editor gives you the following basic functions:

¥ Crop: Removes unwanted material from a video clip or still image
¥ Rotate: Rotates a clip or image on its center axis

3 Trim: Trims frames from a video clip

Before you can edit, however, you have to select a section of a clip:

1. clicka clip or image in the Project pane (where changes you make are
specific to this project) or the Event pane (where edits you make are
reflected in any project that uses that footage).

iMovie displays the clip or image in the monitor.
2. Toselect the entire clip or image, click it.

3. Drag the cursor across the thumbnail to select the section of the media
you want to edit.

Some editing functions, such as Crop and Rotate, automatically apply to the
entire clip.

The selected region is surrounded by a yellow frame. You're ready to edit that
selected part of the clip.

4. Make fine changes to the selected section by dragging the handles that
appear when you move the cursor to the beginning or end of the
selection.

TIP
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To crop: Click the Crop button on the toolbar at the top of the Viewer. Drag
the edges of the frame, using the handles to select the section you want to
keep. To preview your selection, click the Play button that appears when
you move the cursor into the Viewer pane. When you're ready, click the
Done button (which bears a check mark), and everything but the selected
region is removed.

To rotate: Click the Crop button. Now click one of the two rotation buttons
that appear at the right side of the Viewer (both of which carry a box and
curved-arrow icon). Each click rotates the media 90 degrees in the indi-
cated direction. Click the Done button (with the check mark) when the clip
orimage is properly oriented.

To trim: Right-click the selection, and choose Trim to Playhead from the
contextual menu. iMovie removes the frames up to the playhead position
from the selected video.

Transitions for the masses

Many iMovie owners approach transitions as visual bookends, merely acting as
placeholders that appear between video clips. Nothing could be further from the
truth, though, because judicious use of transitions can make or break a scene.
Which would you prefer after a wedding ceremony: an abrupt, jarring cut to the
reception or a gradual fadeout to the reception?

Because today’s audiences are sensitive to transitions, you should try not to over-
use the same transition. Pick two or three that match the mood of your film and
the scenes between which you’re transitioning. Also, carefully weigh the visual
impact of a transition. You may even decide that having no transition is the most
effective. (Directors call the deliberate lack of a transition a jump cut.)

iMovie includes a surprising array of transitions, including old favorites (such as
Fade In and Dissolve) and some nifty stuff that you may not be familiar with (such
as Cube and Page Curl). To display your transitions collection (see Figure 15-5),
click the Transitions entry in the Content Library.

To see what a particular transition looks like, click the thumbnail to select it, and
move the cursor over the thumbnail to display the transition in the Viewer.

Adding a transition couldn’t be easier: Drag the transition from the thumbnail

list, and drop it between clips or between a clip and a still image in the Project
pane. In iMovie, transitions are applied in real time.
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Transitions

FIGURE 15-5:
Add transitions
for flow between
clips in iMovie.

Even Gone With the Wind had titles

The next stop on the iMovie Hollywood Features Tour is the Titles list, shown in
Figure 15-6. You find it by clicking the Titles entry in the Content Library. You can
add a title with a still image, but iMovie also includes everything you need to add
basic animated text to your movie.

Crrojeers

MyMedia  Audio sackgrounds R i & & @

-
Title

Subtitic

FIGURE 15-6:
Add titles for your
next silent film.

Most of the controls you can adjust are the same for each animation style. You can
change the font, the size of the text, and the color of the text. To add a title manu-
ally, follow these steps:
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Select a Title animation thumbnail from the Titles list, and drag it to the
desired spot in the Project pane.

Note that the title is previewed in the Viewer as well as in the Project pane.
Click the title strip in the Project pane to select it.

Click the Title Settings button (which bears a capital-T symbol) in the
toolbar to make any changes in the fonts or text attributes.

Click the text box within the Viewer to delete the default text and type
your own titles.

Click the Done (checkmark) button to save your changes.
Click the Play button in the Viewer to preview your title.

iMovie displays a preview of the effect in the Viewer with the settings you
choose.

Adding maps and backgrounds

iMovie includes easy-to-use animated maps — think Indiana Jones traveling by
airplane from place to place — and static backgrounds that can be used with your
titles. To display them, click the Backgrounds entry in the Content Library.

To use an animated map, follow these steps:

1.
2.
3.

4.

Drag one of the globe or map thumbnails to the Project pane.

When the globe or map is created, click it in the Project pane to select it.

Click the Map Settings button (which bears a globe icon) and then click
the Start Location button (and, optionally, the End Location button) to
enter the start and stop points for the animation.

Type a city or place name to see your choices. (Heck, you can even type an
airport code or decimal coordinates to specify the spot.)

Click Done.

Watch as iMovie animates your location (or your trip) in seconds!

To add a static background from the browser, drag it to the desired spot within the
Project pane.
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HAVE A SEAT IN THE iMOVIE THEATER

After you produce a great movie, what's the easiest way to watch it? Or how can you
quickly and easily share that movie with your other iOS devices and your Apple TV?
The answer is iMovie Theater mode, where you can add completed movies, trailers, and
individual video clips — and everything is shared automatically via iCloud! (Any Mac or
iOS device with iMovie installed includes its own iMovie Theater, and the stuff you add
appears there.)

Suppose that you want to present your content on your own iMac or on a projector or
external monitor that you've connected to your computer. Press the 3 key to display
thumbnails of the content you've shared to the Theater. You don't have to load a fin-
ished movie project in Library mode. Double-click any thumbnail to view that item. To
switch back and work on your current iMovie project, click the Projects button at the top
of the window (or press the 2 key).

To add a movie, trailer, or video clip in the Event/Project Library pane, click the item to
select it, click the Share button in the top-right corner of the iMovie window, and click
the Theater button.

Creating an Honest-to-Goodness
Movie Trailer

276

Yes, friends, you read that correctly: iMovie includes a Trailer feature that can
turn your film clips into a Hollywood-class preview, complete with genre transi-
tions and background music.

To create a trailer project, follow these steps:

1 . Choose File=> New Trailer (or click the Create New button and choose
Trailer from the pop-up menu).

2. Click a Movie Trailer thumbnail to select it.

If you hover the cursor over the thumbnail and click the Play icon that appears,
iMovie displays a nifty preview of the trailer style you selected. You can click
different thumbnails to preview their look before you decide. Naturally, you
want to choose a trailer style that most closely matches the mood you want to
project with your movie.
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Note that each trailer has a suggested number of cast members. This number
reflects the number of people who will appear in the clip placeholders during
the editing process. (More on this in a moment.)

3. Click Create.

iMovie replaces the Project pane with the Trailer pane, as shown in Figure 15-7.
You can fine-tune your trailer with the Outline, Storyboard, and Shot List tabs:

Outline: On the Outline tab, you can edit the titles used in the trailer, as
well as pop-up lists of information, such as the names of the star(s) and
the logo style you want for your “studio” at the beginning of the trailer.

To change a text field, click it and type the new text. The changes you make
in the Trailer display appear in the Viewer in real time.

Storyboard: When you complete your edits to the titles, click the Storyboard
tab. Now you can edit the text for each transition: Simply click the text to
display the edit box, and type. You can also drag clips from the Event pane
(or from a Finder window) to fill the storyboard's placeholders for video clips.
To delete a clip from the storyboard, click it to select it, and press Delete.

To preserve the look and feel of the trailer storyboard, try to match your
clips with the description and suggested activity indicated by the place-
holder. (In other words, don't stick a wide-angle video clip of the family dog
cavorting in the yard into a placeholder marked Closeup. You get the idea.)

The Storyboard tab may not look like an editing timeline, but you can move
the cursor anywhere within the storyboard to preview your trailer. The
playhead indicator appears wherever the cursor appears, allowing you

to watch the clip or transition it's resting on. You'll soon be sweeping the
cursor to the left or right to move through each section of your trailer.

Shot List: For an overall listing of each clip required for the full trailer, click
the Shot List tab. On this tab, clips are organized by type. All the action clips
appear in one section, for example, and all the landscape and close-up
clips are grouped as well. If necessary, you can also add, delete, or swap
video clips from the Shot List.

To preview your trailer in its entirety, click the Play button at the bottom of the
Viewer (or the Play Full-Screen button at the far-right end of the Viewer con-
trols). Naturally, any storyboard placeholder you haven’t filled with a clip displays
only the placeholder.

Note that iMovie displays your trailer when you click the Updated Projects entry in
the Libraries list, and it now appears in the Event/Project Library pane.

I bet that all those hard-working Hollywood video editors are fuming about how
easy it is to create a trailer in iMovie!
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FIGURE 15-7:

Build your movie
trailer from the

Trailer pane.
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Name and Date

Movie Name: The Game
Release Date: Septamder 23, 2015
Studio
Studio Name: AMLC Studios
Logo style: Sncuwy Mowntan Peak

Credits

Sharing Your Finished Classic with Others
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Your movie is complete, and iMovie has saved it automatically to your drive. Now
you’re wondering where to go from here. Select your movie in the Event/Project
Library pane, and click Share in the top-right corner of the window. iMovie can
unleash your movie on your unsuspecting family and friends (and even the entire
world) in several ways:

¥ iTunes: Send your movie to your iTunes Library as a movie.
¥ Theater: Add your movie to the iMovie Theater on your iMac.

3 YouTube/Facebook/Vimeo: Why, certainly you can send your iMovie
directly to any of these websites! Can it get any more convenient than that?
(I think not.)

¥ File: Create a copy of your movie on your hard drive in one of four resolutions
(from Standard Definition to High Definition).

3 Email: Send your movie as an email message attachment.

When you choose a sharing option, iMovie displays the video quality for the
option and makes automatic changes to the movie attributes. (Choosing
Email, for example, reduces the finished movie as far as possible in file size.)

If you're worried about permanently reducing the quality of your project
by sharing it in a smaller size, fear not! When you choose a sharing option
to export your movie, your original project remains on your hard drive,
unchanged, so you can share a better-quality version at any time in

the future.
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IN THIS CHAPTER

» Navigating the GarageBand window

» Adding tracks and loops to your song

» Repeating loops and extending
your song

» Building arrangements
» Adding effects to instruments
» Exporting your work across the globe

» Burning your song to an audio CD

Chapter 16

Recording Your Hits
with GarageBand

o you dream of making music? I’ve always wanted to join a band, but

I never devoted the time to learning to play the guitar. You know the drill:

Rock stars struggle for years to master an instrument, practice for untold
hours, and memorize chords. Wait a second; I almost forgot. You don’t need to do
any of that now!

Apple’s GarageBand lets a musical wannabe (like yours truly) make music with an
iMac — complete with a driving bass line, funky horns, and perfect drums that
never miss a beat. In fact, the thousands of prerecorded loops on tap in this awe-
some application allow you to design your music to match that melody running
through your head, from techno to jazz to alternative rock.

This chapter explains everything you need to know to create your first song. I also
show you how to import your hit recording into iTunes so that you can listen to it
on your iPhone with a big silly grin on your face (as I do) or add it to your next
iMovie project or Photos slideshow.

CHAPTER 16 Recording Your Hits with GarageBand 279



Don’t be too smug when you think of all that practicing and hard work you missed
out on. What a shame!

Shaking Hands with Your Band

As you can see in Figure 16-1, the GarageBand window isn’t complex, and that’s
good design. In this section, I list the most important controls so you know your
Play button from your Loop Browser button.

Rewind/Forward Media Browser
New Track Go to Beginning Loop Browser
Smart Controls Play Time/Tempo Volume slider

Classic Electric Piana
# 0 Q

e Wi 44th Street Long

4l 4dth Street Medium
4 44th Street Short

FIGURE 16-1:
The GarageBand
window, edged
in woodgrain,
no less. Track list Playhead  Timeline

Your music-making machine includes:

¥ Track list: In GarageBand, a track is a discrete instrument you set up to play
one part of your song. A classical piece for string quartet, for example, would
have four tracks: one each for violin, viola, cello, and bass. The Track list
contains all the tracks in your song, arranged so that you can easily see
and modify them, like the rows in a spreadsheet. A track begins in the list,

280 PART 4 Living the Digital Life



»

»

»

»
»

»

»

»

»

stretching out to the right all the way to the end of the song. In the top-left
corner of Figure 16-1, | already have one track defined: a Classic Electric Piano.

Timeline: This scrolling area holds the loops (see the next bullet) that you
add, compose, or record, allowing you to move and edit them easily. When
a song plays, the Timeline scrolls to give you a visual look at your music.
(Bear with me; you'll understand that cryptic statement in a page or two.)

Loop: Loops — prerecorded clips of an instrument being played in a specific
style and tempo — are the building blocks of your song. Most are five
seconds in length, and others are even shorter. You can drag loops from

the Loop Browser to a track and literally build a bass line or guitar solo. Loops
can also be repeated within a track, which I discuss further in a page or two.
(Note that loops haven't been added in Figure 16-1; you'll see them later.)

Playhead: This vertical line is a moving indicator that shows you the current
position in your song while it scrolls by in the Timeline. You can drag the
playhead to a new location at any time. The playhead also acts like the
insertion cursor in a word processing application: If you insert a section of

a song or a loop from the Clipboard, it appears at the playhead's current
location. (More on copying and inserting loops later, so don't panic.)

New Track button: Click this button to add a new track to your song.

View/Hide Loop Browser button: Click the button with the loop icon
to display the Loop Browser on the right side of the window (as shown
in Figure 16-1); click it again to close it. You can see more of your tracks'
contents at one time without scrolling by closing the Loop Browser.

View/Hide Media Browser button: Click this button (which bears icons of

a filmstrip, camera, and musical note) to display the Media Browser on the
right side of the window; click it again to close it (and see more of your tracks).
Use the Media Browser to add media (in this case, digital song files or movies)
to your GarageBand project for use as ringtones.

Go to Beginning button: Clicking this button returns the playhead to the
beginning of the Timeline. (Note that this button appears only when the
playhead isn't already at the beginning of the Timeline.)

Rewind/Forward One Measure buttons: To move quickly through your song
by jumping to the previous or next measure, click the corresponding button.

Play button: Hey, old friend! At last, here’s a control you've probably used
countless times before — and it works just like the same control within iTunes
or on your audio CD player. Click Play, and GarageBand begins playing your
entire song. Notice that the Play button turns green. To pause the music, click
Play again; the button loses that sexy green sheen, and the playhead stops.
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3 Time/Tempo display: This cool-looking LCD display shows you the beats and
time measurements for the current playhead position.

You can click the drop-down menu at the right of the display to switch
between beats and time.

TIP 3 Volume slider: Here's another familiar face. Just drag the slider to raise or
lower the volume.

More controls are scattered around the GarageBand window, of course, but these
are the main controls used to compose a song, which is the next stop!

Composing Made Easy

In this section, I cover the basics of composition in GarageBand, working from the
beginning. Follow along with this running example:
1. click the GarageBand icon on the Dock.

This icon looks like an electric guitar and an amplifier.

2. If GarageBand opens a window for a previous project, close it by clicking
the Close button in each window.

GarageBand displays the top-level New Project dialog, shown in Figure 16-2.

@ Choose a Project

New Project

|Z| Learn to Play e

w L
[*] Lesson store ll‘lll] D

Empty Project Keyboard C > Amp C

L Wéfﬂ

Ringtone Hip Hop Electronic

Create an emp

FIGURE 16-2:
Start creating » Details
your new song
here.

‘Open an existing Project...
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Click New Project in the list on the left side of the window.
Click the Empty Project icon; then click the Choose button.
GarageBand displays the Track Type dialog.

Click the Software Instrument icon.

In this chapter, | focus on using software instrument tracks, which are the
easiest for a nonmusician to use (and don't require you to play any notes on an
instrument).

Click the Create button.

You see the window shown in Figure 16-1. Now you're ready to add tracks.

Adding tracks

Although I’'m not a musician, I’'m a music lover. I know that many classical com-
posers approached a new work the same way you approach a new song in Garage-
Band: by envisioning the instruments they wanted to hear. (I imagine that Bach
and Beethoven would’ve been thrilled to use GarageBand, but I think they did a
pretty decent job with pen and paper.)

If you’ve followed along to this point, you’ve noticed these things:

»

»

A Musical Typing keyboard in your GarageBand window: You can record
the contents of a software instrument track by playing the Musical Typing
keyboard layout. (As you might imagine, this feature isn't the best solution.)
If you're a musician, the best method of recording your own notes is using

a MIDI instrument, which | discuss later in the chapter. You can display

the Musical Typing keyboard window at any time by pressing $8+K. If the
keyboard window is onscreen, and you don't need it, banish it by pressing
38+K or by clicking the Close button in the keyboard window.

The example song with only one empty track: If you want to write the next
classical masterpiece for Classic Electric Piano, that's fine. ('m a big fan of this
instrument, so I'll use this track later in the example.) Note that you can always
delete a track, however. Click the offending track to select it, and choose

Track = Delete Track.

You can use five kinds of tracks in GarageBand:

»

Software instrument tracks: These tracks aren't audio recordings. Rather,
they're mathematically precise algorithms that your iMac renders (builds) to fit
your needs. If you have a MIDI instrument connected to your laptop, you can
create your own software instrument tracks. (More on MIDI instruments later
in this chapter.)
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3 Real instrument tracks: These tracks are actual audio recordings, such
as your voice or a physical instrument without a MIDI connection. (Think
microphone.)

¥ Electric Guitar and Bass tracks: GarageBand includes a real instrument
track especially made for either an electric guitar or bass. This track allows
you to use different amplifiers and stompboxes (those effect pedals that
electric guitarists are always poking with their feet to change the sound of
their instruments).

3 Drummer track: | call this feature “Ringo in a Box” — a drum track that's
automatic, yet very configurable and easy to customize. You have presets
galore, so you can quickly jump into different drum sets and playing styles.

¥ Movie tracks: The video sound track appears if you're scoring (adding music
to) an iMovie movie. You also get a cool companion video track that shows the
clips in your movie. (For more on this topic, see the “Look, I'm John Williams!”
sidebar later in this chapter.)

It’s time to add a software instrument track of your very own. Follow these steps:

1. Press $8+Option+N (or click the New Track button).

GarageBand displays the New Track sheet.

N

Click the Software Instrument icon and then click Create.

W

Click the new track (the second in the list) to select it.

4. Inthe Library pane on the left side of the window, choose the general
instrument category you want.

When you choose Guitar, you get a second list of choices, still in the Library
pane.

5. From the second list, choose your specific style of weapon, such as
Classic Clean for a simple playing style.

Figure 16-3 shows the new track that ends up in your list when you follow
these steps. Now you're ready to rock with both the original electric piano

and an electric guitar! If you like, you can hide the Library by clicking the Show/
Hide Library button in the top-left corner of the window.

GarageBand includes a Songwriter project (also available from the top-level New
@ Project dialog; refer to Figure 16-2). When you choose a Songwriter project,
GarageBand presents a full set of instrument tracks, plus a real instrument track

TIP for your voice. You're ready to start adding loops and recording your own voice!

284  PART 4 Living the Digital Life



RSN ] *» Untitied - Tracks.

Library

S~ Classic Electric Piano
é "0 [ )

Classic Clean
Acoustic Guitar w0
Classic Clean

Hard Rock

FIGURE 16-3:
The new
track appears,
ready to rock.

Choosing loops

When you have a new empty track, you can add loops to build your song from the
Loop Browser. Apple gives you thousands of loops to choose among, in mind-
boggling variety. Click the Loop Browser button (which bears a loop symbol,
somewhat like a roller coaster; refer to Figure 16-1) to display your collection, as
shown in Figure 16-4.

s: All Genres

st
Elec Piano Sy
Classic Electric Plano.

# 0
Elec Piano

Classic Clean
# 0

ide Stepping Electric Piano

Spacey Electric Piano 01

Spacey Electric Piano 04

FIGURE 16-4: Symth ray 11
) Upbeat Electric Piano 01
The Loop
BrOWSGr |S a great Upbeat Electric Piano 03
Uplifting Disco Electric Piano.
hangout for any Lounge Electric Piano
i L J i)

musician.
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Looking for just the right loop

The running project already includes two tracks but no loops yet. (Refer to
Figure 16-3.) Just for grins, add a Classic Electric Piano loop. Follow these steps to
search the loop library for just the right rhythm:

1. Inthe Loop Browser, click the Instrument tab; then click the button that
corresponds to the instrument you're using.

| chose the Elec Piano button.

A list of beats appears in the pane at the bottom of the Loop Browser window.
(Refer to Figure 16-4.)

2. Click one of the loops that has a green musical-note icon.

Go ahead; this is where things get fun! GarageBand begins playing the loop
nonstop, allowing you to get a feel for how that particular loop sounds.

The examples | chose for this chapter are software instruments, which are
identified by a green musical-note icon. (If you have a MIDI instrument that you

play, have at it with real instrument loops.)
REMEMBER

3. Click another entry in the list, and the application switches to that loop.

Now you're beginning to understand why GarageBand is so cool for both
musicians and the note-impaired. It's like having your own band, with mem-
bers who never get tired, never miss a beat, and play whatever you want while
you're composing. (Mozart would've loved it.)

If you want to search for a particular instrument, click the Search box near the
top of the Loop Browser, and type the text you want to match. GarageBand
returns the search results in the list.

TIP

4. scroll down the list, and continue to sample the loops until you find one
that fits like a glove.

For this reporter, it's Upbeat Electric Piano 01. (Refer to Figure 16-4.)

5. Drag the entry to your Classic Electric Piano track, and drop it at the
beginning of the Timeline (as indicated by the playhead).

Your window looks like Figure 16-5.

loops to that track. (More on extending that beat in the next section.) If you want
the piano’s beat to change later in the song, however, add a second loop after the
TP first one in the same track. For now, leave this track as is.

‘ If you want that same beat throughout the song, you don’t need to add any more
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FIGURE 16-5:
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Whoops! Did you do something you regret? Don’t forget that you can undo most
actions in GarageBand by pressing the old standby $8+Z immediately afterward.

Second verse, same as the first

When you compose, you can add tracks for each instrument you want in your
song:

¥ Each track can have more than one loop.

¥ Loops don't have to start at the beginning; you can drop a loop anywhere
in the Timeline. You may prefer to start a song with just your drum kit,
for example, with your bass line beginning some time later (for a funkier
opening).

You put loops on separate tracks so that they can play simultaneously on different
instruments. If all your loops in a song are added on the same track, you hear only
one loop at a time, and all the loops use the same software instrument. By creating
multiple tracks, you give yourself the elbow room to bring in the entire band at the
same time. It’s iiber-convenient to compose your song when you can see each
instrument’s loops and where they fall in the song.

Click the Reset button in the Loop Browser (which carries an X icon) to choose
another instrument or genre category.
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LOOK, I'M JOHN WILLIAMS!

You, too, can be a famous composer of soundtracks . . . well, perhaps not quite as
famous as Mr. Williams, but even he had to start somewhere. To add a GarageBand
score to an iMovie, choose Track = Show Movie Track to display the Movie track. Now
choose File => Movie ©> Open Movie, select the movie, and click Open.

At this point, you add and modify instrument tracks and loops just as you would in any
other GarageBand project. GarageBand displays a video preview within the Movie track.
When you click the Play button, the video is shown as well so that you can check your
work and tweak settings (as described later in the chapter).

When you finish composing, choose File &> Movie => Export Audio to Movie. You can
specify the name, location, and quality of the new movie file. Note that you can't edit
your finished movie file by using iMovie again, so scoring should always be the last step
in your filmmaking process.

Resizing, repeating, and moving loops

If you haven’t already tried listening to your entire song, try it now. You can click
Play at any time without wreaking havoc on your carefully created tracks. Sounds
pretty good, doesn’t it?

But wait: I bet that the song stopped after about five seconds, right? (You can
watch the passing seconds using the Time/Tempo display or the second rule that
appears at the top of the Timeline.) I’m sure that you want your song to last more
than five seconds! After the playhead moves past the end of the last loop, your
song is over. Click Play again to pause the playback; then click the Go to Beginning
button (which appears next to the Play button) to move the playhead back to the
beginning of the song.

The music stops so soon because your loops are only so long. As mentioned ear-
lier, most loops are five seconds in length, and others are even shorter. To keep
the groove going, you must do one of three things:

3 Resize the loop. Hover the cursor over the left or right edge of most loops,
and an interesting thing happens: The cursor changes to an icon representing
the left or right edge of the loop, with arrows pointing both ways. That's your
cue to click and drag. As you drag, some loops expand to fill the space you're
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FIGURE 16-6:
By repeating a
loop, you can
keep the notes
flowing.

»

making, repeating the beats in perfect time. To resize a loop, drag the loop's
edge as long as you like.

Repeat the loop. Depending on which loop you chose, you may find that
resizing it doesn't repeat the measure. Instead, the new part of the loop is
dead air. In fact, the length of many loops is one to five seconds. If you move
the cursor over the corner of a loop that you want to extend, however, the
cursor it turns into a vertical line with a circular arrow, which tells you that you
can click and repeat the loop. GarageBand adds multiple copies of the same
loop automatically for as far as you drag the loop. In Figure 16-6, you can see
how | repeated the Upbeat Electric Piano 01 loop.

»

= Untitied - Tracks.

Classic Electric Piano
# Q0 O

Classic Clean
# 0

Add a new loop. You can switch to a different loop to change the music's
flow. Naturally, the instrument stays the same, but there’s no reason why you
can't use a horn-riff loop in your violin track (as long as it sounds good played
by a violin)! To GarageBand, a software instrument track is compatible with
any software instrument loop you add from the Loop Browser, as long as that
loop is marked with your old friend the green musical note. You'll find dozens
of these software instrument loops available within GarageBand.
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REMEMBER

TIP

You can also use the familiar Cut (38+X), Copy (38+C), and Paste (38+V) editing
keyboard shortcuts to cut, copy, and paste loops both on the Timeline and from
track to track. And you can click a loop and drag it anywhere.

A track doesn’t have to be filled for every second with one loop or another. Most
of my songs have repeating loops with empty space between them as different
instruments perform solo.

Each track can be adjusted so you can listen to the interplay between two or more
tracks or hear how your song sounds without a specific track:

3 Mute a track. Click the tiny speaker button below the track name in the list,
and the button turns blue to indicate that the track is muted. To turn off the
mute, click the speaker icon again.

3 Change the volume or balance of a track. Use the mixer that appears next
to the track name. This feature comes in handy if you want an instrument to
sound louder or confine that instrument to the left or right speaker.

Using the Arrangement track

GarageBand includes another method that you can use to monkey with your
music: Use the Arrangement track to define (or mark) specific sections of a song,
allowing you to reorganize things by selecting, moving, and copying entire
sections. You’re probably familiar with a song’s chorus (or refrain) and how often
it appears during the course of the tune. With the Arrangement track, you can
reposition the entire chorus within your song, carrying all the loops and settings
within the chorus along with it. If you need another chorus, just copy that
arrangement.

To use the Arrangement track, display it by choosing Track= Show Arrangement
Track. The Arrangement track appears as a thin strip at the top of the Track list.
Click the Add Marker button (the circular button bearing a plus sign) at the right
end of the Arrangement track, and a new marker appears, as shown in Figure 16-7.
You can drag the right end of the Arrangement marker to the left or right to resize
it, or drag it to move it anywhere in the song.

To rename an Arrangement marker, click the current name to display the menu of
existing marker names, click Rename, type a new name for the marker in the text
box, and press Return. (You can also choose one of the existing names from the
menu.) In Figure 16-7, the first marker is named Intro.
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FIGURE 16-7:
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Now, here’s where Arrangement markers get cool:

3 To move an entire Arrangement marker: Click anywhere on the marker’s
title bar (except the title itself), and drag it anywhere you like in the song.
(You can hold down Shift while clicking multiple contiguous markers to select
more than one.)

3 To copy an Arrangement marker: Hold down the Option key, and drag the
desired marker's title to the spot where you want the copy to appear.

3 To empty the regions in an Arrangement marker: Select it, and press the
Delete key. To delete the marker, press Delete a second time.

Tweaking the settings for a track

You don’t think that bands like Rush and U2 just “play and walk away,” do you?
No, they spend hours after their recording session is over, tweaking their music in
the studio and on the mixing board until every note sounds just as it should. You
can adjust the settings for a track, too. The tweaks you can perform include adding
effects (pull a Hendrix by adding echo and reverb to your electric guitar track) and
kicking in an equalizer (for fine-tuning the sound of your background horns).

To make adjustments to a track, follow these steps:

1 . Click the desired track in the track list to select it.

2. Click the Smart Controls button in the top-left corner of the GarageBand
window (labeled in Figure 16-1).

You can also press B to hide or display the Smart Controls pane.
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3. Cclick the Controls tab to show the settings shown in Figure 16-8.

Note that the settings you see will vary according to the type of instrument
track you've selected.

Arrangement

== Classic Electric Piana

# 0

Classic Clean
# 0

Controls  EQ

FIGURE 16-8:
Finesse your tune
by tweaking the
sound of a
specific track.

4. Cclick the knob control or slider for a specific effect to change the sound.

GarageBand offers a Visual Equalizer window that you can use to create a

@ custom equalizer setting for each track. In the Smart Controls pane, click the
EQ button. To change the Bass, Low Mid, High Mid, or Treble setting for a track,
TP click and drag the equalizer waveform in the desired direction. Yep, you can do

this while your song is playing, so you can use both your eyes and ears to
define the perfect settings!

5. Click the Smart Controls button (or press B) to return to GarageBand.
Time for a Mark’s Maxim:

Save your work often in GarageBand. One power blackout, and you’ll never forgive
yourself. When you’re pleased with the progress you’ve made in your project,
press 38+S, and enjoy the peace of mind (and use Time Machine with an external

autHor  backup drive for good measure).
SAYS
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JOIN IN AND JAM ... OR TALK!

GarageBand is even more fun if you happen to play an instrument! (And yes, I'm envi-
ous, no matter how much | enjoy the techno and jazz music | create. After all, take away
my iMac, and I'm back to playing the kazoo — at least until | absorb all the Learn to Play
lessons for the guitar. More on Learn to Play in the next sidebar.)

Most musicians use MIDI instruments called controllers to play music on the computer.
That pleasant-sounding acronym stands for Musical Instrument Digital Interface. A wide
variety of MIDI controllers is available these days, from traditional MIDI keyboards to
more exotic fun, such as MIDI saxophones. Apple sells a 37-key MIDI keyboard from iRig
for around $150. Alternatively, the highly recommended Casio CTX-3200 offers 61 keys,
and it's available online for about $130. (Both keyboards connect to your trusty iMac Pro
via a USB cable.)

If you have an older instrument with traditional round MIDI ports — you'll never confuse
them with USB connectors — you need a USB-to-MIDI converter. You can find this type
of converter for around $50 on websites that cater to musicians.

You can also connect microphones or traditional electric instruments into your iMac for
use with GarageBand. You'll need an audio interface, which feeds the signal from these
traditional sources into your laptop through the USB port.

When your instrument is connected, you can record tracks with any software instru-
ment. Create a new software instrument track as | demonstrate in this chapter, select it,
and play a few notes. Suddenly, you're playing the instrument you chose! If nothing
happens, check the MIDI status light in the Time display to see whether it blinks with
each note you play. If not, check the installation of your MIDI connection, and make sure
that you've loaded any required drivers, as well as your MIDI settings within QuickTime
and the input settings in the System Preferences Sound pane.

Drag the playhead to a beat or two before the spot in the Timeline where you want your
recording to start. This gives you time to match the beat. Then click the big red Record
button, and start jamming! When you're finished, click the Play button to stop recording.

Sharing Your Songs

When you finish your song, you can play it whenever you like through Garage-
Band. But then again, that isn’t really what you want, is it? You want to share your
music with others on an audio CD or download it to your iPhone so that you can
enjoy it yourself while walking through the mall.

CHAPTER 16 Recording Your Hits with GarageBand 293



294

HEY, GARAGEBAND, TEACH ME
HOW TO PLAY!

In the early days of GarageBand, you were limited to creating music. And if you were a
nonmusician like yours truly, GarageBand had no practical use as a tool for teaching
yourself how to play an instrument.

Ah, but Apple’s addition of Learn to Play actually turns GarageBand into your private
video tutor for basic piano and guitar! Click the Learn to Play entry in the list on the left
side of the New Project dialog (refer to Figure 16-2) to display your guitar and piano
lessons. Right out of the box, you have a solid introduction to both instruments. You
can also download more lessons — which cover more-advanced topics such as finger-
ing and chords — for each instrument from the Lesson Store (available from the New
Project dialog). Your onscreen instructor can even record what you play.

In fact, GarageBand includes the How Did | Play feature, which can pinpoint the portions
of a lesson you played correctly and which spots in the song you need to work on. ('m
told that musicians call such trouble spots flubs. Having no musical talent whatsoever,
anything | attempted to play would be one giant flub.) To try How Did | Play, open your
favorite lesson, click the Record button (with the red dot in the center), and begin play-
ing. To stop recording, click the Play button. Now you can see the portions of the song
you played correctly (where the notation area is green) and spots where you . . . um,
flubbed (the notation area turns red). Oh, and make sure that your instrument is in
tune, because even correct notes played on an instrument that's out of tune produce
errors for How Did | Play!

If you find the free Learn to Play lessons to be valuable, you can move up to the Artist
lessons, which are taught by famous musicians, including favorites of mine such as Alex
Lifeson, John Fogerty, and Sting (who actually teaches you how to play “Roxanne”)! Some
of the artist lessons that address learning songs and instruments are now free as well.

iTunes to the rescue! As with the other digital lifestyle applications I cover in this
book, GarageBand can share the music you make through the digital hub that is
your iMac. (You’ll become an iTunes power user in Chapter 13.)

Creating song files in iTunes

You can create an AAC song file from any project in just a few simple steps:

1. Open the project you want to share.
2. Choose Share > Song to iTunes.

GarageBand displays the settings you see in Figure 16-9.
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FIGURE 16-9:
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3. Cclick each of the text boxes to type the title, artist name, composer
name, album name, and iTunes playlist for the tracks you create.

You can leave the defaults as they are if you prefer. Each track you export is
named after the song's name in GarageBand.

4. Fromthe Quality pop-up menu, choose the proper audio quality for the
finished file.

The higher the quality, the larger the file.
5. click the Share button.

After a second or two of hard work, your iMac opens the iTunes window and
highlights the new (or existing) playlist that contains your new song.

Exporting a project

Sometimes, you’d like to create an audio file from a GarageBand project, but you’d
rather not automatically add that song to your iTunes Music Library. (Perhaps you
now have audio proof that a family member does indeed snore.) In that case, you
can always export a song straight to your internal drive by following these steps:
1. Open the project you want to export.

2. Choose Share= Export Song to Disk.

3. Type a name for the audio file.

Click the button next to the Save As text box to select a specific location where
the file should be created, or choose a preset from the Where pop-up menu.
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4. Fromthe Quality pop-up menu, choose the desired audio quality.
As with sharing a song to iTunes, the higher the quality, the larger the file.
5. click Export.

Burning an audio CD

Ready to create a demo CD with your latest GarageBand creation? If your iMac has
an internal or external optical drive, follow these steps to burn an audio disc from
within GarageBand:

1. Open the song you want to record to disc.

2. Load ablank disc into your optical drive.

If you see a dialog requesting that you choose an action, click the Ignore
button.

3. Choose Share=>Burn Song to CD.
Note that the CD you create has only one track. To include more tracks on the CD,

share the song to your iTunes Library (as described earlier), create a playlist con-
taining the desired songs, and burn that playlist within iTunes.
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IN THIS PART ...

Create and format documents with Pages.
Build spreadsheets with Numbers.

Showcase your ideas with Keynote.



IN THIS CHAPTER

» Creating a Pages document

» Entering, editing, and formatting text
» Inserting tables and graphics

» Resizing objects

» Including photos

» Adding a shape as a background

» Checking your spelling

» Printing Pages documents

» Sharing your work

Chapter 17

Desktop Publishing
with Pages

hat’s the difference between word processing and desktop publishing?

In a nutshell, it’s in how you design your document. Most folks use a

word processor like an old-fashioned typewriter, much like I’m using
Microsoft Word right now. (Yawn.)

A desktop publishing application allows far more creativity in choosing where to
place text, how to align graphics, and how to edit formats. I think desktop pub-
lishing is more visual and intuitive, allowing your imagination a free hand at cre-
ating a document.

In this chapter, I show you how to set your inner designer free from the tedious
constraints of word processing. Whether you need a simple letter, a stunning bro-
chure, or a multipage newsletter, Pages can handle the job with ease — and you’ll
be surprised at how simple it is to use. Plus, Pages is a free download for any iMac
model of recent vintage (and free Apple software is always A Good Thing).
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Creating a New Pages Document

To create a new Pages document, follow these steps:

1. click the Pages icon on the Dock.

If the Pages icon doesn't appear on your Dock, click the Launchpad icon and

then click the Pages icon (which looks like a document and pen). If you haven't
installed the three Apple productivity applications yet — Pages, Numbers, and
Keynote — click the App Store icon in your Dock and download them for free!

2. Click the New Document button at the lower-left corner of the Open
dialog.

Pages displays the Template Chooser window, shown in Figure 17-1.

You can also create a new Pages document at any time from the File menu.
Just choose File => New to display the Template Chooser window.
TIP
[ISK ] Choose a Template
el EQUD DOG
Basic % " . Caar
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Books
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FIGURE 17-1:
Selecta
template from
the Template
Chooser window.

3. Inthelistto the left, click the type of document you want to create.

The thumbnails on the right are updated with templates that match your
choice.

4. Click the template that most closely matches your needs.
To start with a blank page, choose the Blank template from the Basic group.

5. Click the Choose button to open a new document in the template you
selected.
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Open an Existing Pages Document

TIP

©

TIP

©

REMEMBER

Of course, you can always open a Pages document from a Finder window. Just
double-click the document icon. (The All My Files location in the Finder window
sidebar makes it easy to track down a document.) You can also open a Pages docu-

ment from within the program. Follow these steps:

1.
2.

Launch Pages as described in the preceding section.
Press 38+0 to display the Open dialog.

The Open dialog operates much the same as a Finder window in Icon, List, or
Column view mode. To open a document you've already saved in your iCloud
Drive, click the Pages item under the iCloud heading in the sidebar at the left of
the dialog and double-click the desired document thumbnail in the display at
the right side of the dialog. To open a document on your internal drive or
network, click the desired location in the Open dialog sidebar. (If you're into
convenience like | am, click one of the locations under the Favorites heading to
jump immediately to common folders such as your Downloads or Documents
folders.)

Click the desired drive in the Devices list at the left of the dialog, and
then click folders and subfolders until you locate the Pages document.

You can also click in the Search box at the top of the Open dialog and type in a
portion of the document name or its contents.

If you're using Icon view mode (or you're displaying the Preview column in
Column view mode), you can hover the pointer over a document thumbnail
and quickly flip through the different pages by clicking on the left and right
arrows that appear. This “find” feature can help you identify a particular Pages
document without even opening it.

Double-click the thumbnail (or filename) to load it.

If you want to open a Pages document you've edited in the recent past, things
get even easier. Just choose File > Open Recent, and you can open the
document with a single click from the submenu that appears.

Pages can open, edit, and save documents created with the Mac version of
Microsoft Word. However, Pages doesn’t support every feature within a Word
document - for the full list of what Pages supports, visit the webpage at www .
apple.com/mac/pages/compatibility.
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Saving Your Work

Pages fully supports the macOS Auto-Save feature, but you may feel the need to
manually save your work after you finish a significant edit (or if you need to take
a break while designing). If you’re editing a document that has already been saved
at least once, press 38+S. A new version of the document is saved to its current
location — and you can continue with your work.

However, if you’re working on a new document that hasn’t previously been saved,
follow these steps to save it:

1. withthe Pages document open, press 38+S.
2. Type a filename for your new document.

3. Open the Where pop-up menu, and choose a location in which to save the
document.

Note that Pages defaults to your iCloud Drive as the target location. This way,
you can open and edit your Pages document on any Mac or iOS device that
shares the same Apple ID. Alternatively, click the button sporting the down
arrow to expand the Save As sheet. This allows you to navigate to a different
location on your hard drive or network, or to create a new folder to store this
Pages project.

4. Click Save.

current document to an older version, choose File=> Revert To. Pages gives you the
option of reverting to the last saved version, or you can click Browse All Versions
rememser  t0 choose from multiple versions of the document.

@ You can create a version of a Pages document by choosing Filec> Save. To revert the

Touring the Pages Window

Before you dive into any real work, let me show you around the Pages window.
You'll find the following major components and controls, as shown in
Figure 17-2:

¥ Pages list: This thumbnail list displays all the pages you've created within your
document. (For a single-page document, of course, the Page list contains only
a single thumbnail.) You can switch instantly between different pages in your
document by clicking the desired thumbnail in the list. If the list isn't visible,
click the View button at the left side of the Pages toolbar and click Show Page
Thumbnails.
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FIGURE 17-2:

The major points
of interest in the
Pages window.

3 Layout pane: This section takes up most of the Pages window. It's where you

design and edit each page in your document.

¥ Toolbar: Yep, Pages has its own toolbar. It keeps all the most common

application controls within easy, one-click reach.

¥ Inspector: This window extension allows you to quickly switch the appear-
ance of selected paragraphs, characters, and lists (in Format mode) or specify
settings that affect the entire document (in Document Setup mode). You can
hide and display the Inspector from the View menu, or by clicking the Format

or Document buttons on the toolbar.
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If you’ve used a modern word processing program, you’ll feel right at home typ-
ing within Pages. The bar-shaped text cursor, which looks like a capital letter I,
indicates where the text you enter will appear in a Pages document. To enter text,
simply begin typing. To edit existing text in your Pages document, select and
highlight the text. As you type, Pages replaces the existing text. You can delete
text by clicking and dragging across the characters to highlight them and then

pressing Delete.
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Using Text, Shapes, and Graphics Boxes

REMEMBER

Within Pages, you’ll quickly learn that text, shapes, and graphics appear in boxes,
which can be resized by clicking and dragging one of the handles that appear
around the edges of the box. (Click the box to select it and hover the mouse cursor
over one of the square handles; you’ll see that it changes to a double-sided arrow,
indicating that Pages is ready to resize the box.)

You can also move a box, including all the stuff it contains, to another location
within the Layout pane. Click inside the box, and drag the box to the desired spot.
Note that Pages displays yellow alignment lines to help you align the box with
other elements around it (or with regular divisions of the page, such as the verti-
cal center of a poster or flyer).

To select text or graphics within a box, you must first click the box to select it and
then double-click the line of text or the graphic you want to change.

The Three Amigos: Cut, Copy, and Paste
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“Hang on, Mark. You’ve covered moving stuff, but what if you want to copy a block
of text or a photo to a second location? Or how about cutting something from a
document open in another application?” Good questions. That’s when you can call
on the power of the cut, copy, and paste features within Pages. The next few
sections explain these actions.

Cutting stuff

Cutting selected text, shapes or graphics removes them from your Pages document
and places that material on the Clipboard. (Think of the Clipboard as a holding area
for snippets of text and graphics you want to manipulate.) To cut, select some
material and choose Edit= Cut or press 38+X.

Copying text and images

When you copy text, shapes, or graphics, the original selection remains untouched,
and a copy of the selection is placed on the Clipboard. Select some material and
choose Edit=> Copy or press 38+C. To copy selected items by dragging, hold down
the Option key while you drag the items to their destination.
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If you cut or copy a new selection to the Clipboard, it erases what was there. In
other words, the Clipboard holds only the latest material you cut or copied.

REMEMBER

Pasting from the Clipboard

Wondering what you can do with the stuff that’s stored on the Clipboard? Pasting
the contents of the Clipboard places the material at the current location of the
insertion cursor.

& You must paste the contents before you cut or copy again to avoid losing what’s
on the Clipboard.

WARNING
To paste the Clipboard contents, click to place the insertion cursor at the location
you want and choose Edit=> Paste or press $§+V.

Formatting Text the Easy Way

If you feel that some (or all) of the text in your Pages document needs a facelift,
you can format that text any way you like. Formatting lets you change the color,
font family, character size, and attributes as necessary.

After the text is selected, you can apply basic formatting in two ways:

3 Use the Inspector. The Inspector appears at the right side of the Pages
window (refer to Figure 17-2). The controls it displays vary according to the
selection you've made. (Click the Format button on the right side of the toolbar,
which looks like a tiny paintbrush, to display and hide the Inspector.) Click to
select a font control to display a pop-up menu, and then click your choice. For
example, select a portion of text and open the Font Family pop-up menu to
change the font family from vanilla Arial to something more daring. You can
also select characteristics, such as the text's paragraph style, or choose italic
or bold. The Inspector also provides buttons for both vertical and horizontal
text alignment.

3 Use the Format menu. Most controls displayed within the Format section of
the Inspector are also available from the Format menu. Click Format and
hover the mouse cursor over the Font menu item, and you can then apply
bold, italic, and underlining to the selected text. You can also make the text
bigger or smaller. To change the alignment from the Format menu, click
Format and hover the mouse cursor over the Text menu item.
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Adding a Spiffy Table

In the world of word processing, a table is a grid that holds text, shapes and graph-
ics for easy comparison. You can create a custom table layout within Pages with a
few simple clicks.

Follow these steps:

1. clickto place the insertion cursor where you want the table to appear.
2. Click the Table button on the Pages toolbar.

Pages displays thumbnail images of different table styles. You have a selection
of colors. Some tables also include highlighted rows and columns. Use the left
and right buttons to display different styles of thumbnails until you find the
one that's closest to the table you need.

Don't worry if the style isn't exactly right. You can always change the layout by
selecting the table and displaying the Format Inspector, where you can
fine-tune all sorts of font, color, grid, and border options.
TIP
3. Click the style thumbnail to insert the table.
If you need to change the number of rows or columns in your table, Pages
makes it easy. To add or delete rows or columns directly from the table, select
it and click the row and column buttons that appear. (Each bears two horizon-
tal or vertical lines, as shown in Figure 17-3.)
LK ] Untitled 3.
Bv woxv | + -~ il i a al v y To
m Cel Tex Arrange
Custom Fixie Bike: $300
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REMEMBER

Click within a cell in the table to enter text.
The table cell automatically resizes and wraps the text you enter to fit.

You can paste material from the Clipboard into a table. See the earlier section
“Pasting from the Clipboard"” for details.

Here are a few pointers on how to dress up your table and make its data more

attractive and readable:

»

TIP »

Change the borders on a selected cell. Click the Format icon on the toolbar
to open the Inspector, click the Cell tab, and then click the desired button in
the Border section.

Select a range of cells in a table by holding down Shift as you click. Hold down 8
and click to select multiple cells that aren’t contiguous.

Add a background color to selected cells, or fill them with an image for a
background. Click the Cell tab, and then click the Fill section in the Inspector
and choose a type of background.

Adding Alluring Photos

You can choose between two methods of adding a picture within your Pages
document:

¥ As a floating object: You place the image in a particular spot, and it doesn't

TIP

move even if you make changes to the text. To add a floating object, drag an
image file from a Finder window and place it at the spot you want within your
document. Alternatively, you can click the Media button on the toolbar, click
Photos, navigate to the location where the file is saved, and click the image
thumbnail. Figure 17-4 shows the Media Browser in action.

Click the magnifying glass icon within the Media Browser to search for a
specific item using keywords or by filename.

Note that a floating object (such as a shape or image) can be sent to the
background, where text does not wrap around it. To bring back a background
object as a regular floating object, click the object to select it and choose
Arrange = Bring to Front. (More about background objects later in this
chapter.)
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FIGURE 17-4:

Hey, isn't that the
Pages Media
Browser?

TIP

¥ As aninline object: The image flows with the surrounding text as you make
layout changes. To add an inline object, hold down the 38 key as you drag an
image file from a Finder window and place it where you want within your
document. You can also click the Media toolbar button and click Photos to
display the Media Browser. Navigate to the location where the file is saved,
hold down the 38 key, and drag the image thumbnail to the spot where you
want it in the document.
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To resize an image object, click the image to select it and drag one of the selection
handles that appear along its border. (The handles look like tiny squares.) The
side-selection handles drag only that edge of the frame. The corner-selection
handles resize both adjoining edges of the selection frame. Hold down the Shift
key to make the vertical and horizontal proportions remain fixed.

Adding a Shape as a Background
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To add a shape (such as a rectangle or circle) as a background for existing text,

follow these steps:

1. clickto place the insertion cursor anywhere on the page where you want
the shape to appear.

2. Click the Shape button on the Pages toolbar and choose a shape.

The shape appears in your document.
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REMEMBER

3.

Click inside the shape and drag it to a new spot.

Shapes can be resized or moved in the same manner as image boxes. See the
preceding section.

You can type over a shape set as a background. Before you do, though, select the
shape, and choose Arrange+> Send to Back.

Are You Sure about That Spelling?

©

REMEMBER

Pages can check spelling as you type (the default setting) or after you complete
your document. If you find automatic spell-checking distracting, you should pick
the latter method.

As my technical editor reminds me, spell-checking only confirms that a word
matches an entry in the Pages dictionary, not that it’s the right word for the job!
If you’ve ever “red” a document that someone else “rote,” you understand.

To check spelling as you type, follow these steps:

1.

2.

3.

Click the Edit menu, and hover the pointer over the Spelling and
Grammar menu item.

Choose Check Spelling While Typing from the submenu that appears.

If a possible misspelling is found, Pages underlines the word with a red dashed
line.

Right-click the word to choose a possible correct spelling from the list, or
choose Ignore Spelling if it's spelled correctly.

To turn off automatic spell-checking, click the Check Spelling While Typing
menu item again to deselect it.

To check spelling manually, follow these steps:

1.
2.

3.

Click within the document to place the insertion cursor where the spell
check should begin.

Click Edit, hover the pointer over the Spelling and Grammar menu item,
and choose Check Document Now from the submenu that appears.

Right-click any possible misspellings, and choose the correct spelling, or
choose Ignore Spelling if the word is spelled correctly.
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Printing Your Pages Documents

Ready to start the presses? You can print your Pages document on real paper, of
course, but don’t forget that you can also save a tree by creating an electronic PDF
instead of a printout. You’ll find the PDF dropdown menu at the bottom of the
standard Mojave Print dialog.

To print your Pages document on old-fashioned paper, follow these steps:

1. within Pages, choose File > Print.

Pages displays the Print sheet.

N

Click in the Copies field, and enter the number of copies you need.
3. Selectthe pages to print:
To print the entire document, select All.

To print a range of selected pages, select the From radio button and enter
the starting and ending pages.

4. Click the Print button to send the document to your printer.

Sharing That Poster with Others

Besides printing — which is, after all, so very passé these days — you can choose
to share your Pages document electronically via the Internet or your network:

3 Send a Copy: To send a copy of the actual document (which the recipient can
open using Pages on his or her own Mac or iOS device), click Share on the
Pages menu, and hover the pointer over the Send a Copy item. You can send
the document via Mail, Notes or Messages, or you can make it available
through AirDrop (if the recipient is within range of your iMac's Wi-Fi signal).

If you decide to send your Pages document as an email attachment, don't
forget that most ISPs have a maximum message size. If your document is too

large, your mail server probably will reject it.
REMEMBER

3 Export: You're not limited to sharing over that Internet thing! Pages can also
export your work directly to your drive in one of six formats: a PDF file, a
Microsoft Word document, an ePub file (for use with electronic book apps like
iBooks), a document compatible with the previous version of Pages, a Rich
Text Format document, or even plain text. (Remember when everything was
in plain text?) Choose File &> Export To, and pick your format; Pages displays
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TIP

©

REMEMBER

»

any options you can set for that format. When you're ready, click Next and
select the location where Pages should save the file. Click Export, and sit back
while your favorite desktop publishing application does all the work.

If the recipient of your document doesn't need to edit your work, | recom-
mend creating a PDF file, which keeps your document as close as possible to
how it appears in Pages.

Collaborate: You can choose to share your document with others — and
optionally allow them to edit it — using the Collaborate toolbar button. (You
determine their access from the Sharing Options that appear when you click
the Collaborate toolbar button.) Pages stores your document on your iCloud
Drive, and sends a link to the individuals you choose via Mail, Messages,
Facebook, or Twitter. Once that lucky person clicks the link, Pages opens your
document in all its glory, ready for them to view or edit.

Your iCloud Drive must be active and you must be signed in to send the
Collaborate sharing invitation, and the recipients you specify must be signed
in using their Apple ID to receive it.
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IN THIS CHAPTER

» Creating, opening, and saving
spreadsheets

» Selecting cells, entering data, and
editing data

» Formatting cells

» Adding and removing rows and
columns

» Creating simple calculations
» Adding charts to your spreadsheets

» Printing a Numbers spreadsheet

Chapter 18

Creating Spreadsheets
with Numbers

re you downright afraid of spreadsheets? Does the idea of building a bud-

get with charts and all sorts of fancy graphics send you running for the

safety of the hall closet? Well, good iMac owner, Apple has again taken
something that everyone else considers super-complex and turned it into some-
thing that normal human beings can use! (Much as Apple did with video editing
and songwriting. Is there any type of software that Apple designers can’t make
intuitive and easy to use?) And Numbers is a free download from the App Store to
boot!

In this chapter, I demonstrate how the Numbers spreadsheet program can help

you organize data and analyze important financial decisions for home and
business — everything from a household budget to your company’s sales statistics!
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Before You Launch Numbers...

©

REMEMBER

In case you’re unfamiliar with applications like Numbers and Microsoft Excel —
and the documents they create — let me provide you with a little background
information.

A spreadsheet organizes and calculates numbers by using a grid system of rows and
columns. The intersection of each row and column is a cell, which can hold either
text or numeric values. Cells can also hold calculations called formulas and func-
tions, which are usually linked to the contents of surrounding cells.

Spreadsheets are wonderful tools for making decisions and comparisons, because
they let you plug in different numbers — such as interest rates or your monthly
insurance premium — and instantly see the results. These are some of my favorite
spreadsheets that I use regularly:

¥ Car and mortgage loan comparisons
¥ Acollege planner

3 My household budget (not that we pay any attention to it)

Numbers can open, edit, and save spreadsheets created with Microsoft Excel.
Note, however, that not all Excel features are supported within Numbers — for the
full list of what Numbers supports, visit the webpage at www.apple.com/mac/
numbers/compatibility/.

Creating a New Numbers Document

314

Like Pages (Apple’s desktop publishing application that I cover in Chapter 17),
Numbers ships with a selection of templates you can modify quickly to create a
new spreadsheet. For example, after a few modifications, you can easily use the
Budget, Loan Comparison, and Mortgage templates to create your own
spreadsheets.

To create a spreadsheet project file, follow these steps:

1. click the Launchpad icon on the Dock.

2. Click the Numbers icon.
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3. Click the New Document button at the lower-left corner of the Open
dialog that appears.

Numbers displays the Choose a Template window, shown in Figure 18-1.
(To display the Choose a Template window and start a new Numbers project
at any time, just choose File => New.)

K] Choose a Template

Basic

Personal Finance

Business

Education

Baby Record Travel Planner Party Planner Meal Planner

FIGURE 18-1:
Hey, these
templates aren't
frightening at all!

4. From thelist on the left, click the type of document you want to create.

The document thumbnails in the center are updated with templates that
match your choice.

5. Cclick the template that most closely matches your needs.

6. Click the Choose button to open a new document using the template
you selected.

Opening an Existing Spreadsheet File

If you see an existing Numbers document in a Finder window or the All My Files
location (or you find it using Spotlight), just double-click the Numbers document
icon to open it. Numbers automatically loads and displays the spreadsheet.
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It’s equally easy to open a Numbers document from within the program. Follow
these steps:

1.
2,
’
4.

TIP

If Numbers isn't already running, click the Numbers icon from the
Launchpad to run the program.

Press 38+0 to display the Open dialog.

If the spreadsheet is stored in your iCloud Drive, click the Numbers item
under the iCloud heading in the sidebar at the left of the dialog and then
double-click the desired document thumbnail to load the spreadsheet.

All three of Apple's productivity applications — Pages, Numbers, and
Keynote — feature an Open dialog that can display the contents of your iCloud
Drive as well as your iMac's internal drive.

If the document is stored on your iMac’s internal drive, your network, or
one of your Favorites locations, click the desired drive or folder in the
sidebar at the left of the dialog. Drill down through folders and subfold-
ers until you locate the desired Numbers document, and double-click the
document thumbnail to load the spreadsheet.

If you're unsure where the document is, click in the Search box at the top of the
Open dialog and type a portion of the document name or even a word or two
of text it contains. Note that you can choose to search your drive, your iCloud
Drive, or both.

choose File=> Open Recent to display Numbers documents that you’ve worked with

If you want to open a spreadsheet you’ve been working on over the last few days,

recently.

TIP

Save Those Spreadsheets!
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Thanks to the macOS Auto-Save feature, you no longer have to fear losing a sig-
nificant chunk of work because of a waning battery or a coworker’s mistake. How-
ever, if you're not a huge fan of retyping data, period, you can also save your
spreadsheets manually after making a major change. Follow these steps to save
your spreadsheet to a specific drive or folder on your iMac:

1.

2.

Press 38+S.

If you're saving a document that hasn't yet been saved, the Save As sheet
appears.

Type a filename for your new spreadsheet.
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3.

TIP

4.

Open the Where pop-up menu and choose a location in which to save
the file.

Common locations are your iCloud Drive, Desktop, Documents folder, and
Home folder.

If the location you want isn't listed in the Where pop-up menu, click the down-
arrow button next to the Save As text box to display the full Save As dialog. Click
the desired drive in the Devices list at the left of the dialog, and then click folders
and subfolders until you reach the desired location. Alternatively, type the folder
name in the Spotlight search box at the top right, and double-click the desired
folder in the list of matching names. (As a bonus, you can also create a new
folder in the full Save As dialog.)

Click Save.

After you save a Numbers document for the first time, you can create a version of
that document by choosing File«> Save. To revert the current document to an older
version, choose File=> Revert To. You can choose to revert to the last saved version,
or you can click Browse All Versions to look through multiple versions of the doc-
ument and choose one of those to revert to.

Exploring

the Numbers Window

Apple has done a great job of minimizing the complexity of the Numbers window.
Figure 18-2 illustrates these major points of interest:

»

»

»

»

Sheets tabs: When a project contains multiple spreadsheets, Numbers
indicates the spreadsheets in the Sheets tabbed bar at the top of the window.
To switch among spreadsheets in a project, click the desired tab.

Sheet canvas: Numbers displays the rows and columns of your spreadsheet
in this section of the window; you enter and edit cell values within the sheet
canvas.

Toolbar: The Numbers toolbar keeps the most common commands you'll use
within easy reach.

Inspector: Located at the right side of the Numbers window, the Inspector
displays editing controls for the object that's currently selected, regardless of
whether it's a selection of text, a table, or a single cell. (If you enter an equal
sign [=] into a cell to create a formula, the Inspector displays the Function list,
where you can specify a calculation that Numbers should perform.)
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Navigating and Selecting Cells
in a Spreadsheet

TABLE 18-1

You can use the scrollbars to move around your spreadsheet, but when you enter
data into cells, moving your fingers from the keyboard is a hassle. Numbers has
various handy navigation shortcut keys you can employ, as shown in Table 18-1.
After you commit these keys to memory, your productivity level will shoot straight

to the top.

Movement Shortcut Keys in Numbers

Key or Key Combination

Where the Cursor Moves

Left arrow («)

One cell to the left

Right arrow (—)

One cell to the right

Up arrow (T)

One cell up

Down arrow (4)

One cell down

Home

To the beginning of the active worksheet

318
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Key or Key Combination Where the Cursor Moves

End To the end of the active worksheet

Page Down Down one screen

Page Up Up one screen

Return One cell down (also works within a selection)

Tab One cell to the right (also works within a selection)
Shift+Enter One cell up (also works within a selection)
Shift+Tab One cell to the left (also works within a selection)

You can also use the mouse or trackpad to select cells in a spreadsheet:

»
»

»

»

To select a single cell, click it.

To select a range of adjacent cells, click a cell at any corner of the range you
want and drag in the direction you want.

To select a column of cells, click the alphabetic heading button at the top of
the column.

To select a row of cells, click the numeric heading button at the far left of
the row.

Entering and Editing Data
in a Spreadsheet

©

REMEMBER

After you navigate to the cell in which you want to enter data, you’re ready to type
your data. Follow these steps to enter That Important Stuff:

1.

2.

Either click the cell or press the spacebar.
A cursor appears, indicating that the cell is ready to hold any data you type.
Enter your data.

Spreadsheets can use both numbers and alphabetic characters within a cell;
either type of information is considered data in the Spreadsheet World.
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3. When you're ready to move on, press Return (to save the data and
move one cell down) or press Tab (to save the data and move one cell
to the right).

Make a mistake? No big deal:

¥ To edit data: Click within the cell that contains the data error (to select the
cell), and then click the cell again to display the insertion cursor. Drag the
insertion cursor across the characters to highlight them, and then type the
replacement data.

3 To delete characters: Select the cell, and then highlight the characters and
press Delete.

Selecting the Correct Number Format

After you enter your data (in a cell, row, or column), you might need to format it
so that it appears correctly. For example, say you want certain cells to display a
specific type of number, such as a dollar amount, percentage, or date. Numbers
gives you a healthy selection of number-formatting possibilities.

and percentage notation — are part of number formatting. If your spreadsheet
contains units of currency, such as dollars, format it as such. Then all you need to
TIP do is type the numbers, and the currency formatting is applied automatically.

‘ Characters and formatting rules — such as decimal places, commas, and dollar

To specify a number format, follow these steps:

1. selectthe cells, rows, or columns you want to format.
2. Cclick the Format toolbar button.
3. Click the Cell tab in the Inspector.

From the Data Format pop-up menu, choose the type of formatting you
want to apply, as shown in Figure 18-3.
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Aligning Cell Text Just So

You can also change the alignment of text in the selected cells. The default align-
ment is flush left for text and flush right for numeric data. Follow these steps:

1. selectthe cells, rows, or columns you want to format.

See the earlier section “Navigating and Selecting Cells in a Spreadsheet”
for tips on selecting stuff.

2. Click the Format toolbar button.

3. Click the Text tab of the Inspector to display the settings shown in
Figure 18-4.

4. Click the corresponding Alignment button to choose the type of format-
ting you want to apply.

You can choose left, right, center, and justified (as well as the defaults of text
left and numbers right). You also can format text to be aligned at the top,
center, or bottom of a cell.

Do you need to set apart the contents of some cells? For example, you might need

@ to create text headings for some columns and rows or to highlight the totals in a

spreadsheet. To change such formatting, select the cells, rows, or columns you

TIP want to format, and then open the Font Family, Font Size, or Font Color buttons
on the Text tab.
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FIGURE 18-4:
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Formatting with Shading

Q

TIP

Shading the contents of a cell, row, or column is helpful when your spreadsheet
contains subtotals or logical divisions. Follow these steps to shade cells, rows, or

columns:

1. selectthe cells, rows, or columns you want to format.

2. Click the Format toolbar button.

3. Click the Cell tab of the Inspector.

4. Cclick the triangle next to the Fill heading, and choose a shading option
from the Fill pop-up menu.
Figure 18-5 shows the controls for a gradient fill.

5. click the color box to select a color for your shading.
Numbers displays a color picker (also shown in Figure 18-5).

6. Cclick to select a color.

7. After you achieve the effect you want, click the color box again to close

the color picker.

You can also add a custom border to selected cells, rows, and columns from the
Cell tab. Click the triangle next to the Border heading to select just the right border.

322  PART 5 Getting Productive with Your iMac



FIGURE 18-5:
Adding shading
and colors to
cells, rows, and
columns is easy
in Numbers.
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Inserting and Deleting Rows and Columns

Q

TIP

What's that? You forgot to add a row, and now you’re three pages into your data
entry? No problem. You can easily add — or delete — rows and columns. First,
select the row or column adjacent to where you want to insert (or delete) a row or
column, and do one of the following:

¥ For a row: Right-click and choose Add Row Above, Add Row Below, or Delete
Row from the shortcut menu that appears.

3 For a column: Right-click and choose Add Column Before, Add Column After,
or Delete Column from the shortcut menu that appears.

If you select multiple rows or columns, right-click and choose Add. Numbers
inserts the same number of new rows or columns you selected.

You can also insert rows and columns via the Table menu at the top of the Num-
bers window.

The Formula Is Your Friend

It’s time to talk about formulas, which are equations that calculate values based on
the contents of cells you specify in your spreadsheet. For example, if you desig-
nate cell A1 (the cell in column A at row 1) to hold your yearly salary and cell B1 to
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TIP

hold the number 12, you can divide the contents of cell A1 by cell B1 (to calculate
your monthly salary) by typing this formula into any other cell:

=A1/B1

Formulas in Numbers always start with an equal sign, and they may include one
or more functions as well. A function is a preset mathematical, statistical, or engi-
neering calculation that will be performed, like figuring the sum or average of a
series of cells.

“So what’s the big deal, Mark? Why not use a calculator?” Sure, you could. But
maybe you want to calculate your weekly salary. Rather than grab a pencil and
paper, you can simply change the contents of cell B1 to 52, and — boom! — the
spreadsheet is updated to display your weekly salary.

That’s a simple example, of course, but it demonstrates the basics of using formu-
las (and the reason why spreadsheets are often used to predict trends and forecast
budgets). It’s the what-if tool of choice for everyone who works with numeric data.

To add a simple formula within a spreadsheet, follow these steps:

1. select the cell that will hold the result of your calculation.
2. Type = (the equal sign).
The Formula Box appears within the confines of the cell.

3. Click the Format button on the Numbers toolbar to display the available
functions in the Inspector, as shown in Figure 18-6.

4. Click the category of calculation you want from the left column of the
Inspector.

Instead of scrolling through the entire function library, it's easier to choose a
category — such as Financial for your budget spreadsheet — to filter the
selection. (Alternatively, you can click in the Search box and type a function
name or keyword.)

To display more information about a specific function, click it in the right
column of the Inspector. In Figure 18-6, choosing the SUM function brings up a
description at the bottom of the Inspector.

5. after you select the perfect function in the right column, click the Insert
Function button.

The function appears in the Formula box, along with any arguments it requires.

In case you're unfamiliar with the term argument, it refers to a value specified in
a cell that a formula uses. For example, the SUM formula adds the contents of
each cell you specify to produce a total; each of those cell values is an argument.
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FIGURE 18-6:
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6. Click an argument button in the formula, and click the cell that contains

the corresponding data.

Numbers automatically adds the cell you indicated to the formula. Repeat this

step for each argument in the formula.

7. After you finish, click the Accept button — the green checkmark — to add

the formula to the cell.

That’s it! Your formula is now ready to work behind the scenes, doing math for

you so the correct numbers appear in the cell you specified.

Adding Visual Punch with a Chart

TIP

Sometimes, you just have to see something to believe it, so it can help to use the
data you’ve added to a spreadsheet to generate a professional-looking chart. After

you’ve entered the data you want to chart, follow these steps:

1. select the adjacent cells you want to chart by dragging.

To choose individual cells that aren’t adjacent, you can hold down the 38 key as

you click.
2. Click the Chart button on the Numbers toolbar.

The Chart button bears the symbol of a bar graph.
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Numbers displays
the range of chart

Numbers displays the thumbnail menu shown in Figure 18-7. Note that you
can display different categories of charts by clicking one of the three tabs at the
top (2D/3D/Interactive), and you can scroll the menu to reveal additional
thumbnails by using the left- and right-arrow buttons.
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TIP

Click the thumbnail for the chart type you want.

Numbers inserts the chart as an object within your spreadsheet so you can
move the chart. You can drag using the handles that appear on the outside of
the object box to resize your chart.

With your chart selected, click the Format toolbar button to display your old
friend the Inspector, complete with the controls you can use to customize your
chart's appearance. For example, you can change the colors and add (or
remove) the title and legend.

To change the default title, click the title box to select it; click it again to
edit the text.

Printing Your Spreadsheet

326

You can easily send a Numbers spreadsheet to a USB or shared network printer —
or, if you’d rather create an electronic copy of the document as an Adobe PDF, you
can click the PDF button that appears on the Numbers Print dialog and select a
location where the file will be saved.
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To print a Numbers spreadsheet on your default printer, follow these steps:

1. choose File=> Print from the Numbers menu bar to display the Print
Setup window (Figure 18-8).

Because a Numbers document can contain multiple spreadsheets, you can
select a specific spreadsheet to print (by clicking it in the grid and clicking the
Print This Sheet radio button at the bottom of the window), or you can print all
spreadsheets in the document (by clicking the Print All Sheets radio button).

e0e 4| Basics.

View  Zoom Insert  Table  Chart  Text  Snape  Meda Comment Coliaborate Fonmat  Sort & Filtar

Print Setup

Printer & Page Size
Any Printer B
US Letter B
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v
85 T1inches
Content Scale « Fit
— ) 78% O
Ropeat table headers
Page Numbers
FIGURE 18-8: © Continue from previous sheet
Options available st
from the Print: o;;\:::;s:
Numbers Print
. D print...
Setup window.

2. Click the desired page orientation.

Spreadsheets with a large number of columns are often printed in landscape
orientation to ensure that everything fits on the page. You can also scale the
spreadsheet so it automatically fits on the page by clicking the Fit button (next
to the Content Scale slider).

3. Click Print at the bottom of the window.

Numbers displays the Print dialog shown in Figure 18-9. To display additional
settings, click the Show Details button at the bottom of the sheet.

4. Clickinthe Copies field, and enter the number of copies you need.
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5. Sselectthe pages to print:

® To print the entire spreadsheet, select All.

® To print a range of selected pages, select the From radio button, and enter
the starting and ending pages.

6. click the Print button to send the document to your printer.

Click the Share menu item to send a copy of your spreadsheet masterpiece to
others. Click the Collaborate button on the toolbar to allow others to view or

edit your spreadsheet from your iCloud Drive as a shared document.
TIP
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» Printing slides and notes

Chapter 19

Building Presentations
with Keynote

t seems like only yesterday that I was giving business presentations with a

clunky overhead projector and black-and-white acetate transparencies. Fancy

color gradients and animation were unheard of, and the only sound my presen-
tations made was the droning of the projector’s fan. I might as well have been
using tree bark and chalk.

Thank goodness those “cave painting” days are gone. Cutting-edge presentation
software like Keynote makes slide creation easy and — believe it or not — fun! This
is the application Steve Jobs once used for his Macworld keynotes every year. So
much visual candy is available that you’ll never need to shout to wake your audience
again. Even better, this jewel of an application is a free download from the App Store!

In this chapter, I first demonstrate how simple it is to build a stunning Keynote pres-
entation. Then you can see how to start and control your slide display from the key-
board (or even your iPhone, iPad, or iPod touch). And don’t forget that you can print
your slides and notes so that your audience can keep a copy of your brilliant work.
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Creating a New Keynote Project

Like the other applications in Apple’s productivity suite, Keynote begins the doc-
ument creation process with a Theme Chooser window. To create a new presenta-
tion project, follow these steps:
1. click the Launchpad icon on the Dock.
2. Click the Keynote icon, which looks like a lectern.

The familiar visage of the Open dialog appears.

3. Click the New Document button at the lower-left corner of the Open
dialog.

The Theme Chooser window, shown in Figure 19-1, appears. (I have to say that
these are probably the most stunning visual building blocks I've seenin a
presentation application.)

[ ] [ ] Choose a Theme

Standard Wide

My Presentation My Presentation
s [ty

Gradient

MY PRESENTATION

FIGURE 19-1: y Prescntatic My Prosentation
Select a template
from the Theme
Chooser window.

Classic Slate Cream Paper Artisan

Cancel Choose

4. Choose the aspect ratio, using either the Standard or Wide button at the
top of the window.

Although you don't necessarily need to select an exact match for your iMac's

screen resolution, it's a good idea to select the value closest to your projector’s
maximum resolution. If someone else is providing the projector, the Standard
size is the more compatible choice. If you'll present on a typical high-resolution
computer monitor, widescreen provides a better display. (Of course, nothing’s
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stopping you from creating two documents of the same presentation, one in
Standard ratio and one using Wide ratio. As the Scouts say, “Be prepared!”)

n

Click the theme thumbnail that most closely matches your needs.

6. Cclick the Choose button to open a new document that uses the theme
you selected.

Opening a Keynote Presentation

If an existing Keynote presentation file is visible in a Finder window, you can
double-click the document icon to open the project. If Keynote is already running,
follow these steps to load a project from within the application:

1. Ppress $8+0 to display the Open dialog.

2. Click the desired drive in the Devices list at the left of the dialog; then
click folders and subfolders until you locate the Keynote project. If the
project is stored in your iCloud Drive, click the Keynote item under the
iCloud heading in the sidebar at the left of the dialog, and then double-
click the desired project thumbnail.

If the project is stored on your hard drive, the All My Files location can quickly
display all your documents. You can jump directly to any location or folder
under the Favorites heading by simply clicking on the entry. Oh, and don't
forget that you can use the Search box at the top of the Open dialog to locate
the document by name or by some of the text it contains.

3. Double-click the filename to load it.

get even easier — just choose File> Open Recent, and you can open the document

If you want to open a Keynote document you’ve edited in the recent past, things
with a single click from the submenu that appears.

TIP

Saving Your Presentation

Because Keynote provides full support for the macOS Auto-Save feature, saving
your work often isn’t as critical as it used to be. To safeguard your work in a world
of power failures, though, follow these steps:

1 . Press 38+S.

If you're saving a document that hasn't yet been saved, the familiar Save As
sheet appears.

CHAPTER 19 Building Presentations with Keynote 331



2. Enter a filename for your new document.

3. From the Where pop-up menu, choose a location in which to save the
document.

By default, Keynote saves the project directly to your iCloud Drive (iCloud
appears in the Where pop-up menu), making it available to other Macs and iOS
devices using the same Apple ID. To select a location not available from the
Where pop-up menu, click the button with the down-arrow symbol to expand
the sheet. You can also create a new folder from the expanded sheet.

4. click save.

You can create a version of a Keynote presentation by choosing Filec> Save. To
revert the current presentation to an older version, choose File=> Revert To. Key-
note gives you the option of reverting to the last saved version, or you can click

rememser  Browse All Versions to browse multiple versions of the presentation and revert to
any saved version.

Putting Keynote to Work

Ready for the 5-cent tour of the Keynote window? Launch the application and cre-
ate or load a project, and you see the tourist attractions shown in Figure 19-2:

¥ Slides list: Use this thumbnail list of all the slides in your project to navigate
quickly. Click a thumbnail to switch instantly to that slide.

The Slides list can also display your project in outline format, allowing

@ you to check all your discussion points. (This is a great way to ferret out any
“holes” in your presentation’s flow.) While in outline mode, you can still jump
TIP directly to any slide by clicking the slide’s title in the outline. To display the

outline, choose View > Outline. You can switch back to the default Navigator
Slides list by choosing View => Navigator.

3 Layout pane: Your slide appears in its entirety in this pane. You can add
elements to and edit the content of the slide from the Layout pane.

¥ Toolbar: As does the toolbar in Pages and Numbers, the Keynote toolbar
makes it easy to find the most common controls you'll use while designing
and editing your slides. Clicking an icon on the toolbar performs an action,
just as selecting a menu item does.

3 Presenter Notes pane: You might decide to add notes to one or more
slides — either for your own use or to print as additional information for your
audience. Click the View icon on the toolbar, and select Show Presenter Notes
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FIGURE 19-2:
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(or choose View = Show Presenter Notes) to open the Presenter Notes pane.
This text box appears under the Layout pane.

¥ Inspector: Keynote displays this pane on the right side of the window when
you click the Format button, allowing you to format selected text and images
on the fly.
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Adding Slides

Keynote creates a single Title slide when you first create a project. However, not
many presentations are complete with just a single slide! To add more slides to
your project, use one of these methods:

Presenter Notes pane

¥ Click the Add Slide button on the toolbar.

¥ Choose Slide = New Slide.

¥ Press

98-+Shift+N.

Inspector

¥ Right-click an existing slide in the Slides list, and choose New Slide from the
menu that appears.
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TIP

Keynote adds the new slide to your Slides list and automatically switches to the
new slide in the Layout pane.

Need a slide that’s very similar to an existing slide you've already designed?
Right-click the existing slide, and choose Duplicate to create a new slide just like
it. (Consider this cloning without the science.)

To move slides to different positions in the Slides list (that is, to change the order
in your Keynote presentation), drag each slide thumbnail to the desired spot in the
list.

Working with Text, Shapes,
and Graphics Boxes

334

REMEMBER

All the text, shapes, and graphics placeholders on your first Title slide appear
within boxes. Keynote uses these boxes to manipulate text, shapes, and graphics.
You can resize a box (and its contents) by clicking the box and dragging one of the
handles that appear around the edges of the box. (The cursor changes into a
double-sided arrow when you’re “in the zone.”) Side selection handles drag only
the edge of the frame, whereas corner selection handles resize both adjoining
edges of the selection frame.

To keep the proportions of a box constrained, hold down Shift while dragging the
box’s corner handles.

Boxes make it easy to move text, shapes, and graphics together (as a single unit)
to another location within the Layout pane. Click inside the box, and drag the box
to the desired spot. Keynote displays alignment lines to help you align the box with
other elements around it (or with regular divisions of the slide, like horizontal
center).

To select a box, click it. To select text, shapes, or graphics within a box (see the
next section), double-click the box.

When you’re resizing a photo in a box, hold down the Shift key while you drag the
frame. Doing so tells Keynote to preserve the image’s aspect ratio so that the ver-
tical and horizontal proportions remain fixed. You can also flip images horizon-
tally or vertically from the Arrange menu.To delete an image, just click it to select
it and press Delete.
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Adding and Editing Slide Text

As with Pages, which also uses boxes for text layout, you can add or edit text in
Keynote with ease. For example, say you have a box with the placeholder text
Double-click to edit. Just double-click in that box, and the placeholder text
disappears, leaving the field ready to accept new text. Any new text you type
appears at the blinking cursor within the box.

Here are some additional ways to work with slide text:

3 Add a new text box: Just click the Text button in the Keynote toolbar, and
click one of the sample styles that appear. Your new text box appears in the
middle of the slide.

¥ Edit existing text: Click — using the bar-shaped cursor to select just the right
spot in the text — and drag the insertion cursor across the characters to
highlight them. Type the replacement text, and Keynote obligingly replaces
the old text with the new text you type.

3 Delete text: Click and drag across the characters to highlight them; then
press Delete. You can also delete an entire box and all its contents: Right-click
the offending box, and choose Delete from the menu that appears.

When a box’s contents are just right, and you’re finished entering or editing text,
click anywhere outside the box to hide it from view. You can always click the text
again to display the box later.

Formatting Slide Text for the Perfect Look

Keynote doesn’t restrict you to the default fonts for the theme you choose. It’s
easy to format the text in your slides — a different font family, font color, text
alignment, and text attributes (such as bolding and italicizing) — on the fly.

Select the desired text by double-clicking a box and dragging the text cursor to
highlight the characters. Now apply your formatting using one of two methods:

3 The Inspector: The font controls in the Inspector work in one of two ways:
After you've selected text, either click a font control to display a pop-up menu,
or click a button to immediately perform an action. Opening the Font Size
pop-up menu, for example, displays a range of sizes for the selected text. With
a single click of the B (bold) button, add the bold attribute to the highlighted
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characters. To create bullets and lists, click the Text tab at the top of the
Inspector.

3 The Format menu: When you select text, the controls on the Keynote Format
menu generally mirror those in the Inspector. To change the alignment from the
Format menu, click Format and hover the cursor over the Text menu item. To
change text attributes, click Format and hover the cursor over the Font menu.

Using Presenter’'s Notes in Your Project

TIP

As mentioned earlier, you can type presenter’s text notes in the Presenter Notes
pane. I use them to display related topic points while presenting my slideshow.
However, you can also print the notes for a project along with the slides, so pre-
senter’s notes are also great for including reminders and To Do points for your
audience in handouts.

To type your notes, just click within the Presenter Notes pane. If that pane is hid-
den, choose Viewr> Show Presenter Notes, or click the View button at the far left
of the Keynote toolbar and choose Show Presenter Notes. When you’re finished
adding notes, click in the Slides list or the Layout pane to return to editing mode.

To display your notes while practicing, use the Keynote Rehearsal feature. Click
the Play menu at the top of the Keynote window, choose Rehearse Slideshow, click
the Tools icon at the top right, and select the Presenter Notes check box to enable
it. Now you can scroll through the notes while the slideshow runs.(More on slide-
shows in a second.)

Every Good Presentation Needs Media

336

Adding audio, photos, and movies to a slide is drag-and-drop easy in Keynote.
Simply drag an image, audio, or movie file from a Finder window, and place it at
the spot you want within your document.

You can also use the Media Browser. To do so, follow these steps:

1 . Click the Media button on the toolbar, and then click the Photos, Music,
or Movies tab to select the desired type.

Keynote displays the contents of your various media collections (such as your
Photos, iMovie and iTunes libraries).
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2. When you find the file you want to add, drag it to the spot you want in
the document.

Figure 19-3 shows the Media Browser in action.
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Having trouble finding that specific photo or movie? Click the Search icon (which
looks like a magnifying glass) at the top-right corner of the Media Browser, and

you can specify a particular filename or keyword.
TIP

Adding a Background Shape

Text often stands out on a slide when it sits on top of a background shape. To add
a shape (such as a rectangle or circle) as a background for your text, follow these
steps:

1. click the insertion cursor in the location you want.

2. Cclickthe Shape button on the Keynote toolbar, and choose a shape.

The shape appears in your document.

W

Click the center of the shape, and drag it to a new spot.

4. Aswith image boxes, you can resize or move shapes. You can read about
how to do just that in the earlier section “Working with Text, Shapes and
Graphics Boxes.”
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TIP

5. Whenthe shape is properly positioned and sized, select it, and choose
Arrange = Send to Back.

You want to “send the shape to the back” so that any text you enter sits in front
of the shape, not hidden behind it.

Of course, you're not limited to creating shapes and graphics within Keynote;
consider using an application like Adobe Photoshop or Illustrator to create graphics
that you can import into your slides. As mentioned earlier, you can easily drag and
drop your new graphic into a slide from a Finder window.

Creating Your Keynote Slideshow

TABLE 191

The heart of a Keynote presentation is the slideshow you build from the slides
you’ve created. A Keynote slideshow is typically presented as a full-screen pres-
entation, with slides appearing in linear order as they are sorted in the Slides list.

You run a Keynote slideshow simply by clicking the Play button on the toolbar or
by choosing Play Play Slideshow. You can advance to the next slide by clicking,
or by pressing the right bracket key, which looks like this: ].

Of course, other controls are available besides just the ones that advance to the
next slide. Table 19-1 lists the key shortcuts you’ll use most often during a
slideshow.

Keynote Slideshow Shortcut Keys
Key Action

1 (right bracket) Next slide

[ (left bracket) Previous slide

Home Jump to first slide

End Jump to last slide

@ Show or hide the pointer

number Jump to the corresponding slide in the Slides list
U Scroll notes up

D Scroll notes down

N Show current slide number
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Key Action

H Hide the slideshow and display the last application used
(the presentation appears as a minimized icon on the Dock)

B Pause the slideshow and display a black screen (press any key
to resume the slideshow)

Esc Quit

Keynote offers a number of settings you can tweak to fine-tune your slideshow.
To display these settings, choose Keynoter> Preferences, and click the Slideshow

button in the Preferences window.
TIP

If you have an iPhone, iPad, or iPod touch handy, and you’ve installed the iOS
version of Keynote on your device, choose Keynoter> Preferences to display the

Preferences window. Click the Remotes tab to link your device to your iMac
TIP and Keynote. Now you can use your handheld device as a remote during your
slideshow. Sweet!

Printing Your Slides and Notes

I’ll be honest: I don’t print handouts for every presentation I give. However, if
you’re presenting a lengthy slideshow with plenty of information you want your
audience to remember or refer to later, nothing beats handouts that include
scaled-down images of your slides (and, optionally, your presenter’s notes).

You’re not limited to paper, though. You can also use Keynote to create an elec-
tronic PDF (Portable Document Format) file instead of a printed handout, which
your audience members can download from your website. Or, if you’re an educator
with access to an interactive whiteboard (such as a SMART Board), you can use
this cutting-edge technology with Keynote.

To print your slides and notes, follow these steps:

1.  within Keynote, choose File = Print or press 35+P.

Keynote displays the Print sheet, shown in Figure 19-4. (Note that some printer-
specific features may be different on your screen.) If necessary, expand the Print
sheet to show all the settings by clicking the Show Details button at the bottom of
the sheet.
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FIGURE 19-4:
Keynote offers a
wide range of
printing options
for your slides
and notes.

2. Click one of the following formats (each format displays a different set of
Layout options):

Slide: Print each slide on a separate page at full size. You can optionally
choose to print the presenter notes for each slide as well.

Grid: Print multiple slides on a page at a reduced size. From the Slides per
Page pop-up menu, specify how many slides Keynote should print on each

page.

Handout: Print a handout with multiple slides per page (and, optionally,
with presenter’s notes). Again, you can choose how many slides appear
on each page.

Outline: Print the contents of your Slides list in Outline view.
3. Selectthe pages to print:
To print the entire document, select the All radio button.

To print a range of selected slides, select the From radio button, and then
enter the starting and ending pages.

4. select or deselect additional options from the Options section.

5. Cclick the Print button to send the job to your printer.

You can also send a copy of your finished presentation as an attachment within
Mail or Messages, or you can provide others with a copy through Twitter or Face-
book. Click Share=> Send a Copy to explore your options. To share your presenta-
tion with others (allowing them to view or edit your work), click the Collaborate
button on the toolbar and specify who should receive a sharing invitation!
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IN THIS PART ...

Troubleshoot and fix problems with your iMac.

Expand your iMac with peripherals, external drives,
and more.

Maintain your iMac properly for peak performance.



IN THIS CHAPTER

» Avoiding the blame (righteously)

» Putting basic troubleshooting
precepts to work

» Using Mark’s Troubleshooting Tree

» Getting help

Chapter 20
It Just...Sits...There

wish you weren’t reading this chapter.
Because you are, I can only surmise that you’re having trouble with your iMac,
and that it needs fixing. (The other possibility — that you just like reading about
solving computer problems — is more attractive but much more problematic.)
Consider this chapter a crash course in the logical puzzle that is computer trouble-
shooting: the art of finding out What Needs Fixing. I tell you what to do when you

just plain can’t solve the problem yourself.

Oh, and you’re going to encounter a lot of Tips and Mark’s Maxims in this chapter.
I learned all of them the hard way, so I recommend committing them to memory.

Repeat after Me: Yes, | Am a Tech!

Anyone can troubleshoot. Believe it, and put these common troubleshooting myths
to rest:

3 It takes a college degree in computer science to troubleshoot. Tell that to
my troubleshooting teen. She'll think it's a hoot, because she has an iMac in
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her room, as well as Apple computers in the classroom, and she fixes minor
problems all the time. You can follow all the steps in this chapter without any
special training.

3 I'm to blame. Ever heard of viruses? Failing hardware? Buggy software? Any

of those things can cause the problem. It's Mark's Maxim time:

Don’t beat yourself up! Your iMac can be fixed.

3 I need to buy expensive utility software. Nope. You can certainly investin a

commercial testing and repair utility if you like. My favorite is Drive Genius
from Prosoft Engineering (www . prosofteng. com), but a third-party utility isn't
a requirement for troubleshooting. (I do, however, consider an antivirus
application a must-have; you should have one already. Hint, hint.)

¥ There's no hope if | can't fix it. Sure, parts fail and computers crash, but your

Apple Service Center can repair just about any problem. And (ahem) if you
backed up your computer (as | preach throughout this book), you'll keep that
important data (even if a new hard drive or motherboard is in your future).

¥ It takes forever. Wait until you read the number-one rule in the next section;

the first step takes but 10 seconds and often solves the problem. Naturally,
not all problems can be fixed so quickly. But if you follow the procedures in
this chapter, you should fix your iMac (or at least know that the problem
requires outside help) in an afternoon.

With those myths banished, you can get down to business and start feeling
better soon.

Step-by-Step iMac Troubleshooting

344

In the following sections, I walk you through my should-be-patented Trouble-
shooting Tree, as well as the macOS built-in troubleshooting application, Disk
Utility. I also introduce you to several keystrokes that can make your Mac jump
through hoops.

The number-one rule: Reboot!

The simple fact is that rebooting your iMac can often solve many problems. If
you’re encountering these types of strange behavior with your iMac, a reboot
might be all you need:
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WHY IS REBOOTING SO DARNED EFFECTIVE?

Rebooting fixes problems because it resets everything. Your network connection,

for example, might be acting up or might have timed out, and rebooting restores it.
Hardware connections are reset when you reboot, which can “magically” bring
recalcitrant external peripherals back to life. Rebooting also fixes problems due to
brownouts or those notorious AC power flickerings you undoubtedly have noticed
from time to time. Such interruptions in constant juice might not bother you or me
(or your less-intelligent toaster), but they can play tricks on your iMac that rebooting
can fix.

¥ Intermittent problems communicating over a network

¥ Agarbled screen, strange colors, or screwed-up fonts

¥ The swirling Beach Ball of Doom that won't go away after several minutes
3 An application that locks up

¥ An external device that seems to disappear or can't be opened

To put it succinctly, here’s a modest Mark’s Maxim:
Always try a reboot before beginning to worry. Always.

If you're in the middle of a program, try to save all your open documents before
you reboot. That might be impossible, but try to save what you can.

As your first (and best) option for shutting down, click the Apple menu and choose
Shut Down. If you need to force a locked application (one that’s not responding) to
quit so that you can reboot, follow these steps to quash that locked application:
1 . Click the Apple (%) menu, and choose Force Quit.

The dialog shown in Figure 20-1 appears.
2. Click the offending application and then click the Force Quit button.

When you get everything to quit, you should be able to click the Apple menu and
choose Shut Down (not Restart) without a problem.
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[ IeN | Force Quit Applications

If an app doesn't respond for a while, select its
name and click Force Quit.

B Microsoft Word
#& Photos
@ Safari
& Finder

FIGURE 20-1:
Force a

recalcitrant
. . You can open this window by pressing
appllcatlon to Command-Optlon-Escape. e

take off.

If your iMac simply won’t shut down (or you can’t get the offending application
to quit), do what must be done:
1. Pressand hold your iMac’s Power button until it shuts itself off.
You have to wait about five seconds for your Mac to turn itself off.
If holding the Power button down on your iMac doesn't do the trick, press the
Power button and the Left Option+Left Shift+Left Control keyboard shortcut at
the same time; then release them all at the same time. (This method also

TP resets some of your iMac’s internal hardware settings, which is often A Good
Thing.)

2. Wait about ten seconds.
3. Press the Power button again to restart the computer.

After everything is back up, check whether the problem is still apparent. If you use
your iMac for an hour or two and the problem doesn’t reoccur, you likely fixed it!

Special keys that can come in handy

Several keys have special powers over your iMac. I’'m not kidding! These keys
affect how your computer starts up, and they can really come in handy while
troubleshooting.

Using Safe mode

You can use Safe mode to force macOS to run a directory check of your boot drive
and disable any login items that might be interfering with your system. Follow
these steps:

346  PART 6 The Necessary Evils: Troubleshooting, Upgrading, and Maintaining



1 . Choose the Shut Down menu item from the Apple (%) menu to turn off
your iMac.

2. Press the Power button to restart the computer.

3. Immediately after you hear the start-up tone, press and hold down the
Shift key (and keep holding it down until you see the boot progress
indicator).

4.  After macos boots, you're in Safe mode, and you can check the operation
of your iMac by using Disk Utility (or a commercial utility application).

5. When you're ready to return to normal operation, restart your iMac again
(this time, without pressing the Shift key).

Start-up keys

Table 20-1 provides the lowdown on start-up keys. Hold down the indicated key
either when you push the Power button or immediately after the screen goes blank dur-
ing arestart. (As I just mentioned, the Shift key shortcut to Safe mode is the excep-
tion; you should press it and hold it down after you hear the start-up tone.)

Some of the keys and combinations in Table 20-1 might never be necessary for
your machine, but an Apple technician might instruct you to use them.

TABLE 20-1 Start-Up Keys and Their Tricks
Key Effect on Your iMac
C Boots from the CD or DVD that's loaded in your optical drive (if you have one)
Media Eject Ejects the CD or DVD in your optical drive (if you have one)
Option Displays a system boot menu, allowing you to choose any bootable operating system on
your iMac
Shift Boots in Safe mode
T Starts your iMac in Target Disk mode (using your Thunderbolt port)
3B+V Shows macOS Console messages
38+R Boots from the macOS Recovery HD volume
38+4S Starts your iMac in Single User mode
38+Option+P+R Resets Parameter RAM (PRAM)
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FIGURE 20-2:

drives: the
Mojave Disk
Utility.

DANGER, WILL ROBINSON!

Many Disk Utility functions can actually wipe your drives clean of data instead of repairing
them! These advanced functions are unlikely to help you with troubleshooting a prob-

lem with your existing volumes.

Remember: Don't use the following Disk Utility functions unless an Apple technician tells

you to:

® Partitioning and erasing drives

® Setting up RAID arrays with the Raid Assistant

® Restoring files from disk images

All hail Disk Utility, the troubleshooter’s

friend

The macOS Disk Utility is a handy tool for troubleshooting and repairing your
iMac’s drive — you can use it to check the format and health of both drives and
volumes (and automatically correct any problems). You can find Disk Utility in the

Utilities folder in Launchpad.

Fire up Disk Utility to open the rather powerful-looking window shown in

Figure 20-2.
[ X X ] Disk Utility
B~ + € ® @
View Volume First Aid Partition Erase Restore Unmount Info
Internal
v [ ST31000528AS M... - —_—
— ~ . Wolfgang =@
[E woltgang 315.356 GB
— . SATA Internal Physical Volume « Mac OS Extended (Jou... o ]
= Ludwig
& Johann

External

v £

TOSHIBA TOSHI...

; Time Machine...

@ used Free
310.25 GB 5.16B
Mount Point: I Type: SATA Internal Physical Volume
Capacity: 315.35GB  Owners: Enabled
Available: 6.1 GB (16 KB purgeable) Connection: SATA
Used: 310.25GB Device: disk0s2

PART 6 The Necessary Evils: Troubleshooting, Upgrading, and Maintaining




(= =)
T
TECHNICAL
STUFF

o
T
TECHNICAL
STUFF

LD,
TECHNICAL
STUFF

SO EXACTLY WHAT IS A DISK
PERMISSION, ANYWAY?

Because macOS is built on a Unix base, lots of permissions can apply to the files on your
drive — that is, who can open (or read or change) every application, folder, and docu-
ment on your drive. Unfortunately, these permissions sometimes get messed up by
wayward applications or power glitches, or application installers that do a subpar job of
cleaning up after themselves. And if the permissions on a file are changed, applications
often lock up or refuse to run.

If you're an experienced OS X user, and you're looking for the familiar Repair Disk
Permissions button in Disk Utility, let me shorten your search: It no longer exists in
Mojave. Instead, disk permissions are now automatically checked and repaired as part
of the First Aid process. Progress marches on, but I'll miss that old codger.

Click the View drop-down list at the left corner of the window, and choose Show
All Devices. In the left column of the Disk Utility window, you can now see:

3 The physical drives in your system (the actual hardware).
¥ The volumes (the data stored on the drives).

You can always tell a volume, because it's indented below the physical drive
entry.

3 Any CD or DVD loaded on your iMac.

3 USB or Thunderbolt external drives.

Figure 20-2 shows that I have one internal drive (the ST3100 entry) and one USB
3.0 external drive (the TOSHIBA USB entry). The hard drive has three volumes
(Wolfgang, Ludwig and Johann), and the external drive has one volume (Time
Machine).

The information in the bottom section of the Disk Utility window is the specifica-
tions for the selected drive or volume. This info includes information like the

capacity and available space.

Using Disk Utility to repair your hard drive carries a couple of caveats:

3 You may not be able to immediately repair problems on your boot drive
or boot volume. This limitation actually makes sense, because you're actually
using that drive and volume right now.
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First Aid reports
that this drive is
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error-free.

»

If First Aid finds a problem on your boot drive but reports it can't fix that error,
boot your iMac from the macOS Recovery HD volume. Reboot and then hold
down the 38+R keyboard shortcut immediately after you hear the start-up
chord. Then run Disk Utility from the window that appears. Because you've
booted your iMac from the Recovery HD volume, you can repair those
problems with your start-up drive. (You should be able to select your boot
hard drive or volume and click the First Aid button.)

You can't repair CDs and DVDs. CDs and DVDs are read-only media and thus
can't be repaired (at least by Disk Utility).

If your iMac is having trouble reading a CD or DVD, wipe the disc with a soft
cloth to remove dust, oil, and fingerprints. Should that fail, invest in a disc-
cleaning contrivance of some sort.

To check and repair problems using First Aid, follow these steps:

1.
2.
3.
4

Click the Go menu and choose Utilities; then double-click the Disk
Utility icon.

In the list at the left side of the Disk Utility window, click the drive or
volume you want to check.

Click the First Aid button, and click the Run button that appears.
Click Done to exit First Aid.

If changes were made (or if you had to boot from the macOS Recovery HD
volume), Disk Utility may prompt you to reboot after repairs have been made.

Figure 20-3 illustrates the details you see if you click Show Details to expand the
display. Although some of the messages might include cryptic Linux details, you

can

still tell from the figure that the operation is successful (and you get that

snazzy green check mark). All is well!

hd

‘===  Running First Aid
m First Aid process is complete, click Done to continue.

Checking the EFl system partition's size

Checking the EFl system partition's file system
Checking the EFl system partition's folder content
Checking all HFS data partition loader spaces
Checking booter partitions

Checking Core Storage Physical Volume partitions
The partition map appears to be OK

Operation successful.

Hide Details
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Mark'’s iMac Troubleshooting Tree

As hip-hop artists say, “All right, kick it.” And that’s just what my iMac Trouble-
shooting Tree is here for. If rebooting your aluminum supercomputer didn’t solve
the problem, follow these steps in order until you either find the solution or run
out of steps (more on that in the next section).

If you’re not sure quite what’s producing the error, this process is designed to be
linear — followed in order — but if you already know that you’re having a problem
with one specific peripheral or one specific application, feel free to jump to the
steps that concern only hardware or software.

Step 1: Investigate recent changes

The first step is a simple one that many novice iMac owners forget. Simply retrace
your steps and consider what changes you made to your system recently. Here are
the most common culprits:

3 Did you just finish installing a new application? Try uninstalling it by
removing the application directory and any support files it might have added
to your system. (And keep your applications current with the most recent
patches and updates from the developers’ websites.)

3 Did you just apply an update or patch to an application? Uninstall the
application, and reinstall it without applying the patch. If your iMac suddenly
works again, check the developer’s website, or contact the application’s
technical support department to report the problem.

3 Did you just update macOS? Updating Mojave can introduce problems in
your applications that depend on specific routines and system files. Contact
the developer of the application, and look for updated patches that bring your
software in line with the latest Mojave updates.

¥ Did you just make a change in System Preferences? Return the options
you changed to their original settings; then consult Chapter 5 for information
on what might have gone wrong. (If the setting in question isn't listed in
Chapter 5, consider searching the macOS Help system or the Apple support
website for more clues.)

3 Did you just connect (or reconnect) an external device? Try unplugging
the device and then rebooting to see if the problem disappears. Remember
that many peripherals need software drivers to run; without those drivers
installed, they don’t work correctly. Check the device's manual or visit the
company’s website to search for software you might need.

If you didn’t make any significant changes to your system before you encountered
the problem, proceed to the next step.
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Step 2: Run Disk Utility

The next step is to run Disk Utility and use First Aid. The earlier section “Repair-
ing permissions and disks” shows how to complete this task on your macOS boot
drive.

Step 3: Check your cables

Cables can work themselves loose, and sometimes they fail. Check all the cables to
your external devices — make sure that they’re snug — and verify that every-
thing’s plugged in and turned on. (Oh, and don’t forget to check for crimps in your
cables or even Fluffy’s teeth marks.)

If a Thunderbolt or USB device acts up, swap cables around to find whether you
have a bad one. A faulty cable can have you pulling your hair out in no time.

Step 4: Check your Trash

Check the contents of the Trash to see whether you recently deleted files or folders
by accident. Click the Trash icon on the Dock to display the contents. If you deleted
something by mistake, right-click the item in the Trash and choose Put Back from
the contextual menu.

I know this one from personal experience. A slight miscalculation while selecting
files to delete made an application freeze every time I launched it.

Step 5: Check your Internet and network
connections

Now that always-on DSL and cable modem connections to the Internet are the
norm, don’t forget an obvious problem: Your iMac can’t reach the Internet if your
ISP is down or your network is no longer working!

When you’re at home, a quick visual check of your DSL or cable modem usually
indicates whether a connection problem exists between your modem and your
ISP. My modem has a set of informative activity lights that I always glance at first.
If your iMac is connected to the Internet through a larger home or office network,
however, and you can’t check the modem visually, you can check your Internet
connection by pinging www.apple.com, as follows:

1. Cclick the Spotlight icon at the right side of the Finder menu bar, and type
Network Utility in the search box.
2. Click the Network Utility entry.

3. Click the Ping button.
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4. Enter www.apple.com in the Address box.
5. click Ping.

You should see successful ping messages. If you don't get a successful ping and
you can still reach other computers on your network, your cable modem, DSL
modem, or ISP is likely experiencing problems. If you can't reach your network
at all, the problem lies in your network hardware or configuration. (In an office
environment, your network system administrator will be happy to help you at
this point, especially if you're blood relatives.)

Step 6: Think virus

If you’ve made it to this point, it’s time to run a full virus scan. Make sure that
your antivirus application has the latest updated data files. My antivirus applica-
tion of choice is Avast Security for Mac from Avast Software (www.avast.com). It’s
both excellent and free!

If a virus is detected, and your antivirus application can’t remove it, try quarantin-
ing it instead. This basically disables the virus-ridden application and prevents it
from infecting other files.

Step 7: Check your login items

macOS might encounter problems with applications you’ve marked as login items
in System Preferences. Your account’s login items are applications that run auto-
matically every time you log in to your iMac. If one of these login items is to blame
for your problems, your iMac will encounter some type of trouble every time you
log in. (This is usually the case when you receive an application error message
each time you start the computer.)

To check the boot process, it’s time to use that fancy Safe Boot mode I discussed
earlier in the chapter. Restart your iMac, and press and hold down the Shift key
after you hear the start-up tone. Login items are disabled when you’re running in
Safe mode, so if your computer starts up without any errors, you know that one or
more login items are probably to blame.

If your computer starts without problems in Safe mode, the next step is to check
your login items. Restart your iMac and then follow this procedure for each item

in the login list:

1. Open System Preferences, click Users & Groups, and then click the Login
Items button.
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2. Select the first item from the list, and remove it.

You can delete the selected item by clicking the Delete button, which bears a
minus sign. (If a recurring error message mentions a specific application that
appears in the Login Items list, that's your likely culprit, so start by deleting that
item.)

w

Restart your iMac.

4. your iMac is still misbehaving, repeat Steps 2 and 3, and disable a new
login item.

When your Mac starts up normally, you have discovered the perpetrator.
5. Delete that application, and reinstall it.

Don't forget to add back each of the working login items to the Login Items list
using the Add button (which carries a plus sign)!

Step 8: Turn off your screen saver

The next step is to turn off your screen saver. This remedy is a long shot, but it
isn’t unheard of to discover that a faulty, bug-ridden screen saver has locked up
your iMac. If you are running a screen saver other than one from Apple, and your
computer never wakes up from Sleep mode or hangs while displaying the screen
saver, you’ve found your prime suspect.

Reboot your iMac (if necessary), open System Preferences, click Desktop & Screen
Saver, and click the Screen Saver button. Then do one of the following:
¥ Switch to an Apple screen saver.

¥ Click the Start After pop-up menu and choose Never.

Step 9: Run System Information

Ouch. You’ve reached the final step, and you still haven’t uncovered the culprit. At
this point, you’ve narrowed the possibilities to a serious problem, such as bad
hardware or corrupted files in your macOS System folder. Fortunately, macOS
includes the System Information utility, which displays real-time information on
the hardware in your system. To start System Information, follow these steps:

1. choose About This Mac from the Apple () menu.
2. Cclickthe System Report button.

3. Cclick each of the Hardware categories in turn, double-checking to make
sure everything looks okay.
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You don’t have to understand all the technical hieroglyphics. If a Hardware cate-
@ gory doesn’t return what you expect or displays an error message, though, that’s

suspicious. (If your iMac doesn’t have a specific type of hardware onboard — such
rememser  as an optical drive — you won’t see information in that category.)

The Diagnostics category shows whether your iMac passed the Power On
self-test.

TIP

Okay, | Kicked It, and It Still Won't Work

Don’t worry, friendly reader. Just because you’ve reached the end of my spiffy
iMac Troubleshooting Tree doesn’t mean you’re out of luck. In the following sec-
tions, I discuss the online help available in macOS and on the Apple website, as
well as local help in your own town.

Local service, at your service

In case you need to take in your iMac for service, an Apple Store or Apple Autho-
rized Service Provider is probably in your area. To find the closest service, launch
Safari and visit the Apple website Support page (www.apple.com/support); then
click the Apple Authorized Service Providers link at the bottom of the page. You
can search by city and state or zip code. Click one of the locations near you to dis-
play the provider’s mailing address, website address, telephone number, and even
a map of the location.

Always call your Apple Authorized Service Provider before you lug your iMac’s
svelte frame all the way to the shop. Make sure you know your iMac’s serial num-
ber (which you can display in System Information) and which version of macOS
you’re using.

The macOS Help Center

Although most iMac owners tend to blow off the Help Center when the trouble-
shooting gets tough, that’s never the best course of action. Always take a few
moments to search the contents of the Help Center by choosing Finder = Help to
see whether any mention is made of the problem you’ve encountered.
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Apple Help Online

If you haven’t visited the Apple iMac Support site yet, run, don’t walk, to www.
apple.com/support/imac. There, you find:

¥ The latest patches, updates, and tutorials for the iMac line
¥ iMac and macOS discussion boards, moderated by Apple

¥ Tools for ordering spare parts, checking on your remaining warranty cover-
age, and searching the Apple knowledge base

¥ Do-it-yourself instructions (PDF files) that you can follow to repair or upgrade
your iMac
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IN THIS CHAPTER

» Adding memory

» Upgrading your hard drive
» Adding USB and Thunderbolt devices

» Reviewing what add-ons are available

Chapter 21
| Want to Add Stuff

0 iMac is an island.” Somebody famous wrote that, I’'m sure.

Without getting too philosophical — or invoking the all-powerful Internet yet
again — the old saying really does make sense. All computer owners usually add
at least one peripheral (external device), such as a printer, backup drive, joystick,
camera, or scanner. I talk about the ports on your iMac in Chapter 1. Those holes
aren’t there to just add visual interest to the back end of your treasured iMac.
Therefore, I cover your USB and Thunderbolt ports (and what you can plug in to
them) in detail in this chapter.

Ah, but what about the stuff inside your supercomputer? That’s where things get
both interesting and scary at the same time. In this chapter, I also describe what
you can add to the innards of some iMac models as well as how to get inside there
if you work up the courage to go exploring. (Don’t tell your family or your friends,
but adding memory to a late-model 27" iMac is as simple as pressing a button and
pulling a couple of plastic levers. There’s actually nothing to fear whatsoever.)

Here’s the trick: Just make it sound like an adventure from Mission: Impossible, and
folks will crown you their new resident techno-wizard!
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FIGURE 21-1:
Find out how
much memory
your iMac has.

TIP

Hey, wait a second. No however stuck on the end? You mean that, for once, there
isn’t an exception? Aren’t all computers different? Hard as it is to believe, just
keep in mind this Mark’s Maxim:

More memory helps.

Period. End of statement. No matter what type of computer you own, how old it is,
or what operating system you use, adding more memory to your system (to the
maximum it supports, of course) significantly improves the performance of your
operating system (and practically every application that you run).

Memory maximizes the power of your computer: The more memory you have, the
less data your iMac has to temporarily store on its hard drive. Without getting into
virtual memory and other techno-gunk, just consider that extra memory as extra
elbow room for your applications and your documents. Believe me, both macOS
and Windows efficiently make use of every kilobyte of memory that you can
provide.

Figuring out how much memory you have

To see how much memory you have on your computer, click the Apple menu and
choose About This Mac. Figure 21-1 shows the dialog that appears.

[ X ] Displays = Storage  Support  Service

macOS

Version 10.14

iMac (27-inch, Mid 2012)

Processor 2.7 GHz Intel Core i5

Memary 32 GB 1333 MHz DDR3

Startup Disk Wolfgang

Graphics AMD Radeon HD 8770M 512 MB
Serial Number D2PSDH13

System Report... Software Update...

The 8GB of standard memory supplied by Apple is enough for running any of the
Apple applications bundled with Mojave. If your primary applications include
video editing, playing the latest crop of immersive 3D games, or image editing,
though, you can use all the memory your iMac can hold — as you can see from
Figure 21-1, my 27" iMac is stuffed with 32GB of RAM for just such applications.
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Ah, but there’s a caveat. (Go figure.) At this writing, only the 27" iMac from the
current lineup has memory sockets that you — a Regular Human Being — can
access. The 27" models provide slots for four 2400 MHz DDR4SO-DIMM memory
modules at up to 8GB each. (Don’t fret over what those abbreviations mean. Rest
assured that this memory type is fast.)

Unfortunately, the memory in the late-model 21.5" iMac and the iMac Pro can’t be
replaced or upgraded by anyone except an authorized Apple Service Center tech-
nician. So if you’re using a 21.5" iMac or iMac Pro, you can skip the rest of this
section, except for the rest of this paragraph. If you’re ready to order a new 21.5"
iMac or iMac Pro from Apple, I strongly recommend that you opt for as much addi-
tional memory as you can afford while configuring your dream machine, since you
can’t upgrade it yourself later.

In the past, Apple’s prices for RAM were . . . well . . . outrageous (as in, “Boy,
howdy, I can’t afford that!”). Recently, however, Apple’s memory prices have
become far more competitive, so I now recommend that you add memory while
configuring and ordering either model of iMac.

How you plan memory upgrades depends on how much memory you want. If your
27" iMac uses the two default 4GB modules (8GB total) supplied by Apple, you can
add RAM by inserting memory modules in the empty slots. At this writing, a 4GB
memory module should set you back about $40 or so.

If your iMac already has all four memory slots filled and you’d still like to add
more system RAM, it’s time to remove one or all of the existing modules and
replace them with full 8GB or 16GB modules. (Current prices for an 8GB module
hover around $100.) With all four slots filled with 8GB modules (bringing you to
32GB) or 16GB modules (arriving at that coveted 64GB total), you’ll have a 27"
iMac that marks you as one of the “In People.”

If you’ve already bought your 27" iMac and you’d like to shop around for the best
memory prices, I can heartily recommend any one of these online sources that
cater to Mac owners:

¥ MacMall (www.macmall .com)

¥ CDW (www.cdw.com/content/brands/apple/default.aspx)

¥ Crucial (www.crucial.com)

¥ Small Dog Electronics (www.smalldog.com)

3 Newegg (www . newegg . com)
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Installing memory modules

I’'m happy to report that adding extra memory to a 27" iMac is one of the easiest
internal upgrades that you can perform. Therefore, I recommend that you add
memory yourself unless you simply don’t want to mess with your iMac’s internal
organs. Of course, your local Macintosh service specialist will be happy to install
new RAM modules for you (for a price).

As you’ve concluded by this point in this book, Apple has designed the world’s
best all-in-one computer. That even includes making it EZ-Open. (Forgive me if
your treasured work of art now reminds you of a longneck beer bottle. Come to
think of it, the level of technical knowledge required to gain access to either one is
about the same.)

Unlike earlier “picture frame” iMac models, however, you can’t remove the back
completely. In fact, Apple allows the owner of a 27" iMac to perform only one kind
of upgrade, and there’s only one opening you need to worry about. Naturally, an
Apple repair technician can get deeper into the machine, but I hope that you never
need aid from those folks.

You’ll void your warranty by tinkering with anything other than your memory

slots, so don’t even think about it. (Even if your warranty has expired, I’d still stay
my distance.)
WARNING

To add memory modules to a late-model 27" iMac, follow these steps:

1. Get ready to operate:

(a) Spread a clean towel on a stable work surface, like your kitchen table. The towel
helps protect your screen from scratches.

(b) Shut down your iMac.
(c) Unplug all cables from the computer.

2. Tiltthe computer over, and lay the screen flat (face-down) on top of the
towel.

3. Press the button directly above the power-cord socket.
The memory access door pops open.
4. Removethe memory access door.
5. stowthe memory access door safely out of reach of kids and cats.

Tah-dah! That wasn’t much of a challenge, was it? Take a moment to gaze with
rapt fascination at a small portion of the bare innards of your favorite
computer.
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6. Ground thyself!

Check out the “Let’s get grounded!” sidebar.

7. Gently pull outward on the two plastic securing levers and then pull them
toward the bottom of the access door (as shown in Figure 21-2).

FIGURE 21-2:
Remove a
memory module
like a pro.
8. Remove a module by gripping it by the corners and gently pulling it
straight upward.
Save the old module in the static-free packaging that held the new module.
Your old RAM (which you can now sell on eBay) will be protected from static
electricity.
TIP

9. Position the new module in the socket:
(@) Line up the module’s copper connectors toward the socket.

(b) Line up the notch in the module aligned with the matching spacer in the socket.
See what | mean in Figure 21-3, which shows the correct orientation for a

late-2013 27" iMac.
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FIGURE 21-3:
Installing the new
module is a snap

(pun intended)!

10. press gently (but firmly) on both ends of the module until the module
clicks into place.

11. Repeat Steps 8-10 for each module you're replacing.

12. push the two securing levers back into their original positions.
You should hear a click when they're seated.

13. Replace the memory access door.

14. Return your iMac to its natural upright stance, and plug any cables you
removed back into the back of the computer.

Waxing nostalgic: This is rather like changing the oil on my Dad's 1970 Ford
pickup truck.

Congratulations! You’ve done it — and you’re now an iMac memory guru! To ver-
ify that all is well with your iMac, boot the computer, click the Apple menu, choose
About This Mac and click the Memory button. Your iMac should report the addi-
tional memory. If your iMac doesn’t boot, check to make sure that the modules
you installed are properly seated in the sockets.
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LET'S GET GROUNDED!

Follow one cardinal rule when the unguarded insides of any computer are in easy
reach: Always ground yourself before you touch anything! Your body can carry enough
static electricity to damage the RAM you're installing or removing, and touching those
modules without grounding yourself is an invitation for disaster.

WARNING

Grounding yourself is easy to do: Just touch any metal surface around your work table,
such as a chair leg or your local metal sink. After you ground yourself, you can then
safely handle RAM modules that you remove (if any) as well as the new ones that you're
installing. (If you often swap RAM modules on different computers, you can also invest
in a device called a grounding strap that ensures you're always grounded.)

If you walk anywhere in the room — say, taking a sip of liquid reinforcement that you
stashed a comfortable and safe distance away — you must ground yourself again
before you get back to work. Remember: You can actually pick up a static charge by sim-
ply walking. Go figure.

Can | Upgrade My Internal Drive?

Asking whether you can upgrade your iMac’s internal drive is a trick question.
Yes, you certainly can upgrade your drive. But before you start cruisin’ the Inter-
net for a 4TB monster, I have two suggestions:

3 Be sure you really need an internal drive upgrade.

Apple is pretty generous when configuring drive storage for its base systems.
(Current models run with anywhere from a 1TB to a whopping 4TB drive —
yep, that's 4 terabytes, or 4,000GB! Something tells me that your prized walnut
brownie recipe will have plenty of elbow room on a 4TB drive, as will as a huge
amount of digital video.) Naturally, if you're purchasing a new iMac and you
want to avoid a bad case of “storage pinch” in the future, | definitely recom-
mend that you opt for more than a 1TB drive.

I'l be honest here: Most folks simply don't need more than 1TB of internal
drive space. You're likely to find that you still have plenty of wide-open spaces
for a typical family's needs on your hard drive unless you're heavily into:

Digital video (DV) or a large collection of movies
Cutting-edge video games

Tons of high-quality digital audio
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Four generations of high-resolution digital photos of your family (hey, it's
possible!)

3 If you decide that you do need to upgrade, don't install your internal
drive yourself.

Read more about dealing with the installation of an internal hard drive in the
upcoming section “Gotta have internal.”

If you’re short on drive space, first clean up your existing internal drive by delet-
ing all the crud you don’t need, such as game and application demos, duplicate or
“work” copies of images and documents, archived files you downloaded from the
Internet, and the contents of your Trash. You can read how in Chapter 22.

Consider your external options

If you do need additional drive space, I recommend using an external drive. Use a
high-speed Thunderbolt 3 or USB 3.0 port to connect a second drive the quick and
easy way.

Today’s Thunderbolt and USB peripherals don’t even require the driver software
that Mac old-timers remember with such hatred. You simply plug a device into
one of these ports, and it works. And you can move your external drive between
different Macs with a minimum of fuss and bother.

An external drive can do virtually anything that your internal drive can do. You
can boot from it, for example, or install (and boot from) a different version of
macOS (great for beta testers like me).

Apple’s Time Capsule unit is an external hard drive with a difference: It stores the
huge Time Machine backup files created by the Macs running macOS on your net-
work, and it uses a wireless connection to transfer data! (In fact, if you’re thinking
of adding a wireless base station to your wired network, your Time Capsule actu-
ally acts as a wireless base station, complete with USB port for connecting a USB
printer.) At this writing, Time Capsule is available with a 2TB ($299) or 3TB ($399)
drive. Note that Apple will retire the Time Capsule line of devices in April, 2019.

Here’s one problem with external drives, though. Even USB 3.0 connections trans-
fer data more slowly this way than via an internal drive (only the newer Thunder-
bolt 3 connections rival the speed of an internal drive). That’s why most Mac
owners (especially graphics and video professionals) use their external drives for
storing backups, digital media, and little-used documents and applications. Their
favorite applications, work in-progress and often-used documents are housed on
the internal drive.
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Putting a port to work

Current iMac models carry two kinds of high-speed ports, either of which is a
good match for connecting any external device.

USB 3.0

The USB standard is popular because it’s just as common in the PC world as in the
Mac world. (Most PCs don’t have a Thunderbolt port.) Your iMac carries its USB
3.0 ports on the back of the case, which are fully compatible with older USB 2.0
devices. Hardware manufacturers make one USB device that works on both Macs
and PCs.

If you’re using an older iMac with USB 2.0 ports, there’s no need to spend extra
money on USB 3.0 devices, because you won’t get the performance boost. 'Nuff
said.

THUNDERBOLT 2 AND 3

Talk about raw speed. An older iMac’s second-generation Thunderbolt 2 connec-
tion provides a blazing 20Gbps, which is twice as fast as USB 3.0 — and the latest
iMac models sport the Thunderbolt 3 port, which doubles that transfer speed to an
unbelievable 40Gbps maximum! You can use a Thunderbolt port to connect an
external hard drive or even a high-resolution monitor or HD-TV. Luckily, the
price for Thunderbolt external drives has dropped significantly since the port first
appeared on the Mac, so you no longer have to pay a premium price for Thunder-
bolt devices.

Connecting an external drive

With Thunderbolt or USB, you can install an external hard drive without opening
your iMac’s case. With your iMac turned on and the external drive disconnected
from the AC outlet, follow these steps:

1. connect the Thunderbolt or USB cable betwixt the drive and your
computer.

2. Ifthe drive requires an AC adapter, plug the external drive into a conven-
ient surge protector or UPS (uninterruptible power supply).

3. Switch on the external drive.
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4. If the drive is unformatted (or formatted for use under Windows),
partition and format the external drive.

The drive comes with instructions or software to help you do this. (Don’t worry,
external drives typically come from the factory completely empty, and you
won't damage anything by formatting it. To be sure, check the drive’s manual.)
Partitioning divides the new drive into one (or more) volumes, each of which is
displayed as a separate hard drive under macOS.

If the drive comes preformatted for use with a Windows PC, | strongly suggest
reformatting it for use with macOS. Doing so results in much faster perfor-
mance and more efficient use of space.

After the drive is formatted and partitioned, it immediately appears on the Desk-
top. Shazam!

Gotta have internal

If you decide that you absolutely have to upgrade your existing internal hard
drive — or if your internal drive fails and needs to be replaced — you must take
your iMac to an authorized Apple Service Center and allow the techs there to sell you a
drive and make the swap. Here are four darned good reasons why:

3 Warranty: As | mention earlier, you'll void your iMac's warranty by attempting
a drive upgrade yourself.

¥ Selection: If you're worried about picking the proper drive, an Apple techni-
cian can order the right drive type and size for you . . . no worries.

¥ Difficulty: Swapping a hard drive in your iMac is nothing like adding RAM
modules. It's complex and involves breaking into your iMac — not A Good
Thing, even for the knowledgeable Mac guru.

3 Backup: That very same Apple service technician can back up all the data on
your existing drive and move it to the new drive, saving you from losing a
single document. That will save you time and possible angst.

To those who truly won’t be satisfied with their lives until they upgrade an inter-
nal drive in an iMac all by themselves: Yes, I'm sure you can find a magazine
article that purports to show you how. Even better, I’ve seen many how-to articles
on the web that will lead you down a rosy path to a hard drive upgrade. Here’s my
take on those savvy instructions: You’re walking into a field of land mines with
someone else’s map, so you had better have complete faith in your tech skills. (And
a darn good backup.)
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Weighing Attractive Add-Ons

The external toys I cover in this section might add a cord or two to your collection
at the back of your iMac, but they’re well worth the investment. And they can
really revolutionize how you look at technologies such as television, digital audio,
and computer gaming.

Game controllers

If you’re ready to take a shot at the enemy — whether they be Nazi soldiers, chit-
tering aliens, or the latest jet fighters — you’ll likely find your keyboard and
mouse somewhat lacking. (And if that enemy happens to be a friend of yours play-
ing across the Internet, you’ll be ruthlessly mocked while you’re fumbling for the
right key combination.) Instead, either pick up a USB joystick (for flying games)
or a gamepad (for arcade and first-person shooting games)!

External drive arrays

In case you’re not familiar with a drive array (typically called a RAID array), it’s
just a fancy moniker for an enclosure that holds multiple drives. “Grouping” hard
drives like this provides a boost in speed, or you can use an array to make a self-
maintaining redundant backup of all your data. Your Thunderbolt port is perfect
for this high-tech magic. You can also pick up a wired or wireless network storage
unit (commonly called a NAS, short for network-attached storage), which is essen-
tially drive storage that’s connected and available to your entire Ethernet network.

Video controllers

For armchair directors, specialized USB digital video controllers make editing eas-
ier. The ShuttlePRO V2 from Contour Design (www.contourdesign.com) provides
a 15-button jog control that can be configured to match any DV editor. For around
$100, you’ll have the same type of editing controller as do those dedicated video-
editing stations that cost several thousand dollars.

Audio hardware and MIDI controllers

Ready to put GarageBand to the test with your favorite version of “Chopsticks”?
You need a USB piano keyboard, and I recommend the Keystation 88es from
M-Audio (www.m-audio.com), which retails online for around $150. It provides
88 keys and uses a USB connection.
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IN THIS CHAPTER

» Cleaning unnecessary stuff off your
hard drive

» Backing up your data
» Fixing permissions errors
» Automating tasks in Mojave

» Updating macOS automatically

Chapter 22

Tackling the
Housekeeping

othing runs better than a well-oiled machine, and your iMac is no excep-

tion. (But please, don’t ever oil your iMac; that’s just a figure of speech.)

In this chapter, I demonstrate how you can make good use of every byte of
storage space provided by your hard drive.

With a little macOS maintenance, such as Time Machine (for backing up and
restoring your hard drive) and frequent scans of your hard drive for disk errors,
you can ensure that your iMac is performing as efficiently as possible. Automator
allows your iMac to perform tasks automatically that used to require your atten-
tion. In addition, configuring Software Update to run automatically can allow you
to live life free and easy, watching your favorite reality TV and eating ice cream (or
yogurt — your pick).

Cleaning Unseemly Data Deposits

Criminy! Where does all this stuff come from? Suddenly, that spacious 1TB hard
drive has 19GB left, and you start feeling pinched.
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FIGURE 22-1
Manage your
ge to reclaim

drive space.
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TIP

Before you consider buying a new internal or external hard drive (which you can
read about in Chapter 21), take the smart step: Sweep your hard drive clean of
unnecessary and space-hogging software.

Managing your storage in macOS
(or cleaning things the elegant way)

Apple recently added the Manage Storage feature within macOS to help identify
and display (and optionally delete) those huge files that are taking up so much of
your drive’s real estate. Right-click the Desktop icon for the hard drive you want
to clean, and choose Manage Storage. After a pause (which may be considerable,
depending on the capacity of the drive), you’ll see the window shown in
Figure 22-1.

00 Colossus - 130.59 GB available
0 Recommendations
Store in iCloud
O RERElEccks Zads ‘p Store all files, photos, and messages in iCloud and save Store in iCloud.
O Applications 29.76 GB space by keeping only recent me_s and optimized photos
on this Mac when storage space is needed.
[ Documents 35168
iCloud Drive 14.9 MB
D e 25 ol ™ Optimize Storage
“‘;'_; Tunes 69.3 MB @ Save space by automatically removing iTunes movies Optimize...
- and TV shows that you've already watched from this
&) mail Zero KB Mac.
() Messages 3932 MB
'.":l Music Creation 11.02 GB
% Photos Zero KB “uss  Empty Trash Automatically
Save space by automatically erasing items that have Turn On...
been in the Trash for more than 30 days.
@ Other Users 50.9 MB i
@ system 74.77 GB
= Reduce Clutter
Sort through documents and other content stored on Review Files
this Mac and delete what is no longer needed.

Note the categories in the list at the left side — from here, you can see the approx-
imate amount of space taken up by notoriously spacious items like your docu-
ments and your iTunes media. Click a category to display the worst offenders,
sorted by size. If you see an item that you no longer need (like that 2GB happy cat
video you downloaded two years ago), move your cursor over that item and click
the X button that appears to delete it. If only cleaning your house were this easy!

The Recommendations category is unique, since it offers space-saving features
that macOS offers rather than displaying files.For example, if you’ve invested in
additional iCloud storage, you can choose to “offload” files, photos, and messages
to iCloud rather than store them locally. (Naturally, you must be connected to the
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Internet to retrieve them.) You can also choose to empty your Trash automatically
from here.

Getting dirty (or cleaning things
the manual way)

If you’re willing to dig into your data a little, you can eschew the Manage Storage
feature and dive elbow-deep into your drive to hunt down every unnecessary file.
All you really need is the willpower to announce, “I simply don’t need this partic-
ular item any longer.” (Sometimes, that’s tougher than it may seem.)

Unnecessary files and unneeded folders

Consider all the stuff that you probably don’t really need:

»
»

»
»
»
»
»

Game demos and shareware that you no longer play (or even remember)

Movie trailers and other QuickTime video files that have long since passed
into obscurity

Temporary files that you created and promptly forgot

Log files that chronicle application installations and errors
GarageBand loops and iMovie video clips you'll never use

Stuffit and Zip archives that you downloaded and no longer covet

iTunes music, video, and movies that no longer appeal

How hard is it to clean this stuff off your drive? Easier than you might think!

»
»

»

»

You can quickly delete files.

You can remove items from your iTunes Library (especially movies, which take
up several gigabytes of space each). If you've purchased an item from the
iTunes Store, don't forget that you can download that item again in the future
for free — perhaps when you've added an external drive to hold some of your
stuff. You can also choose to stream your music and movies directly from
iTunes, which takes up no space on your drive at all - just a fast broadband
Internet connection.

You can move seldom-used files and folders to external storage (such as a
USB flash drive, an external hard drive, or a DVD).

You can uninstall applications purchased from the App Store using Launchpad.
From the Launchpad display, click and hold down the icon until it wiggles. If an
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X button appears on the icon, you can click the X to remove the application
from your iMac. Again, these applications can be reinstalled at any time.

¥ You can get rid of most of the space taken by any application (often the whole
application) by deleting its application folder that was created during the
installation process.

Always check the application’s README file and documentation for any special
instructions before you manually delete any application’s folder! If you created
any documents in that folder that you want to keep, don’t forget to move them
before you trash the folder and its contents. In fact, some applications may come
with their own uninstall utility, so checking the README file and documentation
may save you unnecessary steps.

Removing an application or file from your drive usually takes two simple steps:

1. Display the file or application folder in a Finder window.

2. Delete the file or folder with one of these steps:
Drag the icon to the Trash.
Select the icon and press g8+Delete.
Right-click the icon and choose Move to Trash from the contextual menu.
Select the icon and click the Delete button on the Finder toolbar (if you
added one).

Truly, no big whoop.

Unlike programs in the Windows world, most macOS applications don’t need a
separate, silly uninstall program (although some larger Mac applications include
one for convenience).

Don’t forget to actually empty the Trash, or you’ll wonder why you aren’t regain-
ing any drive space. (macOS works hard to store the contents of the Trash until
you manually delete it, just in case you want to undelete something.) To get rid of
that stuff permanently and reclaim the space, do the following:

1. click the Trash icon on the Dock and hold down the button — or right-
click — until the pop-up menu appears.
2. Cchoose Empty Trash.

As I mentioned earlier in the chapter, if you use the Manage Storage feature you
can elect to set your Trash to empty automatically.
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FIGURE 22-2:
Mine your hard
drive for
additional files to
delete.

Associated files in other folders

Some applications install files in different locations across your hard drive. (Appli-
cations in this category include the Microsoft Office suite,Adobe Creative Suite and
Creative Cloud applications like Adobe Photoshop.) How can you clear out these

orphan files after you delete the application folder?

The process is a little more involved than deleting a single folder, but it’s still no

big whoop. Here’s the procedure:

1. Click the Search text box in a Finder window.
You can read more about Search and Finder windows in Chapter 7.
2. Type the name of the application in the Search text box.
Figure 22-2shows this search. | want to remove Toast Titanium, so | search for
every file with the word Toast in its name; therefore, | found both the applica-
tion and its main folder. This trick displays files created in other folders that
include your search word in their names, such as project files, PDF files, and
the font files that appear in the system Fonts folder.
3. Decide which of these files belong to the to-be-deleted application.
Be sure that the files you choose to delete are part of the deleted application.
In Figure 22-2, a word processing document named Instructions on Making a
Perfect Piece of Toast is definitely not part of Toast Titanium!
[ X X ) [ Searching "This Mac"
< EED = . H* - 32~ | Q [NAMES Toast |
Favorites Search: “Colossus™ Save
22 Dropbox B Edge Toaster ‘e DiscCatalogMaker RE
@ AirDrop + Instructions on Making a Perfect Piece of Toast l! Live Screen Capture
Toast Titanium @ MultiCam Capture
& Recents 8 Toast Slice & MyDVD
/A Applications = - Roxio Secure Burn
£ Toast Audio Assistant ) Toast Audio Assistant
© pownloads i Toast Slice
E Movies Toast Titanium
n Music
[i&1 Pictures
ﬁ} mark
iCloud
) iCloud Drive
=] Desktop
B Documents
Locations
Remote Disc
2 Network
0 items
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CCleaner for Mac
is a great tool for
cleaning your
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iMac's drive.

Many associated files:
® Have the same icon as the parent application
® Arein the Preferences, Caches, or Application Support folder

4. In the Search Results window, click the associated file(s) that you want to
delete and just drag them to the Trash.

Don't empty the Trash immediately after you delete these files. Wait a few
hours or a day. That way, if you realize that you deleted a file that you truly
need, you can easily restore it from the Trash.

Using a commercial cleanup tool

If you’d rather use a commercial application to help you clean up your drive, sev-
eral applications are available, but most are shareware applications that perform
only one task. For a good all-around cleanup utility, I recommend CCleaner for
Mac, from Piriform (https://www.ccleaner.com/ccleaner-mac), as shown in
Figure 22-3. This great utility can clean everything from Internet crud (browser
cookies and your surfing history) to those macOS system caches that can grow so
doggone huge. And you can easily fine-tune whatever CCleaner for Mac wants to
remove. The utility can also uninstall many applications with a single click. Oh,
and did I mention that it’s free? I really like free!

% CCleaner

CCleaner Free 115507
iMac Intel Core i5 @ 2.70GHz, 32.0GB RAM

Mac 0S X
@ Safari

Applications

S —— ANALYSIS COMPLETE - (22.848 secs)
~1,902 MB (5,867 files) to be removed
Internet History
Cookies Details of files to be removed
Download History
Session @ Safari - Internet Cache 58,008 KB 446 files
@ System @ Safari - Internet History 3,994 KB 6 files
Trash @ Safari - Cookies 13,382 KB 1241 files
Recent Documents @ Safarl - Download History 1KB 1files
Recent Applications @ Safari - Session 5KB 2 files

Recent Servers

.' System - Recent Documents 0 KB 30 files

Recent Places % System - Recent Applications O KB 30 files
;[i’iimry Service Cache . System - Recent Places O KB 5 files
IEDEoT RS @ System - Logs 1,078,356 KB 820 files
Font Registry Cache @ Applications - Grab 0 KB 1files
Unneeded Languages @ Applications - Microsoft Word 38 KB 2 files
[ Miscellaneous - Caches 748,510 KB 3283 files

@ System Applications
Quick Look
HelpViewer
Finder
0 Advanced
Custom Files and Folders

Check for updates...

Online Help
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Backing Up Your Treasure

Do it.

I’m not going to lecture you about backing up your internal drive . . . well, perhaps
just for a moment. Imagine what it feels like to lose everything: names, numbers,
letters, reports, presentations, saved games, photographs, video and music. Then
ask yourself, “Self, isn’t all that irreplaceable stuff worth safeguarding?”

Time for a Mark’s Maxim:
Back up. On a regular basis.

MARK'S Take my word for it; you will thank me some day!

You can back up your files either by saving them to external media or — as
I strongly recommend — by using the awesome Time Machine feature included
with macOS. Read more about Time Machine in the “Putting Things Right with
Time Machine” section later in this chapter.

Saving Files

The simplest method of backing up files is simply to copy the files and folders to
an external drive, USB flash drive or a CD or DVD. Nothing fancy — in fact, I call
this procedure the “quick-and-dirty backup” — but it works.

Backing up to an external drive

If you have an external drive or USB flash drive on your iMac, you can easily drag
backup files to it from your internal drive (I cover external drives in Chapter 21):
1. Open separate Finder windows for:

The external drive

The internal drive

Because you're using macOS, you can also open a Finder tab within a single
Finder window to accomplish the same task — from the keyboard, press $8+T.

2. select the desired files that you want to back up from your internal drive.

3. Drag the selected files to the external drive window.
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TIP

“Mark, can I back up individual files to cloud-based storage like iCloud Drive,
Dropbox, Google Drive, and OneDrive?” Of course! These services are fine for your
most important files (much like backing up a handful of critical files to DVD or
flash drive), but these cloud drives aren’t suitable for backing up the entire con-
tents of your iMac’s internal drive. (You should always use Time Machine with an
external drive for that important chore.) Also, don’t forget that you need an Inter-
net connection to save or retrieve files from cloud storage.

Backing up to CD and DVD

You can burn backups of your most important files to a recordable CD or DVD, if
you have an external optical drive. Saving your data is more labor-intensive this
way, but the end result is a truly bulletproof backup that doesn’t rely on an exter-
nal drive or flash drive, and the backup can be read in any CD or DVD drive for
decades to come.

Burning backups from the Finder

To use the Finder’s Burn feature to create a backup CD or DVD, follow these steps:

1. Load ablank disc into your iMac’s optical drive.

If you're using the default settings in the CDs & DVDs pane in System
Preferences, a dialog appears, asking you to choose an action.

2. From the Action pop-up menu, choose Open Finder and then click OK.

An icon named Untitled DVD appears on your Desktop. Double-click the icon to
open a Finder window.

3. Drag the files and folders that you want to back up into the disc’s Finder
window.

They can be organized any way you like. Don't forget that the total amount of
data shouldn't exceed 4GB or so (on a standard recordable DVD) or 8GB (on a
dual-layer recordable DVD). You can see how much free space remains on the
disc at the bottom of the disc’s Finder window.

4. When you're ready to record, click File and then choose Burn Disc from
the Finder menu.

You can also click the Action button that appears at the top of the disc's Finder
window and choose Burn Disc from the pop-up menu.

o

Choose the fastest recording speed possible.

6. Click Burn.
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TIP

Burning backups from other recording
applications

If you’ve invested in Toast Titanium from Roxio (www.roxio.com) or another CD/
DVD recording application, you can create a new disc layout to burn your backup
disc. (Think of a layout as a road map indicating which files and folders Toast
should store on the backup.)

If you do decide to back up to CD/DVD or to an external backup drive without using
Time Machine, it’s a good idea to store that backup media somewhere safe, away
from calamities. On the other hand, if you back up with Time Machine — as I’m
about to demonstrate — you should instead leave your external drive plugged in
to your iMac.

Putting Things Right with Time Machine

TIP

©

REMEMBER

If you enable backups via the macOS Time Machine feature, you can literally move
backward through the contents of your iMac’s internal drive, selecting and restor-
ing all sorts of data. Files and folders are ridiculously easy to restore — and I mean
easier than any restore you’ve ever performed, no matter what the operating sys-
tem or backup program. Time Machine can even handle some deleted items, like
Contacts cards! To sum it up, Time Machine should be an important and integral
part of every Mac owner’s existence.

Apple’s Time Capsule device (which has been discontinued) is designed as a wire-
less storage drive for your Time Machine backup files. If you’re interested in a
single Time Machine backup location for multiple Macs across your wireless net-
work, a Time Capsule is a great addition to your home or office.

Before you can use Time Machine, you must have it enabled within the Time
Machine pane in System Preferences. I cover the Time Machine configuration set-
tings (and how to turn the feature on) in more detail in Chapter 5. You’ll also need
an external drive that provides considerably more storage capacity than the drive
you’re backing up. I recommend that your external Time Machine backup drive be
at least twice the capacity of the drive you’re backing up. (To check on the size of
a drive displayed on your desktop, right-click the drive and choose Get Info from
the contextual menu.)
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Here’s how you can turn back time, step by step, to restore a file that you deleted
or replaced in a folder:

1. Open a Finder window and navigate to the folder that contained the file
you want to restore.

2. Click the Time Machine icon on the Finder menu bar (which bears a clock
with a counterclockwise arrow) and then click Enter Time Machine.

The oh-so-ultra-cool Time Machine background appears behind your folder,
complete with its own set of buttons at the bottom of the screen (as shown in
Figure 22-4). On the right, you see a timeline that corresponds to the different
days and months included in the backups that macOS has made.

iz =[] =~
View Arrange  Share
@ 30.9781..546-ch21
T 2018pprc
@ ACT phots
B9 Desktop
9 Documents

% Documents

T Fundraiser Certificate
8 Pictures [ GarageBa..or mac0S

Games 2 Grab

€2 iCloud Drive

J7 Music

A Applications

[0 Deskiop A script Editor
E Recents Y

FIGURE 22-4: 16 1es, 8003 B avaaie en s

Yes, Time
Machine really
does look like this!

3. Cclick within the timeline to jump directly to a date (displaying the folder’s
contents on that date).

Alternatively, use the Forward and Back arrows at the right to move through
the folder's contents through time. (You should see the faces of Windows users
when you riffle through your folders to locate something you deleted several
weeks ago!)

The backup date of the items you're viewing appears in the button bar at the
bottom of the screen.

rememser 4. After you locate the file you want to restore, click it to select it.
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TIP

TIP

MARK'S
MAXIM

5. Click the Restore button at the right side of the Time Machine button bar.

If you want to restore all the contents of the current folder, click the Restore All
button instead.

Time Machine returns you to the Finder, with the newly restored file now
appearing in the folder. Outstanding!

To restore specific data from your Contacts database, launch the Contacts appli-
cation first and then launch Time Machine. Instead of riffling through a Finder
window, you can move through time within the application window.

You can easily restore the entire contents of your iMac’s internal drive from your
Time Machine backup, too. Reboot your iMac and hold down the g8+R startup key
sequence to boot using the macOS Recovery HD volume, then use the Restore
function.

For robust backup and restore protection, Time Machine is all that a typical Mac
owner at home is likely to ever need. Therefore, a very easy Mark’s Maxim to
predict:

Get an external drive, connect it, and turn on Time Machine. Do it now. Don’t
make a humongous mistake.

Maintaining Drive Health

Shifty-eyed, sneaky, irritating little problems can bother your internal drive: per-
missions errors. Incorrect disk and file permissions can:

¥ Make your iMac lock up
¥ Make applications act screwy (or refuse to run at all)

3 Cause weird behavior within a Finder window or System Preferences

And that’s not all: Problems with your drive’s catalog file can also result in cor-
rupted data and files that won’t open.
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To keep macOS Mojave running at its best, I recommend that you fix permissions
and catalog errors at least once per week. Follow these steps:

1. click the Launchpad icon on the Dock and then click the Search box at
the top of the window.

2. Type the word disk.

3. Double-click the Disk Utility icon.

4. Click the volume at the left that you want to check.

Volume is just computer-speak for a named partition, like Macintosh HD, which

"6" appears under your physical hard drive.
TECS;ilI;IFIgAL 5. Click the First Aid button and then click Run.

Disk Utility does the rest and then displays a message about whatever it has to
fix, if anything. (When will someone invent a car with a Repair Me button?)

Automating Those Mundane Chores

The macOS Automator application is a big hit among iMac power users. You use
Automator (shown in Figure 22-5) to create customized tools that automate
repetitive tasks. Of course, writing an application might sound daunting — akin
to singlehandedly building your own nuclear submarine over a long weekend —
but Automator is actually easy to use. Heck, you might find it downright fun!
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WARNING

You can also create workflows, which are sequential (and repeatable) operations
that are performed on the same files or data, and then your Automator application
can automatically launch whatever applications are necessary to get the job done.

Here’s a great example: You work with a service bureau that sends you a huge
.zip file every week with new product shots for your company’s marketing
department. Unfortunately, these images are flat-out huge — taken with a
24-megapixel camera — and they’re always in the wrong orientation. Before you
move them to the Marketing folder on your server, you have to use Preview to
laboriously resize each image and rotate it, and then save the smaller version.

With help from Automator, you can build a custom application that automatically
reads each image in the folder, resizes it, rotates it, generates a thumbnail image,
prints the image, and then moves the massaged images to the proper folder —
and all with a single double-click! Of course, you can run Automator from Launch-
pad, or from your Applications folder in a Finder window. Currently, Automator
can handle specific tasks within more than 150 applications (including the Finder),
but both Apple and third-party developers are busy adding new Automator task
support to all sorts of new and existing applications.

Creating an application in Automator

To create a simple application with Automator, launch the application and follow
these steps:
1. click the New Document icon.
2. select Application and click the Choose button.
3. Click the desired application in the Library list.
Automator displays the actions available for that application.

4, Drag the desired action from the Library window to the workflow
window on the right.

5. Modify any specific settings provided for the action you chose.
6. Repeat Steps 3-5 until you complete the workflow.
7. click the Run button (at the upper right) to test your script.

Use sample files while you're fine-tuning your application lest you accidentally
do something deleterious to an original (and irreplaceable) file!

8. Whenthe application is working as you like, press 38+S to save it.

9. Inthesave dialog that appears, type a name for your new application.
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10. click the Where pop-up menu and specify a location where the file should
be saved.

11. click the File Format pop-up menu and choose Application.
12. click save.

Your new Automator application icon includes the Automator robot standing
on a document. Most normal human beings would call you a programmer, so
make sure you're inscrutable from now on! If you plan to use your new
Automator application often, don't forget that you can make it more conven-
ient to use by dragging the application icon to the Dock or to the desktop.

at the top of the Library list and type a keyword, such as save or burn. You don’t
even need to press Return!

To find all the actions of a certain type in the Library list, click in the Search box
TIP

Creating an Automator login item

If you want your Automator application to run every time you log in (to track your
time on a project, for example), follow these steps to set up the Automator appli-
cation as a login item:

1. Open System Preferences.

2. Display the Users & Groups pane.

3. Clickthe Login Items button.

4. Clickthe plus button at the bottom of the list.

5. Navigate to the location of your new Automator application.
6. Cclick Add.

Now your Automator application is really automatic. Watch your significant
other gape in amazement as your iMac begins to work without your touching
the keyboard! (If you've added the application icon to your Dock, you can also
simply right-click the icon and choose Options = Open at Login from the
menu that appears. Either way, your iMac gets the message.)

Updating macOS Automatically

I prefer my iMac to take care of cleaning up after itself, so updating macOS should
be automatic as well. In macOS Mojave, operating system updates are performed
by the Software Update pane within System Preferences.
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TIP

Software Update uses the Internet, so you need an Internet connection to shake
hands with the Apple server and download any updates.

Updates are available in two convenient spots:

3 The Apple menu: Click the Apple menu () and then choose About This Mac.
Click the Software Update button, which alerts you to anything new that's
available.

3 System Preferences: Click the Software Update icon in the System
Preferences window.

To set Software Update to check for critical system updates and install them
automatically, simply select the Automatically Keep My Mac Up To Date check
box to enable it.

If you’re using the same Apple ID on more than one Mac, the applications you’ve
purchased through the App Store on your other Macs can be automatically down-
loaded to this computer as well. Click the Advanced button on the Software Update
pane, then select the Install App Updates From the App Store check box to enable
it; then sit back and watch convenience happen.
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The Part of Tens



IN THIS PART ...

Improve your iMac's performance.

Avoid costly mistakes.



IN THIS CHAPTER

» Adding memory

» Using Dictation

» Defragmenting your drive

» Banishing the Desktop background
» Using column mode

» Customizing the Dock

» Using keyboard shortcuts

» Customizing your Finder windows

» Launching recent applications and
documents

» Using the Go menu

Chapter 23

Ten Ways to Speed Up
Your iMac

ven an iMac Pro with an 18-core Intel Xeon W processor can always go just a

bit faster . . . or can it? There’s actually a pretty short list of tweaks that you

can apply to your iMac’s hardware to speed it up, and these suggestions are
covered in this chapter.

You can also work considerably faster within Mojave by customizing your Desktop
and your Finder windows, which makes it easier to spot and use your files, folders,
and applications. That’s in this Part of Tens chapter, too.

Finally, you can enhance your efficiency and make yourself a power user by

tweaking yourself. (Sounds a bit tawdry or even painful, but bear with me, and
you’ll understand.)
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Nothing Works Like a Shot of Memory

REMEMBER

Okay, maybe shot is the wrong word, but adding additional memory to your iMac
(by either replacing or adding a memory module) is the single surefire way to
speed up the performance of your entire system. That includes every application
as well as macoOS itself.

With more memory, your iMac can hold more of your documents and data at once,
and thus has to store less data temporarily on your internal drive. It takes your
iMac much less time to store, retrieve, and work with data when that data is in
RAM (short for random access memory) rather than on your hard drive. That’s why
your system runs faster when you can fit an entire image in Adobe Photoshop in
your iMac’s system memory.

At this writing, you can cram up to 128GB of memory in an iMac Pro, up to 64GB
in a 27" iMac model, and 21.5" models can be configured with up to 32GB of mem-
ory as well when you order from the Apple online store.

Only 27" iMacs can be upgraded with additional memory by the owner after
purchase - the iMac Pro and iMac 21.5” models must be upgraded by an Apple
Authorized Service Provider (and usually at quite a cost).

Hold a Conversation with Your iMac

Many Mac owners will attest that you can significantly increase your own effi-
ciency by using the Dictation feature, which allows you to dictate text by speaking
within many applications. Your voice is indeed faster than your fingers!

To enable Dictation, choose System Preferences > Keyboard, click the Dictation
tab and click the On radio button next to Dictation. Remember that by default,
Dictation is active only when you press the Fn (Function) key twice. (You can
change the Dictation shortcut from the Dictation tab).

Vamoose, Unwanted Fragments!

388

Apple would probably prefer that I not mention disk fragmentation because macOS
doesn’t come with a built-in defragmenting application. (Go figure.) A disk-
defragmenting application reads all the files on your magnetic drive and rewrites
them as continuous, contiguous files, which your machine can read significantly
faster.
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To keep your hard drive running as speedily as possible, I recommend defrag-
menting at least once monthly. You can use third-party applications like Prosoft
Engineering’s Drive Genius (www.prosofteng.com) to defragment your drive.

You should never defragment your iMac internal drive if it’s a SSD (solid-state) or

Fusion drive (the memory in a solid-state drive has a limited number of write/
delete cycles during its lifespan, and the defragment process continuously writes

warning  and deletes data from the drive). Only traditional magnetic hard drives benefit
from defragmenting. To determine which type of internal drive you’re using,
launch Disk Utility, click the internal drive entry in the list on the left, and check
for the acronym SSD in the drive description. If you see it, your iMac has an SSD
or Fusion drive installed.

Keep Your Desktop Background Simple

It’s funny that I still include this tip in a chapter dedicated to improving perfor-
mance. After all, I recommended using a solid-color background in my first books
on Mac OS 8 and Windows 98! Just goes to show you that some things never
change.

If you’re interested in running your Retina 5K iMac Pro system as fast as it will go,
choose a solid-color background from the Desktop & Screen Saver pane in System
Preferences. (In fact, there’s even a separate category that you can pick called
Solid Colors. Someone at Apple has the right idea.)

Column Mode Is for Power Users

One of my favorite features of macOS is the ability to display files and folders in
column view mode. Just click the Column button on the standard Finder window
toolbar, and the contents of the window automatically align in well-ordered
columns.

Other file-display options require you to drill through several layers of folders to
get to a specific location on your hard drive — such as Users/mark/Music/
iTunes/iTunes Music, which I visit on a regular basis. In column mode, however,
a single click drills a level deeper, and often you won’t even have to use the Finder
window’s scroll bars to see what you’re looking for. Files and folders appear in a
logical order. Also, it’s much easier to move a file (by dragging it from one loca-
tion on your hard drive to another) in column mode.
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Make the Dock Do Your Bidding

REMEMBER

Just about every Mac owner considers the macOS Dock a good friend. But when’s
the last time you customized it — or have you ever made a change to it at all?

You can drag files and folders to the Dock, as well as web URLSs, applications, and
network servers. You can also remove applications and web URLs just as easily by
dragging the icon from the Dock and releasing it on your Desktop.

I find that I make a significant change to my Dock icons at least once every week.
I find nothing more convenient than placing a folder for each of my current proj-
ects on the Dock or adding applications to the Dock that I might be researching for
a book or demonstrating in a chapter.

You can position the Dock at either side of the Desktop or even hide the Dock to
give yourself an extra strip of space on your Desktop for application windows.
Click the Apple menu at the left side of the Finder menu bar and then hover your
pointer over the Dock item to display these commands.

It All Started with Keyboard Shortcuts

Heck, keyboard shortcuts have been around since the days of WordStar and Visi-
Calc, back when a mouse was still just a living rodent. If you add up all those
seconds of mouse-handling that you save by using keyboard shortcuts, you’ll see
that you can literally save hours of productive time every year.

You're likely already using some keyboard shortcuts, such as the common editing
shortcuts g8+C (Copy) and $8+V (Paste). When I'm learning a new application,
I often search the application’s online help to find a keyboard shortcut table and
then print that table as a quick reference. Naturally, you can also view keyboard
shortcuts by clicking each of the major menu groups within an application. Short-
cuts are usually displayed alongside the corresponding menu items.

Hey, You Tweaked Your Finder!

390

Here’s another speed enhancer along the same lines as my earlier tip about
customizing your Dock: You can reconfigure your Finder windows to present just
the tools and locations that you actually use (rather than what Apple figures
you’ll use).
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You can right-click the toolbar in any Finder window and choose Customize Tool-
bar, for example. By default, the macOS Finder toolbar includes only the default
icon set that you see at the bottom of the sheet, but you can drag and drop all sorts
of useful command icons onto the toolbar. You can save space by displaying small
icons, too.

With Finder tabs, you can even open multiple tabs within a Finder window (mak-
ing it just about as efficient as it can possibly be for operations such as moving
files, quickly navigating between locations, and comparing items in different
locations).

a healthy, no-nonsense repository for those locations that you constantly visit

throughout a computing session. I have both a Games folder and a Book Chapters
TIP folder that I use countless times every day (it’s important to balance work with

pleasure, you know), and I’ve dragged both of those folders to the sidebar.

The Finder sidebar — which hangs out at the left side of the Finder window — is

Keep in Touch with Your Recent Past

Click that Apple menu and use that Recent Items menu! I know that sounds a little
too simple, but I meet many new Apple computer owners every year who either
don’t know that the Recent Items menu exists or forget to use it. You can access
both applications and documents that you’ve used within the past few days. Con-
sider the Dock and Finder sidebar to be permanent or semi permanent solutions
and the Recent Items menu to be more of a temporary solution to finding the stuff
that you’re working on Right Now.

Go Where the Going Is Good

To round out this Part of Tens chapter, I recommend another little-known (and
underappreciated) Finder menu feature (at least among Macintosh novices): the
Go menu, which is located on the Finder menu bar.

The Go menu is really a catch-all, combining the most important locations on
your system (such as your Home folder) with folders that you’ve used recently.
Also, the Go menu is the place where you can connect to servers or shared folders
across your local network or across the Internet.
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Pull down the Go menu today — and don’t forget to try out those spiffy keyboard
shortcuts you see listed next to the command names. (Press $8+Shift+H to go
immediately to your Home folder, for example.) And if a Finder window isn’t open
at the moment, a new window opens automatically. Such convenience is hard to
resist!

Hold down the Option key when you click the Go menu, and you’ll be able to
choose your personal Library folder (which is normally hidden) from the menu.
This comes in handy when you have to troubleshoot problems with applications

TIP that save files or store configuration data in your Library folder.
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IN THIS CHAPTER

» Overheating is the enemy

» Phishing (without a pole)
» Using a single password
» Liquid Mac meltdowns

» Antique utility software
» lllegal software

» That nasty root account
» Cheap surge protectors
» Refurbished stuff

» Just plain dirt

Chapter 24

Ten Things to Avoid Like
the Plague

f you’ve read other books that I’ve written in the For Dummies series, you might

recognize the title of this chapter: It’s a favorite Part of Tens subject of mine

that appears often in my work. I don’t like to see any computer owner fall prey
to pitfalls. Some of these pitfalls are minor, like being less than diligent about
keeping your iMac clean. Others are downright catastrophic, like providing valu-
able information over the Internet to persons unknown.

All these potential mistakes, however, have one thing in common: They’re easily
prevented with a little common sense as long as you’re aware of them. That’s my
job. In this chapter, I fill in what you need to know. Consider these pages as expe-
rience gained easily (for you, that is!).
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Keep Things Cool

I’ve met several iMac owners over the years who’ve parked their supercomputers
next to a heat source, shoehorned an iMac under a shelf, or draped something over
the top of the screen. (That last one happens more often than you think, just
because such a cover helps prevent dust from accumulating on the top of any
computer.)

What, dear reader, do these three mistakes have in common? In a word, heat,
which is something you must avoid. Don’t forget that your iMac has the same
heat-generating CPU, video card, and internal devices that any other computer
has these days but only a single pathway for air to flow. Trust me: Your mother-
board and internal devices will suffer if you don’t allow your iMac’s internal fan
to perform its job!

As I discuss in Chapter 1, the location of the fan exhaust on your iMac varies with
the model: On older iMacs, the exhaust is the slot at the top back of the case, while
recent iMacs and the iMac Pro have vents at the center back of the case. No matter
where your fan exhaust is located, don’t ever cover it with anything, and locate your
iMac in a spot where there’s plenty of ventilation directly above and behind the
computer. Also, avoid major heat sources anywhere around your iMac that could
significantly raise its temperature.

Phishing Is No Phun

394

Phishing refers to an attempt by criminals to illegally obtain your personal infor-
mation. If that sounds like an invitation to identity theft, it is — and thousands of
sites have defrauded individuals like you and me (along with banks and credit card
companies) out of billions of dollars.

A phishing scam works like this: You get an email purporting to be from a major
company or business (think eBay), government agency, social networking site, or
major credit card company. The message warns you that you have to “update”
your login or financial information to keep it current, or that you have to “vali-
date” your information every so often — and the message ever-so-conveniently
even provides you a link to an official-looking web page (although sometimes full
of spelling errors and always with a bogus address). After you enter information
on that bogus page, it’s piped directly to the bad guys, and they’re off to the races.
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Here’s a Mark’s Maxim that every Internet user should take to heart:

No legitimate company or agency will ever solicit your personal information
through an email message!

MARK'S
MAXIM Never respond to these messages. Don’t use the link provided in the phishing email! If

you smell something phishy, open your web browser and visit the company’s site
(the real one) by typing the address directly; then contact the company’s customer
support department to report the scam.
WARNING
In fact, sending any valuable financial information through unencrypted email —
even to those whom you know and trust — is a bad idea. Email messages can be
intercepted or can be read from any email server that stores your message.

Don’t Rely on a Single Password

Okay, confess: Are you using a single password for everything you do on your iMac?
Is your Apple ID password the same as your user account password — and also the
same as your password on every website you visit? Even your online banking?
(Oh, my!)

If so, you're taking a big risk with both your personal data and your online rep-
utation. All it takes is a single moment of weakness (perhaps when your friend or
co-worker asks to use your iMac, or you use that “oh-so-convenient” universal
password on a phishing website). No matter how your password gets out, you and
your iMac are suddenly wide open to malicious attacks.

I recommend the same security measure that I recommend to my clients, family,
and friends: Use a different password for each of the important websites you visit
often, and keep a separate password reserved for your user account. I know it’s a
hassle to remember multiple passwords, but the alternative is no security at all.

Do You Really Want a Submerged
Keyboard?

Your answer should be an unequivocal “No!” — and that’s why everyone should
make it a rule to park all beverages well out of range of keyboards, speakers, mice,
backup drives, and any other piece of external hardware. Especially when kids or
cats are in close proximity to your iMac.
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Cleaning up a hazardous soda spill is hard enough in the clear, but if that liquid
comes in contact with your hardware, you’re likely to be visited with intermittent
keyboard problems (or, in the worst-case scenario, a short in an external periph-
eral or your iMac’s motherboard).

Suffice it to say that 12 inches of open space can make the difference between a
simple cleanup and an expensive replacement!

Don't Use Antiquated Utility Software

If you’re using macOS Mojave, you should upgrade your older utility programs.
These older disk utility applications can actually do more damage than good to a
hard drive under Mojave. Things always change when Apple makes the leap to a
new version of macOS, including subtle changes to disk formats and memory
management within applications. With an out-of-date utility, you could find
yourself with corrupted data. (Note that some out-of-date utilities actually refuse
to run on newer versions of macOS that they don’t recognize, but other antique
utilities attempt to soldier on, sometimes with nasty results.)

Make sure that you diagnose and repair disk and file errors by using only a utility
application that’s specifically designed to run in Mojave, such as Drive Genius
from Prosoft Engineering (www.prosofteng.com). Your iMac’s hard drive will
definitely thank you.

(Oh, and while you’re at it, don’t forget to check the manufacturer’s website for
any updates to drivers or application software for your third-party external hard-
ware! 'Nuff said.)

Don't Endorse Software Piracy

396

This one’s a real no-brainer. Bear in mind that Apple’s overall market
share among worldwide computer users currently weighs in at little more than
12 percent. Software developers know this, and they have to expect (and receive) a
return on their investment or they’re going to find something more lucrative to do
with their time. As a shareware author, I can attest to this fact firsthand.

An iMac is a great machine, and Mojave is a great operating system, but even the
best hardware and the sexiest desktop won’t make up for an absence of good
applications. Pay for what you use, and everyone benefits.
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Call It the Forbidden Account

You might never have encountered the root, or System Administrator, account within
macOS — and that’s always A Good Thing. Note that I’m not talking about a stan-
dard administrator (or admin) account here. Every iMac needs at least one admin
account (in fact, it might be the only visible account on your computer), and any
standard user account can be toggled between standard and admin status with no
trouble at all (by another admin account).

The root account, though, is a different beast altogether, and that’s why it’s dis-
abled by default. All Unix systems have a root account; because Mojave is based on
a Unix foundation, it has one, too. Anyone logging in with the root account can do
anything on your system, including deleting or modifying files in the System
folder (which no other account can access). Believe me: Deliberately formatting
your hard drive is about the only thing worse than screwing up the files in your
System folder.

Luckily, no one can accidentally access the root/System Administrator account. In
fact, you can’t assign the root account with System Preferences; you must use the
Terminal application in Utilities (within your Applications folder). Unless an Apple
support technician tells you to enable and use it, you should promptly forget that
the root account even exists.

Don't Settle for a Surge Suppressor

Technically, nothing is wrong with using a surge suppressor to feed power to your
iMac and all your external peripherals, but it doesn’t do the entire job. Your system
is still wide open to problems caused by momentary brownouts, not to mention
the occasional full-fledged blackout. Losing power in the middle of a computing
session will likely lead to lost documents and might even result in disk or file
errors later. With an uninterruptible power supply (UPS), you can rest more easily,
knowing that your iMac will have a few minutes more of iLife. (Incredibly sad pun
unfortunately intended.)

Most Mac owners know about the backup battery power that a UPS provides, but
they don’t know about the extra work performed by most UPS units — namely,
filtering your AC current. A filtering UPS prevents electronic noise (think about a
vacuum being used next to a TV set) and momentary current spikes. These days,
you’ll find good UPS models for less than $100.
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Refurbished Hardware Is No Deal at All

REMEMBER

Boy, howdy, do I hate refurbished stuff. To quote someone famous, “If the deal
sounds too good to be true, it probably is.”

Examine what you get when you buy a refurbished (often called recertified) hard
drive. It’s likely that the drive was returned as defective, of course, and then sent
back to the factory. There, the manufacturer probably performed the most cursory
of repairs, perhaps tested the unit for a few seconds, and packed it up again.
(I should, however, note that Apple sells refurbished Macs and generally has a
good reputation for value on these computers.)

Before you spend a dime on a bargain that’s remanufactured — I can’t get over that
term — make sure that you find out how long a warranty you’ll receive, if any.

If at all possible, I recommend spending the extra cash on trouble-free, brand-
new hardware that has a full warranty.

iMacs Appreciate iCleanliness

398

Clean your machine, including your keyboard, mouse, and trackpad. Your iMac
case needs only a thorough wiping job with a soft cloth to stay spotless, but don’t
be surprised at the primordial nastiness that can build up on your keyboard and
the underside of your mouse over time!

Your screen should be cleaned at least once every two or three days. Never spray
anything — cleaners, water, anything! — directly on your screen or your iMac’s
case. I highly recommend using premoistened LCD cleaning wipes to clean your
iMac monitor safely.
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Index

A

AAC (Advanced Audio Coding), 214, 216, 226,
228,294

Accent Color (General), 91

account image, 162-163, 172

account name, 160

activation hot corner, 88

active application, 36

Add Faces link (Photos), 247, 248

Add Folder button (Desktop), 87

Add List button (Reminders), 113

Add Marker button (GarageBand), 290

Add Reminder button (Reminders), 113

Add to Favorites button (Photos), 241
add-ons, 367

Admin (administrator) user account level, 159
Adobe Acrobat, 49

Adobe Acrobat DC, 76

Adobe Creative Suite, 373

Adobe lllustrator, 338

Adobe InDesign, 60

Adobe PDF, 326

Adobe Photoshop, 60, 104, 206, 338, 373, 388

Advanced Audio Coding (AAC), 214, 216, 226,
228,294

AIFF, 214, 216, 226

AirDrop, 136, 189, 241, 310

AirPlay, 86, 180, 185, 233

AirPort Base Station, 187, 188

AirPort Express, 185, 186, 233

AirPort Express Base Station, 197, 233

AirPort Extreme, 183, 184, 185, 186, 189, 197
AirPort Extreme Base Station, 14, 182, 184, 185

AirPort Time Capsule, 14, 15, 16, 29, 96, 97, 185,
186, 197

ALAC (Apple Lossless), 214, 216, 226
Alert Styles, 100

Alias icons, 49-50
aliases, 49-50, 58, 59, 62
All Tabs view, 143

Allow Guests to Log In to This Computer check
box, 165

Allow Handoff Between this Mac and Your
iCloud Devices check box, 92

Allow Joining Game Center Multiplayer Games
check box, 170

Allow Use of Camera check box, 170

Allow User to Administer This Computer check
box, 162

aluminum stand, 11
AMD Radeon Pro graphics hardware, 15
Animate Opening Applications check box, 94

App Store, 19, 36, 40, 42,79, 117, 151, 155, 171,
300, 313, 329, 371, 383

Appearance option (General), 91
Apple AirPort Base Station, 187, 188
Apple AirPort Express Base Station, 233

Apple AirPort Extreme, 183, 184, 185, 186,
189, 197

Apple AirPort Extreme Base Station, 14, 182,
184, 185

Apple AirPort Time Capsule, 29, 96, 185, 186,
197,364, 377

Apple Authorized Service Provider, 355, 388

Apple Base Station, 14, 184, 185, 186,
187-188

Apple Help online, 356
Apple ID
iCloud ID as often called, 26

Look Me Up by Email tab to specify which
applications allow owners of other Macs or
iOS devices to access yours, 153

needed to access iTunes Radio, 230
needed to access iTunes Store, 237
needed to join iCloud revolution, 151
needed to use FaceTime first time, 209
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Apple iMac Support site, 356
Apple Lossless (ALAC), 214, 216, 226

Apple Mail, 21, 26, 34, 60, 118, 132, 135, 165,

170, 241
Apple menu, 36, 40
Apple Music subscription service, 230
Apple online product support, 71
Apple Store, 28, 355
Apple Support, 25, 351, 355
Apple TV, 86, 180, 214, 218, 263, 276
AppleCare, 25

Apple's Time Capsule, 14, 15, 16, 29, 96, 97,

185, 186, 197, 364, 377

applets, 61, 117
application icons, 41, 48, 94
Application menu, 36, 56, 59
Application Windows corner, 90
applications (apps)

adding of to Dock, 64

Automator app, 380-382

Calendar app, 20, 113

Contacts app, 21

Creative Cloud applications, 373

defined, 33

Dictionary widget/application, 10, 39, 168

digital lifestyle applications, 19, 294

Home app, 78

iMovie, 259-278

Keynote app, 19, 330-340

launching/quitting, 40-43

Mail app, 20, 26, 34

Maps app, 111, 118-123

new iOS ones, 78

News app, 78, 111, 123-125

Notes app, 111, 115-116

Numbers app, 19, 314-328

Pages app, 19, 300-311

Pages as desktop publishing application, 299

Photos app, 239-257
productivity applications, 19
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Reminders app, 111, 112-114
Stocks app, 78
Voice Memos app, 78

Arrangement track (GarageBand),
290-291

Ask to Keep Changes When Closing Documents
check box, 92

Ask Websites Not to Track <e check box, 146
At a Location check box, 113
audio

importing and adding audio (iMovie),
267-268

options for, 11-13

tweaking of, 227
audio CDs, 214, 215-216, 233, 296
audio files

embedding, 116

playing, 216-221

ripping, 226-227

tweaking settings for, 295
audio hardware, as add-on, 367
Audio Mute key, 55
audiobooks, 215, 217, 222, 223
AutofFill, 134
automatic login, 171-172, 174
Automatically Adjust Brightness check box, 86

Automatically Allow Built-in Software to Receive
Incoming Connections check box, 198

Automatically Allow Downloaded Signed
Software to Receive Incoming Connections
check box, 198

Automatically Hide and Show the Dock check
box, 94

Automatically Keep My Mac Up To Date check
box, 383

Automatically Rearrange Spaces Based on Most
Recent Use check box, 89

Automator app, 380-382

Auto-Play, 136

Auto-Save, 302, 316, 331

Avast Security for Mac (Avast Software), 353



B
back end, 12
Back Up Automatically check box, 97
background
choosing favorite one, 63, 64
keeping desktop background simple, 389
backgrounds (iMovie), 275
backing up, 97, 366, 375-377
Badge App Icon check box, 100

base station, 184, 185, 186, 187-188, 233. See
also Apple AirPort Express Base Station;
Apple AirPort Extreme Base Station

beverages, cautions with around equipment,
395-396

Block CD and DVD Burning in the Finder check
box, 168

Bluetooth
bonus chapters on, 4, 201
as built into every Intel iMac, 14
checking connection, 25
connecting printer, 201
as requirement for AirDrop, 189
as requirement for Handoff, 152-153
sharing data among wireless devices via, 4
wireless Bluetooth speakers, 12, 13
bonus chapters, 4, 25, 30, 201
bookmarks
adding and using, 138-139
organizing/reading, 131
shared bookmarks, 20, 98
where they appear, 132
Boot Camp, 4, 30
Brightness slider, 86
Browse mode (iTunes), 220
browsing mode, 219
Burn feature, 376
burning music, 233-235
button, use of term, 39
buttons
Close button, 43, 47
Directions button, 122

Effects button (Photo Booth), 208
Log Out button, 175

Minimize button, 45

Photo Browser button, 116
power button, 12

Share button, 136

Show All button, 83

Table button, 116

Today button, 117

C

cables
Ethernet cable, 18, 22, 186, 190, 191
power cable, 12
Thunderbolt cable, 28, 29, 365

USB (Universal Serial Bus) cable, 202, 231,
243, 293, 365

Calendar app, 20, 113
Calendars check box, 98
CCleaner for Mac, 374
CD audio, 214, 215-216. See also audio CDs
CDs
backing up to, 376-377
creating, 233-235
CDs & DVDs pane, 376
CDW, 359
channels, 124-125
chart (Numbers), 325-326
Cheat Sheet, 4
check boxes

Allow Guests to Log In to This Computer
check box, 165

Allow Handoff Between this Mac and Your
iCloud Devices check box, 92

Allow Joining Game Center Multiplayer Games
check box, 170

Allow Use of Camera check box, 170

Allow User to Administer This Computer
check box, 162

Animate Opening Applications
check box, 94
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check boxes (continued)

Ask to Keep Changes When Closing
Documents check box, 92

Ask Websites Not to Track <e check box, 146
Automatically Adjust Brightness check box, 86

Automatically Allow Built-in Software to
Receive Incoming Connections check
box, 198

Automatically Allow Downloaded Signed
Software to Receive Incoming Connections
check box, 198

Automatically Hide and Show the Dock check
box, 94

Automatically Keep My Mac Up To Date check
box, 383

Automatically Rearrange Spaces Based on
Most Recent Use check box, 89

Back Up Automatically check box, 97
Badge App Icon check box, 100

Block CD and DVD Burning in the Finder check
box, 168

Calendars check box, 98
On check box, 96, 108, 196, 197, 204

Close Windows When Quitting an App check
box, 92

Contacts check box, 98
On a Day check box, 113,114
Disable check boxes, 236

Disable Editing of Printers and Scanners check
box, 168

Displays Have Separate Spaces check box, 90

Double-Click a Window's Title Bar to Minimize/
Zoom check box, 94

Download Album Artwork check box, 226
Enable Parental Controls check box, 167
Enable Stealth Mode check box, 198

Find My Mac check box, 98

Group Windows by Application check box, 90
iCloud Drive check box, 98

iCloud Photos check box, 256

Install App Updates From the App Store check
box, 383
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Internet Radio check box, 228
Keychain check box, 98, 147

Limit Applications on this Mac check box,
170-171

Limit Mail to Allowed Contacts
check box, 170

Live Updating check box, 223
At a Location check box, 113
Look Up check box, 39
Magnification check box, 93
Mail check box, 98

Minimize Windows into Application Icon check
box, 94

Mute Project check box (iMovie), 269

My Local Network check box, 232

My Photo Stream check box, 154

My Photo Stream check box (Photos), 257
Notes check box, 98, 116

Open “Safe"” Files after Downloading check
box, 141

Optimize Mac Storage check box, 154
Other Apps check box, 171

Photos check box, 98

Play Sound for Notifications check box, 100
Presenter Notes check box (Keynote), 336

Prevent the Dock from Being Modified check
box, 169

Print Backgrounds check box, 145
Random Order check box, 88

Random Screen Saver check box, 88
Reader When Available check box, 140
Recent Applications check box, 41
Reminders check box, 98, 114

Require Password After Sleep or Screen Saver
Begins check box, 89

Require Password check box, 232

Restrict Explicit Language in Dictionary check
box, 168

Safari check box, 98
Secondary Click check box, 39
Shared Albums check box (Photos), 257



Show Content Ratings in Library check box, 236

Show Fast User Switching Menu As check
box, 174

Show in Notification Center check box, 100

Show Indicators for Open Applications check
box, 95

Show Mirroring Options in the Menu Bar
When Available check box, 86

Show Notification Preview check box, 100

Show Notifications on Lock Screen check
box, 100

Show Recent Applications check box, 65

Show Recent Applications in Dock check
box, 95

Show Time Machine in Menu Bar check
box, 97

Show Wi-Fi Status in Menu Bar check box, 187
Show with Clock check box, 88

Shut Down/Sleep check box, 93

Siri check box, 98

Start Up or Wake check box, 93

Tap to Click check box, 39

Three Finger Drag check box, 39

Turn Off Siri & Dictation check box, 168

Turn On Until Tomorrow check box, 86

Use LCD Font Smoothing When Available
check box, 92

Use Simple Finder check box, 169
Use Sound Check check box, 235
When Switching to an Application check box, 90
Wi-Fi check box, 195
children. See parental controls
cleaning, recommendations for, 398
cleanup tool, using commercial one, 374
Click in the Scroll Bars (General), 92

Clipboard, 56, 304, 305. See also Universal
Clipboard

clips (iMovie), 270-273
Close button, 43, 47

Close Windows When Quitting an App check
box, 92

closed networks, 188

collection, displaying photos by, 240
Color Temperature slider, 86
ColorSync, 86

column mode, 389

column view, 43-44, 389

column view (Pages), 301
Command key, 55

compilation tape, 233

composing (GarageBand), 282-283
Computer Sleep slider, 93
connecting, 18

Contacts app, 21

Contacts check box, 98

Content pane (News), 124, 125
Content pane (Safari), 134

Content Scale slider (Numbers), 327
Contour Design, 367

controllers, 293. See also game controllers; MIDI
controllers; video controllers

controls, parental, 159, 160, 165, 167, 169,
235-237

cookies, 145-146
copying
items (Mojave), 52
text and images (Pages), 304-305
corners
activation hot corner, 88
Application Windows corner, 90
Dashboard corner, 90
Desktop corner, 90
disabling hot corner, 88
Hot Corners, 88, 90
Launchpad corner, 90
Mission Control corner, 90
Notification Center corner, 90
Creative Cloud applications, 373
Crucial, 359
Ctrl key, 55
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D

Dark Mode, 36, 76, 91
Dashboard, 61-62
Dashboard corner, 90
Dashboard widgets, 20, 90, 117
data deposits, cleaning, 369-370
dead pixels, 24
Default Web Browser (General), 92
defragmentation, 388-389
Delete key, 55
deleting

History menu, 147

rows and columns, 323

unnecessary user accounts, 165
Desktop

described, 33-37

for launching applications/opening
documents, 41

personalizing, 62-64
Desktop & Screen Saver pane, 63, 90, 389
Desktop corner, 90
Desktop pane, 87-88
desktop publishing application, Pages as, 299

DHCP (Dynamic Host Configuration Protocol)
server, 183, 191, 192, 193, 195

Dictation, 168, 388

Dictionary widget/application, 10, 39, 168
digital audio files, 216-217

digital extraction, 226

digital lifestyle applications, 19, 294
digital subscriber line (DSL), 180
Directions button, 122

Disable check boxes, 236

Disable Editing of Printers and Scanners check
box, 168

disabling hot corner, 88
disk fragmentation, 388-389
disk permission, 349, 379

Disk Utility functions, 347, 348, 349-350, 352,
380, 389
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Display Sleep slider, 93
Displays Have Separate Spaces check box, 90
Displays pane, 85-87
Do Not Disturb mode, 100
Dock
customization of, 64-65, 390
described, 34
resizing, 67
Dock pane, 41, 65, 93-95
Document icons, 48-49
Document Setup mode (Pages), 303
Domain Name System (DNS) address, 192

Double-Click a Window's Title Bar to Minimize/
Zoom check box, 94

double-clicking, 41

Download Album Artwork check box, 226
Downloads button (Safari), 135

dragging, 44

drive array (RAID array), 367

Drive Genius (Prosoft Engineering), 389
drives

external drive, 29, 96, 364, 365-366,
375-376

external hard drive, 96, 247, 364, 365
flash drives, 22, 32

Fusion Drive, 14, 389

Google Drive, 376

hard drive, 14, 91-92, 93, 96, 349, 364,
366, 389

iCloud Drive, 97, 98, 150, 151, 153-154, 180,
301, 302, 311, 376

internal drive, 14, 363-366, 379-380
OneDrive, 150, 151, 376
optical drive, 11, 21, 22, 203, 215, 233, 376
serial ATA (SATA) hard drive/flash storage, 14
solid-state drive (SSD), 14
thumb drive, 32

Drop Box folder, 175

Dropbox, 150, 376

DSL (digital subscriber line), 180



duplicating items, 53
DVD, backing up to, 376-377
DVD player, 21

Dynamic Host Configuration Protocol (DHCP)
server, 183, 191, 192, 193, 195

E
editing
clips (iMovie), 272-273
data (Numbers), 319-320
photos, 251-256
slide text (Keynote), 334
text (Pages), 303
Effects button (Photo Booth), 208
Ejecticon, 68
email
cautions in clicking links in, 132

macOS Mail application, 20, 26, 34. See also
Apple Mail

Enable Parental Controls check box, 167
Enable Stealth Mode check box, 198
encryption

of Home folder, 176-177

WEP encryption, 188

WPA2 encryption, 188
Energy Saver pane, 88, 92-93
equalizer, 227, 291, 292
equalizer sliders, 227
Ethernet cable, 18, 22, 186, 190, 191
Ethernet connection, 13

Ethernet network, 14, 16, 28, 186, 189, 191,
195, 204, 367

Ethernet port, 13, 16, 18, 190, 191
Ethernet switch, 190
Event pane (iMovie), 263, 270, 272, 277

Event/Project Library pane (iMovie), 262, 270,
271,276, 277,278

expansion potential, 16
external audio, 13

external device, 357
external drive
for additional drive space, 364
backing up to, 96, 375-376
connecting, 365-366
Time Machine external drive, 29
external drive arrays, 367
external hard drive, 96, 247, 364, 365

F

Facebook
sending your movie to, 278

sharing copy of finished presentation
on, 340

sharing maps and directions using, 123
sharing photo or video on, 208, 241, 242
FaceTime

allowing calls from anyone while Do Not
Disturb is active, 100

answering of directly from notification, 118
conversing with, 209-210
HD camera, 14, 206, 264, 265
for video conferencing, 20
Family Sharing, 97, 155
Fast User Switching, 172,173, 174
favicons, 144
Favorites, 124-125
Favorites bar (Safari), 130
file icons, 49, 62
file permission, 379
files
audio files, 116, 216-221, 226-227, 295
cleaning unnecessary ones, 371-372
clearing out orphan ones, 373-374
downloading, 140-141
saving, 375
text log files, 169
FileVault, 176-177
Find My Mac, 98, 154
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Finder
as basic toolbox, 32
as friend, 36
for keyboard shortcuts, 56-57
for launching applications, 41
performing tricks with, 43-47
Finder Search window, 106, 107, 108
Finder Tabs, 44, 54, 391
Finder windows
for juggling folders and icons, 48-54
for launching applications, 37
performing tricks with, 43-48
reconfiguration of, 390-391
firewall, 96, 197-199
First Aid, 349, 350, 352, 380
flash drives, 22, 32
Flickr, sharing photo or video on, 208, 241, 242
flubs, 294
folders
cleaning unneeded ones, 371-372
Drop Box folder, 175
duplicating, 54
Home folder, 57-59, 162, 175, 176
Public folder, 175
Shared folder, 175
subfolders, 57, 58
foot (a.k.a. aluminum stand), 11
footprint, 11
For Dummies website, 71
Force Quit, 43, 345
Format menu, 116, 305, 336
Format mode (Pages), 303
formatting
with shading (Numbers), 322-323
slide text (Keynote), 335-336
text (Pages), 305
formulas (Numbers), 323-325
Full Screen Visuals mode, 235

full-screen mode, 46, 88, 94, 133, 207, 221,
241, 255

Fusion Drive, 14, 389

406

iMac For Dummies

G
Gallery view, 42, 44, 77,104
game controllers, 367
games, 21
GarageBand
adding score to iMovie, 288
adding songs from, 267, 268
adding tracks, 283-285
burning audio CD, 296
choosing loops, 284-285
composing, 282-283
controls, 280
exporting project, 295-296
How Did | Play feature, 294
sharing your songs, 293-296
tweaking settings for track, 291-292
using Arrangement track, 290-291
using MIDI instruments with, 293
what's included in, 280-282
Gatekeeper feature, 171
General pane, 76, 91-92, 141
Genius feature, 222, 230
gestures, Multi-Touch, 38
Go menu, 391-392
Go to Beginning button (GarageBand), 281
Google, as search engine for Safari, 132-133
Google Drive, 376
GPS tracking, 251
graphics boxes (Keynote), 334
graphics boxes (Pages), 304
grayscale (Photos), 255
Grid view mode, 66

grounding yourself (when working on insides of
any computer), 363

Group Windows by Application check box, 90
Guest account, 165

H

Hamrick Software, 205
Handoff, 152-153



handouts (Keynote), 336, 339-340

hard drive, 14, 91-92, 93, 96, 349, 364, 366, 389

Hardware icons, 48

headphone port, 12
Headphone/Audio Line Out jack, 13
heat, avoidance of, 394

Help, 70-71. See also Apple Help online;
macOS Help

High Sierra Mojave, 75

highlight, 50

Highlight Color (General), 91
History list, 141-142

History menu, deleting, 147
Home app, 78

Home button (Safari), 132, 137
Home folder, 57-59, 162, 175, 176
Home Sharing, 218

Hot Corners, 88, 90

housekeeping, cleaning data deposits,
369-370

How Did | Play feature (GarageBand), 294

iBooks Store, 151, 155, 168

iCloud
accessing documents from, 151
automatic synchronization with, 149
configuring, 153-155
Handoff, 152-153
how it works, 150-151
managing storage, 155-156

moving, saving, and opening documents,
151-152

setup as allowing you to sign up for iCloud
ID, 26

iCloud Drive, 97, 98, 150, 151, 153-154, 180,
301, 302, 311, 376

iCloud Keychain, 147

iCloud pane, 97, 147, 153, 154, 155, 156, 256

iCloud Photo Library, 256-257
iCloud Photos, 154

iCloud Photos check box, 256
iCloud preferences, 97-99, 153
iCloud System Preferences pane, 153, 155
Icon view, 43, 107
Icon view mode (Pages), 301
icons
Alias icons, 49-50
application icons, 41, 48, 94
bonus icons, 84
on Desktop, 34-35
Document icons, 48-49
Ejecticon, 68
explained, 3
favicons, 144
file icons, 49, 62
guide to, 48
Hardware icons, 48
padlock icon, 134, 145, 236, 237
Show Reader View icon, 140
website icons, 75, 144
wiggling, 42
iMac
charismatic form of, 9
connecting, 18
described, 8
fan system, 25
location for, 15-16
major parts, 9-15
manual, 18
multiuser. See multiuser iMac
preinstalled software, 19-21
registration, 27
setup, 26-27
speeding up, 387-392
unpacking, 17
using as Windows system, 30
ways to speed up, 387-392
iMac Pro, described, 8
Image Capture, 206

image metadata, 77, 251

Index
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images. See also Photos app
importing, 243-244

making use of still images (iMovie),
266-267

organizing/sorting, 244-251
iMovie

adding clips, 270-271

adding GarageBand score to, 288

adding maps and backgrounds, 275

adding sound effects, 268

building cinematic basics, 269-276

controls and displays, 262-263

creating new movie project, 260-261

editing clips, 272-273

importing building blocks, 264-269

importing/adding audio, 267-268

making use of still images, 266-267

marking clips, 271

moviemaking process, 263-264

pulling in video clips, 264-266

removing clips, 271-272

reordering clips, 272

sharing with others, 278

Theater mode, 276

titles, 274-275

trailers, 260, 276-278

transitions, 273-274

video formats supported by, 266

voiceover narration, 268-269
Import mode (Photos), 243-244
Important Hidden Stuff (IHS), 14
importing documents/data

from previous Mac, 27-29

from Windows, 29-30
innovation, advantage of in Apple universe, 149
Inspector (Keynote), 335-336
Inspector (Numbers), 317,318
Inspector (Pages), 305

Install App Updates From the App Store check
box, 383

Intel Iris Plus, 15

408

iMac For Dummies

internal drive
maintaining health of, 379-380
options for upgrading of, 363-366
as part of Important Hidden Stuff (IHS), 14

Internet connection, 18, 20, 180, 183, 196. See
also wired network; wireless networking

Internet protocol (IP) address, 183
Internet Radio check box, 228

Internet router, 183, 190, 191, 193, 195
Internet-sharing devices, 190

iPad, 20, 26, 38, 39, 42,76, 113, 115, 118, 136,
150, 153, 154, 155, 180, 182, 185, 209, 218,
231, 237, 242, 244, 251, 256, 339

iPhone, 20, 26, 38, 42,76, 113, 115, 118, 134,
136, 150, 152, 153, 154, 155, 180, 182, 185,
209, 218, 231, 237, 242, 244, 251, 256,
293, 339

iPod, 66, 218, 223, 231-232

iPod touch, 38, 115, 153, 185, 223, 231, 233,
237,242,339

items
copying, 52
duplicating, 53
Login items, 41, 163, 165-167, 346, 353-354
moving, 53
selecting, 50-51

iTunes
adding songs from (iMovie), 267-268
Browse mode, 220
burning music, 233-235
buying digital media the Apple way, 237
creating iTunes Radio station, 230
creating song files in, 294-295
exercising parental authority, 235-237
feasting on iTunes visuals, 235
with iCloud, 230-231
Internet radio, 228-229
knowing your songs, 224-226
organizing with playlists, 222-223
playing audio CD, 215-216
playing digital audio files, 216-222
radio stations in your playlists, 229-230



ripping audio files, 226-227

sending your movie to, 278

sharing media across your network, 232-233
sharing with iPod, iPad, iPhone, 231-232
tuning in your own stations, 229

tweaking audio, 227

watching video, 222

what you can play on, 214-215

iTunes Library, 231, 236, 237, 255, 267, 268,
278, 371. See also Music Library

iTunes Match subscription service, 230, 231
iTunes Radio, 228, 230
iTunes Sidebar, 217, 221, 223

iTunes Store, 151, 155, 168, 214, 215, 226, 230,
231, 234, 235, 236, 237, 371

iTunes U, 215

iTunes window, 217-218, 220, 221, 227,
230, 295

J

jump cut, 273

K

keyboard
described, 10-11
special keys on, 55
Keyboard pane, 57
keyboard shortcuts
examples of, 390
in Finder, 56-57
iniTunes, 216
Keynote slideshow, 338-339
in Mission Control preferences, 90
in Numbers, 318-319
Keychain check box, 98, 147
keychains, 147
Keynote app
adding background shape, 337-338
adding slides, 333-334
adding/editing slide text, 334

creating new Keynote project, 330-331
creating slideshow, 338-339
formatting slide text, 335-336

media for presentation, 336-337
opening Keynote presentation, 331
printing slides and notes, 339-340

as productivity application, 19

putting Keynote to work, 332-333
saving your presentation, 331-332
using Presenter’'s Notes, 336

working with text, shapes, and graphics
boxes, 334

keys
Audio Mute key, 55
Command key, 55
Ctrl key, 55
Delete key, 55
Media Eject key, 11, 347
Option key, 55
Page Up/Page Down keys, 44
special keys, 55, 346
start-up keys, 347
Volume Up/Volume Down keys, 55
Keystation 88es, 367

keywords, organizing with in Photos,
248-249

kiosk mode, 169

L

LAN party, 180

Landscape mode, 210
Language & Region pane, 85
Laplink, PCmover Express, 30
Launchpad, 41, 42
Launchpad corner, 90

Layout pane (Keynote), 332, 333, 334, 336
Layout pane (Pages), 303, 304
Learn to Play, 294

LED screens, 10

Leisure mode, 206
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libraries

Music Library, 217, 218, 219, 220-221, 222,
224-226

Photos Library, 98, 116, 241, 247, 256,
257, 262

Library mode (iMovie), 276
Library pane (GarageBand), 284
Light Mode, 91

lighting, 16

Limit Applications on this Mac check box,
170-171

Limit Mail to Allowed Contacts check box, 170
links, 131

list login, 172,174

List view, 43, 66

List view mode, 66

Live Updating check box, 223
locating lost or stolen iMac, 154
Location Services, 146

Lock button, 116

locked application, 345

Log Out button, 175

Login items, 41, 163, 165-167, 346,
353-354

Login Items list, for launching applications, 41
login options, 172-175
Login Options pane, 175
login settings, 174, 175
Look Up check box, 39
loops (GarageBand)
choosing, 284-290
defined, 281
looking for just the right one, 286-287
resizing, repeating, and moving, 288-290
second verse, same as the first, 287
lost iMac, locating, 154

M

MacMall, 359
macOS, updating automatically, 382-383
macOS Help, 30, 355
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macOS Mojave. See Mojave
macOS Resume, 92

Macworld, 71

Magic keyboard, 10, 41

Magic Mouse 2, 10, 11, 38

Magic Trackpad 2, 10, 11, 38
Magnification check box/slider, 93
Mail app, 20, 26, 34. See also Apple Mail
Mail check box, 98

Manage Storage, 370, 371, 372
managed account, 159, 160, 167

Managed with parental controls level, 159, 160,
165-172

Map view, 121

maps (iMovie), 275

Maps app, 1111, 118-123
Mark’'s maxims

always click the Log Out button in the logout
configuration dialog before you leave your
iMac (or use the Option key to bypass the
confirmation dialog), and double-check
to make sure that the logout completes
successfully, 174-175

always delete unnecessary user accounts;
otherwise, you're leaving holes in your
Mac’s security, 165

always try a reboot before beginning to
worry, 345

assign other folks standard-level accounts
and then decide whether each new
account needs to be modified to restrict
access as a managed account; never assign
an account admin-level access unless you
deem it truly necessary, 159

assign others their own user accounts, and let
Mojave keep track of everything; then you
can share your iMac with others and still
live happily ever after, 158

back up; on a regular basis, 375

don't beat yourself up; your iMac can be
fixed, 344

get an external drive, connect it, and turn on
Time Machine, 379

if you don't register your iMac, you can't
receive support from Apple, 27



if you need the power of an iMac Pro, you're
likely to know that already, 8

if your printer or scanner includes bundled
applications, try them, 206

keep uninvited guests out of your network;
use your base station’s security features,
and encrypt your data by using WPA2
encryption, 188

more memory helps, 358

no legitimate company or agency will ever
solicit your personal information through
an email message, 395

only one application window can be active in
Mojave at any time, 48

poking too many holes in your file is not A
Good Thing, 96

save your work often in GarageBand, 292

smart computer owners keep their boxes for
the life of their machine, 17

turn on your firewall now, 197

your Home folder is where you hang out and
where you store your stuff; use it to make
your computing life much easier, 58

M-Audio, 367
Media Browser (GarageBand), 281
Media Browser (Keynote), 336-337
Media Browser (Pages), 307-308
Media Eject key, 11, 347
memory
addition of for speeding up iMac, 388
figuring how much you have, 358-359
in iMac, 388
in iMac Pro, 388
installing memory modules, 360-363
online sources for, 359
menu bar, 35-36
menus
Apple menu, 36, 40
Application menu, 36, 56, 59
Go menu, 391-392
History menu, 147
menu bar, 35-36

Recent Items menu, 391
right-click menu, 36, 38
shortcut menu, 36, 38, 39
Messages, 20
metadata, 44, 104. See also image metadata
MFRs (My Favorite Recommendations), 3
microphone
connecting for use with GarageBand, 293
inclusion of internal microphones, 11, 269
recording directly from, 268

Microsoft, creation of WAV audio file format
by, 214

Microsoft Excel, 104, 314
Microsoft Office suite, 373
Microsoft OneDrive, 150, 151, 376
Microsoft Outlook, 114
Microsoft PowerPoint, 46
Microsoft Windows, switching from, 29-30
Microsoft Word

appearance of in Dark Mode, 76

launching, 36

Mac version of, 301

multiple windows in, 46

Pages as not supporting every feature
within, 301

MIDI (Musical Instrument Digital Interface), 293
MIDI controllers, 367

Migration Assistant, 27-29

Minimize button, 45

Minimize Windows into Application Icon check
box, 94

minimized window, 45
Mission Control, 59-60, 89-90
Mission Control corner, 90
Mission Control pane, 59, 61
mix tape, 233
MLC Radio, 229
modes
Browse mode (iTunes), 220
browsing mode, 219
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modes (continued)
column mode, 389
Column view mode (Pages), 301
Dark Mode, 36, 76, 91
Do Not Disturb mode, 100
Document Setup mode (Pages), 303
Edit mode (Photos), 251-256
Format mode (Pages), 303
Full Screen Visuals mode, 235

full-screen mode, 46, 88, 94, 133, 207, 221,
241, 255

Grid view mode, 66

Icon view mode (Pages), 301
import mode, 243

Import mode (Photos), 243-244
kiosk mode, 169

Landscape mode, 210

Leisure mode, 206

Library mode (iMovie), 276
Light Mode, 91

List view mode, 66

Organize mode (Photos), 244-251
outline mode (Keynote), 332
overlay mode, 61

Photos mode, 240

Play mode (iMovie), 264
portrait mode, 70

Safe mode, 346-347, 353
Satellite mode, 120, 121

Single User mode, 347

sleep mode, 88, 93, 100, 354
Songs view mode, 219
Standard (or Map) mode, 120
Stealth mode, 198

Target Disk mode, 347

Theater mode (iMovie), 276
Transit mode, 121

VTR (or VCR) mode (iMovie), 264
windowed mode, 241

412  iMac For Dummies

Mojave
copying items, 52
Dark Mode, 36, 76, 91
Dashboard as turned off in by default, 61
Dock, 64-65, 67
duplicating items, 53-54
Help, 70-71
logging in and out with, 172-175
moving items, 53
selecting items, 50-51
setting up, 26-27
Setup Assistant, 24
Stacks, 65-67
Trash, 68
user account, 57
using Finder Tabs, 54-55
windows management in, 43-48

as your own personal operating system,
32-37

moment, displaying photos by, 240

mounting iMac Pro, 11, 16

mouse, 10, 37

Mouse pane, 38

movie trailers, 260, 276-278

movies. See also iMovie

movies, playing of, 214

moving things, 53

MP2, 214, 216

MP3, 214, 216, 226, 234

Multi-Touch gestures, 38

multiuser iMac
adding users, 160-162
managing account’s access settings, 167-172
modifying user accounts, 162-163
mundane chores for, 172-175
overview, 157-160

setting up login items and parental controls,
165-172

Shared folder, 175



mundane chores, automating of, 380
music. See audio files; GarageBand; iTunes
Music Library

browsing, 219

described, 217, 218

finding songs in, 220-221

knowing your songs, 224-226

setting song information automatically, 225

setting/changing song information manually,
225-226

using playlists in, 222
Mute Project check box (iMovie), 269
muting, 11, 55, 144, 216, 269, 290
My Local Network check box, 232
My Photo Stream, 154, 244, 257

N

narration (iMovie), 268-269
Network pane, 84, 194
networks
advantages of, 180-181
connecting to, 193
deciding wired or wireless, 181-182
network file sharing, 196-197
network Internet connections, 195-196
sharing Internet connection, 183
sharing network printer, 197
what is needed to connect, 184
New Note button, 116
New Tab (Finder), 54
New Tab (Safari), 142, 143
New Track button (GarageBand), 281
Newegg, 359
News app, 78, 111, 123-125
Night Shift, 86
Note Page, 116
Notes app, 111, 115-116
Notes check box, 98, 116
Notification Center, 111, 117-118

Notification Center corner, 90
notifications, setting of in Safari, 148
Notifications pane, 118
Notifications preferences, 99
Notifications view, 117, 118
Numbers app
adding chart, 325-326
aligning cell text, 321-322
background information, 314
creating new Numbers document, 314-315
entering/editing data, 319-320
exploring Numbers window, 317-318
formatting with shading, 322-323
formulas, 323-325
inserting/deleting rows and columns, 323
navigating/selecting cells, 318-319
opening existing spreadsheet file, 315-316
printing spreadsheet, 326-328
as productivity application, 19
saving spreadsheets, 316-317
selecting correct number format, 320-321

o)

On a Day check box, 113,114
On check box, 96, 108, 196, 197, 204
OneDrive, 150, 151, 376

Open “Safe"” Files after Downloading check
box, 141

opening
Desktop for opening documents, 41
documents on iCloud, 151-152
existing Pages document, 301
existing spreadsheet file, 315-316
Keynote presentation, 331
operating system (0S), 32
optical discs, 22
optical drive, 11, 21, 22, 203, 215, 233, 376
Optimize Mac Storage check box, 154
Option key, 55
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Organize mode (Photos), 244-251
Other Apps check box, 171
outline mode (Keynote), 332
outline view (Keynote), 340
overlay mode, 61

P

packing materials, 17
padlock icon, 134, 145, 236, 237
Page Up/Page Down keys, 44
Pages app
adding photos, 307-308
adding shape as background, 308-309
adding tables, 306
copying text and images, 304-305
creating new Pages document, 300
cutting, 304
entering/editing text, 303
formatting text, 305
opening existing Pages document, 301
pasting, 305
printing documents, 310
as productivity application, 19
saving your work in, 302
sharing posters, 310-311
spelling check, 309
touring Pages window, 302-303
using text, shapes, and graphics boxes, 304
pairing, 25
panes
CDs & DVDs pane, 376
Content pane (News), 124, 125
Content pane (Safari), 134
Desktop & Screen Saver pane, 63, 90, 389
Desktop pane, 87-88
Displays pane, 85-87
Dock pane, 41, 65, 93-95
Energy Saver pane, 88, 92-93
Event pane (iMovie), 263, 270, 272, 277
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Event/Project Library pane (iMovie), 262, 270,
271, 276,277,278

General pane, 76, 91-92, 141

iCloud pane, 97, 147, 153, 154, 155, 156, 256
iCloud System Preferences pane, 153, 155
Keyboard pane, 57

Language & Region pane, 85

Layout pane (Keynote), 332, 333, 334, 336
Layout pane (Pages), 303, 304

Library pane (GarageBand), 284

Login Options pane, 175

Mission Control pane, 59, 61

Mouse pane, 38

Network pane, 84, 194

Notifications pane, 118

Presenter Notes pane (Keynote), 332, 333, 336
Preview pane, 77, 78

Print & Scan pane, 168

Printers & Scanners pane, 204, 206

Privacy pane, 146

Project pane (iMovie), 262, 263, 266, 267, 268,
269, 270, 271, 272, 273, 275, 277

Restrictions pane, 235

Security & Privacy pane, 89, 168
Sharing pane, 95-96, 108, 175, 197
Sidebar pane, 131

Smart Controls pane (GarageBand), 291, 292
Software Update pane, 79, 382, 383
Sound pane, 82, 83

Spotlight pane, 108

Summary pane, 232

System Preferences pane, 83

Tab pane, 144

Thumbnails pane, 241, 251

Time Machine pane, 96-97, 377
Trackpad pane, 38

Trailer pane (iMovie), 277, 278

Users & Groups pane, 160, 162, 164, 165, 166,
171,382

Viewer pane (iMovie), 273



parental controls, 159, 160, 165, 167, 169,
235-237

Password Assistant, 161
passwords
cautions in relying on single password, 395
iCloud Keychain, 98, 147
for locked notes, 116
multiuser iMac, 160-161

required before allowing anyone to turn off
screen saver, 89

PCmover Express, 30
PDF (Portable Document Format) file, 339
People recognition system, 247
peripherals, 357
permission errors, 379-380
personal information (Setup), 26
phishing, 394-395
Photo Booth, 206-209
Photo Browser button, 116
photos, adding of in Pages, 307-308
Photos app
adding pizzazz, 254
creating your own keywords, 250
cropping, 252-254
digging through your library with
keywords, 250
Edit mode, 251-256
iCloud Photo Library, 256-257
Import mode, 243-244
major controls in, 239-242
My Photo Stream, 154, 244, 257
Organize mode, 244-251
organizing with keywords, 248-249
removing red-eye, 254
retouching, 254
rotating tipped-over shots, 252

searching by locations where photos were
taken, 251

Shared Albums, 257
slideshow, 255
Smart Album, 245-247

using filters/adjustments, 255-256
working with images in, 242-256
working with people, 247-248
Photos check box, 98
Photos Library, 98, 116, 241, 247, 256, 257, 262
Photos mode, 240
Photoshop Elements, 206
Pin Note, 116
pinging, 193-195
pinned tabs, 132, 144
piracy, software, 396
Piriform, 374
pitfalls
antiquated utility software, 396

beverages: keep out of range of equipment,
395-396

heat: keep things cool, 394

losing power: use uninterruptible power
supply (UPS), 397

maintenance: keep equipment clean, 398
passwords: don't rely on single password, 395
phishing: avoid these scams, 394-395
refurbished hardware, 398
root account: forget it event exists, 397
software piracy, 396

placement, importance of, 15-16, 394

Play button (GarageBand), 281

Play mode (iMovie), 264

Play Sound for Notifications check box, 100

Playhead (GarageBand), 281

playlists, 222-223

podcasts, 151, 214-215, 223, 231, 232, 234

point-and-click, 37

pointer, 37, 38, 39

portrait mode, 70

ports, 12, 13, 365

Position on Screen button (Dock), 93

posters (Pages), 310-311

power button, 12

power cable, 12

power switch, 23-24
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Preamp slider, 227
preferences
iCloud preferences, 97-99, 153
Mission Control preferences, 90
Notifications preferences, 99
Systems Preferences, 85-100
preliminary check of equipment, 24-25
presentations (Keynote)
adding background shape, 337-338
adding slides, 333-334
adding/editing slide text, 334
creating new Keynote project, 330-331
creating slideshow, 338-339
formatting slide text, 335-336
media for, 336-337
opening Keynote presentation, 331
printing slides and notes, 339-340
putting Keynote to work, 332-333
saving your presentation, 331-332
using Presenter’s Notes, 336
Presenter Notes check box (Keynote), 336
Presenter Notes pane (Keynote), 332, 333, 336

Prevent the Dock from Being Modified check
box, 169

Preview pane, 77, 78
Print & Scan pane, 168
Print Backgrounds check box, 145
Print button, 70, 310, 328, 340
Print sheet, 69, 70, 123, 145, 310, 339
Printers & Scanners pane, 204, 206
printing
all you need to know about, 69-70
connecting printers, 201-205
Keynote slides and notes, 339-340
network printers, 204-205
Pages documents, 310
sharing network printer, 197
spreadsheet, 326-328
USB printers, 198-204
web pages, 144-145
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Privacy pane, 146
privacy protection, 26, 145-148
productivity applications, 19

Project pane (iMovie), 262, 263, 266, 267, 268,
269, 270, 271, 272, 273, 275, 277

Prosoft Engineering, 389
Public folder, 175
pushing, 150

Q

quarantining, 353

Quick Actions, 78-79

Quick Look, 42, 77, 103

Quit command, 42

quitting applications, 42-43, 92

R

radio
creating iTunes Radio station, 230
Internet radio, 228-229
MLC Radio, 229
radio stations in your playlists, 229-230
tuning in your own stations, 229

RAID array, 367

RAM (random access memory), 8, 358, 359,
360, 363, 388

Random Order check box, 88

Random Screen Saver check box, 88
Reader View, 140, 145

Reader When Available check box, 140
Reading List, 139-140

rebooting, as troubleshooting strategy,
344-346

Recent Applications check box, 41

Recent Applications group, for launching
applications, 41

Recent Applications to your Dock, 65
Recent Items (General), 92
Recent Iltems menu, 391



Recent Items selection, for launching use of for visiting websites, 131-132

applications/opening documents, 41 using History, 141-142
red-eye, 254 working with Reading List, 139-140
refurbished hardware, cautions with, 398 Safari check box, 98
Rehearsal (Keynote), 336 Safe mode, 346-347, 353
remanufactured, use of term, 398 SATA (serial ATA) hard drive/flash storage, 14
Reminders app, 111, 112-114 Satellite mode, 120, 121
Reminders check box, 98, 114 Satellite view, 121

Require Password After Sleep or Screen Saver saving
Begins check box, 89 files, 375

Req.u.ire P:.ﬂssword check box, 232 in GarageBand, 292

re5|2|r1g Wln(?lO'WS, a4 o iCloud documents, 151-152
RestE(C)E(E?gilglot Language in Dictionary check presentations (Keynote), 331-332
' spreadsheets (Numbers), 316-317

Restrictions pane, 235
work in Pages, 302

Rewind/Forward One Measure buttons

(GarageBand), 281 scanners, 205-206
right-click menu, 36, 38 Schedule button (Energy Saver pane), 93
ripping, 226-227 screen (display), 10
root account, 397 screen saver, 87-89, 90, 354
Roxio, 377 screen wipes, 22

scroll bars, 44
S scrolling, 44
. SD memory cards, 12

Safari

SDXC card slot, 12, 14

searching. See also Spotlight
doing basic search, 102-104
expanding search horizons, 106-107
what Spotlight can do, 105-106

secondary click, 38

adding and using bookmarks, 138-139
author’s preference for, 20

bad cookies, 145-146

banishing iCloud Keychain passwords, 147
downloading files, 140-141

Googlg as seérch e‘ngine for, 132-133 Secondary Click check box, 39
handling ancient history, 147

) ) o security, of Spotlight, 106
major sections of Safari window, . )
130-131 Security & Privacy pane, 89, 168

selecting items, 50-51

serial ATA (SATA) hard drive/flash storage, 14
Setup Assistant, 24

shapes (Keynote), 334

shapes (Pages), 304, 308-309

Share button, 116, 123, 124, 135, 136, 145, 208,
257, 276, 295

Shared Albums (Photos), 257

for navigating web, 133-136
pinned tabs, 144

printing web pages, 144-145
protecting your privacy, 145-148
setting notifications, 148

setting up home page, 136-137
tabbed browsing, 142-143
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shared bookmarks, 20, 98
Shared folder, 175
sharing
data via Bluetooth, 4
iMovie, 278
Internet connection, 183
iTunes, 231-233
maps and directions, 123
network file sharing, 196-197
network printers, 197
photos/video, 208, 241, 242
posters (Pages), 310-311
presentations (Keynote), 340
songs, 293-296
Sharing pane, 95-96, 108, 175, 197
Sheet canvas (Numbers), 317
Sheets tab (Numbers), 317
shortcut (a.k.a. alias), 49
shortcut menu, 36, 38, 39
shortcuts, keyboard. See keyboard shortcuts
Show All button, 83
Show All Tabs button (Safari), 143
Show Content Ratings in Library check box, 236
Show Details button (Keynote), 339
Show Details button (Numbers), 327
Show Details button (Print sheet), 70, 123, 145

Show Fast User Switching Menu As check
box, 174

Show in Notification Center check box, 100

Show Indicators for Open Applications check
box, 95

Show Mirroring Options in the Menu Bar When
Available check box, 86

Show Notification Preview check box, 100

Show Notifications on Lock Screen check
box, 100

Show Reader View icon, 140
Show Recent Applications check box, 65

Show Recent Applications in Dock check
box, 95

Show Scroll Bars option, 92
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Show Time Machine in Menu Bar check box, 97
Show Wi-Fi Status in Menu Bar check box, 187
Show with Clock check box, 88
Shut Down/Sleep check box, 93
ShuttlePro V2 (Contour Design), 367
Sidebar, 53, 58
Sidebar (Safari), 131
Sidebar Icon Size (General), 91-92
Sidebar pane, 131
Simple Finder, 171
Single User mode, 347
Siri
for launching applications, 41
use of Spotlight's search features by, 104
Siri check box, 98
Size slider, 254
sleep mode, 88, 93, 100, 354
sliders
Brightness slider, 86
Color Temperature slider, 86
Computer Sleep slider, 93
Content Scale slider (Numbers), 327
Display Sleep slider, 93
equalizer sliders, 227
Magnification slider, 93
Preamp slider, 227
Size slider, 254
Tracking speed slider, 39
Volume slider, 215, 269
Volume slider (GarageBand), 282
Zoom slider, 241
slides (Keynote), adding, 333-334
slideshow
creating of in Keynote, 338-339
creating of in Photos, 255
Small Dog Electronics, 359
Smart Album (Photos), 245-247
SMART Board, 339
Smart Controls pane (GarageBand), 291, 292
Smart Playlist, 221, 223



software, what's already installed, 19-21
software piracy, cautions in endorsing, 396
Software Update pane, 79, 382, 383
solid-state drive (SSD), 14
songs
creating song files in iTunes, 294-295
exporting project, 295-296
knowing yours, 224-226
sharing yours, 293-296
Songs view mode, 219
Songwriter project (GarageBand), 284
sound effects (iMovie), 268
Sound Effects section (Sound pane), 83
Sound pane, 82, 83
Spaces, 60-61
speaker icon, 144, 290
speakers, 11, 12,13
special keys, 55, 346
spelling (Pages), 309
Spotlight, 101-109
Spotlight pane, 108

Spotlight Search box (System Preferences),
84-85, 102, 103, 104, 106, 108, 317

spreadsheet. See also Numbers app
spreadsheet, defined, 314
SSD (solid-state drive), 14
Stacks, 65-67
Standard (or Map) mode, 120
Standard user account level, 159, 160, 163
Start Up or Wake check box, 93
start-up keys, 347
status bar, 51
Status bar (Safari), 131
Stealth mode, 198
stereo speakers, 11, 13
Stocks app, 78
stolen iMac, locating, 154
storage
capacities, 14
managing iCloud storage, 155-156
managing of in macOS, 370-374

streaming Internet radio, 215, 228
Summary pane, 232
surge suppressor, 22, 397
switch, power, 23-24
synchronization, 149, 150
System Administrator account, 397
System Information utility, 354
System Preferences pane, 83
Systems Preferences

Displays pane, 85-87

locating special setting, 84-85

overview, 82-84

popular preferences panes, 85-100

T

Tab bar (Safari), 130
Tab pane, 144
tabbed browsing, 20, 142-143
Table button, 116
tables (Pages), 306-307
tabs
Finder Tabs, 44, 54, 391
pinned tabs, 132, 144
Tap to Click check box, 39
tapping, 38
Target Disk mode, 347
telephone support, 27
temperature, keeping iMac cool, 16
text (Keynote), 334
text (Pages), 304, 305
text log files, 169
Theater mode (iMovie), 276
3D effect, 121
Three Finger Drag check box, 39
thumb drive, 32
thumbnails, 131, 241
Thumbnails pane, 241, 251
Thunderbolt 2, 365
Thunderbolt 3, 12, 13, 15, 364, 365
Thunderbolt cable, 28, 29, 365
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Time button (parental controls), 168

Time Capsule, 14, 15, 16, 29, 96, 97, 185, 186,
197, 364, 377

Time Machine, 375, 377
Time Machine pane, 96-97, 377
Timeline (GarageBand), 281
Time/Tempo display (GarageBand), 281
title bar, 45
titles (iMovie), 274-275
Toast Titanium (Roxio), 377
Today button, 117
Today view, 117
toolbar, 47
Toolbar (Numbers), 317
Top Sites, 132, 134, 142
track (GarageBand), 280
Track list (GarageBand), 280
Tracking speed slider, 39
trackpad, 37. See also Magic Trackpad 2
Trackpad pane, 38
Trailer pane (iMovie), 277, 278
trailers (iMovie), 260, 276-278
transfer, 189
Transit mode, 121
transitions (iMovie), 273-274
Trash, 68
troubleshooting
Apple Help online, 356
defined, 343
Disk Utility functions, 348-350
First Aid, 350
local service, 355
macOS Help Center, 355
myths about, 343-344
rebooting, 344-346
Safe mode, 346-347
special keys that can come in handy, 346-347
start-up keys, 347
step-by-step, 344-355
Troubleshooting Tree, 351-355
Turn Off Siri & Dictation check box, 168
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Turn On Until Tomorrow check box, 86

TWAIN device standard, 205

Twitter
sharing copy of finished presentation on, 340
sharing maps and directions using, 123
sharing photo or video on, 208, 241, 242

U

Undo, 247, 253

Undo (iMovie), 272

uninterruptible power supply (UPS), 22, 397
Universal Clipboard, 153

Unix, 37, 349, 397

unpacking your iMac, 17

Unpin Note, 116

USB (Universal Serial Bus) cable, 202, 231, 243,
293, 365

USB (Universal Serial Bus) ports, 12, 13, 186
USB 3.0 connections, 13, 22, 364, 365

USB printers, 67, 186, 202, 364

USB-C (a.k.a. Thunderbolt 3), 13

Use LCD Font Smoothing When Available check
box, 92

Use Simple Finder check box, 169

Use Sound Check check box, 235

user account levels, 159-160

user groups, 71-72

username and password login, 172

users
adding, 160
banishing mischievous user, 163-165
modifying user accounts, 162-163
working with guest account, 165

Users & Groups pane, 160, 162, 164, 165, 166,
171,382

utility programs, cautions in using antiquated
utility software, 396

\'

VESA mounting adapter, 11, 15
video



playing of, 214

pulling in video clips in iMovie,
264-266
watching, 221
video camera, 206
video card, 15
video controllers, 367
video formats (iMovie), 266
videoconferencing, 20
Viewer pane (iMovie), 273

View/Hide Loop Browser button
(GarageBand), 281

View/Hide Media Browser button
(GarageBand), 281

views

All Tabs view, 143

column view, 43-44, 389

column view (Pages), 301

Gallery view, 42, 44,77, 104

Icon view, 43, 107

List view, 43, 66

Map view, 121

Notifications view, 117, 118

outline view (Keynote), 340

Reader View, 140, 145

Satellite view, 121

Today view, 117
Vimeo, sending your movie to, 278
virus scan, 353
Visualizer, 235
Voice Memos app, 78
voiceover narration (iMovie), 268-269
Volume slider (GarageBand), 282
Volume slider (iMovie), 269
Volume slider (iTunes), 215
Volume Up/Volume Down keys, 55
VTR (or VCR) mode (iMovie), 264
VueScan, 205

W

warranty, voiding of by tinkering with anything
other than memory slots, 360

warranty support, 27

WAV, 214, 216, 226

web surfing, 20, 133, 136

website icons, 75, 144

websites, using Safari for visiting, 131-133
WEP encryption, 188

When Switching to an Application
check box, 90

widescreen aspect ratio, 10
widgets, 61, 62, 89, 117
Wi-Fi check box, 195
windowed mode, 241
windows
closing, 47
minimizing and restoring, 45
moving and zooming, 46-47
only one active at once, 48
scrolling in and resizing, 44-45
Windows, switching from, 29-30
Windows Easy Transfer utility, 30
wiping, 99
wired network, 181-182, 190-192
wireless networking, 16, 181-182, 184-189
WPA2 encryption, 188
wrist rest, 22

Y

year, displaying photos by, 240
YouTube, sending your movie to, 278

Z

Zoom, 46
Zoom slider, 241
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